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Welcome to Approach 3.0

Welcome to Lotus® Approach® 3.0 for Windows, a powerful but 
intuitive relational database application. Whether you are new to 
databases or a veteran information manager, Approach will help you 
handle your data as skillfully, efficiently, and easily as possible.

This manual is your source for in-depth information about 
Approach. It covers the basic terms and concepts you need to know 
and gives step-by-step instructions for all of the Approach 
procedures. It also provides tips for making your work easier.

The manual assumes you know how to work with files and windows 
in the Microsoft® Windows™ environment and that you are familiar 
with basic techniques such as clicking and dragging. If you need help 
with Windows, see your Windows User’s Guide.

Approach comes with an online guided tutorial, a comprehensive 
online Help system, and sample applications for common business 
scenarios.

After installing Approach, you may want to turn to the online 
tutorial to help you get started. The tutorial provides a quick 
overview of Approach and takes you through many of the most 
important features.

Each module in the tutorial addresses a particular part of Approach. 
You can go through the entire tutorial at once or use individual 
modules to learn specific procedures.

To start the tutorial with Approach running, choose Tutorial from the 
Help menu in the Approach menu bar.

About this manual

About the online 
materials

Online tutorial
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Use the Approach Help system to get information quickly while 
working in Approach. The Help system provides the same 
procedures that are in this manual, but more concisely. It also 
contains keyboard shortcuts and technical information about SQL 
that is not in the manual.

You can search for topics in the Help system, and in many places you 
can click an icon or text to go to a page with related information. 
Once you have a basic familiarity with Approach, you may find the 
Help system the quickest and easiest means of getting the 
information you need.

To open the Help system, choose a topic from the Help menu. For 
instructions on navigating through Help, press F1 while the Help 
system is running.

Use the sample applications to explore and learn about Approach, or 
as a starting point for databases of your own. The samples are in the 
\APPROACH\SAMPLES directory (unless you specify otherwise 
when you install Approach).

In this manual and in the online materials, the terms click, double-click, 
and drag refer to the left mouse button unless the right mouse button 
is specified.

Approach provides SmartIcons® in an icon bar at the top of the 
application window and in a floating palette in Design. In this 
manual, whenever you can apply a command by clicking an icon in a 
default icon bar (such as the Browse icon shown at the left), a picture 
of the icon appears to the left of the procedure.

Online Help system

Sample applications

Conventions
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Before installing Approach, check to see that you have the correct 
equipment and operating system, and make a backup copy of your 
disks.

This is what you’ll need to run Approach:

• An IBM-PC® or fully compatible personal computer with a 80386 
or later processor, a hard drive, and at least one floppy disk drive 
(if you’re installing from disks)

• At least 4 megabytes (MB) of random access memory (RAM) 
(6 MB is recommended)

• A color or grayscale VGA or higher resolution monitor

• For a full installation on a standalone computer, 19 MB of 
available disk space; for a minimum installation, 6.7 MB plus an 
additional 1.8 MB during install

• A mouse or other pointing device

• Microsoft Windows, version 3.1 or later

If you plan to use Approach on a network, you’ll need one of the 
following networking systems and the associated Windows drivers:

• Novell® Advanced NetWare® network, version 2.0A or later (or 
NetWare 386)

• NetWare Lite™

• LANtastic®

• Windows for Workgroups

• Microsoft LAN Manager

• IBM-PC Local Area Network Program, version 1.12 or later

• 3Com® 3+Open, version 1.0 or later

• Banyan® VINES® network, version 2.1 or later

Make a backup copy of your Approach disks and use the backups to 
install Approach. Store the original disks in a safe, dry place.

The disks you use for the backup must be the same size as your 
install disks (that is, they must all be 3.5-inch or 5.25-inch). If you’re 
backing up onto 5.25-inch disks, the disks must be high density.

Before you begin

System 
requirements

Network 
requirements

Backing up your 
disks



xiv User’s Guide

To back up your disks, use the Copy Disk command in the Windows 
File Manager. For help with this, see your Windows User’s Guide.

You can install Approach on a standalone computer, a network node, 
or a network file server:

• If you install on a standalone computer, you can install the 
complete set of Approach files, a minimum configuration of files, 
or a custom set of files you specify. The minimum configuration 
installs only the program files and is useful for a laptop or other 
computer with limited disk space.

• If you install on a network node, only a few Approach files are 
installed. The rest of the files you need to run Approach reside on 
the network.

• If you install on a network file server, you can install a server 
version of Approach for other users to run on their network 
nodes, or a distribution version for other users to install on their 
standalone computers.

Note that if you already have Approach 2.1 on your computer and do 
not specify a different location for the Approach 3.0 files, installing 
Approach 3.0 overwrites the 2.1 program files and sample 
applications. It does not affect your data files.

To install Approach:

1. If you’re installing from disks, insert the first disk into a drive.

You can install Approach from disks or from install files on a 
network. 

2. In the Windows Program Manager, choose Run from the File 
menu.

The Run dialog box appears.

3. Type the installation command in the Command Line text box 
and click OK.

If you’re installing from disks, type a:install or b:install. If you’re 
installing from a network, type path\install, where path is the 
location of the install files; for example, f:\lotus\approach\install.

Installing Approach

You must have SHARE.EXE 
to run Approach. If you do 
not have it, Approach installs 
it for you automatically.
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4. Follow the instructions on the screen to install the application.

The Approach installation program guides you through the 
process. Click the Next button whenever you’re ready to go on to 
the next set of instructions. For details about installation at any 
point along the way, click Help.

Approach alerts you when the installation is complete.
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1 An Overview of Approach

Approach is a relational database application that is powerful and 
versatile, but easy to use. You can work with data from a variety of 
database files (and database file types) in Approach, and you can 
design attractive and efficient forms, reports, and other views—
without programming.

A database is an organized collection of data. Like other database 
applications, Approach lets you manage data in sets called records; 
for example, everything about one customer is a record. The data in 
records is divided into fields such as name, address, and city.

Approach handles data in a particularly flexible way. Your data is 
stored separately from your view of it. And because Approach is 
relational, you can pull together data from many different sources 
and use it in one place.

Approach uses two basic kinds of files: Approach files and database 
files. An Approach file stores the forms, reports, worksheets, crosstabs, 
form letters, and mailing labels you design to enter, organize, and 
present data. You do all your work through Approach files.

A database file stores the data you see in an Approach file. You do not 
work directly in a database file, but use the Approach file as a 
“window” into it.

How Approach 
handles data

Approach files and 
database files

ORDERS.APR ORDERS.DBF

The actual data is stored behind 
the scenes in a database file.

You work with data 
through forms and other 
views in an Approach 
file.
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By storing data separately from the Approach file, Approach gives 
you enormous flexibility in the types of data you can work with and 
in the different ways you can bring it together. You can even have 
two or more Approach files read from the same database file.

With Approach’s PowerKey technology, you can read and write to 
databases in a variety of formats: dBASE®III+ and dBASE IV, 
Paradox® 3.5 and Paradox 4.0 (including Paradox for Windows), 
FoxPro® 2.1, Microsoft Access®, Oracle® SQL, Microsoft/Sybase 
SQL Server, and IBM®DB2®. And if you have other database 
applications that use an ODBC™ driver, you can work with those 
databases in Approach. You can also open spreadsheets and text files 
and save them as database files.

Approach gives you convenient access to data in Lotus 1-2-3® 
spreadsheets and Lotus Notes® databases. You can open and view 
1-2-3 and Notes files directly in an Approach file, create views to edit 
1-2-3 data in Approach, and create and route Notes messages in 
Approach. Beginning with Lotus 1-2-3 for Windows versions later 
than 4.0, you can even create Approach views from 1-2-3. Approach 
also provides seamless integration with data and graphics in other 
applications through OLE 2.0.

The filename extension for Approach files is .APR. The extensions for 
database files vary depending on the file type; for example, if you 
use the dBASE IV file type, the extension is .DBF.

For more information about Approach files and database files, see 
“About files in Approach” on page 2-1.

It’s usually most efficient to split up data into separate, manageable 
database files—such as one for orders, one for inventory records, one 
for individual customer data, and another for product specifications. 
Even if you don’t have a lot of data and complexity to begin with, 
data has a tendency to grow over time. A database design that 
groups data judiciously from the start can help you avoid problems 
later.

Joins between 
databases
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Approach is a relational database application, which means that you can 
bring together data from separate database files and use it as if it 
were all stored in one place. To do this, you join the database files 
within an Approach file that uses their data.

As you work with joined data in an Approach file, the underlying 
databases and the relationships between them are completely 
transparent. The databases can even be of all different file types; for 
example, a Paradox 4.0 file and three dBASE IV files can be joined 
together.

For more information about joins, see “About joined databases” on 
page 4-1.

You can work with data in Approach in a variety of different views, 
such as forms for entering data, summary reports for presenting data 
from a range of records, and form letters that retrieve names and 
addresses from a database. Views are stored in an Approach file, and 
can use data from all the databases joined in that Approach file.

When you create a new Approach file, it has a basic form and 
worksheet already set up. You can modify these views and add as 
many other views as you need. 

Approach provides a rich set of predefined field layouts and color 
and style combinations called SmartMastersTM for creating custom 
views quickly and easily. You can also use Approach’s design tools to 
modify views. In any view, you can put fields wherever you want 
them, import graphics and OLE objects, draw objects such as lines 
and rectangles, and customize the design in other ways for your own 
needs.

An Approach file can 
use data from a set of 
joined database files.

PRODUCT.DBF

CUSTOMER.DBF

INVENTRY.DBF

ORDERS.DBF

ORDERS.APR

Views of your data
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A form shows data about one record at a time, with as much or as 
little detail as you want. (You can browse through the database to see 
other records in the form.) Forms are usually used for entering and 
editing data about a record.

When you print a form, each printed page shows one record.

Forms are covered in Chapter 7, “Designing Forms and Repeating 
Panels.”

A report can display more than one record on a single page. Reports 
let you organize and analyze information from multiple records in 
powerful ways. You can sort the records that are showing, calculate 
summaries for them, and lay out and arrange record data however 
you need to.

Reports are most often used for organizing and analyzing data and 
for presenting it to others. You can also use reports to enter and edit 
data.

A report has a header and footer that repeat at the top and bottom of 
each page. You can use the header and footer to display information 
about the report, such as title and page number. Between the header 
and footer is the body of the report. Approach displays as many 
records as will fit in the body.

Forms

A form shows one record 
at a time. In this case, it 
shows one order.

Order

Ship To
Order #Barcelona Cafe 53

Ship Date

Item #
17

Price

9/1/94

90 Cabernet 6 12.25
Item Name Qty

Attn: Jose Morales

Reports
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If records have a field with a numeric value, such as the number of 
items sold, you can perform summary calculations on this field for a 
range or group of records. If a report has more than one summary 
range of records, you can also perform higher-level calculations, such 
as a grand total for the report.

Reports are covered in Chapter 8, “Designing Reports.”

Form letters are usually a mixture of text you type and information 
from fields in a database. 

Approach creates a copy of a form letter for each record you’re 
working with and addresses the copies for you, using the name and 
address fields in the records. You type your text around the fields in 
the letter, as you would in a merge document in a word processing 
application. 

You can also have Approach provide a salutation, closing, and return 
address, or you can type these items yourself.

90 Cabernet

90 Merlot

3,000
2,200
5,200

1,500

Produc t Sales Rep Amount

Lindsay
Renault
Subtotal

Washington
2,000
3,500

Wu
Subtotal

8,700Grand Total

A report can show more 
than one record at a 
time. In this case, each 
sales rep is a record.

You can calculate 
subtotals and a grand 
total in a report.

Quarterly Report

Form letters
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For example, you might have Approach get a name and address for a 
form letter from a customer database. You type the text of the letter 
only once, but for each copy of the letter, Approach supplies a 
different name and address.

Form letters are covered in Chapter 9, “Designing Form Letters and 
Mailing Labels.”

You can also have Approach generate mailing labels from 
information in a database. Each region on the page is the label for one 
record. Approach provides standard Avery® formats for mailing 
labels, and you can also create other formats of your own.

Jose Morales
Barcelona Cafe
15 Miramar Place
Pensacola, FL 33345

Dear Jose Morales ,

We’d like to take this opportunity
to thank you and all the folks at 
Barcelona Cafe for your
business in the past year...

The name and business 
data come from one 
record. The rest of the 
letter is typed text.

Mailing labels

Each label has data 
from one record.

Jose Morales
Barcelona Cafe
15 Miramar Place
Pensacola, FL 33345
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Mailing labels are covered in Chapter 9, “Designing Form Letters 
and Mailing Labels.”

A worksheet presents database records in a grid of columns and rows. 
The columns are fields; the rows are individual records. Worksheets 
are often the most efficient and flexible type of view for displaying 
data.

A cross-tabulation worksheet, or crosstab, expands on the worksheet 
model, allowing you to categorize and summarize database records. 
Instead of rows containing individual records, a crosstab shows you 
cells that summarize underlying records grouped or categorized by 
any fields you select.

Worksheets and crosstabs are covered in Chapter 12, “Designing 
Worksheets and Crosstabs.”

Worksheets and 
crosstabs

In a worksheet, 
each row is a record, 
and each column is 
a field.

Sales Rep Product # Cases

Lindsay

Lindsay

Lindsay

Renault

90 Cabernet

90 Merlot

90 Pinot Noir

90 Cabernet

Renault

Wu

90 Merlot

90 Merlot

3,000

1,600

1,500

2,700

3,400

2,000

Wu 90 Zinfandel 3,100

You can summarize 
worksheet data in a 
crosstab. This one 
summarizes by product 
and sales rep.

# Cases # Cases # Cases

3,000

1,600

1,500

2,700

3,400 2,000

3,100

Lindsay Renault Wu

90 Cabernet
90 Merlot

90 Pinot Noir

90 Zinfandel

6,100 6,100 5,100Total

Total

5,700

7,000

1,500

3,100

17,300
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Approach can generate presentation-quality charts from your 
reports, worksheets, or crosstabs. Charts make complex data easier to 
understand, and are often the best way to communicate and analyze 
data.

You can create bar charts, line and area charts, and pie charts in 
Approach. After you create a chart, you can easily change the chart’s 
type to one of the 20 types supported by the Lotus Chart facility. You 
can also add, modify, and delete elements in the chart.

Charts are covered in Chapter 13, “Creating Charts.”

The Approach work area contains file windows, menu commands, 
SmartIcons, view tabs, and a status bar for working with data and 
designing views.

Each Approach file you open appears in its own window inside the 
work area. You can enlarge the Approach file windows to fill the 
entire work area and manipulate windows in other ways. For 
information about the Control menu, the Minimize and Maximize 
buttons, and other window commands, see your Windows User’s 
Guide.

The SmartIcons are a subset of the commands from the menu bar. You 
can click an icon in an icon bar as a quick and convenient way to 
apply a command. The SmartIcons that appear in the work area at 
any one time are only a few of those available. 

Charts

A chart displays 
your data graphically.

Lindsay Renault Wu

Sales of 90 Merlot (by sales rep)

4,000

3,000

2,000

1,000N
o.

 o
f c

as
es

The Approach 
work area
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Approach comes with a default icon bar for Browse, Find, and 
Preview, and for worksheets and crosstabs. For Design, Approach 
provides three default icon bars and a floating palette of icons that 
are used for drawing. You can also prepare custom icon bars of your 
own.

The names of views in an Approach file appear in view tabs at the top 
of the file’s window. You can click one of these tabs to change to 
another view. In Design, you can also double-click a tab and then 
type in the tab to rename the view, and drag tabs horizontally to 
rearrange them.

The status bar at the bottom of the work area has pop-up menus for 
changing the view, the environment, and the icon bar. The rest of the 
information in the status bar varies depending on which 
environment you’re in.

The icon bar has icons 
you can click to apply 
commands.

The status bar gives 
information about the 
work area.

Control menu Menu bar Minimize button
Maximize

The view tabs show the 
names of views. Click a 
tab to go to a view, 
double-click a tab to 
rename it, or drag tabs to 
rearrange them.

button

Title bar

To choose from a pop-up 
menu, press on the 
menu to open it and drag 
to the option you want.

View pop-up 
menu

Environment 
pop-up menu

Icon bar pop-
up menu
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For a description of a menu command, move the pointer over the 
command in its menu. The description appears in the window 
title bar.

For a description of SmartIcons, move the pointer over the icon (or if 
your icon options are set this way, click the icon with the right mouse 
button). The description appears in a “bubble.”

Many commands open a dialog box. You can click the question mark 
(?) in the upper-right corner of a dialog box to go to online Help 
about it.

If you want to increase the size of the work area in your Approach 
window, you can hide the icon bar, the view tabs, or the status bar. To 
change the display of one of these elements, choose Show 
SmartIcons, Show View Tabs, or Show Status Bar from the View 
menu. The commands have a checkmark by them when they are on.

To see a description of a 
menu command, move the 
pointer over the command.

To see a description of 
SmartIcons, move the pointer 
over the icon or right-click it.

To get online Help 
about a dialog box, click 
the question mark.
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You can work in four different environments in Approach: Design, 
Browse, Find, and Preview. The work area changes in several ways 
when you go to another environment.

In Design, you edit the layout of forms, reports, form letters, and 
mailing labels in an Approach file. You do not work with actual data 
in Design, but you can see data and plan the arrangement of it.

■ To go to Design, click the Design icon in the icon bar, or choose 
Design from the View menu or from the environment pop-up 
menu in the status bar.

You can add and edit fields in Design; draw, lines, rectangles, and 
other graphic items; write text on the background of a view; import 
graphics; and link or embed OLE objects. Everything on a view in 
Design is a design object. You can work with all objects in many of the 
same ways—such as moving and resizing them, grouping and 
aligning them, and adding line and fill colors.

When you’re in Design, you can show data in fields as it appears in 
Browse, or show the names of fields and databases. If you show data, 
you see data from the first record (in a form or form letter) or first 
page of records (in other views).

Environments in 
Approach

Design

Fields can show data or 
field names in Design.

Views and 
objects can 
be filled with 
colors and 
patterns.

The Tools palette has 
icons for drawing 
design objects.
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Approach provides three default icon bars for Design—the Design 
icon bar, the Text icon bar, and the Report icon bar—and a floating 
Tools palette that has icons for drawing objects. The Tools palette 
opens automatically when you go to Design; you can drag the palette 
by its title bar to move it around in the work area.

The status bar in Design has buttons for formatting selected text and 
pop-up menus for changing the view, the environment, the zoom 
setting, and the icon bar. It also shows the location of the insertion 
point or the selected object.

Each object on a view has a set of design properties, such as 
dimensions, text attributes, line and fill colors, and attached macros. 
The settings for an object are stored in an InfoBox. You can keep the 
InfoBox open on the screen as you work and use it to edit objects.

You can save a set of InfoBox properties in a named style and then 
apply the style to other objects.

For more information about the icon bars, Tools palette, status bar, 
and InfoBox in Design, see “About Design” on page 5-1.

Use the InfoBox to edit 
objects in Design.



An Overview of Approach 1-13

In Browse, you work with the information in a database. You can 
enter and edit data here, find and sort records, and print views. You 
can also create views (but you need to go to Design to modify the 
design of forms, reports, form letters, and mailing labels).

You work in Browse most of the time. When you first create or open 
an Approach file, you see a view in Browse.

■ To go to Browse, click the Browse icon in the icon bar, or choose 
Browse from the View menu or from the environment pop-up 
menu in the status bar.

The default icon bar in Browse has icons for entering and editing 
data, moving from one record to another, finding and sorting records, 
adding and deleting records, spell checking, and printing.

The status bar in Browse shows the position of the current record in 
the found set and the total number of records in the found set. It also 
has arrow buttons for moving to another record and pop-up menus 
for changing the view, the environment, and the icon bar.

For more information about Browse, see “About Browse” on 
page 10-1.

Browse

In Browse, you enter and 
edit data.
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In Find, you fill out a find request to search for records that meet 
certain criteria. A find request is a blank copy of the view you’re 
currently using. 

■ To go to Find, click the Find icon in the icon bar, or choose Find 
from the Browse menu or from the environment pop-up menu in 
the status bar.

For example, to find all employees who were hired after May 1, 1994, 
using the find request above, you would type >5/1/94 in the Date 
Hired field.

When you finish filling out a find request, Approach returns you to 
Browse and displays only the records that match the criteria you 
specified. This subset of records is the found set.

The default icon bar in Find has icons for inserting operators in 
search criteria. The status bar in Find is the same as it is in Browse.

For more information about Find, see “Finding data in records” on 
page 11-1.

Find

In Find, Approach 
opens a blank copy of 
the current view. You fill 
in the fields to use as 
search criteria.
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The Preview environment shows what the current view will look like 
when it is printed. This gives you a chance to correct errors or make 
design changes before committing a view to paper.

■ To go to Preview, click the Preview icon in the icon bar, or choose 
Preview from the File menu or from the environment pop-up 
menu in the status bar.

All of the data from Browse also appears in Preview. You can move 
through records in Preview as you can in Browse, but you cannot 
click in fields or edit data. 

If a view has any fields that summarize data from multiple records, 
Approach calculates the summary in Preview and shows the results. 
If a view has fields or other objects that slide up or left, the fields 
slide into position in Preview and in Design if you’re showing data.

When you first go to Preview, you see the current view reduced to 75 
percent of its normal size. You can change to other zoom settings.

The default icon bar in Preview has icons for moving through 
records, finding and sorting records, and printing. The status bar in 
Preview is the same as it is in Browse, except that it also has a pop-up 
menu for changing the zoom setting.

For more information about Preview, see “Previewing a view” on 
page 14-3.

Preview

Preview shows what the 
current view will look like 
on a printed page.
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These are the basic steps for setting up a new database in Approach. 
Turn to the chapters listed below for detailed procedures.

1. Create a new database file.

You can create an empty database file (without data) or start with 
an existing database, spreadsheet, or text file from another 
application. Approach automatically creates an Approach file for 
the database file.

See Chapter 2, “Managing Files.”

2. Define the fields of the new database file.

A field definition specifies a name and type for the field, and in 
some cases additional information such as a length or a formula. 
When you create a new database file, you can select a template 
that has fields already defined. You can edit existing fields and 
add new fields to a database at any time.

See Chapter 3, “Defining Fields.”

3. If you want to use data from other databases in your new 
Approach file, join the other databases to the new database file.

You can join two databases on any field they have in common.

See Chapter 4, “Joining Database Files.”

4. If you want to use custom views, design the views for the new 
Approach file.

Approach supplies a standard form and worksheet for a new 
Approach file. You can also design custom forms, reports, form 
letters, mailing labels, worksheets, and crosstabs.

See Chapter 5, “Working in Design,” Chapter 6,  “Adding and 
Editing Fields in a View,”  Chapter 7, “Designing Forms and 
Repeating Panels,” Chapter 8, “Designing Reports,” Chapter 9, 
“Designing Form Letters and Mailing Labels,” and Chapter 12, 
“Designing Worksheets and Crosstabs.”

5. Enter data in the records.

Either type in data yourself, or import it from another file. You 
can enter the data in the standard form or worksheet that 
Approach provides, or in a custom view that you design.

See Chapter 10, “Entering and Editing Data,” and Chapter 16, 
“Exchanging Data with Other Files or Applications.”

Basic steps for 
setting up a 
database
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2 Managing Files

The fields and records of a database are stored in a database file. Each 
database can have at least one Approach file with forms, reports, and 
other views that provide a “window” into the information.

This chapter describes how to create, open, save, close, and delete 
Approach files and database files within Approach.

The instructions in this chapter assume you know how to specify 
directory and disk locations in file dialog boxes in Windows 
applications. If you need help with this, see your Windows User’s 
Guide.

In Approach, you work in Approach files that have the forms, reports, 
worksheets, crosstabs, letters, and mailing labels you design. You do 
all your work in Approach files, including entering and editing data, 
finding and sorting records, and organizing and printing information 
for colleagues.

The data you see in Approach files is not actually stored there, but is 
kept behind the scenes in one or more database files. You do not work 
directly in these files, but use their data through the Approach files. 
With this arrangement, an Approach file can use data from a variety 
of database files—and a variety of database types.

Approach can read database files directly in dBASE IV, dBASE III+, 
Paradox 3.5, Paradox 4.0 (including Paradox for Windows), 
FoxPro 2.1, Microsoft Access, Lotus Notes, Oracle SQL, Microsoft/
Sybase SQL Server, and IBM DB2 formats. Other formats may be 
available if you have installed applications that use an ODBC driver. 
Approach can also create database files from Lotus 1-2-3 and 
Microsoft Excel spreadsheets, and from delimited and fixed-length 
text files.

About files in 
Approach

Appendix B, Appendix C, 
and Appendix D give detailed 
information about file types.
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The Approach files always have the same Approach format and 
interface, so the file type of an underlying database is invisible to you 
as you work. Approach files can provide a “front end” to many 
different sources of data, with a consistent and easy-to-use interface.

Approach files have the filename extension .APR. The filename 
extension for dBASE and FoxPro files is .DBF, for Paradox files it is 
.DB, for Lotus Notes files it is .NSF, and for Microsoft Access files it is 
.MDB. SQL tables do not have an extension.

A single Approach file can bring together data from more than one 
database at a time. To do this, you join the underlying databases in 
the Approach file. Joining allows you to synthesize information in 
more complex and flexible ways than you can with a single database. 
The joined databases for an Approach file can even be of different 
types.

Whenever you create a new database file, or open an existing 
database file, Approach automatically creates and opens a new 
Approach file so that you can begin entering data. And when you 
want to work with an existing Approach database file, you open an 
Approach file for it, rather than the database file.

As you work in an Approach file, Approach automatically saves 
changes you make to data in the corresponding database file. If you 
make design changes to views, you save those changes in the 
Approach file yourself.

Approach creates additional files as needed for memos, indexes, and 
file format compatibility. You do not work directly in these files, but 
you may notice them in a file dialog box or in the Windows File 
Manager. See “Filename extensions” on page B-8 for a list of 
extensions for all the Approach files.

PRODUCT.DBF

CUSTOMER.DBF

INVENTRY.DBF

ORDERS.DBF

ORDERS.APR
An Approach file stores 
forms, reports, and other 
views for a database or for 
a set of joined databases. 
You do all your work in 
Approach files.

Data is stored behind the 
scenes in database files.
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To set up a database in Approach, you can create a new database file, 
open a database file that has already been created (often in another 
application), or create a database from a spreadsheet or a text file. 
Approach automatically creates and opens an Approach file for each 
new database file. To open an existing database in Approach, you 
open the database’s Approach file.

Approach is preset to display a Welcome dialog box whenever you 
start the application and whenever you close all Approach files but 
leave the application running. You can use this dialog box to create 
and open files. If you don’t want the Welcome dialog box to appear, 
turn on “Don’t show this screen again” at the bottom of it. (To show 
the dialog box again, turn on “Show Welcome dialog” in the Display 
panel of Preferences.)

Query files are text files that store log-on information and Select 
statements for SQL tables; they have the filename extension .QRY. For 
information about these files, see “Opening a query file in Approach” 
on page C-15.

If you’re setting up a database from scratch, begin by creating a 
database file for it. You need to give the file a name and location and 
specify a file type. Approach automatically creates and opens a new 
Approach file for the database file.

Approach comes with several templates that provide predefined 
fields for common types of databases. If you create a database using a 
template, the database will be a copy of the template; you can modify 
its predefined fields for your particular needs. If you create a 
database without using a template, you define the fields from 
scratch.

Make sure you save your Approach file. Approach does not 
automatically save an Approach file for a new database (though it 
saves any data in the database file).

To create a new database file:

1. If you just started Approach and the Welcome dialog box 
appears, select “Create a new file,” select a template if you want, 
and click OK.

Creating and 
opening files

Creating a new 
database file

Even if a template does not 
provide exactly what you 
need, you may find it quicker 
to start with one than to set 
up a database from scratch.
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The Welcome dialog box appears if “Show Welcome dialog” is 
on in Preferences. 

If you leave the template setting as Blank Database, the new 
database file will be empty, with no fields.

If you don’t want the Welcome dialog box to appear after this, 
turn on “Don’t show this screen again.”

2. If Approach is already running, click the New File icon or choose 
New from the File menu.

The New dialog box appears.

3. Type a name for the database file in the File Name text box.

You can also change the directory and disk if you want to specify 
a different location for the file.

4. Select a database file type in the List Files of Type drop-down list.

The list shows the file types you can use for a new database. The 
standard file types in the list are dBASE IV, dBASE III+, 
FoxPro 2.1, and Paradox. You do not need to have a dBASE, 
FoxPro, or Paradox application to use these file types with 
Approach.

Select “Create a new file.”

If you want, select a template 
for the new database.

Turn this on if you don’t want 
to see the Welcome again.

Type a name for the new 
database file.

Select a file type for the 
database file.

Specify a 
location for the 
database file.

You don’t need to type an 
extension for a filename. 
Approach adds an extension 
based on the file type.
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If the ReadOnly line in your APPROACH.INI file is set to 0, the list 
also shows the types Access, Oracle, SQL Server, DB2-MDI, and 
Lotus Notes, and any ODBC drivers you have installed. For more 
information about these file types, see Appendix B, Appendix C 
or Appendix D.

5. Click OK.

If you created the file with a template, the file opens to a view 
specified by the template. The fields are already defined.

If you created the file without a template, the Field Definition 
dialog box appears so that you can define fields for it. For help 
with this, turn to “Adding fields to a database” on page 3-5.

When you want to work with an existing Approach database, you 
open the Approach file rather than the database file; Approach files 
have the filename extension .APR. After opening the file, you can 
switch to the particular form, report, or other view you want. If 
multiple database files are joined in an Approach file, the Approach 
file gives you access to all of those databases.

If you open a database file (a file with an extension such as .DB or 
.DBF), Approach creates a new Approach file for the database. The 
Approach file has the same name as the database, but with the 
extension .APR.

In versions of Approach earlier than 3.0, the files that contain views 
are called view files rather than Approach files and have the filename 
extension .VEW. When you’re showing Approach files in the Open 
dialog box, any view files you have also appear. You can open a view 
file just as you open an Approach file.

An .APT file contains views and data and is created when you attach 
an Approach file to a message in Lotus Notes, cc:Mail, or other VIM 
or MAPI mail packages. If you open one of these files, it is read-only. 
You can save the file as an Approach file if you need to edit it.

To open an Approach file for a database:

1. Click the Open File icon or choose Open from the File menu. Or if 
the Welcome dialog box is on the screen, select “Open an existing 
file” and click OK. 

If you plan to use a database 
only in Approach and not 
with other applications, leave 
the file type as dBASE IV.

Opening an 
Approach file for a 
database

If the file you want to open 
appears in the Approach files 
list in Welcome, just select 
the filename and click OK.
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The Open dialog box appears.

2. Select the name of the Approach file in the File Name list.

The list is preset to show Approach files, so you don’t need to 
select the file type to see them. You can change the directory and 
disk if you need to look for the file.

3. To open the Approach file only for reading, turn on Read-only.

If you turn on this setting, you will not be able to edit data or 
save design changes in the Approach file. This setting applies 
only to your current session with the file, and does not make it 
permanently read-only.

4. Click OK.

The Approach file opens to the form, report, or other view you 
were using when you last saved the file.

If the Approach file has fields that need to be mapped to fields in 
a database file, the Field Mapping dialog box appears. For 
information about this, see “Mapping fields in an Approach file” 
on page 2-7.

Passwords
If a database requires a password, Approach asks you to provide the 
password when you try to open an Approach file that uses that 
database. A database can have a read/write password or both a 
read/write and a read-only password. Approach opens the 
Approach file only if you type the password correctly. For more 
information, see “Entering a password” on page 18-7.

Select the Approach file 
you want to open.

Specify the 
location of the 
Approach file.Leave the Approach file 

type selected.

If the file has a description, 
it appears here.

If you want to launch a macro 
every time you start 
Approach, create a macro 
called Open. See page 15-1.



Managing Fi les 2-7

Approach keeps track of the last five Approach files you opened or 
saved, and displays their names at the bottom of the File menu and 
in a drop-down list in the Welcome dialog box. You can quickly open 
one of these files by selecting its name. 

To reopen one of the last five Approach files used:

■ Select the name of the file in the bottom of the File menu. Or 
press ALT-F and the number (1 through 5) that appears for the 
Approach file in the menu. 

■ If the Welcome dialog box is on the screen, select the name of the 
file in the Open drop-down list and click OK.

The Approach file opens to the form, report, or other view you were 
using when you last saved the file.

If you open an Approach file with fields that need to be mapped, the 
Field Mapping dialog box appears. For information about this, see 
“Mapping fields in an Approach file,” next.

If you make structural changes to fields and then do not save the 
Approach file, or if you make structural changes through another 
Approach file, the next time you open an Approach file you need to 
map the changed fields. This can happen if you have changed the 
name or type of a field or have deleted a field from the database file.

To map fields in an Approach file:

1. Open the Approach file.

An alert box appears if the Approach file has fields that need to 
be mapped.

Reopening one of 
the last Approach 
files used

The names of the last five 
Approach files used 
appear in the File menu…

…and in the Welcome 
dialog box.

Mapping fields in an 
Approach file

Click Yes.
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2. Click Yes.

The Field Mapping dialog box appears. (You can click No if you 
want to open the file without mapping the fields.)

3. Map an unmapped field to the database field right across from it 
by clicking between the two fields.

The fields on the left side of the Field Mapping dialog box are in 
the Approach file. The fields on the right side are in the database 
files. An arrow between two fields means that the fields are 
mapped.

If necessary, you can drag a database field up or down to move it 
across from the Approach file field you want to map to. When 
you position the pointer over the database fields, it turns into a 
move cursor to show that you can drag the fields.

If two fields do not have an arrow between them, the field in the 
Approach file is unmapped. When you click between the fields, 
an arrow appears.

Follow these suggestions for mapping a field: 

If you have Do this

Changed the name of a field in 
the database file

Map the Approach file field to the 
new field name in the database.

Fields with the same name are 
mapped automatically.

Move cursor

Fields that are mapped have 
an arrow between them.

Click here to map two fields 
on the same line.

If necessary, move database 
fields to align them with fields 
in the Approach file.

Continued
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To remove all the mapping in the Approach file, click Clear. To 
restore the Approach file to its original mapping, click 
Automatically Line Up Fields. 

4. Continue mapping unmapped fields in the same manner.

If you leave any fields unmapped, they will not show any data in 
the Approach file. In Design, the unmapped fields will have 
NO_FIELD_REFERENCE in them. In Browse, if you click in an 
unmapped field you get an error telling you that you cannot edit 
the field and must assign a database field to it.

5. When you’re finished mapping fields, click OK.

The Approach file opens.

You can open a database that was created in another application. 
Approach automatically creates and opens a new Approach file for it, 
and you can work with the database as if it had been created in 
Approach. This makes it easy for you to share data with people who 
use other database applications.

After you open a database from another application, you save its 
Approach file with the forms, reports, and other views you’ve 
designed. The next time you need to work with the database, open 
the Approach file and proceed as you would with any other 
Approach database.

You can also save the database file in another file type. For example, 
if you open a database that’s on a mainframe computer, you may 
want to save a copy of the database in dBASE IV to make it more 
suitable for use on your own computer. For more information, see 
“Saving a copy of an Approach file and a database file” on page 2-19.

Changed the type of the field 
in the database file

Map the Approach file field to its 
same name in the database, or map 
it to a different name to replace it 
with a different field.

Deleted the field from the 
database file

Map the Approach file field to a 
different field name in the 
database.

If you have Do this

In Design, you can use the 
InfoBox to make a link on an 
unmapped field or to remove 
the field from the view.

Opening a database 
created in another 
application

Make sure you save a new 
Approach file. Approach does 
not save it automatically.
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This section describes how to open a database in most compatible 
applications. For information about opening a database table, see 
“Opening a database table created in Microsoft Access,” next, 
“Working together with Lotus Notes” on page 17-1, or “Opening an 
ODBC data source” on page D-3.

To open a database created in another application:

1. Click the Open File icon or choose Open from the File menu. Or 
if the Welcome dialog box is on the screen, select “Open an 
existing file” and click OK.

2. Select a database file type in the List Files of Type drop-down list.

The drop-down list shows the file types of databases you can 
open. When you select a file type, the File Name list shows the 
databases in that type.

If you select Oracle, SQL Server, or DB2-MDI and are not already 
connected to a SQL server, a dialog box appears that lets you 
connect. For more information, see Appendix C. 

3. Select the name of the database in the File Name list.

You can change the directory and disk if you need to look for the 
file.

4. To open the new Approach file only for reading, turn on Read-
only.

5. Click OK.

Approach creates an Approach file for the database and opens 
the file to a standard form.

Key fields for a Paradox database
If you try to open a Paradox database and Approach cannot find a 
key field, the Choose Key Field dialog box appears so that you can 
select a field to use as the key field. If the database does not have a 
unique field or a combination of fields you can use for this, click Add 
Key Field in the dialog box. For more information, see “Specifying a 
key field for a Paradox database” on page 3-19.

Read-only applies only to 
your current session with 
Approach and does not make 
a file permanently read-only.
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You can use Approach to open a table created in Microsoft Access. 
You need to see the contents of the database first and then select the 
table in it you want. Approach automatically creates and opens a 
new Approach file for it, and you can work with the table as if it had 
been created in Approach.

To open a database table created in Microsoft Access:

1. Click the Open File icon or choose Open from the File menu. Or if 
the Welcome dialog box is on the screen, select “Open an existing 
file” and click OK.

The Open dialog box appears.

2. Select Access in the List Files of Type drop-down list.

The names of Access databases appear in the Directories list with 
a filecard icon in front of them and with the filename extension 
.MDB.

3. Double-click the name of the database in the Directories list.

You can change the drive if you need to look for the database. 
When you double-click the name, the tables in the database 
appear in the File Name list.

4. Select the name of the table in the File Name list.

5. Click OK.

6. If an alert box appears, click OK to open the table.

The alert box appears if your preferences are set for displaying 
SQL and ODBC databases as read-only.

You can open a spreadsheet in a Lotus 1-2-3 or Excel format, and 
Approach will create a database file with a copy of the spreadsheet 
data. Approach also creates a new Approach file for the database. 

The rows in the spreadsheet become records in the database, and the 
columns become fields.

Opening a database 
table created in 
Microsoft Access

Creating a database 
from a spreadsheet
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The fields are initially named A, B, C, and so on, but you can rename 
them in the Field Definition dialog box. If the first row of the 
spreadsheet has text that identifies the rest of the contents, you can 
use this row to provide the field names.

If you’re opening a Lotus 1-2-3 spreadsheet and do not want to use 
all of the spreadsheet data, you can specify a sheet or a named range 
to use. You can also work in a Lotus 1-2-3 spreadsheet directly in 
Approach without creating a database from the spreadsheet. For 
more about Approach and Lotus 1-2-3, see Chapter 17, “Working 
Together with Other Lotus Applications.”

To create a database from a spreadsheet:

1. Click the Open File icon or choose Open from the File menu. Or 
if the Welcome dialog box is on the screen, select “Open an 
existing file” and click OK.

2. Select Lotus 1-2-3 or Excel in the List Files of Type drop-down 
list.

3. Select the name of the spreadsheet in the File Name list and 
click OK.

If you’re opening a Lotus 1-2-3 spreadsheet, the Select Range 
dialog box appears.

In a spreadsheet, the 
data is divided into rows 
and columns.

In a database, the rows 
become records, and the 
columns become fields.

1st Qtr
101.97

57.22

2nd Qtr
97.42

118.93

3rd Qtr
93.69
89.15

83.48 79.00 98.75

4th Qtr
84.32

103.99
93.79

1
2

A
1st Qtr
101.97

B
2nd Qtr

97.42

C
3rd Qtr

93.69
3 57.22 118.93 89.15

D
4th Qtr

84.32
103.99

4 83.48 79.00 98.75 93.79

The first row of a 
spreadsheet can 
provide field names 
for a database.

Select a sheet or named 
range of data to use.

Turn this on if you want to 
use the first row as field 
names.
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If you’re opening an Excel spreadsheet, the Field Names dialog 
box appears.

4. Specify how to open the spreadsheet in the dialog box.

In the Select Range dialog box for Lotus 1-2-3, select a sheet or 
named range with the data you want to use in the new database. 
Named ranges appear in all capital letters in the list. (With an 
Excel spreadsheet, all of the data is copied into the database.)

To use the text in the first row of the spreadsheet as field names, 
turn on “First row contains field names.”

5. Click OK.

The Convert To dialog box appears.

6. Type a name for the database file in the File Name text box.

You can change the directory and disk if you want to specify a 
different location for the file.

7. Select a database file type in the List Files of Type drop-down list.

8. Click OK.

The Approach file for the new database opens to a standard 
form. 

Turn this on if you want to 
use the first row as field 
names.

Type a name for the new 
database file.

Select a file type for the 
database file.

Specify a 
location for the 
database file.
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You can open an ASCII text file with delimited text, and Approach 
will create a database with a copy of the file’s data. Approach also 
creates a new Approach file for the database.

A delimited text file uses separators such as commas, spaces, or tabs to 
break up the text into discrete units. When you create a database 
from delimited text, these separators mark where one field ends and 
the next one begins. You specify the delimiter used when you open 
the text file in Approach. A paragraph return marks where one 
record ends and the next one begins.

The fields are initially named A, B, C, and so on, but you can rename 
them in the Field Definition dialog box. If the first row of the text file 
has text that identifies the rest of the file’s contents, you can use this 
first row to provide the field names.

You can also use non-delimited, fixed-length text to create a 
database. See “Creating a database from a fixed-length text file,” 
next.

To create a database from a delimited text file:

1. Click the Open File icon or choose Open from the File menu. Or 
if the Welcome dialog box is on the screen, select “Open an 
existing file” and click OK.

2. Select Text–Delimited in the List Files of Type drop-down list.

3. Select the name of the text file in the File Name list and click OK.

Creating a database 
from a delimited 
text file

Name
Johnson
Ramirez

Address
1234 Fifth Avenue
1234 Calle Carlos V

City
New York
Madrid

In a delimited text file, 
the text on each line is 
separated with commas 
or other delimiters.

Schmidt 1234 Strausstrasse Bonn

In a database, the 
delimited text is divided 
into fields. Each line is a 
record.

Name,Address,City
Johnson,1234 Fifth Avenue,New York
Ramirez,1234 Calle Carlos V,Madrid
Schmidt,1234 Strausstrasse,Bonn

The first row of a text 
file can provide field 
names for a database.
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The Text File Options dialog box appears. 

4. Select the separator used in the text file in the Separate Fields 
With area.

The separators mark where one field ends and the next one 
begins. Check the documentation for the file’s application to find 
out which separator is used.

If the separator you want does not appear in the list, select Other 
and type the character in the text box.

5. Select the character set used in the text file.

6. To use the text in the first row of the file as field names, turn on 
“First row contains field names.”

7. Click OK.

The Convert To dialog box appears.

8. Type a name for the database file in the File Name text box.

You can change the directory and disk if you want to specify a 
different location for the file.

9. Select a database file type in the List Files of Type drop-down list.

10. Click OK.

The Approach file for the new database opens to a standard 
form. 

Select the separator used 
in the file.

If the separator does not 
appear in the list, type the 
character in this text box.

Select the character set 
used in the file.

Turn this on if you want to 
use the first row as field 
names.

You don’t need to type an 
extension for a filename. 
Approach adds an extension 
based on the file type.
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You can open an ASCII text file with fixed-length text, and Approach 
will create a database with a copy of the file data. Approach also 
creates a new Approach file for the database.

In a fixed-length text file, the text on each line is broken into blocks of 
text a specific length. (If the text does not fill the entire length, it has 
spaces after it until the next block begins.) When you create a 
database from fixed-length text, you need to tell Approach how long 
each block of text is. Approach uses fixed-length fields for the text in 
the database—the fields are the same length in every record.

A paragraph return marks where one record ends and the next one 
begins. If the records do not have paragraph returns, the next record 
begins at the end of the block; you need to know the contents of the 
text file to define the blocks correctly.

You can name the fields when you create the database. Or if the first 
row of the text file has text that identifies the rest of the file contents, 
you can use this first row to provide the field names. 

In this example, characters 1 through 12 become a 12-character field 
in the database, characters 13 through 40 become a 27-character field, 
and so on:

To create a database from a fixed-length text file:

1. Click the Open File icon or choose Open from the File menu. Or 
if the Welcome dialog box is on the screen, select “Open an 
existing file” and click OK.

2. Select Text–Fixed-Length in the List Files of Type drop-down list.

3. Select the name of the text file in the File Name list and click OK.

Creating a database 
from a fixed-length 
text file

Johnson
Ramirez

In a fixed-length text file, 
the text on each line is 
broken into blocks of 
fixed lengths. Schmidt

In a database, the blocks 
become fixed-length 
fields. Each line is a 
record.

1234 Fifth Avenue New York
1234 Calle Carlos V Madrid
1234 Strausstrasse Bonn

1 411312 40

You name the fields 
when you create the 
database.

Name
Johnson
Ramirez

Address
1234 Fifth Avenue
1234 Calle Carlos V

City
New York
Madrid

Schmidt 1234 Strausstrasse Bonn
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The Fixed Length Text File Setup dialog box appears. 

4. Select the character set used in the text file.

5. Type a name for the first field in the Field Name text box, or turn 
on “First row contains field names” to use text in the first row of 
the file as field names.

The restrictions on characters and on the length of the name 
depend on the file type of the database—for example, some file 
types allow spaces but others don’t. For details about these 
restrictions, see Appendix B, Appendix C, or Appendix D.

6. Select a data type for the first field in the Data Type drop-down 
list.

7. Type the starting position for the first field in the Start text box (if 
the position is different from 1).

8. Type the number of characters for the first field in the Width text 
box.

9. For the rest of the fields, type a field name (unless “First row 
contains field names” is on), select a data type, and type a width.

You don’t need to provide the starting position for fields after the 
first one. Approach calculates their starting positions.

10. Click OK.

The Convert To dialog box appears.

Select the character set 
used in the file.

Type a number of 
characters for each 
field.

Type a name and select a 
data type for each field.

Turn this on if you want to 
use the first row as field 
names.

Type the position of 
the starting character 
for the first field.

For fields after the first one, 
Approach supplies the Start 
value when you click in the Field 
Name text box.
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11. Type a name for the database file in the File Name text box.

You can change the directory and disk if you want to specify a 
different location for the file.

12. Select a database file type in the List Files of Type drop-down list.

13. Click OK.

The Approach file for the new database opens to a standard 
form. 

Approach automatically saves changes to data in an underlying 
database file as you work and whenever you close a file. You need to 
save an Approach file manually after Approach creates the file (such 
as for a new database file) and whenever you make design or join 
changes in the Approach file.

You can also save a copy of a database file and an Approach file, 
either to back up a database or to prepare a template for other 
databases.

The first time you save an Approach file, you give the file a name and 
specify a location. Approach has one type of Approach file, 
regardless of the type of the associated database files.

To save a new Approach file:

1. Click the Save Approach File icon or choose Save Approach File 
from the File menu.

The Save Approach File dialog box appears.

Saving and 
closing files

Saving a new 
Approach file

Type a name for the 
Approach file.

Specify a 
location for the 
Approach file.

If you want, set a password 
for the Approach file.
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2. Type a name for the file in the File Name text box.

Approach suggests a name based on the name of the database 
file, plus the extension .APR. You can keep this name or give the 
file a different one.

You can also change the directory and disk if you want to specify 
a different location for the file.

3. To give the Approach file a password, turn on “Set Approach file 
password” and type the password in the text box.

If an Approach file has a password, a user must enter the 
password before making design or join changes in the file. For 
information about Approach file passwords, see “Defining 
passwords for files” on page 19-6.

4. Click OK.

Approach automatically saves your data as you work, so you don’t 
need to worry about saving it yourself. But if you make any changes 
to the design of forms, reports, worksheets, and other views in an 
Approach file, or if you join or unjoin databases, you need to save 
those changes.

When you open an Approach file, the file opens to the view you were 
using the last time you last saved the file. Before saving an Approach 
file, change to the view you want to appear when the file is opened 
or create an Open macro that automatically changes to the view you 
want.

■ To save changes to an existing Approach file, click the Save 
Approach File icon or choose Save Approach File from the File 
menu.

If the Approach file has already been saved once, this command only 
saves the file, and does not open the Save Approach File dialog box.

You can make a copy of an Approach file and its associated database 
file(s), either with or without the data:

• Include the data in the copy if you want the copy to be a backup 
of the original. The copy will be an exact duplicate of the original 
Approach file and database file.

Saving changes to 
an existing 
Approach file

Save an Approach file often 
when making design or join 
changes.

Saving a copy of an 
Approach file and a 
database file
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• Leave the data out of the copy if you plan to use the copy as a 
template for other databases. The copy will have the same field 
definitions, views, macros, and setup options as the original, but 
no data.

To save a copy of an Approach file and a database file:

1. Choose Save As from the File menu.

The Save Approach File As dialog box appears. You use this 
dialog box to save the copy of the Approach file.

2. Type a different name or specify a different location for the copy 
of the Approach file.

The name and location of the original file appears in the dialog 
box. You need to change at least the name or the location.

3. To give the copy a password, turn on “Set Approach file 
password” and type the password in the text box.

4. Select “Exact copy” or “Blank copy” in the Databases area.

”Exact copy” makes an exact copy of the database, with all of its 
data. Use this setting to create a backup of a database. 

“Blank copy” makes a copy of the database with everything 
except for the data. Use this setting to create a template for other 
databases.

If more than one database file is joined in the current Approach 
file, either of these settings makes a copy of each joined database.

“.APR file only” copies an Approach file but not a database file. 
This is described in “Saving a copy of an Approach file only,” 
next.

Type a name for the copy 
of the Approach file.

Specify a 
location for 
the copy.

If you want, set a password 
for the copy.

Select “Exact 
copy” or “Blank 
copy.”

It’s a good idea to create a 
backup before making 
extensive changes to a 
database. You can return to 
the backup if you need to.
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5. Click OK.

The Save Database As dialog box appears. You use this dialog 
box to save the copy of the database file.

6. Type a different name or specify a different location for the copy 
of the database file.

The name and location of the original file appears in the dialog 
box. You need to change at least the name or the location.

7. To change the file type for the copy, select another type in the List 
Files of Type drop-down list.

8. Click OK.

Approach saves the copies of the Approach file and database 
files, and opens the new Approach file.

If more than one database file is associated with the Approach 
file, the Save Database As dialog box appears for every database 
file. Specify a different name or location for each file. The files do 
not all have to be the same type.

Key fields for a Paradox database
If you use the Paradox file type for the new database file, the Choose 
Key Field dialog box appears so that you can select a field to use as 
the key field. If the database does not have a unique field or a 
combination of fields you can use for this, click Add Key Field in the 
dialog box. For more information, see “Specifying a key field for a 
Paradox database” on page 3-19.

Type a name for the copy 
of the database file.

Specify a 
location for 
the copy.If you want, select a file 

type for the copy.

If you click Cancel rather 
than OK in Save Database 
As, no new Approach or 
database files are created.
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You can save a copy of an Approach file that uses the same set of data 
as the original file. This allows you to quickly set up multiple 
Approach files for a single set of data.

To save a copy of an Approach file only:

1. Choose Save As from the File menu.

The Save Approach File As dialog box appears.

2. Type a different name or specify a different location for the copy 
of the Approach file.

The name and location of the original file appears in the dialog 
box. You need to change at least the name or the location, or the 
copy will overwrite the original file.

3. To give the copy a password, turn on “Set Approach file 
password” and type the password in the text box.

4. Select “.APR file only” in the Databases area.

This specifies that you want a new Approach file but not a new 
database file. Both the new Approach file and the original 
Approach file will be connected to the same database files.

5. Click OK.

Approach saves and opens the new Approach file.

When you close an Approach file, if you’ve made any design or join 
changes you haven’t saved, an alert box asks if you want to save the 
changes. (Changes to data are saved automatically as you work.)

■ To close an Approach file, click the Close File icon, choose Close 
from the File menu, or double-click the control menu box in the 
upper-left corner of the file window.

You can delete an Approach file or a database file from within 
Approach. When you delete a database file, all related files such as 
indexes are deleted along with it.

If you delete an Approach file, Approach can delete the associated 
database file (and its related files) for you. If you delete an Approach 
file that is based on more than one database file, Approach gives you 
a chance to delete or keep each joined database file.

Saving a copy of an 
Approach file only

Closing an 
Approach file

Deleting a file
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You can also delete files in the Windows File Manager, but you 
cannot delete an Approach file and its database files all in one step. If 
you want to be sure you’re deleting a set of associated files, delete the 
files in Approach.

Approach files and database files must be closed before you can 
delete them.

To delete a file:

1. Choose Delete File from the File menu.

The Delete File dialog box appears.

2. To delete a database file, select the database file type in the List 
Files of Type drop-down list.

The File Name list is preset to show the Approach files, so if you 
want to delete a database file you need to select a different type. 

3. Select the name of the file you want to delete in the File Name 
list.

4. Click OK.

Approach asks if you’re sure you want to delete the file.

5. Click Yes to delete the file.

If you’re deleting an Approach file, for each associated database 
file Approach asks if you’re sure you want to delete that file. You 
can click No in any of these alert boxes to keep a particular 
database file.

You can delete an Approach 
file to delete a set of joined 
database files all at once.

Select the file you want 
to delete.

Select the file type of 
the file.

Specify the 
location of the 
file.

If the file has a description, 
it appears here.

Be especially careful when 
deleting database files from an 
Approach file. Other 
Approach files may also be 
based on them.
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3 Defining Fields

A field in a database is an individual category of information, such as 
an invoice number, a customer name, or an amount due. When you 
create a new database, you define the fields for it. You can also 
redefine the fields in an existing database at any time.

This chapter describes the types of database fields in Approach. It 
also explains how to define fields, set options for entering data in 
fields, set a key field for some database types, and delete fields.

When you define a field, you specify the type of data the field can 
contain. The possible field types are text, numeric, memo, Boolean, 
date, time, PicturePlus, calculated, and variable.

A field’s type determines what you can store in it. The type may also 
affect how you can use that field for finding and sorting records and 
whether its data can be used in calculations. In a form, report, or 
other view, you can also apply specific formatting characteristics to 
some types of fields.

A text field can contain any characters you can type, including letters, 
numbers, and symbols. You can search on a text field using any 
character in the field. A sort on a text field is alphabetical in either 
ascending order (0 to 9, then A to Z) or descending order (Z to A, 
then 9 to 0).

Define text fields for text-based information such as names or for 
combinations of letters and numbers such as addresses. When you 
define a text field, you specify the number of characters allowed in it. 

You cannot have more than 254 characters in a text field for most 
database file types. If you need to have more characters, use a memo 
field instead of a text field.

Types of fields

Text fields
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Numeric fields are for storing numeric data that you need to use in 
calculations or to find or sort arithmetically. You can sort records by a 
numeric field in either ascending order (lowest to highest) or 
descending order (highest to lowest).

Set up a numeric field for strictly numeric data, such as a price or 
quantity. If you want to show a calculated result, define the field as 
calculated rather than as numeric. (You can use a value from a 
numeric field in a formula, however. For example, you might use a 
Unit Price value in a formula in an Amount field.)

With some database file types, you specify the number of characters 
to the left and the right of the decimal point when you define a 
numeric field. With others, you just need to set the numeric type.

Like text fields, memo fields can store any characters you can type. You 
can perform a search on a memo field, but you cannot sort records by 
data in a memo field or use a memo field in a formula.

Use memo fields to keep notes or to provide supplemental 
information about individual records. Often, this is the kind of 
information that is for internal use and not included in reports. For 
example, you might use a memo field to record background notes 
about customers to maintain a customer contact log.

You can store much more data in a memo field than in a text field 
because the data is kept in a separate memo file. The maximum size 
of a memo varies depending on the file type of the database file. For 
details about memos for different file types, see Appendix B, 
Appendix C, or Appendix D.

A Boolean field contains a value of Yes, No, Y, N, 1, or 0.

Define a Boolean field for information that requires a simple yes or 
no, such as whether a payment has been received. A Boolean field 
often uses a checkbox in a view to make data entry easier. 

Boolean fields can be used in calculations. For example, if a Payment 
Received field contains the value No, you can use the value in the 
Total field for that record to calculate the next month’s bill.

Numeric fields

Memo fields

Boolean fields
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A date field holds a single date. You can find and sort records on a 
date field, and you can use a date in some calculations. A sort on a 
date field is in either ascending order (earliest to latest) or 
descending order (latest to earliest). 

You can type a date into a date field or have Approach enter the date 
for you automatically. If Approach provides the date, it is the date the 
record was either created or last modified (according to the system 
clock). You specify this when you define the field.

The order in which you type a month, day, and year into a date field 
is determined by the date format selected in the Windows 
International Control Panel.

A time field holds a single time. You can find and sort records on a 
time field, and you can use a time in some calculations. A sort on a 
time field is in either ascending order (earliest to latest) or 
descending order (latest to earliest).

You can type a time into a time field or have Approach enter the time 
for you automatically. If Approach provides the time, it is the time 
the record was either created or last modified (according to the 
system clock). You specify this when you define the field.

Approach allows precision of up to hundredths of a second.

A PicturePlus field can hold a graphic or an object that comes from a 
Windows application that supports OLE (Object Linking and 
Embedding). Some common OLE objects are charts, sound files, and 
data ranges. You paste or import the graphic or object into the field in 
a record.

Define a PicturePlus field to display graphic information that is 
specific to individual records or to enter information you want to 
keep current through an OLE relationship.

When you define a PicturePlus field, you can specify a default OLE 
application for it.

A calculated field stores the result of a formula. You set up the formula 
when you define the field, and Approach calculates the result and 
enters it in the field. The result can be a text string, a number, a date 
or time, or a Boolean value. You cannot edit a result in a calculated 
field.

Date fields

Time fields

PicturePlus fields

Calculated fields
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The values in a formula can be constants you type into it or 
references to other fields. If a formula has a reference, Approach gets 
the value from the referenced field and uses it in the calculation. For 
example, you might define a calculated field called Tax and put this 
formula in it:

Subtotal*.06

For each record, Approach multiples the value in the Subtotal field 
by 6 percent and enters the result in the Tax field.

You can use a summary calculation in a calculated field to compute a 
value from information in a range of records, such as to summarize 
the totals from all invoices for one month.

For more information about summaries, see “Summarizing data in a 
report” on page 8-14.

A variable field is a temporary storage area. Any data in a variable 
field is stored in memory, not on disk. A variable field is accessible 
whenever the Approach file in which it’s defined is open. 

Variable fields differ from other types of fields in that the value in a 
variable field is the same for every record in a database. They are like 
other fields, though, in that they can be displayed, formatted, and 
used in calculations and macros.

When you define a variable field, you specify the type of data it can 
contain: text, a number, a date or time, or a Boolean value. You can 
also assign an initial value for the variable field, which is used every 
time the Approach file is opened.

You can use variable fields and macros to take data from one record 
and insert it in another. For example, you could use a variable field 
and two macros to reserialize existing records in a database. The first 
macro moves to the first record in the database and sets the variable 
field to 1. The second macro sets the serial number field to the 
current value in the variable field, moves to the next record, 
increments the variable field by 1 (by setting the variable field to the 
current value in the field plus 1), and then runs itself again. This 
continues for all the records in the database or current found set.

For more information about macros, see Chapter 15, “Automating 
Your Work with Macros.”

A calculated field is part of an 
Approach file rather than an 
underlying database file.

Variable fields

A variable field is part of an 
Approach file rather than an 
underlying database file.
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For each field in a database, you need to assign a name, specify the 
type of data the field can store, and in some cases set a maximum 
length. If a field is calculated, you also need to set up a formula for it.

With most types of fields, you can also set data entry options (for 
example, to have data entered automatically or to have data 
validated). For information about these options, see “Defining fields 
for a database” on page 3-5.

Approach comes with templates that provide predefined fields for 
common business scenarios. You can use one of these templates 
when you create a database file. For more information, see “Creating 
a new database file” on page 2-3.

If you create a database file without using a template, the Field 
Definition dialog box appears automatically so you can add fields to 
the database. You can also open the Field Definition dialog box at any 
time to add more fields to an existing database file.

When you add fields to a database, they do not automatically appear 
in any views. You can add fields to views by dragging them from the 
Add Field dialog box or by drawing them with the Field tool.

If “Show the Add Field dialog” is on in Preferences, when you close 
Field Definition you go to Design and the Add Field dialog box 
opens. For more information, see “Adding a field to a form, report, or 
mailing label” on page 6-1. 

To add fields to a database:

1. Choose Field Definition from the Create menu, or create a new 
database file without using a template.

The Field Definition dialog box appears. If you chose Field 
Definition, the dialog box shows the fields in databases used in 
the current Approach file.

Defining fields for 
a database

Adding fields to a 
database

You can also click Field 
Definition in a field’s InfoBox 
to open the dialog box.

For each field you’re 
adding, type a name, select 
a type, and type a length (if 
required).
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If you created a database file without using a template, Creating 
New Database and the name of the file appear in the title bar of 
the dialog box. The dialog box is empty; you can select a 
template in the Template drop-down list if you want to fill it with 
predefined fields.

2. To add fields to a different joined database than the one with 
fields listed, select the name of the database in the Database 
drop-down list.

The drop-down list appears if you chose Field Definition to open 
the dialog box. The names of all databases joined in the current 
Approach file appear in the list.

3. For the first field you want to add to the database, click in the 
empty line at the bottom of the field list, or click Insert to put a 
new empty line above the line with the insertion point.

4. Type a name for the field in the Field Name text box in the empty 
line.

In a dBASE or FoxPro database created in Approach, the names 
of fields can be up to 32 characters long. You can use any 
characters in a field name, including letters, whole numbers, 
spaces, commas, periods, and arithmetic signs.

In a Paradox database created in Approach, the names of text, 
numeric, and date fields can be up to 25 characters long; the 
names of time, memo, Boolean, and PicturePlus fields can be up 
to 18 characters long. These characters can include letters, whole 
numbers, spaces, commas, periods, and arithmetic signs.

In an Access table created in Approach, the names of text, 
numeric, memo, and Boolean fields can be up to 32 characters 
long; the names of date, time, and PicturePlus fields can be up to 
26 characters long. The first character must be a letter, but after 
that, a name can have letters and whole numbers.

For each field you’re 
adding, type a name, select 
a type, and type a length (if 
required).

If you want, select a 
template with predefined 
fields.

You can edit an existing field 
by selecting it and changing 
the name, type, or length.

Use a field name that 
corresponds to the type of 
data the field will contain. A 
field name should be easy to 
recognize later.
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The field names stored in a database file may be different from 
the field names you use with that file through Approach. For 
more details about field names, read about the type of your 
database in Appendix B, Appendix C, or Appendix D. 

5. Select a type for the field in the Data Type drop-down list.

The possible field types are Boolean, calculated, date, memo, 
numeric, PicturePlus, text, time, and variable. 

If you select the calculated, PicturePlus, or variable type, the 
bottom of the dialog box shows a panel for entering a formula or 
for setting options.

6. If necessary, type a length for the field in the Size text box.

You need to enter a maximum length for text fields in all types of 
databases and for numeric fields in some types of databases.

For a text field, type the number of characters you want allowed 
in the field. In dBASE, FoxPro, or DB2, a text field can have up to 
254 characters; in Paradox, Access, Oracle SQL, or SQL Server, it 
can have up to 255 characters. (In Oracle 7, a text field can be up 
to 2,000 characters, but Approach treats any text field over 255 
characters as a memo field.)

dBASE and FoxPro databases require a length for numeric fields. 
Type the number of digits you want to the left and the right of 
the decimal point. You can have up to 19 digits on the left and up 
to 15 on the right, but the total number of digits can’t exceed 19.

7. Continue defining and adding fields in the same manner.

For each field, specify a name, a data type, and a length.

All of the fields except for calculated and variable ones appear in 
the order you add them. Calculated and variable fields are at the 
end of the list because they are part of the Approach file and not 
part of an underlying database file.

8. To change the order of the fields, select an order in the View 
Fields By drop-down list.

The possible field orders are Default Order, Field Name 
(alphabetical), Data Type (grouped by type), and Custom Order. 
If you select Custom Order, you can drag the fields up and down 
in the list to rearrange them.

9. To print a copy of the field definitions, click Print and use the 
Print dialog box to specify the settings.

10. When you’re finished adding fields, click OK.

Make a field only as long as it 
needs to be. Field lengths can 
affect available disk space and 
the speed of finds and sorts.

The field order affects only 
how fields appear in Field 
Definition. In a database, 
fields are stored in the order 
they were created.
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If “Show the Add Field dialog” is on in Preferences, you go to 
Design and the Add Field dialog box appears, showing the fields 
you just defined.

If you defined fields for a new Paradox database file, the Choose 
Key Field dialog box appears. See “Specifying a key field for a 
Paradox database” on page 3-19.

When you add a calculated field to a database, you need to set up a 
formula for the field. Approach calculates the result of the formula 
and displays the result in the field. The result can be a text string, a 
number, a date or time, or a Boolean value.

For example, you can use a simple calculated field to determine an 
amount due for each line item in an order. (Each line item is a 
record.)

Approach can also calculate a formula for a summary range of 
records. For example, to determine a total amount due for all the line 
items, you could use the function SSum(Amount). This adds up the 
values in the Amount fields for all the records in the order.

When applying a formula to a range of records, you need to use one 
of the functions defined specifically for summaries (such as SSum) 
and supply a field reference as the function’s parameter. Because the 
value of a summary calculation field is not associated with a single 
record, the value can vary depending on the option you specify for 
the field in the Summarize On drop-down list.

In most cases, Approach does not calculate a summary value in 
Browse. The exception is a summary on records in a repeating panel. 
Approach displays a value for the repeating panel if it can calculate 
the value for the current record.

For more information about using summary calculations, see 
“Summarizing data in a report” on page 8-14.

Setting up a formula 
for a calculated field

For each item, Approach 
calculates an amount due.

The Amount field 
uses the formula 
Quantity*Price.

Approach calculates the 
total amount due for all 
the items.

The Subtotal field 
uses the function 
SSum(Amount).

Summary calculations are 
most often used in reports. 
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To set up a formula for a calculated field:

1. Choose Field Definition from the Create menu, or create a new 
database file without using a template.

The Field Definition dialog box appears.

2. Type the name of the field and select Calculated in the Data Type 
drop-down list.

The bottom part of the Field Definition dialog box shows the 
options for setting up a formula. If you have set up other 
formulas in your current work session with Approach, you see 
the formula last defined.

3. Build the formula by clicking the elements you want or by typing 
in the Formula text box.

When you select a field name, a function name, or an operator in 
one of the lists, Approach copies it into the Formula text box. You 
can also type these elements directly into the text box, and you 
can type constants in the box. To move the insertion point in the 
Formula text box, click where you want it to go or press the left 
or right arrow key.

The Fields list shows the fields defined for the database except 
for PicturePlus and memo fields. Calculated and variable fields 
are in italics. To see the fields in a different joined database, select 
the database you want in the Fields drop-down list.

Select a field to use as a 
reference.

Define the formula in this 
box.

Select a function to apply a 
predefined operation.

Select an operator to manipulate 
or compare two values.

The bottom part of the 
dialog box opens when you 
select certain data types or 
click Options.

Appendix A explains the 
elements of a formula in 
much more detail, and it gives 
syntax and examples for all 
the functions.

Make sure functions are 
spelled correctly and have the 
right punctuation.
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Field names with spaces or other special characters such as 
hyphens must be enclosed in double quotation marks.

Enclose text, date, and time constants in single quotation marks. 
To change the order of evaluation, use parentheses to enclose the 
expressions you want evaluated first.

When the formula’s syntax is complete and correct, the flag next 
to the Formula text box is no longer crossed out.

4. If the formula will summarize a set of records, click the Define 
Summary tab and specify the summary options.

The bottom part of the dialog box shows the summary options. 

Select from the Summarize On drop-down list to specify which 
records the formula should apply to.

To apply a formula to Select

A set of records as defined by 
the summary panel with the 
calculated field

“Summary panels where this field is 
placed”

Every record in the current 
found set of a database

“Summary of all records in 
database,” where database is the name 
of the database you want (This 
option appears for every database 
joined in the current Approach file.)

Every record in the current 
found set of all databases 
joined in the Approach file

“Summary of all records in all 
databases”

If you click a field name in the 
list, Approach provides the 
quotation marks for you.

The flag shows that this 
formula’s syntax is valid.

Specify how to apply the 
formula to a set of records.

Turn this on to maintain a 
running total for the formula.

The “where-placed” option 
(first in the list) allows you to 
use the same summary 
calculated field for more than 
one set of records and in more 
than one view.

Continued



Defining Fields 3-11

If you want Approach to maintain a running total for this 
formula in a view, turn on “Make calculation a running 
summary.” (This is not available for the where-placed option.)

For examples of summaries with different settings, see 
“Summarizing data in a report” on page 8-14.

5. Continue adding or editing other fields in the Field Definition 
dialog box, or click OK to close the dialog box.

You can edit the name, type, length, or formula of any existing field. 
The change applies to the field throughout the database, even if the 
field already has data in any of the records.

These are the effects of editing a field definition:

• If you change the name of a field, the new name appears 
wherever the name is used. This includes field references in 
formulas.

• If you change the type of a field that contains data, Approach 
tries to convert the data to the new type. If it cannot convert the 
data in a particular field, Approach warns you that the data will 
be deleted and asks if it’s OK to delete the data.

You can change a field type from numeric to text or from text to 
numeric (if the field does not contain any text) without losing 
data. If you change a calculated field to another type of field, you 
lose the field’s calculated result. If you change any other type of 
field, Approach warns you that data will be deleted and asks if 
it’s OK to delete the data.

• If you decrease the length of a field that already contains data, 
the data is truncated after the new length.

A set of records as defined by 
a summary panel of a 
specific type

An option for a type of summary 
panel, such as “Left leading 
summaries of all records in database” 
(These options appear for every 
summary panel in the current 
Approach file.)

To apply a formula to Select

Use an option for a type of 
panel when you want to place 
a grand total or other 
summary outside the panels, 
on a report’s body.

Editing fields in a 
database

It’s often a good idea to 
make a backup of your 
database before changing a 
field type or length.
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• If you change a formula, Approach recalculates the formula in all 
the records. If the result is used in formulas in other fields, those 
formulas are also recalculated. (Some summary calculations are 
not updated until you preview or print.)

To edit fields in a database:

1. Choose Field Definition from the Create menu.

The Field Definition dialog box appears.

2. To edit fields in a different joined database than the one with 
fields listed, select the name of the database in the Database 
drop-down list.

3. For each field you want to edit, select the part of the definition 
you want to edit and make the change. 

You can type a new name or length or select a new data type. 

For a calculated field, you can also change the formula. Select 
any part of the formula in the bottom of the Field Definition 
dialog box, and type or click elements in the lists to replace the 
selection. For more information about formulas, see “Setting up a 
formula for a calculated field” on page 3-8.

4. If an alert box appears, click OK to confirm the changes.

An alert box appears if you change a field type or decrease a 
length. It warns you that data in the field may be deleted or 
truncated.

5. To change the order of the fields, select an order in the View 
Fields By drop-down list.

The possible field orders are Default Order, Field Name 
(alphabetical), Data Type (grouped by type), and Custom Order. 
If you select Custom Order, you can drag the fields up and down 
in the list to rearrange them. 

6. To print a copy of the field definitions, click Print and use the 
Print dialog box to specify the settings.

7. When you’re finished editing fields, click OK.

You return to the view you were last using.

You can also click Field 
Definition in a field’s InfoBox 
to open the dialog box.

Be careful about changing 
the type or length of a field 
that has data. You cannot 
retrieve data that is lost.
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Approach provides several ways to customize the entry of data in 
fields:

• For a text, numeric, date, time, or Boolean field, you can have 
Approach enter data automatically or check the accuracy of data 
that has been entered.

• For a PicturePlus field, you can specify whether to allow OLE 
objects and which application to use as a default OLE server.

• For a variable field, you can specify the type of data allowed and 
set an initial value.

You can specify data entry options when you create a field or 
anytime later. If you change an option for an existing field, it does not 
affect any data already in the field. (Approach checks data as you 
enter it, and not any data already in a field.)

You can also set a format for a field in a view to make data entry 
easier. For example, you can type numbers for a price and have 
Approach provide the currency signs and thousands separators. For 
more information, see “Formatting data in fields” on page 6-14.

Entering data automatically makes filling out records as quick, easy, 
and accurate as possible. For example, you might have Approach 
date revisions or number invoices for you, rather than typing in this 
information yourself.

Approach can enter a date, a time, fixed data you specify, data from 
the previous record, a serial number that increases or decreases from 
one record to the next, or the result of a formula.

To enter data automatically:

1. Choose Field Definition from the Create menu.

The Field Definition dialog box appears.

2. Add a new text, numeric, date, time, or Boolean field, or select an 
existing one.

3. If the bottom part of the dialog box is not open, click Options.

Customizing a 
field for data entry

Entering data 
automatically

You can also click Field 
Definition in a field’s InfoBox 
to open the dialog box.
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The bottom of the dialog box shows options for entering data 
automatically.

4. Set the option for the value you want entered automatically.

Some of the options may be dimmed. The options available vary 
depending on the type of field you’re customizing.

You can set only one of these options for a field.

To Do this

Remove a previously set option 
(in any field)

Click Nothing.

Enter the data from the same 
field in the last record added 
(in any field)

Click “Previous record.”

Enter the date or time the 
record was created (in a date, 
time, or text field)

Click “Creation date” or “Creation 
time.”

Enter the date or time the 
record was last modified (in a 
date, time, or text field)

Click “Modification date” or 
“Modification time.”

Enters specified data in the 
field in each new record

Enters a result when the 
record is created or modified

Assigns the field a unique 
value in each new record

Enters the date or time the 
record was created or 
modified

Enters data from the last 
record added

The bottom part of the 
dialog box opens when you 
select certain data types or 
click Options.

Continued
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5. Continue adding or editing other fields in the Field Definition 
dialog box, or click OK to close the dialog box.

You can have Approach verify that the data in a field is valid for that 
field. For example, Approach can check to see that a customer name 
in the current record is unique in the database, or that a numeric 
value falls within a certain range.

Approach verifies the accuracy of data as you enter it. If you try to 
enter data that Approach determines to be invalid, an alert appears 
describing the problem. You cannot move to another field until you 
correct the problem.

To verify the accuracy of entered data:

1. Choose Field Definition from the Create menu.

The Field Definition dialog box appears.

2. Create a new text, numeric, date, time, or Boolean field, or select 
an existing one.

Enter the same data in the field 
in each new record (in any 
field)

Click Data and type the data you 
want in the text box.

Enter a unique number in the 
field in each new record (in a 
numeric or text field)

Click “Serial number” and type a 
value for the first record in 
“Starting at” and an increment 
value in “Incremented by.” The 
increment value can be positive (to 
increase the number from one 
record to the next) or negative (to 
decrease the number).

Enter the result of a formula 
when you create the record (in 
any field)

Click “Creation formula.” Then 
click Formula and set up the 
formula in the dialog box that 
appears.

Enter the result of a formula 
when you create the record and 
update the result whenever 
you modify the record (in any 
field)

Click “Modification formula.” 
Then click Formula and set up the 
formula in the dialog box that 
appears.

To Do this

“Creation formula” and 
“Modification formula” let 
you use a formula without a 
calculated field.

Verifying the 
accuracy of 
entered data
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3. If the bottom part of the dialog box is not open, click Options.

4. Click the Validation tab.

The bottom part of the dialog box shows the options for checking 
entered data.

5. Set the options you want for verifying the data in the field.

You can set as many of these options as you want for each field.

To verify that Do this

The field in each record has 
a unique value.

Turn on Unique.

The value is within an 
alphabetical, numerical, or 
chronological range.

Turn on From/to and type values for 
the beginning and end of the range 
(inclusive) in the text boxes.

The field contains a value 
in each record.

Turn on “Filled in.”

The value matches one of 
the values in a set.

Turn on “One of.” Then for each value 
you want in the set, type the value in 
the text box and click Add. To remove 
a value, select it and click Remove.

A formula evaluates to 
True when the value is 
used as an operand.

Turn on “Formula is true.” Then click 
Formula and set up the formula in the 
dialog box that appears (For example, 
the formula >100 accepts only values 
that are greater than 100.)

The value must fall within a 
specified range.

The value in each record 
must be unique.

The field must have 
a value.

A formula must evaluate 
to true or false.

The value must match a 
value in another field.

The value must match one 
of the specified values.

Continued
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6. Continue adding or editing other fields in the Field Definition 
dialog box, or click OK to close the dialog box.

An OLE object is an object created in another application that you can 
link or embed in a PicturePlus field in Approach. OLE objects let you 
include a variety of different kinds of information in your database—
including graphics, charts, sounds, and text ranges.

When you link an OLE object, the object is not stored in the field, but 
a copy of the object appears there. The original object remains in its 
source file, and if the original object changes, the display of the object 
in the PicturePlus field is updated to match it. When you embed an 
OLE object, the object is stored in the field.

If you have a default OLE server application, that application starts 
when you double-click an empty PicturePlus field or when you press 
the space bar with an empty PicturePlus field selected. You can then 
create an object, and it will be embedded in the field.

To set OLE options for a PicturePlus field:

1. Choose Field Definition from the Create menu.

The Field Definition dialog box appears.

2. Create a new PicturePlus field or select an existing one.

The bottom part of the dialog box shows the options for 
PicturePlus fields.

The value matches a value 
in another field in this 
database or in a database 
joined to it.

Turn on “In field” and select the other 
field in the list. If the other field is in a 
different database, select the database 
in the drop-down list.

To verify that Do this

Setting OLE options 
for a PicturePlus 
field

You can edit an OLE object 
using tools from the source 
application without leaving 
Approach. Double-click 
the object in the field.

Turn this on to allow OLE 
objects in the field.

Select a default OLE server 
application for the field.
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3. To allow OLE objects in the field, turn on “Allow OLE objects.”

4. Select a default server application in the Default Object Type list.

The default application will start when you double-click an 
empty PicturePlus field or press the space bar with an empty 
PicturePlus field selected.

5. Continue adding or editing other fields in the Field Definition 
dialog box, or click OK to close the dialog box.

You can specify what type of data to allow in a variable field. If you 
try to store the wrong type of data, Approach alerts you so that you 
can change it.

You can also set an initial value for a variable field.

To set data options for a variable field:

1. Choose Field Definition from the Create menu.

The Field Definition dialog box appears.

2. Create a new variable field or select an existing one.

The bottom part of the dialog box shows the options for variable 
fields.

3. Select a data type in the Select the Field Type drop-down list.

A variable field can store a text, numeric, date, time, or Boolean 
value.

4. To give the field an initial value, type the value in the Set a 
Default Value text box.

The initial value will appear in the field every time you open this 
Approach file.

5. Continue adding or editing other fields in the Field Definition 
dialog box, or click OK to close the dialog box.

Even if you have a default 
application, you can still 
store objects from other 
applications in the 
PicturePlus field.

Setting data options 
for a variab le fiel d

Select the type of data the 
field can contain.

If necessary, type an initial 
value for the field.
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A key field is a field or a combination of fields that uniquely identifies 
each record, such as an invoice number or a first name and last name 
together. Using a key field ensures that there are no duplicate records 
in a database.

The Paradox database type requires a key field in Approach. If you 
use this file type, the Choose Key Field dialog box appears 
automatically when you finish adding fields to a new database. You 
can either add a new field to be the key or select an existing field or 
combination of fields.

If you want to change the key field in an existing Paradox database, 
you can either export the database in the Paradox file type, or save 
the database as a dBASE file, and then save it again as a Paradox file. 
The Choose Key Field dialog box appears when you export or save.

To specify a key field for a Paradox database:

1. Define fields for a new Paradox database file.

When you click OK in the Field Definition dialog box, the 
Choose Key Field dialog box appears.

2. Click Add Key Field to have Approach add a key field, or select 
the name of the field or fields you want to be the key.

The list shows all the text, numeric, date, and time fields defined 
for the database. To select more than one field, CONTROL-click the 
fields.

Specifying a key 
field for a Paradox 
database

Instead of typing a unique 
key value in each record, you 
can have Approach enter 
serial numbers for you. See 
page 3-13.

Click to add a new 
key field…

…or select one or 
more existing fields 
to be the key.

In most cases, you should 
click Add Key Field and let 
Approach add the field.
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If the database file does not already have a field you can use for 
this, click Add Key Field. Approach inserts a numeric field 
named Key Field at the beginning of each record. The key field 
value is a serial number starting at 1, and it increments by 1 from 
one record to the next.

3. Click OK.

When you delete a field, Approach removes the field and its data 
from every record in the database.

If you delete a field used in a formula, the formula will return a blank 
result. In views and in the Define Formula panel of the Field 
Definition dialog box, Approach replaces the deleted field name with 
NO_FIELD_REFERENCE. You need to edit the formula so that it no 
longer uses that field.

Before deleting a field, make sure that you do not need the data it 
contains and that you do not need the field in another Approach file.

To delete a field:

1. If the field you want to delete is used in a join, unjoin the field.

You must unjoin a field before you can delete it. Choose Join 
from the Create menu, select the field’s join line in the Join dialog 
box, click Unjoin, and close the unjoined database in the dialog 
box if it has no more joins. For more information, see “Unjoining 
database files” on page 4-20.

2. Choose Field Definition from the Create menu.

The Field Definition dialog box appears.

3. Select the field you want to delete in the list of field definitions.

If the field is in a different database joined in the current 
Approach file, select the name of the database in the Database 
drop-down list.

4. Click Delete.

Approach warns you that deleting the field will remove the 
field’s data in every record of the database.

5. Click OK to delete the field.

Deleting a field

Be careful about deleting a 
field. You cannot retrieve data 
from a deleted field.
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4 Joining Database Files

If you have multiple databases with related information, you can join 
the databases together in an Approach file. Joining lets you keep data 
in smaller, more manageable databases but work with the data as if it 
were all stored in one file.

This chapter gives an overview of joined databases, and it describes 
how to join and unjoin database files in an Approach file. For 
information about creating views that show data from joined 
databases, see Chapter 7, “Designing Forms and Repeating Panels,” 
Chapter 8, “Designing Reports,” and Chapter 9, “Designing Form 
Letters and Mailing Labels.”

It often makes sense not to keep your data all in one file, but to divide 
it into more specific databases. Approach is a relational database 
application, which means that you can bring together data from 
separate database files. To do this, you join the databases in the 
Approach file that uses their data.

The forms, reports, and other views in an Approach file can use data 
from any of the databases joined in that file. An Approach file can 
have up to 50 joined databases (if the underlying database file can 
support this capability).

A set of joined databases offers much greater efficiency, accuracy, and 
flexibility than a single “flat-file” database.

With joined databases, you need to store only one copy of your data, 
even if you use a particular piece of data in more than one place. For 
example, suppose you’re maintaining a database of your company’s 
departments, and each department has more than one employee. If 
you store the department and employee data in a single flat-file 
database, you need to enter the department data for every employee. 
But if you use a set of joined databases, you need to enter the 

About joined 
databases

Why use joined 
databases?
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department data only once, regardless of how many employees are 
in a department, and you simply display the department data as 
many times as necessary.

Storing one copy of data saves disk space and saves time in data 
entry and updating. It also ensures that shared data is consistent and 
makes it easy to maintain accuracy. If you need to update shared data 
(such as the location of a department), you make the change in one 
place, and the change automatically appears in all views where the 
data is used.

Joined databases are also efficient and flexible in how they let you 
display data. You can see and edit a record from one database and 
one or more related records from a joined database together in a 
single view. For example, you could display the Cost Accounting 
department data and a list of the employees in that department on a 
single form, rather than repeating the department data for each 
employee.

In a flat-file database, the 
department data is stored 
for each employee.

In joined databases, the 
department data is stored 
only once even though it 
is used several times.

COMPANY

Cost Accounting
Cost Accounting
Cost Accounting
Cost Accounting

Joann
Keng
Jean-Pierre
Maria

Willis
Wu
Renault
Lopez y Garcia

DEPARTMT

Dept Name Dept Location First Name Last Name

Hampton Plaza
Hampton Plaza
Hampton Plaza
Hampton Plaza

EMPLOYEE

This data is redundant.

Cost Accounting

Dept Name Dept Location

Hampton Plaza Joann
Keng
Jean-Pierre
Maria

Willis
Wu
Renault
Lopez y Garcia

First Name Last Name

Cost Accounting James MaclaneHampton Plaza

James Maclane

You can see department 
and employee data from 
joined databases together 
in a single view.

Cost Accounting, Hampton Plaza
Joann Willis
Keng Wu
Jean-Pierre Renault
Maria Lopez y Garcia
James Maclane
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The relationship between the department and employees in this 
example is called one-to-many. In general, with a flat-file database 
you cannot display a one-to-many relationship on a form; you would 
need to repeat the department data for each employee.

To design a set of joined databases, you divide the fields for the data 
into logical groups, each of which is a separate database file. Your 
goal should be to avoid unnecessarily duplicating any data from one 
database to another.

After creating the databases and defining the fields, you establish a 
relationship between two databases using one or more fields that the 
databases have in common. These are the join fields. It’s usually best 
to define one field in each database specifically to be a join field and 
then enter an ID value in that field in the records. (If you do not have 
a field you can use as a join field, you can join databases on other 
fields they have in common. The fields must together uniquely 
identify records in one of the databases, such as first name, last name, 
and phone number.)

For example, suppose you want to compile a list of all the employees 
in each department in your company. Rather than putting all the data 
in one flat-file database, you divide the data into two smaller 
database files: one for departments and one for employees. In 
addition to the department and employee information, the databases 
have at least one join field with ID numbers that identify each 
department.

The department and employee databases use a join field called 
Dept ID:

How databases are 
joined

Ideally, join fields should be 
the only duplicate fields in 
two joined databases.

The department and 
employee databases 
are joined on a 
department ID field.

DEPARTMT

Dept ID
Dept Name
Dept Location

EMPLOYEE

Empl ID
First Name
Last Name

Position
Level

Dept ID

Mgr ID
Hire Date

Notes

Reviews
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When a record in one database has the same join value as a record in 
a joined database, the two records are “related” and can be used 
together in views. In the department and employee databases, 
records with a matching value in Dept ID are related.

If your preferences are set this way, you can even use a calculated 
field as a join field. For example, suppose you have two employee 
databases, one with a First Name and Last Name field and the other 
with a Name field that combines first and last name. To join the 
databases on the employee names, you create a calculated field called 
Name for the first database and use a Combine function to enter the 
first and last name in the field. Then join the databases on their Name 
fields. (This is not available for Paradox database files.)

You cannot delete a field used in a join. (If the join field is a calculated 
field, you also cannot delete any fields referred to in the join field’s 
formula.) If you need to delete a join field, you can first unjoin the 
databases or join them on a different field.

Once databases are joined in an Approach file, you can design views 
that use related data from the databases joined in that file. As you 
work in a form, report, or other view in Browse, Approach looks for a 
matching value in join fields. If it finds a match, it displays data from 
each record that has the matching value, regardless of which joined 
database contains the record. 

Cost Accounting332
290 Customer Support

Marketing178
Product Development245

First Name

Barbara

James

Keng

Joann

EMPLOYEE

Dept ID

178

332

332

332
290

332
245

332

245

Leo

Maria
Jose

Jean-Pierre

Indira

The Cost Accounting department and 
employee records are related. They all 
have 332 in their Dept ID join field.

DEPARTMT

Dept NameDept ID Last Name

Kumar
Willis
Pavlovich
Wu
Renault
Taylor
Lopez y Garcia
Morales
Maclane

178 Yasunari Murasaki

How joined data 
appears in views
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In a form that describes one department at a time, you see all the 
employees that have the same value in the department ID field as the 
current department.

If you’re in Design and are showing field names rather than data, 
each field in a view shows both the name of the joined database and 
the name of the field.

Each form, report, or other view that uses joined databases has one 
main database and one or more detail databases. The main database 
provides the basic information for that view—each record from the 
main database appears in it. A view “is based on” its main database. 
The other joined databases act as detail databases, providing 
additional, related information to display in the view. 

This data comes from the 
department record with 
the department ID 332.

This data comes from 
employee records with 
the department ID 332.

In Design, the names of 
the joined databases 
appear before the names 
of the fields.

A calculated field is 
part of an Approach file, 
so a database name 
does not appear with it.

Main and detail 
databases in a view
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In a form, each page of the view corresponds to one record in the 
main database. For example, the department form is based on the 
department database. The employee database is used as a detail 
database.

A repeating panel in a form is always based on one of the form’s detail 
databases. The panel shows all the records from the detail database 
that match the value in the main database’s join field.

In a report, you see all the records from the main database as line 
items in the report body. For example, if you want to list all the 
employees in your company and group them by department, you 
design a report based on the employees database and then use 
summary panels for the department groupings. (For more 
information about summary panels, see “Summarizing data in a 
report” on page 8-14.)

When you design a report that uses joined data, it’s important to base 
the report on the database from which you want to display all the 
records. In the employee report above, you want to see all the records 

Each view in an Approach file 
can have a different main 
database.

Department FormThe department form is 
based on the department 
database. It has one page 
for each department.

Cost Accounting

To find the main database for 
a view, look at the Basics 
panel of the view’s InfoBox.

This report is based on 
the employee database. 
It lists every employee in 
the company grouped by 
department.

Employees

Cost Accounting
Maria Lopez y Garcia

Joann Willis

James Maclane

Keng Wu
Customer Support

Leo Pavlovich

Jean-Pierre Renault

-1-

(by Department)
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from the employee database. If you base the report on the 
department database rather than on the employee database, you’ll 
see all the departments and only one employee for each department.

You specify which database is the main one for a view when you 
design the view. You can change to another main database later using 
the InfoBox.

For more information about creating forms and reports for joined 
data, see Chapter 7, “Designing Forms and Repeating Panels,” and 
Chapter 8, “Designing Reports.”

The relationship between records in two joined databases can be one-
to-many, many-to-one, or one-to-one.

In a one-to-many relationship, a record in one database can be related 
to one or more records in the other database. For example, one 
department can have several employees; in other words, one record 
in the department database has the same department ID as several 
records in the employee database. 

If you base the report on 
the department database, 
only one employee appears 
for each department 
grouping.

Employees

Cost Accounting
Maria Lopez y Garcia

Marketing

Customer Support

Yasunari Murasaki
Product Development

Indira Kumar

Leo Pavlovich

-1-

(by Department)

One-to-many, 
many-to-one, and 
one-to-one 
relationships
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To show the result of a one-to-many relationship on a form, you add 
a repeating panel to a form that is based on the “one” database. The 
repeating panel is based on the “many” database, and each line in the 
panel is a record in that database.

A many-to-one relationship is the reverse of one-to-many. For 
example, several employees can be in the same department; in other 
words, several records in the employee database have the same 
department ID as one record in the department database. On an 
employee form, the department data is the same for all employees in 
this many-to-one relationship.

Many-to-one relationships are often used as a lookup, to provide a 
convenient means of displaying data in a view. If you type a 
department ID on the employee form, the department name and 
location for that ID appear automatically.

The Cost Accounting 
department has a one-to-
many relationship with 
five employee records.

Related records in the 
“many” database are 
displayed in a repeating 
panel.

The repeating 
panel is based on 
the employee 
database.

This form is based 
on the department 
database.

This employee record and 
four others have a many-
to-one relationship with 
Cost Accounting.

The department name 
and location are the 
same for the five 
employees. The data 
comes from the 
department database.

When you type the 
department ID, 
Approach displays 
the department data 
automatically.

This form is based on 
the employee 
database. The 
department database 
is used as a detail.
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For a lookup to work properly, the join field on the view must come 
from the main database, and the fields with the lookup data must 
come from a detail database. On the employee form, the department 
ID field comes from the employee database, and the other 
department fields come from the department database.

You can see which databases the fields come from when you look at a 
view in Design with field names showing:

In a one-to-one relationship, a record in one database is related to only 
one record in the other database. For example, a vehicle number in 
one database might be related to a license number for that vehicle in 
a joined database.

You don’t normally need to use one-to-one relationships in 
Approach. You can store a set of data (such as everything about one 
vehicle) together in a single record. 

Once you’re familiar with the basic concepts and techniques of 
joining data, you may want to set up many-to-many relationships 
and joins involving alias databases.

In a many-to-many relationship, many records in one database can be 
related to many records in the other database. A set of orders for 
products is a common application of this. Each order can include 
many products, and each product can appear on many orders. A 
many-to-many relationship is a one-to-many relationship in both 
directions.

The ID field comes from the main 
database (employee), not from the 
database with the lookup data.

Advanced joins

Many-to-many 
relationships
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You cannot set up a many-to-many relationship directly between two 
databases. For example, if you join an orders database and a 
products database directly on an order number, each product can 
appear on only one order (because the order number becomes part of 
the product record). 

Similarly, if you join the two databases on a product number, each 
order can have only one product (because the product number 
becomes part of the order record).

To set up a many-to-many relationship between two databases, you 
need to add an intermediate database. The other databases each have 
a one-to-many relationship with this database.

For the orders and products databases, you might use a third 
database that stores the “many” line item data for the repeating 
panel on your order form. This keeps the orders data out of the 
products database and the products data out of the orders database.

ORDERS

Order No
PO No
Ship To

Address
City

Attn

State
Ship Date

If you join orders and 
products on an order 
number, a product can be 
on only one order.

PRODUCTS

Order No
Name
Cost

Supplier
Contact

Retail Price

Join the orders and 
products databases 
through an intermediate 
database.

LINEITEM

Order No
Prod No
Quantity

ORDERS

Order No
PO No
Ship To

Address
City

Attn

State

PRODUCTS

Prod No
Name
Cost

Supplier
Contact

Rls PriceOne-to-
many

One-to-
many

Ship Date
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Now each order can have many products, and each product can be 
on many orders. You can display one-to-many data both on order 
views and on product views.

It’s sometimes useful to join a database to itself. For example, 
suppose you want to keep track of which employees in your 
company are managers and who reports to them. The employee 
database can have employee IDs to identify each employee uniquely 
and manager IDs to identify each person’s manager by employee ID.

An order form lists the 
many products…

…and a product form lists 
the many orders.

Each row of the repeating 
panels is a record in the 
line item database.

Alias joins

First Name

Barbara

James

Keng

Joann

EMPLOYEE

Empl ID

49

63

29

74
95

85
35

33

25

Leo

Maria
Jose

Jean-Pierre

Indira

Last Name

Kumar
Willis
Pavlovich
Wu
Renault
Taylor
Lopez y Garcia
Morales
Maclane

12 Yasunari Murasaki

Mgr ID

43

74

74

97
35

74
28

74

81

20

Joann Willis (74) is 
the manager for 
these employees.

The manager ID is the 
employee ID for each 
person’s manager.
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This can be an efficient way to use data because you don’t need to 
duplicate the manager records in a separate database. But you do 
need a second database to express the join relationships properly. 

To join a database to itself, you create a “copy” of the database in the 
Join dialog box. The copy is not an actual duplicate of the database, 
but just another listing of it called an alias. Once you’ve created the 
alias database, you can set up a join between the database and its 
alias as you do between any two databases.

For example, you can join the manager ID in an employee database 
to the employee ID in an alias manager database.

The alias manager database has a one-to-many relationship with the 
employee database. You can display the results of this self-join using 
a repeating panel on a form based on the manager database.

If you create more than one alias copy of a database, you can join one 
alias to another and even join an alias to a different database.

When you create an alias for a database, the name of the database is 
appended with a 1, and the alias has the same name as the database, 
plus a 2 (or a 3 and so on); for example, EMPLOYEE:1 and 

The manager ID in the 
employee database is 
joined to the employee ID 
in the alias manager 
database.

EMPLOYEE:2

Empl ID
First Name
Last Name

Position
Level

Dept ID

Mgr ID
Hire Date
Reviews

EMPLOYEE:1

Empl ID
First Name
Last Name

Position
Level

Dept ID

Mgr ID
Hire Date
Reviews

The alias of the employee 
database acts as the 
manager database.

This data comes from the record 
with the employee ID 74 in the 
manager database.

This data comes from records with 
the manager ID 74 in the employee 
database.
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EMPLOYEE:2. These names appear only in the Approach file with the 
joins, and they do not affect the name of the database file itself or the 
name of the database in any other Approach file.

The forms, reports, and other views in an Approach file can use data 
from any of the databases joined in that file.

For each join, you can specify whether you want Approach to 
automatically insert or delete related records from a joined database 
when entering or editing data in a view based on a different 
database.

You need to save an Approach file after joining or unjoining database 
files in it or after setting join options. Approach does not save these 
changes automatically. 

You join two databases by establishing a link on one or more fields 
common to both databases. Often, a join field is an ID field used 
specifically for joining the databases.

To join database files:

1. Choose Join from the Create menu.

The Join dialog box appears, showing a list of fields in the 
database file associated with the current Approach file. 
Approach takes you to Design if you were not already there.

Joining and 
unjoining

Joining database 
files

Fields in the current 
database file

Name of the current 
database file
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If “Show calculated fields in the Join dialog” is on in the 
Preferences dialog box, the list also includes calculated fields in 
the current Approach file so that you can join on one of these 
fields. For more information, see “Calculated fields in the field 
lists” on page 4-17.

2. Click Open to open another database or click Alias to create an 
alias of the current database.

You can join a database to another database or to an alias “copy” 
of itself.

If you click Open, the Open dialog box appears. Use this dialog 
box to select another database to join. When you click OK, a list 
of fields for the database appears in the Join dialog box.

You can join databases of different types. For example, you can 
join a dBASE IV file to a Paradox file.

If you click Alias, a copy of the current database appears in the 
Join dialog box. The name of the database is appended with a 1, 
and the alias has the same name as the original, plus a 2 (or a 3 
and so on); for example, EMPLOYEE:1 and EMPLOYEE:2.

You can join a database to its alias just as you can to any other 
database you open in the Join dialog box. For information about 
when to use aliases, see “Alias joins” on page 4-11.

3. Link the two databases on one or more join fields.

For each field you want to join on, click the field in the list for one 
database and then drag to the field in the other database. Or click 
the field in one database, click the field in the second database, 
and then click the Join button.

The names of calculated fields 
are italicized at the bottom of 
the list, after the database 
fields.

Select the database 
you want to join.

Select the file type of 
the database.

Specify the 
location of the 
database.

An alias is not a copy of a 
database but just another 
listing of it.
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Approach joins the two databases on the join field. A line in the 
Join dialog box shows how the databases are related. The bottom 
of the dialog box shows the pathname of the selected database 
and the name, type, and width of the selected field. 

A join field must be common to the two databases. Most often, 
you link databases on a single field with ID numbers. If you do 
not have an ID field you can use for this, link the databases on 
other fields that together uniquely identify records in one of the 
databases, such as first name, last name, and phone number.

If you want Approach to insert or delete related records 
automatically between two joined databases, see “Setting options 
for a join” on page 4-17.

4. To join more databases in the Approach file, continue opening 
files and joining them in the same manner.

For each join, open the additional database in the Join dialog box 
or create an alias of an existing database, and link the databases 
on one or more join fields.

You must join each database you open to at least one other 
database before you can close the Join dialog box. If you open a 
database you decide not to join, click in its field list and click 
Close.

These two databases are 
joined on the Dept ID field.

This area gives information 
about the selected database 
and the selected field.

A join field does not need to 
have the same name in the 
two databases, but it should 
usually be of the same type.

You can enlarge the Join 
dialog box if you need to make 
more room to see the field 
lists. Drag any border of the 
dialog box outward.
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A single database can be joined to one or more other databases. 
You can use the same join field in all of its joins, or use different 
fields for different joins.

When you first join databases, the database at the farthest left in 
the Join dialog box is the main database for the view. You can 
drag the field lists in the dialog box to rearrange them, but this 
does not make a different database the main one for a view.

5. If you want a printed copy of the database fields and their join 
relationships, click Print.

The Print dialog box appears. 

6. When you’re finished joining databases, click OK.

You return to the environment you were in when you chose the 
Join command.

The OK button is dimmed if any joins in the dialog box are 
invalid. When you correct the errors, you’ll be able to click OK.

This database has two joins: 
one on its Dept ID field and 
one on its Mgr ID field.

This is an alias database. 
When you make an alias, the 
original database and the alias 
are appended with a number.

Be sure to save the Approach 
file after joining databases. 
Approach does not save joins 
automatically.

If the OK button is dimmed, 
you probably have an open 
database that is not joined.
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Valid joins
Every database you open in the Join dialog box must be joined to at 
least one other database in the dialog box. All the databases must be 
joined into a single set, and the join relationships cannot be circular.

Calculated fields in the field lists
If “Show calculated fields in the Join dialog” is on in the Preferences 
dialog box, the field lists in the Join dialog box include calculated 
fields in the current Approach file. This allows you to join on one of 
these fields. For information about setting this option, see “Setting 
general working preferences” on page 19-14.

A field list shows only the calculated fields that refer to fields in the 
listed database, and it does not include summary fields. The 
calculated fields appear in italics at the bottom of the list, after the 
database fields.

If you want calculated fields to appear in a field list for a secondary 
database (one you display with the Open button in the Join dialog 
box), you must first join the database using a database field. Then 
create a calculated field in the Field Definition dialog box, using a 
formula that refers to a field in the secondary database. When you 
open the Join dialog box again, you’ll see the calculated field in the 
database’s field list.

You can have Approach insert or delete related records automatically 
in a database joined in the current Approach file.

For example, if you add a record for a new employee using a 
department form, you may also want to add a corresponding 
employee record at the same time (instead of going to an employee 
form to add the employee record). You can set up the department/
employee join so that when you type in an employee field on the 

Valid Not valid

Valid Not valid

Setting options 
for a join
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department form, Approach automatically inserts a record in the 
employee database. The department and employee records will 
automatically have matching values in their Dept ID join field.

Similarly, if you delete a department from the department database, 
you may want to delete all the department’s employees at the same 
time so that you do not have “orphan” records in the employee 
database. You can set up the department/employee join so that when 
you delete a record from the department database, Approach deletes 
all the records from the employee database that have a matching 
value in the Dept ID join field.

If you have a one-to-many join on a calculated field and the 
calculated field is based on fields in a repeating panel, Approach 
cannot insert new records in the panel, even if you have the option 
on for inserting records automatically. But if a calculated field used in 
a one-to-many join is based only on fields in the form’s main 
database, Approach can insert records in the repeating panel.

You can set the options when you establish a join or anytime later.

To set options for a join:

1. In the Join dialog box, click the join line to select it.

The join line is highlighted when it is selected. If the dialog box is 
not already open, choose Join from the Create menu.

2. Click Options.

Approach can insert a new 
record in the employee 
database when you type in 
an employee field.

The join options apply to a 
particular join, and you can 
set them differently for each 
join in an Approach file. 

The join line may already be 
selected if you have just 
established a join.
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The Relational Options dialog box appears, listing options for 
inserting and deleting records. The options at the top and the 
bottom of the dialog box are the same; they apply to different 
directions of the join.

3. Turn on the options you want for the selected join.

You can turn on as many of these options as you want.

4. Click OK.

You return to the Join dialog box.

This option Specifies

Insert If: You type in a blank field for a detail database on a view, and the 
record for that field does not match a join value in the main database.

Then: Approach inserts a new record in the detail database.

For example: Suppose you turn on “Insert: If no records match the 
DEPARTMT record, typing into a blank EMPLOYEE field inserts a new 
record.” If you type on a new line in an employee repeating panel on a 
department form, Approach inserts a record for the new line in the 
employee database.

Delete If: You delete a record from the database listed first in the Delete 
option.

Then: In the database listed second in the Delete option, Approach 
deletes all records that have a join value matching the record you 
deleted.

For example: Suppose you turn on “Delete: Deleting a record from 
DEPARTMT deletes matching records from EMPLOYEE.” If you delete 
a department, Approach deletes all the employees for that department 
from the employee database.

You can also double-click a 
join line to open this dialog 
box.

Insert or delete department 
records automatically

Insert or delete employee 
records automatically
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When you no longer need a relationship between data in two 
databases, you can unjoin the databases.

If you unjoin and close a database in the Join dialog box, Approach 
deletes all the forms, reports, form letters, mailing labels, and 
repeating panels that are based on that database.

To unjoin database files:

1. Choose Join from the Create menu.

The Join dialog box appears.

2. Click the join line connecting the databases you want to unjoin.

The join line is highlighted when it is selected.

3. Click Unjoin.

The line disappears from the dialog box, and the join between 
the two databases is removed.

4. To unjoin more databases in the Approach file, continue 
unjoining in the same manner.

For each pair of databases you want to unjoin, select the join line 
connecting them and click Unjoin.

5. For each database left without a join, click in its list of fields and 
click Close.

The list disappears when you click Close. You must close all the 
databases without joins before you can close the Join dialog box.

If you try to close a database that is the main database for any 
views or repeating panels, Approach warns you that the views or 
panels will be deleted. Click OK if you’re sure you want to close 
the database.

6. When you’re finished unjoining databases, click OK.

The OK button is dimmed if the joins in the dialog box are not 
valid. When you correct the errors, you’ll be able to click OK. For 
more information, see “Valid joins” on page 4-17.

Unjoining database 
files

Make sure you close all 
unjoined databases and that 
the remaining databases are 
joined into only one set.
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5 Working in Design

Approach provides powerful and easy-to-use tools and commands 
for creating attractive views. You work with these tools and 
commands in the Design environment.

This chapter describes how to customize Design, manipulate and 
edit design objects, prepare styles for consistent formatting, and edit 
entire views. The instructions here apply to forms, reports, form 
letters, and mailing labels. For more detailed information about 
designing a particular type of view, see the chapter about that type of 
view.

The instructions in this chapter assume you know how to use the 
mouse or keyboard to select objects on the screen. If you need help 
with this, see your Windows User’s Guide.

In Design, you lay out forms, reports, form letters, and mailing labels 
for your data. You can add, edit, and delete these views at any time.

■ To go to Design, click the Design icon, or choose Design from the 
View menu or from the environment pop-up menu in the status 
bar.

If an Approach file has a password, Approach asks you for the 
password when you try to change to Design. 

As you work in Design, you need to save the changes you make to 
views. Although Approach automatically saves your data, it does not 
automatically save design changes for you.

■ To save design changes, click the Save Approach File icon or 
choose Save Approach File from the File menu. 

If you go to Design from a chart, the chart appears in a report. For 
more information, see Chapter 13, “Creating Charts.” For 
information about editing a worksheet or crosstab in Design, see 
Chapter 12, “Designing Worksheets and Crosstabs.”

About Design
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Approach provides three Design icon bars with SmartIcons for 
manipulating objects, editing text, preparing reports, and changing 
the Design work area. You click an icon to select it.

■ To change to another icon bar, click the Next Icon Bar icon or 
choose from the icon bar pop-up menu at the right end of the 
status bar.

You can also use a floating palette in Design that has SmartIcons for 
drawing objects. For information about this, see “Showing a Tools 
palette” on page 5-9.

The icon bar that first appears when you go to Design or change to 
another view varies depending on the type of the view. If the current 
view is a form or set of mailing labels, the default Design icon bar is 
preset to appear:

If the current view is a report, the default Report icon bar is preset to 
appear:

If the current view is a form letter, the default Text icon bar is preset 
to appear:

Design icon bars

Open File

Save Approach File

Send Mail

Print

Preview

Undo

Cut

Copy

Paste

Design

Browse

Fast Format

Show Info

Bring Forward

Send Backward

Group

Ungroup

Show Grid

Show Ruler

Show Tools

Zoom In

Zoom Out

Next Icon Bar

Open File

Save Approach File

Send Mail

Print

Preview

Undo

Cut

Copy

Paste

Design

Browse

Fast Format

Show Info

Trailing Summary

Leading Summary

Sort Asc.

Sort Des.

Total

Average

Count

Panel Labels

Show Data

Next Icon Bar

Open File

Save Approach File

Send Mail

Print

Preview

Undo

Cut

Copy

Paste

Design

Browse

Fast Format

Show Info

Left Align

Center

Right Align

Single Space

Double Space

Date

Time

Insert Field

Spell Check

Next Icon Bar
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The default Worksheet and Crosstab icon bars are the same in Design 
as they are in Browse. For information about them, see Chapter 12, 
“Designing Worksheets and Crosstabs.”

The Design menu bar has a context-sensitive menu that changes 
depending on the current view or the current selection. If you have 
no current selection, this menu is called Form, Report, Letter, Mailing 
Label, Worksheet, Crosstab, or Chart and provides commands for 
working with the current type of view. But if an object is selected or if 
you’ve clicked in text, a repeating panel, or a summary panel, the 
menu changes to Object, Text, or Panel, and has commands for 
working with that type of element.

The status bar in Design gives information about the current view 
and the text and objects in it. Most parts of the status bar are pop-up 
menus or buttons you can use to change the selection or work area.

The parts of the status bar that show the view name, environment 
name, font, font size, named style, and zoom setting are pop-up 
menus. You can use them to change to another view, environment, 
and so on. The icon bar symbol at the right end of the status bar is 
also a pop-up menu, with the icon bars available in the current view.

You can click the boldface, italics, and underlining buttons to apply 
those attributes to selected text.

The dimensions area of the status bar shows either the width and 
height of the selected object or the coordinates of the top and left 
sides of the selected object. Click in the dimensions area to toggle to 
the other setting. If no object is selected, the dimensions area shows 
the current location of the pointer.

Design menu bar 
and status bar

This menu can be Form, Report, Letter, Mailing Label, 
Worksheet, Crosstab, Chart, Object, Text, or Panel.

View Font and size

Environment Boldface, italics,
and underlining

Dimensions or location
of the pointer or object

Zoom setting

E-mail notifier

Named style Icon bars
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The e-mail notifier appears when you have new mail on Lotus Notes, 
cc:Mail, or other VIM or MAPI mail systems.

In Design, everything on a view is a design object. You can select and 
manipulate all design objects in many of the same ways, including 
resizing the objects and applying line and color settings to them.

You can add these types of objects to a view:

• Geometric objects are lines, rectangles, ellipses, and other shapes 
you draw on a view.

• Pictures are images you paste onto a view from a graphics 
application.

• Text objects hold text you type directly onto a view, such as a 
name for the view or instructions for entering data.

• Macro buttons are rectangles you can click or tab to in Browse to 
run a macro.

• OLE objects are objects from another application that you can 
embed or link in Approach. Pictures, charts, sound files, and 
data ranges are common OLE objects.

• Field objects establish the area for data from records in a 
database. Normally, a field object is a text box that you type data 
into in Browse, but it can also be a drop-down list, a set of radio 
buttons, or a set of checkboxes that you use for selecting data.

• Some views can have regions, such as a repeating panel on a 
form or a summary panel on a report.

This chapter describes how to add geometric objects, pictures, text 
objects, and macro buttons to a view. Fields are covered in Chapter 6, 
“Adding and Editing Fields in a View,” and OLE objects are covered 
in Chapter 16, “Exchanging Data with Other Files or Applications.” 
For information about regions, see the chapter about the appropriate 
type of view.

A view itself is also a special type of object. It is always in the 
background, behind other objects, and it can be edited in some of the 
same ways as other objects. It provides the page for the other design 
objects.

Design objects

Geometric objects, pictures, 
text objects, macro buttons, 
and OLE objects form the 
unchanging background of a 
view.
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The design settings for objects are all stored in an InfoBox. You can 
keep the InfoBox open as you work in Design and use it to edit 
objects. 

■ To open the InfoBox in Design, click the Show Info icon, choose 
Style & Properties from the context-sensitive menu, or double-
click an object or in the background of a view. The Show Info 
icon is in all three default icon bars in Design.

If a text object is not selected, you can double-click it to open the 
InfoBox. If a text object is selected, double-clicking it puts an 
insertion point in the object.

The InfoBox shows panels of settings for the currently selected object. 
If no object is selected, it shows settings for the current view. You can 
use these settings to edit many different properties of an object, 
including line and color settings and text attributes. Click a panel tab 
at the top of the InfoBox to go to another panel.

When you click another object or click in the background of a view, 
the InfoBox changes to show the settings for that object or view.

You can close the InfoBox by double-clicking its close box in the 
upper-left corner. If you need help with the current panel, click the 
question mark in the upper-right corner.

InfoBox and named 
styles

The InfoBox allows you to set 
all the properties for an object 
in one place.

Use the InfoBox to edit 
the selected object.

Click a panel tab to go to 
another panel of settings.

This shows the type of 
the selected object.

Double-click the close 
box to close the 
InfoBox.

Click the question mark 
for online Help about the 
InfoBox.
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If you want the InfoBox to be out of the way but still open, you can 
double-click the title bar to collapse the InfoBox to its title bar and 
panel tabs. When you’re ready to return the InfoBox to full size, 
double-click the title bar again.

You can save a set of InfoBox properties together in a named style. If 
you want to change the properties of a particular object, you can 
apply a named style to it or use the InfoBox to change properties 
manually. You can also make one named style the default for views. 
For more information, see “Working with named styles” on 
page 5-26.

When you’re in Design, you can quickly open a pop-up menu with 
some of the most commonly used design commands. These 
commands are a subset of the ones in the main menus.

■ To choose a command from the pop-up menu, click an object or 
the page margin of a view with the right mouse button to open 
the menu and drag to the command you want.

The pop-up menu closes after you choose a command.

Double-click the title bar to 
collapse or expand the box.

You can collapse the 
InfoBox to a smaller size.

Pop-up menu with 
design commands

Right-click an object to 
open the menu and drag 
to a command.

The pop-up menu gives 
you quick access to a 
subset of commands.
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Approach provides several ways to customize your Design work 
area. These are the things you can do:

• Show a design grid behind objects

• Make objects “snap” automatically to a grid

• Show a ruler along the top and left sides of the work area

• Show a floating palette of SmartIcon drawing tools

• Show field names or actual data in field objects

• Zoom in for a closer look, or zoom out for a larger perspective

This section describes how to set these options for your current work 
session with Approach. If you’d like to set defaults for the grid, snap, 
rulers, and data or field names, see “Setting display defaults” on 
page 19-2.

You can show a design grid behind objects in the work area. The grid 
appears only in Design; it disappears when you go to Browse, and it 
does not print.

The design grid appears in your work area as dotted lines. On a color 
monitor, the lines are blue.

■ To show a design grid, click the Show Grid icon or choose Show 
Grid from the View menu. To hide the grid, click the icon or 
choose Show Grid again. 

The Show Grid icon is in the default Design icon bar. 

When the command is on, the icon has a line across it and the 
command has a checkmark by it.

Customizing the 
Design work area

Showing a design 
grid

A grid helps you plan and 
lay out objects visually.

You can show a grid 
behind objects.
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When you draw, move, or resize objects, you can have the objects 
snap to the increments on the design grid. The objects snap to the grid 
whether or not the grid is showing.

Approach provides several possible increments for the grid, in inches 
and in centimeters. For information about changing to another 
increment, see “Setting display defaults” on page 19-2.

■ To snap objects to the grid, choose Snap to Grid from the View 
menu. To remove the snap, choose Snap to Grid again.

If the Snap to Grid icon is in an icon bar, you can click the icon 
instead of choosing the command. (You add icons to the icon bar 
using the SmartIcons command in the Tools menu.)

When the command is on, the icon has a line across it and the 
command has a checkmark by it.

Approach can display rulers as guides for manipulating objects. The 
rulers appear along the top and left sides of the Design work area. 
Rulers appear only in Design; they disappear when you go to 
Browse.

As you move the pointer in the work area, lines in the rulers identify 
the pointer’s position. If you move or resize an object, the lines show 
the dimensions of the object.

If you have the insertion point in a text object (including the main 
part of a form letter), the top ruler also shows the left and right 
margins and any tab stops in the text object.

■ To show rulers, click the Show Ruler icon or choose Show Ruler 
from the View menu. To hide the rulers, click the icon or choose 
Show Ruler again. 

The Show Ruler icon is in the default Design icon bar. 

When the command is on, the icon has a line across it, and the 
command has a checkmark by it.

Snapping objects to 
the grid

Snapping makes it easier to 
align objects precisely.

Showing rulers

The rulers are not drawn to 
scale on screen, but 1 inch or 
1 cm on a ruler equals 1 inch 
or 1 cm on a printed page.

You can show rulers in 
the Design work area.

Lines mark the position 
of the pointer or the 
selected object.
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You can show a floating Tools palette in Design, with SmartIcons for 
drawing objects. The Tools palette appears only in Design; it 
disappears when you go to Browse. You can drag the palette by its 
title bar to move it around in the work area.

You click an icon to select a tool for drawing. If you want to draw 
more than one object of that type, you can double-click an icon; the 
icon stays selected until you click another icon.

■ To show the Tools palette, click the Show Tools icon or choose 
Show Drawing Tools from the View menu. To hide the palette, 
click the icon or choose Show Drawing Tools again. 

The Show Tools icon is in the default Design icon bar. 

When the command is on, the icon has a line across it and the 
command has a checkmark by it.

You can show either field names or actual data in field objects in 
Design.

When you show field names in Design, the object borders also 
appear in the work area. If the Approach file has joined databases, 
the database names appear along with the field names (for example, 
EMPLOYEE.Address).

Showing a Tools 
palette

Drag the Tools palette 
by its title bar to move it.Pointer

Rectangle

Rounded Rectangle

Draw Field

Radio Button

PicturePlus Field

Text

Ellipse

Line

Checkbox

Macro Button

Add Field

Showing field 
names or actual 
data
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When you show data in the fields, in a form or form letter the data 
you see is from the first record in the current sort order of the found 
set. In a report or set of mailing labels, the data you see data is from 
the records at the beginning of the found set.

When you’re showing data, an object set to non-printing does not 
appear in Design unless Show in Preview is also turned on for the 
object. These settings are in the Basics panel of an object’s InfoBox.

■ To show data in Design, choose Show Data from the View menu. 
To show field names, choose Show Data again.

If the Show Data icon is in an icon bar, you can click the icon 
instead of choosing the command. 

When data is showing, the icon has a line across it and the command 
has a checkmark by it.

Work with data showing if 
you prefer to see how a view 
will look in Browse or when 
printed.

You can show field names 
in Design…

…or data from the first 
record or records in the 
found set.

If field names are 
showing, object 
borders also appear.
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As you work in Design, you can zoom in for a closer look at your view 
or zoom out for the big picture. The possible zoom settings are 25, 50, 
75, 100, and 200 percent.

Zoom settings affect only how a view appears on the screen, and not 
how it is printed. Approach always prints at 100 percent.

You can change to another zoom setting in several ways:

■ To change to a different zoom setting, click the zoom setting in 
the status bar to open the zoom pop-up menu and choose a 
setting.

■ To zoom in or out one setting, click the Zoom In or Zoom Out 
icon, choose Zoom In or Zoom Out from the View menu, or press 
CONTROL and the up arrow or down arrow key.

The Zoom In and Zoom Out icons are in the default Design icon 
bar.

■ To return to 100 percent in one step, choose Actual Size from the 
View menu or choose 100% from the Zoom pop-up menu in the 
status bar.

Zooming in and out

A view at 50 percent…

…and at 200 percent
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You can add geometric objects, pictures, text objects, and macro 
buttons to the background of a view. In Browse, these objects will 
look exactly the same on every page of the view. (By contrast, data in 
fields changes from record to record in Browse.)

Approach gives a new object the pen width, fill color, text attributes, 
and other properties of the style for the current view. You can change 
any of these properties after creating the object. For more 
information, see “Editing objects and text” on page 5-18 and 
“Working with named styles” on page 5-26.

You can draw straight lines, rectangles and squares, rounded 
rectangles and rounded squares, and ellipses and circles on a view. 
You can use these shapes to emphasize, separate, or “tie together” 
data, or just to enhance the appearance of the view. 

To draw a geometric object:

1. Click the Line, Rectangle, Rounded Rectangle, or Ellipse icon, or 
choose Line, Rectangle, Rounded Rectangle, or Ellipse from the 
Create Drawing submenu. 

The icons are in the Tools palette.

If you plan to draw more than one object of a type, double-click 
the icon. The icon stays selected until you select a different one. 
On a color monitor, the icon changes to blue.

2. Drag to draw the object.

You can press SHIFT while dragging to constrain the object’s 
position or shape. This constrains a line to 0, 45, or 90 degrees; a 
rectangle to a square; a rounded rectangle to a rounded square; 
and an ellipse to a circle.

Adding objects to 
the background of 
a view

The text, the line, and 
the picture of the icon 
appear on this form in 
every record.

The data in the fields 
changes from record 
to record.

Drawing a geometric 
object
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You can paste a picture created in a graphics application, either 
directly from the picture file or from the Clipboard. For example, you 
may want to show a graphic of an icon the user needs to click or have 
a company logo appear on a view in every record.

You can also link or embed an OLE object on a view. For information 
about this, see “About OLE and Approach” on page 16-18.

To paste a picture from a file:

1. Click where you want the upper-left corner of the picture.

If you don’t click anywhere, the picture will be pasted in the 
upper-left corner of the view. You can drag the picture to move it.

2. Choose Paste from File from the Edit menu.

The Paste from File dialog box appears.

3. Select the file you want in the File Name list.

To limit the list to filenames of one type of file, select a file type in 
the List Files of Type drop-down list. You can paste these graphic 
file types in Approach:

Graphic file type Filename extension

Encapsulated Postscript .EPS

Graphics interchange .GIF

Targa .TGA

TIFF (Tagged Image File Format) .TIF

Windows bitmap .BMP

Windows Metafile .WMF

Pasting a picture

Keep in mind that pasting a 
picture in Design puts it on 
the background of the view. 
Pasting a picture in a 
PicturePlus field in Browse 
adds the picture to a record.

Select the graphic file.

Select the file type in the 
drop-down list.

Continued
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If you don’t know the file type, or want to display all the 
filenames, select All Files in the drop-down list.

4. Click OK.

To paste a picture from the Clipboard:

1. In the picture’s source application, select the picture.

2. Choose Copy from the Edit menu.

3. In Approach, go to Design and click where you want the upper-
left corner of the picture.

If you don’t click anywhere, the picture is pasted in the upper-
left corner of the view. You can drag the picture to move it.

4. Click the Paste icon, choose Paste from the Edit menu, or right-
click and choose Paste from the pop-up menu.

The Paste icon is in all three default icon bars in Design.

You can include text in a view, such as a name for the view or 
instructions for entering data. You first draw a text object and then 
type in the object. If you need to edit the text, first enter an insertion 
point in it, or select text you want to replace or delete.

For information about formatting text in a text object, see “Changing 
text attributes” on page 5-23.

To enter text in a text object:

1. Click the Text icon or choose Text from the Create Drawing 
submenu.

The Text icon is in the Tools palette.

If you plan to draw more than one text object, double-click the 
icon. The icon stays selected until you select a different one. On a 
color monitor, the icon changes to blue.

2. Click where you want the text to begin, or drag to define an area 
for the text object.

A text object appears with an insertion point in it, ready for you 
to start adding text.

Windows Paintbrush .PCX

Graphic file type Filename extension

Entering text in 
a text object

If you want to edit an existing 
text object, click the Text icon 
and click in the object, or 
double-click a selected object.
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3. Enter the text.

You can type text, paste text from the Clipboard, and insert a date 
or time. The text appears at the insertion point. You don’t need to 
press RETURN as you type text; the text wraps automatically from 
line to line to fit in the object.

To paste text that is on the Clipboard, click the Paste icon, choose 
Paste from the Edit menu, or right-click and choose Paste from 
the pop-up menu.

To insert the current date or current time, click the Date or Time 
icon, choose Date or Time from the Insert submenu in the Text 
menu, or right-click and choose Date or Time from the Insert 
submenu in the pop-up menu. (The Date and Time icons are in 
the default Text icon bar.) Approach updates a date or time 
whenever you open, preview, or print the Approach file.

You can add a button to a view and attach a macro to the button. In 
Browse, Approach will run the macro whenever you click, tab into, 
or tab out of the button (depending on how you set up the macro).

To add a macro button:

1. Click the Macro Button icon or choose Macro Button from the 
Create Drawing submenu.

The Macro Button icon is in the Tools palette.

If you plan to draw more than one macro button, double-click 
the icon. The icon stays selected until you select a different one. 
On a color monitor, the icon changes to blue.

2. Drag to draw the button.

You can resize a text object if 
your text won’t fit. Click the 
Pointer icon, select the 
object, and drag a handle.

Adding a macro 
button

You click or tab to a 
button to run its macro.
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The InfoBox shows the Macros panel for the button.

3. Select one or more macros for the button in the drop-down lists 
in the Attached Macros area.

You can have Approach run a macro when you click the button 
or when you tab into or out of it.

4. If you need to define a macro, click Define Macro and use the 
dialog box that appears.

For more information, see “Defining a macro” on page 15-1.

5. Click the Basics tab in the InfoBox.

The InfoBox shows the Basics panel for the button.

6. Type a label for the button in the Button Text box.

7. If you’re working with data showing, turn on Show in Preview 
to see the macro button in Design.

Select macros for the 
button.

Click here if you need 
to define a macro.

Type a label for the button.

Turn this on if you’re 
showing data.
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Before making design changes to a view, you need to select the object 
or text you’re editing. Use the Pointer icon to select objects, and the 
Text icon to select text.

A selected object has handles around it. You can drag one of these 
handles to resize the object.

If you select more than one object, you can move, cut, copy, delete, 
and apply properties (such as a fill color) to the selected objects all 
at once.

The Pointer icon is in the Tools palette.

■ To select an object, click the Pointer icon and then click inside the 
object or on its border. 

■ To select more than one object, click the Pointer icon and then 
SHIFT-click the objects. Or point in an empty part of the view and 
drag diagonally to draw a selection rectangle around the objects.

If you draw a selection rectangle, the objects must be completely 
inside the rectangle.

■ To select all the objects in a view, choose Select All from the Edit 
menu.

■ To deselect an object from several selected objects, click the 
Pointer icon and then SHIFT-click the object.

■ To cancel a selection, click in another part of the view. 

You need to select text before applying text attributes (such as italics 
or boldface) to it. Text is highlighted when it is selected.

You can select particular text in a text object or the entire object. If 
you select an entire text object, any attribute you use applies to all 
text in the object.

The Text icon is in the Tools palette.

■ To select a range of text, click the Text icon or double-click the 
text object. Then drag through the text.

Selecting in 
Design

Selecting objects

Handles appear around 
selected objects.

If the object is rounded, the 
handles appear at imaginary 
rectangular boundaries.

Selecting text
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■ To select a word, click the Text icon or double-click the text 
object. Then double-click the word.

■ To select a text object, click the Pointer icon and then click the 
object. 

■ To enter an insertion point in text, click the Text icon and click in 
the text, or click the Pointer icon and double-click a selected text 
object.

■ To cancel a selection, click in another part of the view. 

You can edit objects and text in these ways:

• Change the basic properties of an object, such as the named style

• Change the pen width, pen color, fill color, and drop shadow, 
and put a three-dimensional frame around an object

• Resize an object

• Move an object to another part of the view

• Make an object slide up or left toward a field when you print

• Change the font, size, color, and other text attributes

• Cut or copy an object or text range, and then paste it to another 
part of the view or to a different view

• Delete an object or text range

Many of the procedures in this section use the InfoBox. If the InfoBox 
is not already open, click the Show Info icon, choose Style & 
Properties from the context-sensitive menu, or double-click the object 
you want to edit. (For a text object, use the icon or command.) The 
InfoBox appears; you can keep it on the screen as you work.

When you select an object or click in the background of a view in 
Design, the InfoBox changes to show the settings for that object or 
view. If you’re editing an object and the settings you want disappear 
from the InfoBox, you have probably clicked outside the object. 
Select the object again, and the settings will reappear.

For information about editing a view, such as changing the 
background color, or resizing the page margins, see “Editing views” 
on page 5-35.

For information about attaching macros to an object, see “Attaching a 
macro to an object” on page 15-13.

Editing objects 
and text
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An object’s basic properties are its named style and whether the 
object is non-printing and appears in Preview.

■ To change the basic properties of an object, select the object, click 
the Basics tab in the InfoBox, and set the options in the Basics 
panel.

Most objects in Approach have a line as a border and an interior “fill” 
area. (Lines do not have an interior.) You can set a line width and 
color for an object’s border, a fill color for an interior, and a color for a 
drop shadow.

If you want to see through an object, you can make its border or 
interior transparent.

To Do this

Make an object non-printing Turn on Non-printing.

Show a non-printing object in 
Preview

Turn on Show in Preview. (This is 
available only if Non-printing is 
on.)

Apply a named style with line, 
color, and text properties 
already defined

Select a style in the Named Style 
drop-down list.

Changing the basic 
properties of an 
object

Keep in mind that the InfoBox 
shows settings for the selected 
object or (if no object is 
selected) the current view.

Turn this on to make the 
object non-printing.

Turn this on to show the 
object in Preview.

Select a named style with 
predefined properties.

Changing line or 
color settings for an 
object

This rectangle has a 
black border, a light gray 
interior, and a dark gray 
drop shadow.

The border and interior of this 
text object are transparent so 
that you see the rectangle 
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An object can also have a raised or indented frame to give it a three-
dimensional look.

■ To change line or color settings for an object, select the object, 
click the Lines and Colors tab in the InfoBox, and set the options 
in the Lines and Colors panel.

To Do this

Change the width of a line or of 
the border of another object

Select a width in the Border Width 
drop-down list.

Change the color of a line or of 
the border of another object

Select a color in the Border Color 
drop-down palette. Select T for 
transparent.

Change the fill color of the 
interior of an object

Select a color in the Fill Color 
drop-down palette. Select T for 
transparent. (This is not available 
for lines.)

Give an object a drop shadow Select a color in the Shadow Color 
drop-down palette. Select T for 
transparent (no shadow).

Give an object a dashed, raised, 
or indented frame

Select a frame style in the Frame 
drop-down list.

An object can have no 
frame…

…or it can have a raised 
or indented frame.

A raised or indented frame 
works best against a solid 
gray or colored background.

If you plan to print a view on 
a black-and-white printer, use 
grays rather than colors to get 
the best-looking printouts.

Select a width and color for 
the line or border.

Select a fill color for the 
interior.

Select a color for a drop 
shadow.

Select a frame style.
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You can change the size and shape of any existing design object 
(including fields), using either the mouse or the InfoBox. You can also 
reshape ellipses into circles, circles into ellipses, rectangles into 
squares, and squares into rectangles without redrawing.

The dimensions area of the status bar shows either the width and 
height (W and H) of the selected object, or the left and top 
coordinates (L and T) of the object. If you’re resizing with the mouse, 
you may want to see width and height. Click in the dimensions area 
to toggle from one setting to the other.

■ To resize an object using the mouse, select the object and drag 
one of its handles. 

When you point on a handle, the pointer turns into a resize 
cursor to show that it is properly positioned for resizing. As you 
drag, you can look at the dimensions area in the status bar to see 
the object’s width and height.

If you want a rectangle, rounded rectangle, or ellipse to be in the 
shape of a square, rounded square, or circle, press SHIFT while 
dragging the handle. 

■ To resize an object using the InfoBox, select the object, click the 
Dimensions tab, and type values in the Width and Height text 
boxes.

Resizing an object

The status bar shows the size or 
the location of an object. Click to 
toggle to the other setting.

You may want to turn off 
Snap to Grid when resizing 
objects with the mouse.

Resize cursor

Type a width and height for 
the object.
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You can move any object to another part of a view using the mouse, 
the keyboard, or the InfoBox.

The dimensions area of the status bar shows either the width and 
height (W and H) of the selected object, or the top and left 
coordinates (T and L) of the object. If you’re moving an object with 
the mouse, you may want to see the coordinates. Click in the 
dimensions area to toggle from one setting to the other.

■ To move an object using the mouse, select the object and drag it 
by its border. 

When you point on a border, the pointer turns into a move cursor 
to show that it is properly positioned for moving. As you drag, 
you can look at the dimensions area in the status bar to see the 
object’s top and left coordinates.

■ To “nudge” an object using the keyboard, select the object and 
press the up arrow or down arrow key.

At the 100-percent zoom setting, the object moves 1 pixel each 
time you press the key. 

Nudging an object takes the object off the snap grid. You can use 
Align to Grid in the Align dialog box (Object menu) to move the 
object back onto the grid.

■ To move an object using the InfoBox, select the object, click the 
Dimensions tab, and type values in the Top and Left text boxes.

The data in a field can vary in length, so the distance between field 
data and an object to the right or below it can also vary from record 
to record.

If you want an object to be a consistent distance from a field’s data in 
every record, you can have Approach slide the object to the left or up 
to fill blank space.

Moving an object

Move cursor

You may want to turn off 
Snap to Grid when moving 
objects with the mouse.

Type the top and left 
coordinates for the object.

Sliding an object 
when you print
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For sliding to work, you must have Reduce on (in the Dimensions 
panel of the InfoBox) for the field with the variable data. Approach 
resizes the field so that it is just large enough for the data in it, and 
then it slides the object to fill the space left by the reduced 
boundaries. For more information about reducing boundaries in the 
field, see “Sliding or resizing a field when you print” on page 6-28.

For example, if you have a memo field with a variable amount of 
data in it and a line beneath the memo field, you can slide the line up 
to be just below the data in every record. (The memo field must have 
Reduce on.)

■ To make an object slide when you print, select the object, click the 
Dimensions tab in the InfoBox, and turn on Left or Up in the 
When Printing, Slide area.

Approach slides an object when you preview or print, and in Design 
if you’re showing data.

You can change the font, size, color, and text style of all text in a text 
object or of text in a selected range. The fonts available in Approach 
are the TrueType fonts installed on your system. These are the text 
styles you can use:

Bold Underline
Italic Strikethrough

You can also change the alignment and line spacing of all text in a 
text object. 

If you have a named style with the text attributes you want, you can 
apply the style to an object rather than changing the attributes 
manually. The styles are in the Named Styles drop-down list in the 
Lines and Colors panel of the InfoBox.

Sliding is used most often in 
mailing labels or with memo 
fields.

If you slide the line up, 
it fills the blank space 
left by the reduced 
memo field.

If you don’t slide the line 
up, it is always in the 
same place on the view.

Changing text 
attributes

Use the Pointer icon to select 
a text object and the Text icon 
to select text.



5-24 User’s Guide

■ To change text attributes, select the text or text object, click the 
Text tab in the InfoBox, and set the options in the Text panel.

You can cut an object or some text and paste it elsewhere in the view 
or in another view. You can also make a copy of an object or text and 
paste the copy. 

To cut or copy an object or text:

1. Select the object or text.

2. Click the Cut or Copy icon, choose Cut or Copy from the Edit 
menu, or right-click and choose Cut or Copy from the pop-up 
menu.

The Cut and Copy icons are in all three default icon bars in 
Design.

To Do this

Change the font of text Select a font in the Font Name 
drop-down list.

Apply boldface, italics, 
underlining, or strikethrough 
to text

Select one or more styles in the 
Style/Effect list.

Change the font size of text Type a size in the Size text box or 
select in the Size drop-down list.

Apply a color to text Select a color in the Text Color 
drop-down list.

Change line spacing to single 
space, one and a half space, or 
double space

Select an option in the Line 
Spacing area.

Change alignment to left, 
center, right, or justified 

Select an option in the Alignment 
area.

Select a color for the text.Select a font for the text.

Select one or more text 
styles.

Select a font size.

Select a line spacing.

Select an alignment.

Alignment and line spacing 
affect all text in a text object, 
even if you’ve selected only 
some of the text in the object.

Cutting or copying 
an object or text
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Cut removes the selection from the view and puts it on the 
Clipboard. Copy leaves the selection in place and puts a copy of 
it on the Clipboard.

3. Click where you want to paste the selection.

If you’re pasting an object and don’t specify a location, the object 
is pasted on top of the original object. If you paste into another 
view, the object is pasted at the same location as in the original 
view.

If you’re pasting text, you must click in a text object. The text is 
pasted at the insertion point.

4. Click the Paste icon, choose Paste from the Edit menu, or right-
click and choose Paste from the pop-up menu.

The Paste icon is in all three default icon bars in Design.

You can permanently delete any object or range of text from a view. If 
you delete a field, the field is not deleted from the database, but only 
from the current view.

To delete an object or text:

1. Select the object or text.

2. Choose Clear from the Edit menu or press DELETE or BACKSPACE.

You can copy the line and color settings and the text attributes from 
one object and apply them to another object with a click of the 
mouse. This is a fast and easy way to apply a set of properties.

If you plan to use the properties again later or in another view or 
Approach file, you may want to save them in a named style. For 
more information, see “Working with named styles,” next.

To apply properties from another object:

1. Select the object with the properties you want to use.

2. Click the Fast Format icon or choose Fast Format from the 
context-sensitive view menu.

The Fast Format icon is in all three default icon bars in Design.

The pointer turns into a format cursor to show that you can 
format objects by clicking. The icon has a bar across it and the 
menu command has a checkmark by it.

The Clipboard stores only one 
item at a time. When you cut 
or copy, you erase the current 
contents of the Clipboard.

Deleting an object 
or text

Applying 
properties from 
another object

Format cursor
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3. Click the objects you want to apply properties to.

Each object you click takes the line and color settings and the text 
attributes of the selected object.

4. When you’re finished applying properties, click the Fast Format 
icon, or choose Fast Format, or press ESC.

A named style is a set of object properties that you define and save. 
You can apply a named style to any object, and you can define one 
style to be the default for new views.

A named style can include these properties:

• Text attributes for field data and for text in text objects

• Line and color settings for all objects, and border and baseline 
settings for fields

• Text attributes for field labels

• Picture settings, such as cropping and shrinking, for PicturePlus 
fields

• Width and color settings for the background of views and panels

The properties in a named style are the same as they are in the 
InfoBox, but by saving properties in a style you can easily apply 
them to more than one object. If you change any properties of a 
named style, all objects that use the style are updated to match the 
changes automatically. 

When you create a view using an Assistant, you can apply your 
current default style to the view or apply one of the predefined 
SmartMaster styles. After creating a view, you can change the style 
by using the Named Style drop-down list in the view’s InfoBox. 
Approach uses the properties in a style for the background of the 
view and for all objects you add to the view. 

You can also change the style of any particular object using the 
Named Style drop-down list in the object’s InfoBox. When a named 
style is applied to an object, only the appropriate properties are used. 
For example, if you apply a named style to a rectangle, only the 
width, color, and frame settings apply even though the style may 
also have text attributes and picture settings.

Working with 
named styles

Named styles allow you to 
apply consistent formatting 
to objects within an Approach 
file.
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When you define a named style, you can either create a new style 
from scratch or make a copy of an existing style and then modify it.

The properties in a named style are the same settings that are in the 
InfoBox.

To define and save a named style:

1. Choose Named Styles from the Tools menu.

The Named Styles dialog box appears, showing the names of all 
styles currently available in the Approach file.

2. Click New or select an existing style and click Copy.

The Define Style dialog box appears. If you clicked New, the 
dialog box shows properties in their default “neutral” settings. If 
you selected a style and clicked Copy, the selected style’s 
properties appear in the panels of the dialog box.

Defining and saving 
a named style

Click New to create a 
new style…

…or select a style and 
click Copy to make a 
duplicate.

The names of existing 
styles appear here.

Type a name for the new 
style.

Click tabs and set options 
for the style in the panels.
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3. Type a name for the new style in the Style Name text box.

If you copied a style, the text box shows the name of the copied 
style, plus a number (for example, Corporate 2). You can edit this 
name.

4. If you want to base the style on an existing one, select the 
existing style in the Based On drop-down list.

The base style’s properties appear in the panels of the dialog box. 
You can keep or change any of these properties for the new style.

The new style maintains a relationship with the base style. For 
any property you keep from the base style, if you later change 
that property in the base style, the change is also made in the 
new style. 

5. To define text attributes for data in fields or for text in text 
objects, click the Font tab (if necessary) and set options in the 
Font panel.

For information about text attributes, see “Changing text 
attributes” on page 5-23.

Select a font and size for 
data and text.

Select a style and turn on 
one or more effects.

Select a color for 
data and text.

Select a relief for 
data and text.

Select an alignment.



Working in Design 5-29

6. To define properties for widths, colors, frames, and field borders, 
click the Lines & Colors tab and set options in the Lines & Colors 
panel.

For information about line and color properties, see “Changing 
line or color settings for an object” on page 5-19.

7. To define text attributes for field labels, click the Label tab and set 
options in the Label panel.

For information about text attributes, see “Changing text 
attributes” on page 5-23.

Select a width and color for 
borders and lines.

Select a fill color for the 
interior of objects.

Select a color for drop 
shadows.

Select a frame style 
for objects.

Turn on the borders 
you want for fields.

Turn this on to make 
fields read-only.

Turn this on to put labels inside field borders.

Select a font and size for 
label text.

Select a style and turn on 
one or more effects.

Select an alignment for labels.

Select a position for 
labels relative to 
the field.

Select a color for 
label text.

Select a relief for 
label text.
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8. To define properties for PicturePlus fields, click the Picture tab 
and set options in the Picture panel.

For information about PicturePlus properties, see “Changing 
display options for a PicturePlus field” on page 6-32.

9. To define properties for the background of views and panels, 
click the Background tab and set options in the Background 
panel.

All of the settings in the Background panel apply to repeating 
panels. All of the settings except for Shadow Color apply to 
views and summary panels.

10. Click OK.

You return to the Named Styles dialog box.

11. To apply the new style to the current selection, click Apply.

The Apply button is available only if at least one object is 
selected in a view.

12. Click Done.

Select whether to crop or 
shrink pictures that are too 
large for the field.

Turn this on to stretch 
pictures that are too 
small for the field.

Turn this on to allow 
users to draw in 
PicturePlus fields.

Select a width and color for 
the borders of views and 
panels.

Turn on the borders 
you want for views 
and panels.

Select a fill color for the 
background of views and 
panels.

Select a frame 
style for views and 
panels.

Select a shadow color for repeating panels only.
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You can edit the definition of a named style or delete a style at any 
time. If you edit a style, in general, any existing objects that use the 
style are updated automatically. But if you have changed any 
properties for an object using the InfoBox, those particular properties 
are not updated for that object.

Deleting a style does not affect the properties of any existing objects 
that use the style.

To edit or delete a named style:

1. Choose Define Style from the Tools menu.

The Named Styles dialog box appears.

2. Select the name of the style you want to edit or delete.

You can delete only styles you’ve created.

3. To redefine the style, click Edit and change the settings in the 
Define Style dialog box.

For information about working with Define Style, see “Defining 
and saving a named style” on page 5-27.

4. To remove the style, click Delete.

Approach asks if you’re sure you want to delete the style. Click 
OK to delete the style.

5. Click Done.

Editing or deleting a 
named style

Click Edit to redefine the 
style…

…or click Delete to 
remove the style.

Select the style you want 
to edit or delete.
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Approach makes it easy to quickly change more than one object at a 
time. After you select the objects you want to change, you can cut, 
copy, paste, or move the objects or change their properties just as you 
can with an individual object. 

If you select more than one object at a time, the object name in the 
InfoBox is Multiple Objects. Any changes you make in the InfoBox 
affect all objects in the selection.

A few commands work only with multiple objects. These commands 
let you group objects, change their stacking order, and align and 
distribute the objects for accurate spacing.

You can combine two or more objects so they act as a single object.

When you select a grouped object, one set of handles appears around 
the entire group, and the object name in the InfoBox is Grouped 
Object.

You cannot edit text in a text object that is part of a group. You must 
first ungroup the text object from the other objects.

A group can include other grouped objects.

To group objects:

1. Select the objects.

2. Click the Group icon, choose Group from the Object menu, or 
right-click and choose Group from the pop-up menu.

The Group icon is in the default Design icon bar.

To ungroup a grouped object:

1. Select the object.

2. Click the Ungroup icon, choose Ungroup from the Object menu, 
or right-click and choose Ungroup from the pop-up menu.

The Ungroup icon is in the default Design icon bar.

Working with 
more than one 
object at a time

Grouping and 
ungrouping objects

A group has a single set 
of handles.
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Approach automatically stacks objects in layers. Each time you create 
a new object, it is placed “in front of” any other objects already on the 
view. You can change this stacking order, moving any object closer to 
the front or farther to the back.

To change the stacking order of an object:

1. Select the object.

2. Click one of the following icons, choose one of the commands 
from the Object Arrange submenu, or right-click and choose one 
of the commands from the Arrange submenu in the pop-up 
menu.

The Bring Forward and Send Backward icons are in the default 
Design icon bar.

To do this Click Or choose

Move an object to the 
front 

Bring to Front

Move an object to the 
back

Send to Back

Move an object one layer 
forward

Bring Forward

Move an object one layer 
backward 

Send Backward

Changing the 
stacking order of an 
object

The rounded rectangle 
is in the front layer. Here it has been moved 

to the back.

The stacking order affects the 
appearance of objects both on 
the screen and on a printed 
page.
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Approach lets you align objects vertically, horizontally, or both. You 
can specify alignment along the top, bottom, side, or center of the 
objects’ boundaries. The objects can align to the position of one object 
or to the nearest point on the grid.

You can also distribute objects vertically, horizontally, or both. This 
places an equal amount of space between the objects.

To align and distribute objects:

1. Select two or more objects.

2. Click the Align icon, choose Align from the Object menu, or 
right-click and choose Align from the pop-up menu.

The Align icon is in the default Design icon bar.

The Align dialog box appears.

3. Specify how you want the objects aligned and distributed. 

To do this Select

Align or distribute objects 
horizontally or vertically 
based on one of the objects

“To each other” and a horizontal or 
vertical alignment or distribution.

Aligning and 
distributing objects

These objects are 
aligned vertically along 
their top edges.

They are also distributed 
horizontally for equal spacing.

Select a vertical alignment 
or distribution.

Select whether to align 
objects to each other or to 
the grid. Select a horizontal 

alignment or 
distribution.

This shows the 
effect of “To each 
other” settings.

Continued
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4. Click OK.

In addition to editing individual objects on a view, you can make 
changes that affect the view as a whole. You can edit views in these 
ways:

• Change the basic properties, such as the name of a view and its 
main database

• Add the current date or time to a view

• Resize the page margins of a view

• Change the line width and color of page margins and the fill 
color of the page background

• Duplicate a view

• Delete a view

For information about making changes specific to a certain type of 
view, such as adding a repeating panel to a form, see the chapter 
about that type of view.

Many of the procedures in this section use the InfoBox. If the InfoBox 
is not already open, click the Show Info icon, choose Style & 
Properties from the context-sensitive menu, or double-click in the 
background of the view you want to edit. The InfoBox appears; you 
can keep it on the screen as you work.

When you select an object or click in the background of a view in 
Design, the InfoBox changes to show the settings for that object or 
view. If you’re editing a view and the settings you want disappear 
from the InfoBox, you have probably clicked an object instead of the 
view. Click in the background of the view again or select the view 
name in the drop-down list in the title bar of the InfoBox, and the 
settings will reappear.

For information about attaching macros to a view, see “Attaching a 
macro to a view” on page 15-15.

Align or distribute objects to 
the nearest grid point

“To grid” and a horizontal or 
vertical alignment or distribution.

To do this Select

Editing views
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A view’s basic properties are its name, the main database if the view 
uses joined data, the named style for its background, the set of 
menus, and whether the view appears in Browse. These properties 
are stored in the view’s InfoBox.

A main database provides the framework of data for a view; each 
record from the main database appears in the view. For more 
information about the purpose of the main database, see “Main and 
detail databases in a view” on page 4-5.

If you attach a set of menus to a view, the menus are available 
whenever you go to the view in Browse. You can attach the default 
menus, the Approach short menus, and any custom menus of your 
own. 

The short menus are a subset of the default menus; they do not 
include commands for modifying the file. For example, the short 
menus do not have the Create Form and Define Macro commands. 
For information about setting up custom menus, see “Customizing 
menus” on page 19-18.

A report does not have named styles in its basic properties; instead, 
the panels in the report each have a named style. For more 
information, see “Changing line or color settings for a report panel” 
on page 8-22.

■ To change the basic properties of a view, click in the background 
of the view, click the Basics tab in the InfoBox, and set the options 
in the Basics panel.

To Do this

Change the name of a view Edit the name in the Name text 
box.

Changing the basic 
properties of a view

Use the short menus when 
you want other users to be 
able to enter data in the view, 
but not change its design.

You can also rename a view in 
Design by double-clicking its 
view tab and then typing in 
the tab.

Edit the name of the view.

Select a main database for 
joined data.

Select a named style with 
predefined properties.

Select a set of menus 
to use for the view.

Turn this on to hide the view in Browse.

Turn this on to hide the 
view’s margins in Browse.

Continued
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You can put a current date or current time on the background of a 
view. Approach will update the date or time whenever you open, 
preview, or print the Approach file.

When you first insert a date or time, Approach places it in a new text 
object in the upper-left corner of the view. You can move, resize, and 
otherwise edit the date or time just as you can any other text object. 
In Design, the object contains <<DATE>> or <<TIME>>, but in Browse 
you’ll see the actual date or time.

■ To add a date or time to a view, click the Date or Time icon, 
choose Date or Time from the Insert submenu in the context-
sensitive menu, or right-click the margin of the view and choose 
Date or Time from the Insert submenu in the pop-up menu.

The Date and Time icons are in the default Text icon bar.

You can also insert a page number in the header or footer of a report, 
and Approach will increment the number for you automatically. For 
more information, see “Adding a header or footer” on page 8-24.

Change to a different main 
database

Select a database in the Main 
Database drop-down list.

Apply a named style with line 
and color properties already 
defined

Select a style in the Named Style 
drop-down list. (This is not 
available for reports.)

Change the menus for a view Select a set of menus in the 
Attached Menu Bar drop-down 
list.

Hide a view in Browse Turn on “Hide view.”

Hide a view’s page margins in 
Browse

Turn on “Hide page margins.” 
(This is available for forms and 
form letters, and only if “Hide 
view” is off.)

To Do this

You may want to hide a view 
in Browse when you’re using 
the view to develop an 
application.

Adding a date or 
time to a view
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Page margins are the area between the printable part of a view and the 
edge of the paper. When you create a new view, Approach 
automatically sets margins appropriate for the current printer.

You can change any of the page margins to make the printable area 
larger or smaller, up to the maximum area allowed by the printer. 
Each view in an Approach file can have different margins.

■ To resize page margins, click a border of the view and then drag 
the border.

When you move the pointer over a selected border, the pointer 
turns into a resize cursor to show that it is properly positioned 
for resizing.

If you cannot make a view as large as you’d like, change your current 
printer to one that allows for a larger printing area. For information 
about changing the default printer, see “Specifying the printer, paper, 
and orientation” on page 14-2.

If you want non-printing borders in a form or form letter, such as to 
have a color print to the edges of the view, turn on “Hide page 
margins” in the Basics panel of the view’s InfoBox.

In a form, form letter, or mailing label, you can change the color or 
width of the page borders and the fill color of the page background. 
Objects such as fields and rectangles on the view are not affected by 
the view’s background color (unless the objects are transparent).

In a report, you change the line and color settings in the InfoBox for 
the individual panels. For more information about this, see 
“Changing line or color settings for a report panel” on page 8-22.

Resizing page 
margins

Page borders mark the 
edge of a view’s printable 
area. Drag a border to 

resize the margin.

Resize cursor

Use the Approach rulers 
to help you position the 
margins. It sometimes helps 
to zoom out, too.

Changing line or 
color settings for a 
view
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■ To change line or color settings for a form, form letter, or mailing 
label, click in the background of the view, click the Lines and 
Colors tab in the InfoBox, and set the options in the Lines and 
Colors panel.

If you want to create a form, report, form letter, mailing label, 
worksheet, crosstab, or chart that is similar to one you already have, 
you can make a duplicate and then modify it. 

When you duplicate a view, Approach gives the duplicate a name 
such as Form 2 or Report 2. You can rename the view in the Basics 
panel of the view’s InfoBox.

To duplicate a view:

1. Change to the view you want to duplicate.

You can click a view tab or choose from the view pop-up menu in 
the status bar.

To Do this

Change the width of the page 
borders of a view

Select a width in the Border Width 
drop-down list.

Change the color of the page 
borders of a view

Select a color in the Border Color 
drop-down palette. Select T for 
transparent.

Change the fill color of the 
background of a view

Select a color in the Fill Color 
drop-down palette. Select T for 
transparent.

Give a view a dashed, raised, 
or indented frame

Select a frame style in the Frame 
drop-down list.

Show borders around a view Turn on options in the Borders 
area.

If you apply a frame style, all 
four borders are turned on 
automatically.

Keep in mind that the InfoBox 
shows settings for the selected 
object, or (if no object is 
selected) the current view.

Select a width and color for 
the borders.

Select a fill color for the 
interior.

Select a frame style for the 
view.

Turn on the borders you 
want to show.

Duplicating a view
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2. Choose the Duplicate command from the Edit menu.

The name of the Duplicate command changes, depending on the 
type of the current view (or example, Duplicate Form and 
Duplicate Report). 

When you choose the command, Approach displays a duplicate 
of the view. You can make changes to the duplicate without 
affecting the original.

You can delete a form, report, form letter, mailing label, worksheet, 
crosstab, or chart. 

To delete a view:

1. Change to the view you want to delete.

2. Choose the Delete command from the Edit menu.

The name of the Delete command changes, depending on the 
type of the current view (for example, Delete Form and Delete 
Report). 

Approach asks if you’re sure you want to delete the view.

3. Click Yes to delete the view.

Deleting a view
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6 Adding and Editing Fields in a View

When you create a view, you specify which fields you want in it. You 
can add more fields to a view or delete them from a view, and you 
can format and edit fields in a view in many ways.

This chapter describes how to add fields to a view; display possible 
values for fields in drop-down lists, checkboxes, and radio buttons; 
edit the properties of fields; work with PicturePlus fields; and change 
the data entry order of fields in a view.

You can add a field to a form, report, or mailing label using either the 
Add Field dialog box or the Draw Field tool. (You can also use Add 
Field in a worksheet or crosstab.) The field must already be defined 
in a database used in your Approach file. 

When you add a field to a view, the field appears as a field box for 
entering and editing data in Browse. Approach gives the field box the 
border width, text attributes, and other properties of the named style 
for the current view.

This section describes how to add a field to a form, report, or mailing 
label. For information about adding a field to other kinds of views, 
see “Adding a field to a form letter” on page 9-12 and “Adding a 
database field to a worksheet or crosstab” on page 12-17. For 
information about defining a field, see “Defining fields for a 
database” on page 3-5.

You can delete fields from a view just as you delete other kinds of 
design objects. Deleting a field from a view does not remove the field 
from the underlying database file. For more information, see 
“Deleting an object or text” on page 5-25.

You must be in Design to add a field to a form, report, or mailing 
label.

Adding a field to a 
form, report, or 
mailing label
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To add a field using the Add Field dialog box:

1. In Design, click the Add Field icon, choose Add Field from the 
Form, Report, or Mailing Label menu, or right-click an object and 
choose Add Field from the pop-up menu.

The Add Field icon is in the Tools palette.

The Add Field dialog box appears, showing the fields defined for 
databases used in the Approach file. Calculated fields and 
variable fields in the Approach file appear in italics at the bottom 
of the list.

If you need to define a new field, click Field Definition and use 
the dialog box that appears.

2. Drag the database field you want from the Add Field dialog box 
to the view.

If the field you want is in a different joined database, select the 
database in the drop-down list above the list of fields.

A field box appears in a predefined size and shape.

Click here if you need to 
define a new field.

Add Field shows all the 
existing fields you can 
add to a view.

Drag the database field to 
the view.
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To add a field right after defining it:

1. After closing the Field Definition dialog box, drag the field from 
the Add Field dialog box to the view.

If “Show Add Field dialog” is on in the Display panel of the 
Preferences dialog box, when you close the Field Definition 
dialog box Add Field appears and you go to Design. For the 
moment, Add Field shows only the fields you just defined.

2. When you’ve finished adding new fields, click Show All Fields.

The list shows all the fields defined for databases used in the 
Approach file, and Show All Fields changes to Show New Fields. 
You can click the button again to see only the new fields.

To add a field using the Draw Field tool:

1. In Design, click the Draw Field icon or choose Field from the 
Create Drawing submenu.

The Draw Field icon is in the Tools palette. 

2. Drag diagonally to draw a field box.

The InfoBox shows the settings for the new field. So far, the field 
is based on the first database field listed in the InfoBox.

Right after you define fields, 
Add Field shows only the 
new fields…

…and an additional button 
appears. Click the button 
to see all the fields.

Select a database field.

Click here if you need to 
define a new field.
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If you need to define a new field, click Field Definition and use 
the dialog box that appears.

3. Select the database field you want in the Field list.

If the field you want is in a different joined database, select the 
database in the drop-down list above the Field list.

You can display a field as a drop-down list, as one or more 
checkboxes, or as one or more radio buttons in Browse. Use one of 
these elements to limit the values a user can enter in the field, and to 
make entering data much easier and more accurate.

Some of the procedures in this section use the InfoBox. If the InfoBox 
is not already open, click the Show Info icon, choose Style & 
Properties from the context-sensitive menu in Design, or double-click 
the field you want to edit. The InfoBox appears; you can keep it on 
the screen as you work.

You must be in Design to set up these display elements for a field.

You can have a field appear in Browse as a drop-down list or as a 
combination of a drop-down list and a field box.

If a field appears as a list, a user can select a value to enter in the 
field; the list shows all the possible values for the field. If the field 
appears as a list and a field box, a user can either select in the list or 
type a value in the box to enter data.

When you set up a drop-down list, you can type custom values you 
want to appear in the list, or use existing values from a database 
field. 

Displaying values 
for a field

Lists, checkboxes, and radio 
buttons are especially helpful 
in a form or report used for 
entering data.

Displaying a field as 
a drop-down list

A drop-down list shows 
values you can select 
to enter in a field.

If a list is combined with 
a field box, you can 
either select in the list or 
type in the box.
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If you use values from a field, Approach pastes the unique values 
from that field into the list. For example, the values appearing in the 
list of employees in the example might be data already in the Last 
Name field in the employee database. You can also filter a drop-
down list to display only a subset of the data from a database field.

The values you display in a list do not have to be the data that is 
entered in the field. You can show data simply as descriptions of 
what to enter. For example, suppose a field with a drop-down list 
stores an employee ID. To make it easier to enter the employee IDs, 
you could display the employees’ last names in the list rather than 
their IDs. Then, when you select a name in the list in Browse, the ID 
corresponding to that name is entered into the field.

To display a field as a drop-down list:

1. In Design, select the field you want to display as a list.

2. In the Basics panel of the field’s InfoBox, select Drop-Down List 
Only or Field Box & List in the Data Entry Type drop-down list.

The Drop-Down List dialog box appears.

3. To use custom values in the drop-down list, click “Type in list 
items” and type the values you want in the value list.

For each value, click in an empty line and type. If you want to 
put a new line between two existing values, click Insert to add a 
line above the one with the insertion point.

To remove a value from the list, click in its line and click Remove.

4. To use values from a database field, click “Create list 
automatically from field data.”

Approach finds the unique values for the current field and 
displays them in the value list.

A drop-down list can show up 
to nine items at a time. If a 
list has more than nine items, 
Approach gives it a scroll bar.

Click here and type values 
in the list…

…or click here and select a 
field with values to use.

Click here to 
set options.

Turn this on 
to show an 
arrow with 
the list.
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5. To show an arrow button with the drop-down list, turn on 
“Show drop-down arrow.”

6. To set options for the values in the drop-down list, click Options.

The bottom part of the dialog box opens.

7. To use values from a database field other than the current field, 
select the field you want in the field list on the left.

If the field is in a different joined database, select the database in 
the drop-down list above the field list.

Approach finds the unique values for the field you select and 
displays them in the value list.

8. To display a subset of values from a database field, turn on 
“Filter the list based on another field,” set the conditions in the 
dialog box that appears, and click OK.

For details, see “Displaying a subset of data in a drop-down list,” 
next.

9. To show values from another field as descriptions rather than as 
actual data to enter, turn on “Show description field” and select a 
field in the description field list.

When you select a description in the drop-down list in Browse, 
Approach enters the field value from the same record as the 
description.

For example, if you want to show employee names in the drop-
down list, but enter employee IDs in the field, select Last Name 
in the description list and Empl ID in the field list (at the left). 
When you select a name in Browse, Approach enters the 
employee ID from the record with the name you selected.

Select a database field 
with the values to use.

To display a subset of fields, 
turn this on, click Define 
Filter, and set conditions.

To display 
descriptions, 
turn this on 
and select a 
description 
field.
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10. Click OK.

You’ll see the list when you go to Browse.

When you set up a drop-down list, you can use existing values from 
a database field. The list normally shows all the unique values from 
the field, but you can define a set of conditions if you want to display 
only a subset of data from the field.

For example, suppose a database stores information about all of your 
employees. If you’d like a drop-down list to show only the names of 
employees with the same job title, you can limit the list to names 
from records that have the same value in the Position field as the 
current record. 

If you’re working with joined databases, you can use a match 
between fields in two of the databases to limit a drop-down list. For 
example, suppose you have three joined databases: one for orders, 
one for the line items in orders, and one for product data. (For basic 
information about joins of this type, see “Many-to-many 
relationships” on page 4-9.) 

In a repeating panel for entering products on an order form, you 
might use a drop-down list of product names to make it easier to fill 
out the form. If, in particular countries, only some of the products are 
available, you can add a Country field to the product and order 

Displaying a subset 
of data in a drop-
down list

If a drop-down list uses 
data from a database 
field, it can show all the 
unique values from the 
field…

…or a subset of values 
from the field.

These records all have Staff 
Accountant in their Position field.
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databases. Then limit the drop-down list to products that have the 
same value in their Country field (in the product database) as the 
Country field in the current record (in the order database).

To display a subset of data in a drop-down list:

1. Display a field on a view as a drop-down list.

Follow the instructions in “Displaying a field as a drop-down 
list” on page 6-4.

2. In the Define Drop-Down List dialog box, click “Create list 
automatically from field data.”

3. Click the Options button.

The bottom part of the dialog box opens.

4. Turn on “Filter the list based on another field.”

The Define Filter dialog box appears.

If the current Approach file uses one database file, the Define 
Filter dialog box shows the fields in the database. If the 
Approach file uses joined database files, the dialog box shows 
fields from all the joined databases.

5. Select the field or fields with the value you want to match. 

In Browse, the drop-down list will show only values from 
records that have the same data in the match field as the current 
record.

This drop-down list shows 
the names of all products 
in the product database.

This list shows only 
products with Japan 
in their Country field.
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If the Approach file uses one database file, select a field in the 
database. For example, if you want the drop-down list to show 
only the names of employees who have the same job title as the 
current employee record, select the Position field.

If the Approach file uses joined database files, select a field to 
match between the current database (with the field that has the 
drop-down list) and a joined database. For example, if you want 
the drop-down list to show only products that have the same 
country data as the current order record, select the Country field 
in the product and order databases.

6. Click OK.

You return to the Define Drop-Down List dialog box.

7. Click OK.

Select a field with a value to 
match in the current record.

This describes how the 
selected field limits the 
drop-down list.

Select a match field in the 
current database…

…and in a joined database.
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You can display a field as one or more checkboxes. A checkbox has 
two values: a Checked value, which is entered in the field if the 
checkbox is on, and an Unchecked value, which is entered if the 
checkbox is off. You click a checkbox in Browse to turn it on or off. A 
field with checkboxes can be a text field, numeric field, date field, or 
Boolean field.

For example, you might use a checkbox to identify a product as 
backordered. The checkbox’s Checked value would be Backordered, 
and its Unchecked value would be In Stock.

Because each checkbox has two values, you should typically set up 
only one checkbox for a field. When you click the checkbox, you go 
back and forth between its two values.

If a field has more than one checkbox, only one checkbox can be on at 
a time (but it is possible for no checkbox to be on). When you turn on 
a checkbox, any box already on in the set is turned off. You can turn 
off a checkbox to enter its Unchecked value in the field.

If you never click a checkbox, its value is Null. You must click a 
checkbox to turn it on, and then click it again to turn it off to enter its 
Unchecked value.

You can add a field to a view as a checkbox or display a field already 
in a view as a checkbox. Checkboxes can have custom values that 
you provide or values from the current database field.

To add a field to a view as a checkbox:

1. In Design, click the Checkbox icon or choose Checkbox from the 
Create Drawing submenu.

The Checkbox icon is in the Tools palette. If you plan to add more 
than one field as a checkbox, double-click the icon. The tool stays 
selected until you click another icon. On a color monitor, the icon 
changes to blue.

2. Drag diagonally to draw an area for the checkbox.

Displaying a field as 
a checkbox

Turning on this checkbox enters Backordered 
in the field. Turning it off enters In Stock.

If you want a set of clickable 
options in which one option is 
always on, use radio buttons 
instead of a checkbox.

You can have Approach enter 
an Unchecked value 
automatically in a new 
checkbox. See page 3-13.
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The Define Checkbox dialog box appears.

3. Select a database field for the checkbox in the field list.

If the field you want is in a different joined database, select the 
database in the drop-down list above the field list.

4. To use custom values for the checkbox, type a Checked value, an 
Unchecked value, and a checkbox label in the value list.

For each checkbox, click in an empty line and type. If you want to 
put a new line between two existing checkboxes, click Insert to 
add a line above the one with the insertion point.

To remove a checkbox, click in its line and click Delete.

5. To use values from the database field, click Create Checkboxes 
from Field Data.

Approach finds all the unique values for the field you selected 
and displays them as Checked values and labels in the list. You 
need to provide the Unchecked values.

6. Click OK.

To display a checkbox for a field already in a view:

1. In Design, select the field you want to display as a checkbox.

2. In the Basics panel of the field’s InfoBox, select Checkboxes in the 
Data Entry Type drop-down list.

Type a Checked value, an 
Unchecked value, and a 
label…

…or click here to enter 
values from the field.

Select a database field for 
the checkbox.

Normally, you use only one 
checkbox for a field.
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The Define Checkbox dialog box appears. The dialog box is 
smaller than it is when you add a field as a checkbox; it does not 
have the database list at the bottom.

3. To use custom values for the checkbox, type a Checked value, an 
Unchecked value, and a checkbox label in the value list.

4. To use values from the database field, click Create Checkboxes 
from Field Data.

Approach finds all the unique values for the current field and 
displays them as Checked values and labels in the list. You need 
to provide the Unchecked values.

5. Click OK.

You can display a field as a set of radio buttons. Each radio button can 
provide a Clicked value. You click a radio button in Browse to enter 
its value in the field. A field with radio buttons can be a text field, 
numeric field, date field, or Boolean field.

For example, you might use radio buttons to list the possible types of 
customers.

Because each radio button has only one value, you should normally 
use a set of two or more radio buttons for a single field. In a set of 
radio buttons, only one button can be on at a time. When you turn on 
a radio button, any button that is currently on in the set is turned off.

You can add a field to a view as radio buttons, or display a field 
already in a view as radio buttons. Radio buttons can have custom 
values that you provide or values from the current database field.

Type a Checked value, an 
Unchecked value, and a 
label…

…or click here to enter 
values from the field.

Displaying a field as 
a set of radio 
buttons

You can turn on one radio 
button in a set to enter its 
value in the field.

Radio buttons are initially 
laid out in a vertical column. 
To rearrange buttons, first 
ungroup them (use Ungroup 
in the Object menu).
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To add a field to a view as a set of radio buttons:

1. In Design, click the Radio Button icon or choose Radio Button 
from the Create Drawing submenu.

The Radio Button icon is in the Tools palette. If you plan to add 
more than one field as radio buttons, double-click the icon. The 
tool stays selected until you click another icon. On a color 
monitor, the icon changes to blue.

2. Drag diagonally to draw an area for the radio buttons.

The Define Radio Buttons dialog box appears.

3. Select a database field for the radio buttons in the field list.

If the field you want is in a different joined database, select the 
database in the database drop-down list above the field list.

4. To use custom values for the radio buttons, type the Clicked 
values and button labels in the value list.

For each radio button, click in an empty line and type. If you 
want to put a new line between two existing buttons, click Insert 
to add a line above the one with the insertion point.

To remove a radio button, click in its line and click Delete.

5. To use values from the database field, click Create Buttons from 
Field Data.

Approach finds all the unique values for the selected field and 
displays them as Clicked values and button labels in the list.

6. Click OK.

Type values and button 
labels…

…or click here to enter 
values from the field.

Select a database field for 
the radio buttons.

Give each radio button a 
unique value in the set.
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To display radio buttons for a field already in a view:

1. In Design, select the field you want to display as radio buttons.

2. In the Basics panel of the field’s InfoBox, select Radio Buttons in 
the Data Entry Type drop-down list.

The Define Radio Buttons dialog box appears. The dialog box is 
smaller than it is when you add a field as radio buttons; it does 
not have the database list at the bottom.

3. To use custom values, type the values and button labels in the 
value list.

4. To use values from the database field, click Create Buttons from 
Field Data.

Approach finds all the unique values for the current field and 
displays them as Clicked values and button labels in the list.

5. Click OK.

Approach provides predefined formats for displaying and printing 
date, time, numeric, and text data in a field. You must be in Design to 
set a format for a field.

When you enter data in a field with a format, you enter only the data 
itself. Approach automatically provides formatting characters, such 
as currency signs or thousands separators. You see the data in its 
format when you move out of the field.

Type values and button 
labels…

…or click here to enter 
values from the field.

Formatting data in 
fields

The data is formatted 
when you move out of 
the field.

As you type, the data 
appears the way you 
enter it.
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If you turn on “Show data entry format” for a date, time, or numeric 
field, formatting characters appear in the field when you click in it to 
enter data, and underlines show the maximum number of characters. 
You can press the space bar to move past a separator.

If you turn on “Show data entry format” for a text field, you see the 
data in its capitalization style as you type. For more about entering 
data with a format, see “Entering data in fields” on page 10-7.

For date, time, and numeric fields, a format affects only how data 
appears in a view, and not how it is stored in the database. For text 
fields, if “Show data entry format” is on the data is stored in its 
format.

The procedures in this section use the InfoBox. If the InfoBox is not 
already open, click the Show Info icon, choose Style & Properties 
from the context-sensitive menu in Design, or double-click the field 
you want to edit. The InfoBox appears; you can keep it on the screen 
as you work.

A field’s formatting information is stored in the Format panel of the 
InfoBox. When you select a format type, the panel shows the options 
for that type. (The formats available depend on the data type of the 
database field.)

A standard date format can display the day of a week, a month, a 
date, and a year. You identify which of these elements you want to 
include and in what order you want the month, date, and year to 
appear.

With “Show data entry 
format,” fixed 
characters appear as you 
enter data.

Select a format type 
to see its formatting 
options.

Setting a standard 
date format
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The format can spell out the day or use an abbreviation; spell out the 
month, use an abbreviation, or use a numeral; use a fixed two-digit 
date or a flexible one- or two-digit date; and use a four-digit year or a 
two-digit year.

■ To set a standard date format for a field, select the field, click the 
Format tab in the InfoBox, select Date in the Format Type drop-
down list, and set the options in the Format panel.

To Do this

Change to another order for 
month, day, and year

Select an order in the Current 
Format drop-down list.

Change the spelling of days 
(spelled out or abbreviated) or 
turn off the display of days

Select an option in the Day drop-
down list. Select the blank option 
to turn off the display.

Change the spelling of months 
(spelled out, abbreviated, or 
numeral) or turn off the display 
of months

Select an option in the Month 
drop-down list. Select the blank 
option to turn off the display.

Change the number of digits 
for dates (fixed two digits or 
flexible one or two digits) or 
turn off the display of dates

Select an option in the Date drop-
down list. Select the blank option 
to turn off the display.

Change the number of digits 
for years (four or two) or turn 
off the display of years

Select an option in the Year drop-
down list. Select the blank option 
to turn off the display.

Change a separator between 
days, months, and years

Edit the character in the text box to 
the right of the element.

Show the format in a field 
when you click in the field in 
Browse

Turn on “Show data entry 
format.”

The default order for entering 
the parts of a date is set in the 
Windows International 
Control Panel.

Select a spelling for days and 
months and type separators.

Select the number of digits for 
the date and year and type a 
separator.

Select an order for month, 
day, and year.

Turn this on if you want the 
format to appear in the field 
as you enter data.
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A special date format can display a quarter, a trimester, or a 
semiannual period, along with a year. You can use a predefined date 
format or create a custom format of your own. All special date 
formats, both predefined and custom, use a specific set of characters 
in their syntax.

A numeral in a special date format represents the period displayed: 4 
means a quarter, 3 means a trimester, 2 means a semiannual period, 
and 1 means an entire year. The number of times the numeral 
appears in the format specifies how the numeral is displayed in the 
field: one numeral means a cardinal number (1, 2, and so on), two 
numerals means an ordinal number (1st, 2nd, and so on), and three 
numerals means spelled out (First, Second, and so on).

If a special date format includes the year, YYYY specifies all four 
digits of the year (such as 1994) and YY specifies the last two digits 
(such as 94). 

A format can also include literal text (such as Quarter). If the literal 
text includes the character D, M, Y, 2, 3, or 4, enclose the text in 
double quotation marks (").

These are some of the predefined special date formats:

Format With the date 5/1/94

Q4 Q2

YYQ4 94Q2

44 Qtr. YY 2nd Qtr. 94

444 Quarter, YYYY Second Quarter, 1994

Setting a special 
date format for 
periods of a year

Follow the syntax rules 
carefully when creating a 
custom format.

44 Qtr. YY
This is text that will appear 
literally in the formatted data.

Numerals specify the 
period of time. (4s mean 
a quarter.)

Ys show the year for the 
period of time. (Two Ys mean 
a two-digit year.)
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■ To set a special date format for a field, select the field, click the 
Format tab in the InfoBox, select Date in the Format Type drop-
down list, select Other in the Current Format drop-down list, 
and set the options in the Format panel.

A time can appear as hours and minutes (HH:MM); as hours, minutes, 
and seconds (HH:MM:SS); or as hours, minutes, seconds, and 
hundredths of a second (HH:MM:SS.00). Approach is preset to use a 
colon as the separator between hours, minutes, and seconds, but you 
can change the separator to another character.

You can use either a 12-hour system or a 24-hour system for 
numbering hours. If you use 12-hour numbering, Approach displays 
an AM or PM suffix with the time.

To Do this

Change to another predefined 
format for a quarter, trimester, 
or semiannual period

Select a format in the Predefined 
Format Codes list.

Create a custom format Edit the format’s syntax in the 
Format Code text box.

Show the format in a field 
when you click in the field in 
Browse

Turn on “Show data entry 
format.”

Editing the syntax creates a 
new format. It does not 
change the predefined one.

Select a format code.

If you want, edit the syntax 
here.

Select Other.

Turn this on if you want the 
format to appear in the field 
as you enter data.

Setting a time 
format
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■ To set a time format for a field, select the field, click the Format 
tab in the InfoBox, select Time in the Format Type drop-down 
list, and set the options in the Format panel.

You can use a predefined numeric format for data or create a custom 
numeric format of your own. All numeric formats, both predefined 
and custom, use a specific set of characters in their syntax.

Zeroes (0) in a numeric format represent required digits, number 
signs (#) represent optional digits, and a period (.) specifies the 
position of the decimal point. If a comma is surrounded by zeroes or 
number signs, it acts as a thousands separator.

Dollar signs ($), minus signs (-), plus signs (+), colons (:), and 
parentheses are literal characters. Other literal characters must be 
enclosed in double quotation marks (") in the format.

A percent sign (%) converts a number to a percentage. 

To Do this

Change to another predefined 
format

Select a format in the Current 
Format drop-down list.

Change to 12-hour or 24-hour 
numbering for hours

Select an option in the Time drop-
down list.

Change the AM and PM 
suffixes that appear with 
12-hour numbering

Type a suffix in one of the text 
boxes in the Time Suffix area.

Change the separator between 
hours, minutes, and seconds

Edit the text in the Time Separator 
text box.

Show the format in a field 
when you click in the field in 
Browse

Turn on “Show data entry 
format.”

The default order for entering 
the parts of a time is set in the 
Windows International 
Control Panel.

Select 12-hour or 24-hour 
numbering.

Type AM and PM suffixes 
and a separator.

Select a predefined format.

Turn this on if you want the 
format to appear in the field 
as you enter data.

Setting a numeric 
format

Follow the syntax rules 
carefully when creating a 
custom format.
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If a format has two parts divided by a semicolon (;), the part to the 
left of the semicolon is a format for positive numbers, and the part to 
the right is a format for negative numbers.

If a format begins with an integer and an equal sign (=), greater-than 
sign (>), or less-than sign (<), the format applies only to data that has 
the number of digits specified by the integer and sign. A format line 
can have more than one of these conditional formats together, with 
each format separated by a vertical “or” sign (|). For example, 
suppose a field has this format:

=7 000-0000|<7 "x"000

If you enter 1234567, the data appears as 123-4567. If you enter 12345, 
the data appears as x123.

These are some of the predefined numeric formats:

Format With 8000 With -8 With .8

Integer
#,##0;(#,##0)

8,000 (8) 1

General
#,##0.00;(#,##0.00)

8,000.00 (8.00) 0.80

Currency
$#,##0;($#,##0)

$8,000 ($8) $1

Currency Decimal
$#,##0.00;($#,##0.00)

$8,000.00 ($8.00) $0.80

Percent
0%

800000% -800% 80%

Percent Decimal
0.00%

800000.00% -800.00% 80.00%

Scientific
0.00e+00

8.00e+03 -8.00e+0 8.00e-01

$#,##0.00;($#,##0.00)
A semicolon separates a positive numeric 
format from a negative numeric format.

Number signs specify 
optional digits. Zeroes 
specify required digits.

Dollar signs and parentheses 
are literal characters.
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The other predefined formats provide a required number of digits for 
several types of numeric information:

• Telephone: >7 (###)" "000-0000|=7 000-0000

This format is for a U.S. telephone number. If a field has seven 
digits, no area code appears (###) and all the numerals appear in 
the 000-0000 part of the format. If a field has more than seven 
digits, the numerals begin with the area code.

• Social Security: 000-00-0000

This format is for a U.S. social security number.

• Zip Code: >5 00000-0000|=5 00000

This format is for a U.S. zip code. If a field has more than five 
digits, the code includes the -0000 extension.

When you select a format in the Current Format drop-down list in 
the InfoBox, you see the syntax of the format in the Format Code text 
box.

■ To set a numeric format for a field, select the field, click the 
Format tab in the InfoBox, select Numeric in the Format Type 
drop-down list, and set the options in the Format panel.

To Do this

Change to another predefined 
format

Select a format in the Current 
Format drop-down list.

Create a custom format Edit the format’s syntax in the 
Format Code text box.

Show the format in a field 
when you click in the field in 
Browse

Turn on “Show data entry 
format.”

The quotation marks in the 
telephone format mark where 
a space goes.

Editing the syntax creates a 
new format. It does not 
change the predefined one.

Select a predefined format.

If you want, edit the syntax 
here.Turn this on if you want the 

format to appear in the field 
when you enter data.
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A text format can specify all capital letters, all lowercase letters, or 
capital letters for the first letter in each word.

If you turn on “Show data entry format” for a text field, the 
formatted data is stored in the database; otherwise, the data is stored 
without its format.

■ To set a text format for a field, select the field, click the Format 
tab in the InfoBox, select Text in the Format Type drop-down list, 
and set the options in the Format panel.

You can edit fields in these ways:

• Change the basic properties of a field, such as the named style 
and the data entry type

• Change the font, size, color, and other attributes of data in a field

• Change the border and color properties for a field, and show 
borders or a text baseline

• Change the wording, text attributes, or position of a field’s label

• Slide a field or resize a field’s boundaries when you print

To Do this

Change to another predefined 
format

Select a format in the Current 
Format drop-down list.

Show the format in a field 
when you click in the field in 
Browse, and store the 
formatted data in the database

Turn on “Show data entry 
format.”

Setting a text format

Select a predefined format.

Turn this on if you want the 
format to appear in the field 
when you enter data.

Editing fields
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You can also move, resize, cut, copy, paste, and delete fields as you 
can other types of objects. For more information about this, see 
“Editing objects and text” on page 5-18.

The procedures in this section use the InfoBox. If the InfoBox is not 
already open, click the Show Info icon, choose Style & Properties 
from the context-sensitive menu in Design, or double-click the field 
you want to edit. The InfoBox appears; you can keep it on the screen 
as you work.

For information about attaching macros to a field, see “Attaching a 
macro to a field” on page 15-14.

You must be in Design to edit a field.

A field’s basic properties are the field definition, the data entry type, 
the named style, and whether the field is read-only or non-printing.

■ To change the basic properties of a field, select the field, click the 
Basics tab in the InfoBox, and set the options in the Basics panel.

To Do this

Change the definition of a 
database field

Click Field Definition and edit the 
definition in the dialog box.

Change to another data entry 
type, such as a drop-down list 
or a set of radio buttons

Select the data type in the Data 
Entry Type drop-down list. If a 
dialog box appears, specify the 
values.

Change the values used in a 
drop-down list or a set of 
checkboxes or radio buttons

Click Define List or Define 
Buttons and edit the values in the 
dialog box.

Make a field read-only in the 
current view

Turn on Read-only.

Changing the basic 
properties o f a fiel d

Click here if you want to 
edit the field’s definition.

Select a named style with 
predefined properties. 

Turn these on to make the field 
read-only or non-printing.

Select a data entry type or 
redefine the values.

Continued
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You can change the font, size, color, text style, text relief, and 
alignment of data in a field. The fonts available in Approach are the 
TrueType fonts installed on your system.

Text reliefs give a three-dimensional look to your data. You can use a 
raised text relief or an indented one.

■ To change text attributes of data, select the field, click the Text tab 
in the InfoBox, and set the options in the Text panel.

Make a field non-printing in 
the current view

Turn on Non-printing.

Show a non-printing field in 
Preview

Turn on Show in Preview. (This is 
available only if Non-printing is 
on.)

Apply a named style with 
width, color, and text 
properties already defined

Select a style in the Named Style 
drop-down list.

To Do this

Change the font of data Select a font in the Font Name 
drop-down list.

Apply boldface, italics, 
underlining, or strikethrough 
to data

Select one or more styles in the 
Style/Effect list.

To Do this

Changing text 
attributes of data

A text relief makes data 
look raised…

…or indented.

A text relief works best 
against a solid gray or colored 
background.

Select a text color.Select a font for the data.

Select one or more text 
styles.

Select a font size.

Select a text relief.

Select an alignment.

Continued
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All fields have an interior “fill” area and can also have a border on 
each side. You can set a fill color for a field’s interior, a width and 
color for the borders, and a color for a drop shadow.

You can turn on any borders you want, and add a dotted line as a text 
baseline for data.

A field can also have a raised or indented frame for a three-
dimensional look. If you give a field a frame, all four borders are 
automatically turned on.

The label for a field can go inside or outside the field’s borders.

Change the font size of data Type a size in the Size text box or 
select in the Size drop-down list.

Apply a color to data Select a color in the Text Color 
drop-down list.

Apply a raised or indented 
look to data

Select a relief in the Text Relief 
drop-down list.

Change the alignment of data 
to left, center, or right 

Select an option under Alignment.

To Do this

Changing border or 
color settings for a 
field

This field has a border on 
all four sides.

This field has a baseline and 
only a bottom border.

A field can have a 
raised frame…

…or an indented frame.

A label can be inside 
the field borders…

…or outside the borders.
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■ To change border or color settings for a field, select the field, click 
the Lines and Colors tab in the InfoBox, and set the options in the 
Lines and Colors panel.

To Do this

Change the width of the 
borders of a field

Select a width in the Border Width 
drop-down list.

Change the color of the 
borders of a field

Select a color in the Border Color 
drop-down palette. Select T for 
transparent.

Change the fill color of the 
interior of a field

Select a color in the Fill Color 
drop-down palette. Select T for 
transparent.

Give a field a drop shadow Select a color in the Shadow Color 
drop-down palette. Select T for 
transparent (no shadow).

Give a field a dashed, raised, or 
indented frame

Select a frame style in the Frame 
drop-down list.

Show borders or a baseline for 
a field

Turn on options in the Borders 
area.

Include the field label inside 
borders

Turn on “Borders enclose label.”

A raised or indented frame 
works best against a solid 
gray or colored background.

Select a width and color for 
the borders.

Select a fill color for the 
interior.

Select a color for a drop shadow.

Select a frame style.

Turn on the borders you 
want to show.

Turn this on if you want the 
label inside the borders.
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A field label is the descriptive title for a field that you see in Browse. A 
label is initially set to have the same wording as the field name, but 
you can edit the label to use any text you want.

A label can be above or below the field’s data, or to the left or right of 
it. You can also remove a label altogether.

You can also change the font, size, color, text style, text relief, and 
alignment of a label. The attributes available are the same as they are 
for data in a field.

■ To change the wording, attributes, or position of a label, select 
the field, click the Label tab in the InfoBox, and set the options in 
the Label panel.

To Do this

Change the font of a label Select a font in the Label Font 
drop-down list.

Apply boldface, italics, 
underlining, or strikethrough 
to a label

Select one or more styles in the 
Style/Effect list.

Change the font size of a label Type a size in the Size text box or 
select in the Size drop-down list.

Change the alignment of a 
label to left, center, or right

Select an option in the Alignment 
area.

Change the wording of a label Edit the text in the Label Text box.

Changing the 
wording, attributes, 
or position of a label

A label doesn’t have to 
be above the data.

Alignment applies only to 
labels that are above or below 
the data.

If you have a named style 
with the properties you need, 
apply the style rather than 
setting properties manually.

Select a text color.

Select a font for the label.

Select one or more text 
styles.

Select a font size. Select a text relief.

Select an alignment.

Edit the text in the label.

Select a position for the 
label.

Continued
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Because data in fields can vary in length, you may end up with too 
much blank space in a view. You can slide fields and reduce their 
boundaries to eliminate some of the extra space.

If you have two fields next to each other and don’t want a gap 
between the data in them, you can mark the fields to slide left. This 
moves one field to the left to fill the blank space in the other field. For 
sliding left to work, you must mark both fields to slide left, and the 
two fields must be aligned along the bottom.

Reducing a field’s boundaries makes the field smaller so that is just 
large enough for the data in it. (When you slide fields left, Approach 
automatically reduces the boundaries of the field on the left.)

You can also slide a field up to fill blank space left by a field above it. 
The field on the top might be a memo field with a variable amount of 
data in it. You must mark both fields to slide up.

If a field has more data than it can display, you can also expand the 
field’s boundaries just enough to show the data. If any other fields 
are under the expanded boundary, they slide down to make room.

Approach slides fields or resizes their boundaries when you preview 
or print, and in Design if you are showing data.

Change the position of a label 
relative to the data

Select a position in the Label 
Position drop-down list.

Hide a label Select No Label in the Label 
Position drop-down list.

Apply a color to a label Select a color in the Label Color 
drop-down list.

Apply a raised or indented 
look to a label

Select a relief in the Text Relief 
drop-down list.

To Do this

Sliding or res izing a 
field when you print

When sliding a field left, you 
may want to turn off the two 
fields’ borders or show only 
the bottom border.

If fields do not slide left, 
you may have a gap 
between data in them.

Sliding left moves the 
second field left to fill the 
blank space.

You may also want to 
reduce the boundaries in 
the second field.

Sliding is used most often in 
mailing labels or with memo 
fields.



Adding and Edi ting Fields in a View 6-29

■ To slide or resize a field when you print, select the field, click the 
Dimensions tab in the InfoBox, and set the options in the 
Dimensions panel.

For information about other settings in the Dimensions panel, see 
“Resizing an object” on page 5-21 and “Moving an object” on 
page 5-22.

You can add a PicturePlus field to a form, report, form letter, or 
mailing label to hold a picture, an OLE object, or an image you draw 
with the mouse in Browse. The graphic appears only in the 
PicturePlus field in that record. It is part of the record’s data, not part 
of the design of a view.

To Do this

Slide a field to the left or up 
over a field with reduced 
boundaries when you print

Turn on Left or Up in the When 
Printing, Slide area.

Reduce or expand a field’s 
boundaries to the size of the 
data when you print

Turn on Reduce or Expand in the 
When Printing, Boundaries area.

If sliding left doesn’t seem to 
work, make sure the two fields 
are aligned along the bottom.

Turn these on to slide the 
field left or up.

Turn these on to resize 
the field’s boundaries.

Working with 
PicturePlus fields

A PicturePlus field 
holds a graphic 
that is part of a 
record’s data.



6-30 User’s Guide

You can change the width, color, and frame properties of a 
PicturePlus field, and move, resize, cut, copy, paste, and delete the 
field as you can other types of objects. For more information about 
this, see “Editing objects and text” on page 5-18.

You must be in Design to add and edit a PicturePlus field.

Some of the procedures in this section use the InfoBox. If the InfoBox 
is not already open, click the Show Info icon, choose Style & 
Properties from the context-sensitive menu in Design, or double-click 
the field you want to edit. The InfoBox appears; you can keep it on 
the screen as you work.

You can add a PicturePlus field to a view using either the Add Field 
dialog box or the PicturePlus tool.

A PicturePlus field specifies a fixed area for the graphic in it; 
Approach can shrink, crop, or stretch the graphic to fit in the area. If 
you add a PicturePlus field using the Add Field dialog box, the field 
is a predefined size and shape. If you add the field using the 
PicturePlus tool, you drag to define the area for the field. You can 
resize a PicturePlus field as you can other types of objects.

This section describes how to use the PicturePlus tool. For 
information about the Add Field dialog box, see “Adding a field to a 
form, report, or mailing label” on page 6-1.

To add a PicturePlus field to a view:

1. In Design, click the PicturePlus icon or choose PicturePlus from 
the Create Drawing submenu.

The PicturePlus icon is in the Tools palette.

2. Drag diagonally to draw the PicturePlus field.

The InfoBox shows the settings for the new field. So far, the field 
is based on the first PicturePlus field listed in the InfoBox.

Adding a 
PicturePlus field 
to a view

Select a PicturePlus field 
in the database.

Click here if you need to 
define a new field.
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If you need to define a new field, click Field Definition and use 
the dialog box that appears.

3. Select the PicturePlus field you want in the Field list.

If the field you want is in a different joined database, select the 
database in the drop-down list above the Field list.

The basic properties of a PicturePlus field are the named style and 
whether the field is read-only or non-printing.

■ To change the basic properties of a PicturePlus field, select the 
field, click the Basics tab in the InfoBox, and set the options in the 
Basics panel.

To Do this

Make a field read-only in the 
current view

Turn on Read-only.

Allow drawing with the mouse 
in a field in Browse

Turn on “Allow drawing.” (This is 
available only if Read-only is off.)

Make a field non-printing in 
the current view

Turn on Non-printing.

Show a non-printing field in 
Preview

Turn on Show in Preview. (This is 
available only if Non-printing is 
on.)

Apply a named style with 
width, color, and PicturePlus 
properties already defined

Select a style in the Named Style 
drop-down list.

Changing the basic 
properties of a 
PicturePlus field

If you draw in a PicturePlus 
field, the drawn image 
appears on top of any graphic 
in the field.

Turn these on to make the field 
read-only or non-printing.

Select a named style with 
predefined properties. 
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A PicturePlus field is a fixed size. When you insert a graphic that is 
too large for the field, Approach can either crop the graphic or shrink 
it. When you insert a graphic that is too small, Approach can either 
leave the graphic as it is or stretch it to fill the field.

■ To change display options for a PicturePlus field, select the field, 
click the Options tab in the InfoBox, and set the options in the 
Options panel.

When you enter data in Browse, you can press TAB to move through 
the fields of a record. (You can also press ENTER to tab through fields 
if your Preferences are set this way.) The order in which you move 
through fields is the data entry order. 

Radio buttons and checkboxes each have a separate position in the 
data entry order. If your view has any macro buttons, they are also 
included in the order.

Approach initially sets the data entry order to be the order in which 
fields (and macro buttons) were added to a view, but you can change 
the order whenever you want. You can change the order of a few 
items or reorder all the items.

To Do this

Change the position of a 
picture in a field

Drag the image in the PicturePlus 
Data Position area.

Crop or shrink a picture that is 
too large for a field

Select “Crop it” or “Shrink it.”

Stretch a picture that is too 
small for a field

Turn on “Stretch if too small.”

Changing display 
options for a 
PicturePlus field

Drag the image to where 
you want a picture 
positioned in the field.

Select whether to crop or 
shrink a picture that is too 
large.

Turn this on to stretch a 
picture that is too small.

Changing the data 
entry order for 
fields
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To change the data entry order of a few items:

1. In Design, choose Show Data Entry Order from the View menu.

Numbered squares show the data entry position of each field, 
radio button, checkbox, and macro button.

2. Edit numbers in the squares to change the order.

When you edit the number in one square, Approach renumbers 
the rest of the squares as soon as you click in another square.

To change the data entry order of all items:

1. In Design, choose Show Data Entry Order from the View menu.

2. Move the I-beam cursor over the border of a numbered square 
and double-click.

The numbers are deleted from all of the squares.

3. Click in the squares in the order you want to tab through fields.

Numbers appear in the squares as you click in them.

Edit a number, or double-
click the border of a square 
to delete the numbers and 
start over.
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7 Designing Forms and Repeating Panels

A form is a view that shows one record at a time. Forms are often 
used for entering and editing data. If an Approach file uses data from 
joined databases, you can put a repeating panel on a form to show data 
from detail records that are related to the form’s main record.

This chapter describes how to create forms with and without 
repeating panels, how to add repeating panels to existing forms, and 
how to modify repeating panels. At the end of the chapter you’ll find 
examples of forms and steps for creating them.

Most of the instructions in this chapter require you to be in Design. 
To go to Design, click the Design icon or choose Design from the 
View menu or from the environment pop-up menu in the status bar.

You can modify the design of forms as you can other types of views. 
For example, you can rearrange fields, assign macros, and change 
color properties in a form. For information about editing views, see 
Chapter 5, “Working in Design,” and Chapter 6, “Adding and 
Editing Fields in a View.”

You can use forms to enter and edit records and to browse through a 
database one record at a time. For example, you might use a form to 
maintain information about your customers. The form would show 
data for one customer record at a time.

About forms

In a customer form, 
you see one customer 
record at a time.

Customer Form

Austens Ltd.
Record 4

Record 3
Record 2

Record 1
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When you print a form, each printed page shows one record.

If you’re using only one database in the current Approach file, a form 
displays each record from that database. This is the simplest case of a 
form.

If you have joined databases in the Approach file, you can use data 
from any of those databases in a form. One of the databases must be 
the main database for the form. A form displays each record from its 
main database and is said to be “based on” this database. Other 
joined databases that provide related information for a form are the 
form’s detail databases.

For example, consider an employee form that shows a record for 
each employee. The main database is an employee database, and the 
form also has related department and manager information from 
detail databases.

To see steps for creating a similar employee form, turn to “Example 1: 
Designing a form that looks up joined data” on page 7-17.

The data in this form 
comes from one 
customer database.

This form is based on an 
employee database. It 
shows records from that 
database.

The department and 
manager data come 
from related records in 
detail databases.



Designing For ms and Repeati ng Panels 7-3

If you want to show data from a one-to-many join in a form, you can 
use a repeating panel. In a one-to-many join, one record in a database 
is related to two or more records in a joined database. The repeating 
panel shows the “many” records that are related to the form’s main 
record.

For example, one department can have many employees. To list the 
employees for each department, you set up a form based on a 
department database and then give the form a repeating panel for the 
employees. The panel lists all the employees in the department 
(employees with the same department ID as the department).

Like a form, a repeating panel must have a main database that 
provides the framework of records; this database is one of the detail 
databases for the form. Each line in the panel displays a record from 
its main database. (A repeating panel can also have fields from other 
databases for additional, detail information.) The records in the panel 
all have the same value in the join field as the form’s main record.

In a department form, the repeating panel is based on an employee 
database. The join field is a department ID in both databases.

If you change from a form with a repeating panel to a report that has 
the same main database as the panel, the report shows only the set of 
records that were in the repeating panel. For example, if you change 
to an employee report from the department form above, the report 
will show only employees in the Cost Accounting department. You 
can click the Show All icon to see all the records in a report.

About repeating 
panels

This form is based on a 
department database.

The repeating panel is 
based on an employee 
database. Each line is a 
record in that database.

The employees 
listed in the panel 
have 332 in their 
department ID 
field.
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If you use a repeating panel to display records from a database that is 
joined on a calculated field, be aware that the value in the join field 
can change because of a recalculation. If the value in a record’s 
calculated field no longer matches the form’s join value, the record 
will disappear from the repeating panel. (This does not affect the 
record itself, only whether it appears in the panel.)

To see steps for creating a similar department form, turn to “Example 
2: Designing a form with a repeating panel” on page 7-19.

The Approach Form Assistant guides you as you create new forms. 
You use the Assistant to apply styles and layouts to a new form and 
to specify which fields go on the form. If the form has a repeating 
panel, you also use the Form Assistant to add fields for the panel.

A predefined SmartMaster style gives a form a set of InfoBox 
properties, such as background color, text attributes, and 
specifications for field borders. You can apply a SmartMaster style to 
a new form, or you can use your own default style.

The two basic SmartMaster layouts are Standard and Columnar. In the 
Standard layout, fields are added to the form horizontally from left to 
right; in the Columnar layout, fields are added vertically from top to 
bottom. In both layouts, the fields are added in the order you list 
them in the Fields panel of the Assistant.

If your Approach file uses joined databases, you can include a 
repeating panel with the Standard layout. The panel appears at the 
bottom of the form, under the fields for the main record. Approach 
gives the panel as many lines as will fit comfortably on the form. You 
can change the number of lines in the repeating panel’s InfoBox.

Creating a form

You can drag fields and 
repeating panels to rearrange 
them after creating a form.

In a new form, fields are 
laid out in the order they 
are listed in the Form 
Assistant.

Form

1 2 3

4 5 6

7 8

Form

1
2
3
4

5

6
7

8

Standard layout arranges 
the fields horizontally.

Columnar layout arranges the 
fields vertically.
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A new repeating panel does not have any field labels, but you can 
add labels after creating the form. For information about this, see 
“Adding labels to a repeating panel” on page 7-9.

You can also create a blank form, with no fields or repeating panel.

To create a form:

1. Choose Form from the Create menu.

The Form Assistant appears.

To go to the other panels in the Form Assistant, you can either 
click tabs or click the Back and Next buttons.

2. Type a name for the form in the View Name & Title text box.

A new form automatically has the name Form and a number; you 
can use any name you want, up to 30 characters. The name 
appears at the top of the form and on the form’s view tab.

3. Select the default style or a SmartMaster style in the SmartMaster 
Style drop-down list.

The styles set properties such as background color for the form 
and text attributes for data and field labels. 

The default style is specified in the Display panel of the 
Preferences dialog box. The SmartMaster styles are provided by 
Approach.

4. Select a field layout in the SmartMaster Layout list.

A new form can have a Standard or Columnar layout, or it can be 
blank. If the Approach file uses joined databases, a form can also 
be Standard with Repeating Panel.

If you want to show more 
records than will fit nicely in 
a form with a repeating panel, 
consider creating a repeating 
panel report instead.

Type a name for the form.

Select a named style.

Select a field layout.

When you select a style or a 
layout, the sample form on 
the right side of the Assistant 
shows an approximation of it.

If a predefined layout isn’t 
quite what you need, you can 
easily fine-tune the layout 
after creating the form.
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5. Click the Fields tab and add the fields you want to show in the 
form.

When you click the tab, the Fields panel appears.

To add a field to the Fields to Place on View list, select the field 
name in the Database Fields list and click Add, or double-click 
the name. If you want to add a field from a different joined 
database, select the database in the drop-down list. Approach 
displays the fields in the form in the order they appear in the 
Form Assistant.

To remove a field from the Fields to Place on View list, select the 
field name in the list and click Remove, or double-click the name.

6. If you’re creating a form with a repeating panel, click the Panel 
tab and add the fields you want for the panel.

The Panel tab appears in the Form Assistant if you selected the 
layout with a repeating panel.

Add the fields for the 
main part of the form.

Add the fields for the 
repeating panel.
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To add a field to the Fields to Place in Panel list, select the field 
name in the Database Fields list and click Add, or double-click 
the name. If you want to add a field from a different joined 
database, select the database in the drop-down list. Approach 
will display the fields in the panel in the order they appear in the 
Assistant.

The first database you add a field from will be the default main 
database for the panel. The panel must be based on one of the 
detail databases for the form.

To remove a field from the Fields to Place in Panel list, select the 
field name in the list and click Remove, or double-click the name.

7. Click Done.

The Define Main Database dialog box appears if you select fields 
from more than one joined database in the Fields panel. 
Otherwise, Approach displays the new form.

8. If the Define Main Database dialog box appears, select a database 
in the Main Database drop-down list and click OK.

In addition to creating a repeating panel with the Form Assistant, 
you can add a panel to a form after creating the form. When you add 
a panel to an existing form, you can specify the number of lines in the 
panel, an alternating background color for lines, and a sort order for 
records in the panel.

A new repeating panel does not have any field labels, but you can 
add labels after creating the form. For information about this, see 
“Adding labels to a repeating panel” on page 7-9.

You can change the main 
database of a form or 
repeating panel in the Basics 
panel of the InfoBox.

Select a main database 
for the form.

Adding a repeating 
panel to an 
existing form
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To add a repeating panel to an existing form:

1. In Design, click where you want the repeating panel on the form.

The upper-left corner of the panel will be where you click.

2. Choose Repeating Panel from the Create menu.

The Approach file must have joined database files for this 
command to be available.

The Add Repeating Panel dialog box appears.

3. Add the fields you want in the repeating panel to the Fields to 
Place in Panel list.

To add a field to the Fields to Place in Panel list, select the field 
name in the Database Fields list and click Add, or double-click 
the name. If you want to add a field from a different joined 
database, select the database in the drop-down list. Approach 
displays the fields in the panel in the order they appear in the 
Form Assistant.

The first database you add a field from will be the default main 
database for the panel. The panel must be based on one of the 
detail databases for the form.

To remove a field from the Fields to Place in Panel list, select the 
field name in the list and click Remove, or double-click the name.

4. To use a background color in every other line of the panel, turn 
on “Alternate color with” and select a color in the drop-down 
palette.

Type the number of lines 
for the panel.

If you want, set a color for 
every other line.

If you want, set a sort 
order for the fields.

Add the fields for the 
repeating panel.

You can change the main 
database of a form or 
repeating panel in the Basics 
panel of the InfoBox.

An alternating color can 
make it easier to distinguish 
lines in a repeating panel.



Designing For ms and Repeati ng Panels 7-9

The lines without the color are transparent and appear in the 
background color of the form.

5. To set a sort order for the records in the panel, turn on “Sort the 
values in the panel,” click Define Sort, specify the order in the 
dialog box that appears, and click OK.

For example, you may want to sort the records to list employees 
in alphabetical order by last name.

When you click Define Sort, the Sort dialog box appears. For 
information about this dialog box, see “Sorting records by data in 
fields” on page 11-14. When you click OK, you return to Add 
Repeating Panel.

6. Type the number of lines for the panel in the Number of Lines 
text box.

Use the number of matching records you want displayed at one 
time. You can show up to 30 lines in a repeating panel.

7. Click OK.

The new repeating panel appears where you clicked in the form.

When you create a repeating panel with the Form Assistant or the 
Add Repeating Panel dialog box, the new panel does not have field 
labels. You may want to add labels to make it easier to enter and 
identify data in the panel in Browse.

The fields in a repeating panel are initially laid out in a row. You can 
add the labels you want above the fields.

To add labels to a repeating panel:

1. In Design, use the Text tool to type the labels above the fields and 
outside the borders of the panel.

Click the Text icon in the default Design icon bar or choose Text 
from the Create Drawing submenu to select the tool.

If you’re adding more than one label, double-click the icon. The 
icon will stay selected until you select a different one.

You don’t need to show as 
many lines as you have 
records. Approach adds a 
scroll bar if necessary.

Adding labels to a 
repeating panel

Put the labels above the 
fields.

If you plan to move the panel, 
group the labels together after 
arranging them.
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2. Select the labels and align them along the bottoms.

For information about working with multiple objects, see 
“Working with more than one object at a time” on page 5-32.

You can modify a repeating panel in these ways:

• Change the basic characteristics of a panel, such as the main 
database, the named style, and the number of lines

• Change the line and color settings for a panel, including adding a 
background color to every other line

• Resize a panel

• Add more fields to a panel

• Rearrange fields in a panel

• Summarize data for records in a panel

You can also move, cut, copy, paste, and delete panels and their fields 
as you can other types of design objects. For more information, see 
“Editing objects and text” on page 5-18.

Some of the procedures in this section use the InfoBox. If the InfoBox 
is not already open, click the InfoBox icon, choose Style & Properties 
from the context-sensitive menu, or double-click an object. The 
InfoBox appears, and you can keep it on the screen as you work.

You must be in Design to modify a repeating panel.

You can also modify forms as you can other types of views. For 
example, you can change the main database, apply a color to the 
background, and resize the page margins. For information about this, 
see “Editing views” on page 5-35.

Before you can modify a repeating panel, you sometimes need to 
select the panel in Design. Be careful to select the panel itself and not 
one of the fields inside it.

A repeating panel has a dark border around it when it is selected.

Modifying a 
repeating panel

Selecting a 
repeating panel

A selected panel has a 
black border.
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■ To select a repeating panel, click in any part of the panel except 
for the top line. 

If you click in the top line of the panel, you select a field rather 
than the entire panel.

The basic properties of a repeating panel are its main database, a sort 
order for records, the named style, and the number of lines that 
display. These properties are stored in the panel’s InfoBox.

A main database provides a framework of records for a repeating 
panel. Each line in the panel is a record from the main database.

You can sort records in a repeating panel just as you can sort records 
in a view. For information about the Sort dialog box, see “Sorting 
records by data in fields” on page 11-14.

■ To change the basic properties of a repeating panel, select the 
panel, click the Basics tab in the InfoBox, and set the options in 
the Basics panel.

To Do this

Change to a different main 
database

Select a database in the Main 
Database drop-down list.

Apply a sort order to records in 
a panel

Turn on “Sort panel values,” click 
Define Sort, and specify the sort 
order in the dialog box.

Apply a named style with line 
and color properties already 
defined

Select a style in the Named Style 
drop-down list.

Change the number of visible 
lines in a panel

Type the number in the Number of 
Lines text box.

Changing the basic 
properties of a 
repeating panel

You don’t need to show as 
many lines as you have 
records. Approach adds a 
scroll bar if necessary.

Select a main database for 
the panel.

Type the number of lines 
for the panel.

Select a named style with 
predefined properties.

Set a sort order for records 
in the panel.
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Like most other design objects, a repeating panel has borders and an 
interior fill area. You can set a line width and color for the borders 
between lines and around the outside of the panel, and a fill color 
for the background of the interior. You can also apply a three-
dimensional frame to each line and a drop shadow to the entire 
panel. The sets of colors include several patterns for each color. 

You can apply the fill color to every other line in a repeating panel to 
make it easier to distinguish individual lines in Browse, especially if 
the panel has many lines. The lines that do not use the fill color are 
transparent and appear in the background color of the form.

■ To change line or color settings for a repeating panel, select the 
panel, click the Lines and Colors tab in the InfoBox, and set the 
options in the Lines and Colors panel.

To Do this

Change the width of borders in 
a panel

Select a width in the Border Width 
drop-down list.

Change the color or pattern of 
borders in a panel

Select a color or pattern in the 
Border Color drop-down palette. 
Select T for transparent.

Change the fill color or pattern 
of the interior of a panel

Select a color or pattern in the Fill 
Color drop-down palette. Select T 
for transparent.

Changing line or 
color settings for a 
repeating panel

You can alternate a fill color 
in a repeating panel. The fill 
color for this panel is white.

The border width and color 
apply to outside borders and 
borders between lines.

Select a width and color 
for the borders.

Select a fill color for the 
interior of the panel.

Select a color for a 
drop shadow.

Select a three-dimensional 
frame for the lines.

Turn on the outside borders 
you want.

Turn this on to apply the fill 
color to every other line.

Continued
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You can resize a repeating panel horizontally or vertically. 

Resizing a repeating panel horizontally changes the width of only the 
panel and not the fields in it. If you’re making a panel more narrow, 
be sure that the fields are still inside the borders of the panel.

Resizing a panel vertically changes the height of lines in the panel. It 
does not change the number of lines and does not affect the size of 
the fields or the data in them. If you want to change the number of 
lines, use the Basics panel in the InfoBox.

When resizing a repeating panel, you select and drag only the top 
line of the panel. (The line has a border around it when selected.) 
Dragging the entire panel moves the panel rather than resizing it.

To resize a repeating panel:

1. Select the panel by clicking in any part of it except for the top 
line. 

If you click in the top line of the panel, you select a field rather 
than the entire panel.

2. Drag the gray border of the top line in the panel.

Give a panel a drop shadow Select a color or pattern in the 
Shadow Color drop-down palette. 
Select T for transparent.

Give the lines in a panel a 
raised or indented frame

Select a frame style in the Frame 
drop-down list.

Show outside borders around a 
panel

Turn on options in the Borders 
area.

Show the current fill color or 
pattern in every other line of a 
panel

Turn on “Alternate fill color.”

To Do this

When you alternate a fill 
color, the lines without the 
color are transparent.

Resizing a 
repeating panel

You may need to resize a 
panel horizontally when 
adding or deleting a field in 
it. Resize a panel vertically to 
change the height of lines.

The top line of a 
repeating panel has a 
gray border when the 
panel is selected.
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When you point on a gray border, the pointer turns into a resize 
cursor to show that it is properly positioned for resizing.

If you drag the black border of the main part of the panel rather 
than the gray line border, you move the panel rather than 
resizing it.

You can add more fields to a repeating panel. A new field must be 
entirely inside the borders of the panel and in the top line along with 
the other fields.

To accommodate additional fields in a repeating panel, you may 
need to make the panel larger or make existing fields in the panel 
smaller. 

A new field takes the field style properties associated with the 
repeating panel. For example, a field is usually transparent, with its 
label and borders hidden.

You can add a field by dragging it from the Add Field dialog box or 
by drawing with the Field tool. This section describes how to use the 
dialog box. For information about the Field tool, see “Adding a field 
to a form, report, or mailing label” on page 6-1.

To add a field to a repeating panel:

1. Choose Add Field from the Panel or Form menu.

If the Add Field icon appears in an icon bar, you can click it 
instead of choosing the command. You add icons to the icon bars 
using the SmartIcons command in the Tools menu.

The Add Field dialog box appears, showing the fields defined for 
databases used in the Approach file.

2. Drag the database field you want from the Add Field dialog box 
to the repeating panel.

3. Move and resize the new field or the repeating panel so that the 
field fits inside the borders of the repeating panel and in the top 
line of the panel.

Resize cursor

Adding a field to a 
repeating panel

Put a new field inside the 
panel’s borders and in 
the top line of the panel.

If a field does not repeat in a 
panel in Browse, go back to 
Design and move the panel. If 
the field does not move with 
it, the field is not inside the 
panel and in the top line.

You may find it easier to work 
with field names showing in 
Design when adding fields to 
a panel.
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A repeating panel is initially laid out with the fields for each record 
all in a row. You can rearrange the fields to stack or stagger them any 
way you want inside their line in the panel. This sometimes makes 
each line look like a small form.

When you rearrange the fields in a repeating panel, you’ll probably 
want to show field labels inside the panel rather than above it. 
Usually, the labels go on the left side of the field.

The field labels appear in Browse in rows that contain data. In blank 
rows, the labels appear when you click in the row.

Be sure you’re showing borders between lines to separate the lines of 
the panel visually. Use the Lines and Colors panel in the repeating 
panel’s InfoBox to turn on a border color.

To rearrange fields in a repeating panel:

1. Resize the panel to make the lines tall enough and wide enough 
to accommodate the fields.

For details, see “Resizing a repeating panel” on page 7-13.

2. If you want field labels to appear inside the lines of the panel, 
show the label for each field.

Use the Label Position drop-down list in the Label panel of the 
field’s InfoBox.

3. Drag the fields to the layout you want.

You can add a calculated field to a form to show a total, average, 
count, or other summary on data in a repeating panel. For example, if 
you have a panel that lists all the invoices for a customer, you might 
use a calculated field to show the total sales for the customer’s 
invoices. Or if a panel lists all the employees in a department, a 
calculated field can show the total number of employees in the 
department.

Rearranging fields 
in a repeating panel

You can rearrange the 
fields inside a line of a 
repeating panel. Show each label with 

its field rather than at 
the top of the panel.

Summarizing data 
for records in a 
repeating panel



7-16 User’s Guide

A summary on data in a repeating panel is calculated in Browse and 
Preview, and in Design if you’re showing data rather than field 
names.

To see an example of a form that summarizes data in a panel, turn to 
“Example 2: Designing a form with a repeating panel” on page 7-19.

To summarize data for records in a repeating panel:

1. Define a calculated field with a summary functions for the 
repeating panel.

In the Define Formula panel of the Field Definition dialog box, 
enter a summary function and use a field from the repeating 
panel as the parameter; for example, SSum(Invoice_Number).

In the Define Summary panel, select “Summary of all records in 
database,” where database is the name of the main database for the 
panel; for example, “Summary of all records in INVOICE.”

For more information about formulas, see “Setting up a formula 
for a calculated field” on page 3-8.

2. Add the calculated field to the form with the repeating panel.

Place the field outside the panel, on the form.

This section gives examples of forms you can create in an Approach 
file with two joined databases. The databases store information about 
departments and employees in a company, and they are joined on a 
department ID field. Departments and employees with the same 
value in the department ID field are related.

Creating sample 
forms

The department and 
employee databases 
are joined on a 
department ID field.

DEPARTMT

Dept ID
Dept Name
Dept Location

EMPLOYEE

Empl ID
First Name
Last Name

Position
Level

Dept ID

Mgr ID
Hire Date

Notes

Reviews
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Because one department can have more than one employee, the 
relationship from a department record to employee records is one-to-
many. The relationship from employee records to a department 
record is many-to-one.

The first sample form shows information about each employee. 
When you type the employee’s department ID in the form, the name 
and location of the appropriate department appear automatically. 
This automatic display of information is sometimes called a lookup. 
Many-to-one relationships are often set up as lookups in a form, to 
provide a convenient means of retrieving data from the “one” record.

The second sample form shows information about each department. 
A repeating panel on the form lists all the employees in the current 
department. Using a repeating panel is the best way to display the 
“many” records from a one-to-many relationship.

For more information about a department and employee join, see 
“About joined databases” on page 4-1.

A form can show data from any databases joined in the Approach 
file. One database must be the main database for the form, and the 
others are detail databases. A form shows data from one record at a 
time in its main database. 

The employee form in this example is based on an employee 
database, but has detail information from a department database.

This form provides a lookup to data in the department database. 
When you type in the department ID field, the rest of the information 
about the department with that ID appears automatically.

Although the ID field is stored in both databases, for the lookup to 
work properly the form must use the ID field in its main database 
(employee). The fields with the lookup data come from the detail 
database (department).

If you want to design the 
forms in this section, set up 
department and employee 
databases with the fields 
shown above.

Example 1: 
Designing a form 
that looks up joined 
data

This data is from the 
employee database (the 
main database).

This data is from the 
department database.

The join field is stored in 
both databases. The one 
from the main database 
is used on the form.
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To design a form that looks up joined data:

1. Create or open an Approach file that has a department database 
joined to an employee database on a department ID field.

2. Choose Form from the Create menu and create an employee 
form with related department data.

In the Layout panel of the Form Assistant, type the name 
Employee Form and select the Standard form layout.

In the Fields panel, add the fields First Name, Last Name, 
Position, and Dept ID from the employee database. Then add the 
fields Dept Name and Dept Location from the department 
database.

When you click Done in the Form Assistant, the Define Main 
Database dialog box appears because you selected fields from 
more than one database in the Fields panel.

3. In the Define Main Database dialog box, leave the employee 
database selected as the main database.

The new form appears when you click OK. If you’re showing 
data in Design, you see data from the form’s first record.

4. Go to Design, and arrange and format the fields and other objects 
the way you want them.

To move an object, select the object and drag it by its border. To 
resize an object, select the object and drag one of its handles.

To change the label, text attributes, three-dimensional frame, or 
other properties of an object, use the object’s InfoBox. 

5. Return to Browse, and enter an employee’s name, position, and 
department ID in a new record to see the lookup.

The employee database is 
preset to be the main database 
because you selected fields 
from it first.

The name you 
typed appears at 
the top of the form 
and in the view tab.The fields are arranged in 

rows, in the order you added 
them in the Form Assistant.

Look at the figure on 
page 7-17 for a suggestion on 
how to style the form.
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When you tab or click outside the department ID field, Approach 
“looks through” the detail (department) database for a record 
with that ID and displays data from the record.

Approach can display records from the “many” side of a one-to-
many join in a repeating panel. This example uses a department form 
based on a department database and a repeating panel based on an 
employee database.

The panel lists all the employees in the current department (that is, 
all employees with the same value in the department ID field as the 
department). Each line in the repeating panel is a record from the 
employee database.

Although the ID field is stored in both databases, for the repeating 
panel to work properly the form must use the ID field that is stored 
in the department database.

The form also has a calculated field that counts the number of 
employees in the department.

When you type the 
department ID…

…Approach fills in the rest 
of the department data.

Example 2: 
Designing a form 
with a repeating 
panel

This data is from the 
department database.

This data is from the 
employee database. 
Each line is a record in 
that database.

The ID field for 
joining is in both 
databases.

A calculated field counts the records in the panel.
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To design a form with a repeating panel:

1. Create or open an Approach file that has a department database 
joined to an employee database on a department ID field.

2. Choose Form from the Create menu and create a department 
form with a repeating panel for employees.

In the Layout panel of the Form Assistant, type the name 
Department Form and select the layout Standard with Repeating 
Panel.

In the Fields panel, add the fields Dept Name, Dept ID, Dept 
Location, and Notes from the department database.

In the Panel panel, add the fields First Name, Last Name, and 
Position from the employee database.

When you click Done in the Form Assistant, the new form 
appears.

3. Go to Design, and type the labels Employees in This Department 
and Position above the repeating panel.

Click the Text icon in the Tools palette, click where you want the 
text, and type.

4. Change the number of lines showing in the repeating panel to 4.

This setting is in the Basics panel of the repeating panel’s 
InfoBox. Double-click the border of the repeating panel to open 
the InfoBox, or just click the border if the box is already open.

5. Arrange and format the fields and other objects the way you 
want them.

To move an object, select the object and drag it by its border. To 
resize an object, select the object and drag one of its handles.

The name you typed 
appears at the top of the 
form and in the view tab.

The fields are arranged 
in rows, in the order you 
added them in the Form 
Assistant.

The repeating panel 
appears at the bottom of 
the form.

Look at the figure on 
page 7-20 for a suggestion on 
how to style the form.
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To change the label, text attributes, three-dimensional frames, or 
other properties of an object, use the object’s InfoBox. 

6. Choose Field Definition from the Create menu, and define a 
calculated field with a summary function that counts the number 
of employees in the department.

In the Define Formula panel of the Field Definition dialog box, 
enter the formula SCount(EMPLOYEE."Last Name").

In the Define Summary panel, select “Summary of all records in 
EMPLOYEE” in the Summarize On drop-down list. This tells 
Approach to count all the records from the employee database. 
(Because of the join on the department ID, the function counts 
only the records that appear in the panel.)

For instructions on how to define a formula, see “Setting up a 
formula for a calculated field” on page 3-8.

When you click OK, the Add Field dialog box.

7. Add the calculated field to the form, right under the repeating 
panel.

Drag the field from the Add Field dialog box to the form.

8. Type the label Number of Employees in Department and place it to 
the left of the field.

The label settings are in the Label panel of the field’s InfoBox. 

9. Return to Browse to use the form.
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8 Designing Reports

A report is a view that shows data from multiple records on a single 
page. Reports can display field data, summary information, or a 
combination of the two. When you display field data, it’s located in 
the body of a report, where you can view or edit it in Browse. 
Summary information is located in a summary panel, which you create 
in Design and view in Preview or in Design if data is showing.

This chapter describes how to create reports, how to use a summary 
panel to summarize data, and how to change the format of a report. 
At the end of the chapter you’ll find information about an exciting 
new Approach feature: PowerClick reporting. PowerClick reporting 
gives you a fast and easy way to sort, group, and calculate data. It 
also allows you to see how your report will look as you design it.

Most of the instructions in this chapter require you to be in Design. 
To go to Design, click the Design icon, or choose Design from the 
View menu or from the environment pop-up menu in the status bar.

You can modify reports as you can other types of views. For example, 
you can rearrange fields, assign macros, and change color properties 
in a report. For information about modifying views and fields in 
views, see Chapter 5, “Working in Design.”

You can use Approach reports for a variety of different purposes: to 
enter and edit data, to view or print multiple records on the same 
page, and to organize and summarize data. 

Reports can show data from database fields, summary information 
that is calculated from selected field data, or both. Database fields 
appear in the body of the report. You can view and edit them in 
Browse. Summary information appears in special summary panels.

About reports
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You can view summary information only in Preview (or in Design 
when you have Show Data turned on). Summary information cannot 
be edited. You can however, search and sort on it.

Approach gives you a great deal of flexibility when you design 
reports. For example, you might have a report that allows quick data 
entry of sales records in a columnar format. This type of report shows 
only database fields.

A second report might summarize those same sales records by 
product, showing a combination of database records and totals.

90 Cabernet

90 Merlot

3,000

2,200
1,500

Product Sales Rep Amount

Lindsay

McLane
Washington

2,000Wu

90 Zinfandel 1,000

1,200

Watanabe

Renault

90 Cabernet

90 Merlot
90 Zinfandel

Database records

90 Cabernet

90 Merlot

3,000
2,200
5,200

1,500

Product Sales Rep Amount

Lindsay
McLane
Subtotal

Washington
2,000
3,500

Wu
Subtotal

90 Zinfandel
1,000
1,200
2,200

Watanabe
Renault
Subtotal

10,900Grand Total

Database records

Totals
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A third report might show only subtotals and a grand total for the 
same sales records.

The Approach Report Assistant steps you through creating a report. 
You use the Report Assistant to give the new report a name, a 
SmartMaster style, and a SmartMaster layout. You also select the 
fields that appear on the report, and if the report contains summary 
information, you define the summary groupings and calculations.

A SmartMaster style gives a report a set of InfoBox properties, such 
as background color, text attributes, and specifications for field 
borders and frames. Approach provides predefined SmartMaster 
styles for reports.

The SmartMaster layouts determine where fields and summary 
information appear in a report. You can use any of the SmartMaster 
layouts just as they are, or use the SmartMaster layout as a starting 
point and design your own custom report.

The first SmartMaster layout creates a blank report, without any 
fields. You might use this SmartMaster layout when you intend to 
create a custom report and want to start with a blank slate.

The next two SmartMaster layouts, Standard and Columnar, display 
only database field information. A standard report displays each 
field in its own row. You might use a standard report to group 
database fields together into mini-data entry forms. 

90 Cabernet 5,200

Product Amount

3,500
2,200

90 Merlot
90 Zinfandel

10,900Grand Total

Subtotals

Creating a report

Record 1

Record 2

90 Cabernet

3,000
Lindsay

2,000
Wu
90 Merlot

Each field is in its own row.

Product:

Amount:
Sales Rep:

Amount:
Sales Rep:

Product:

Standard report
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A columnar report displays each field in its own column and each 
record in its own row. You might use a columnar report for quick 
data entry or editing. This type of report is also a good starting point 
for adding subtotals and a grand total.

The next two SmartMaster layouts, Leading Grouped Summary and 
Trailing Grouped Summary, show a combination of database fields in 
columns (like a columnar report) with the addition of subtotals 
(where appropriate) and a grand summary at the end of the report.

The sixth SmartMaster report layout, Columnar with Grand 
Summary, also shows a combination of database fields in columns 
(like a columnar report) with the addition of a grand summary at the 
end of the report.

Each field is in its own column.
90 Cabernet 3,000

Product Sales Rep Amount

Lindsay

2,000Wu90 Merlot

Record 1

Record 2

Columnar report

Leading summary
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The seventh SmartMaster layout, Summary Only, creates a summary-
only report that displays a single column of summary data and a 
grand summary at the end.

The final SmartMaster layout, Repeating Panel, creates a report that 
is very similar to the repeating panel you can create in a form (see 
“About repeating panels” on page 7-3). This SmartMaster layout is 
available only when you’re working with joined databases and 
allows you to display data from a “one-to-many” relationship in the 
same report. 

In appearance, the Repeating Panel report is very similar to a leading 
summary report. However, in a repeating panel report, the leading 
summary field comes from the database representing the “one” side 
of a “one-to-many” relationship. The bulk of the report shows the 
“many” records that are related to the “one” record in the leading 
summary.

Standard and column reports present database field information 
only.

To create a standard or columnar report:

1. Choose Report from the Create menu.

90 Cabernet 5,200Product
3,50090 Merlot

8,700Grand Total

Product
Summaries

Grand summary

The leading summary 
field comes from the 
product database.

The body fields come 
from the “many” 
invoices related to the 
“one” product record.
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Creating a 
standard or 
columnar report



8-6 User’s Guide

The Report Assistant appears.

2. Type a name for the report in the View Name & Title text box.

A new report automatically has the name Report and a number; 
you can use any name you want, up to 30 characters. The name 
you use appears on the report’s view tab and as a default on 
printed reports.

3. Select a SmartMaster style for the report in the SmartMaster Style 
drop-down list.

The drop-down list shows SmartMaster styles that Approach 
provides. The styles specify properties such as background color 
for the report and text attributes for data and field labels.

4. Select Standard or Columnar in the SmartMaster Layout list. 

This SmartMaster layout Displays

Standard Database fields you select in one 
continuous column, with each field in its 
own row

Columnar Database fields you select in columns, 
with each record in its own row

Select a named style.

Select a layout.

Type a name for the report.
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Approach adds a Fields tab and an illustration in the Sample 
Report area to the Report Assistant.

5. Click the Fields tab and add the fields you want to show in the 
report. 

When you click the tab, the Fields panel appears. 

To add a field to the Fields to Place on View list, select the field 
name in the Database Fields list and click Add, or double-click 
the name. If you want to add a field from a different joined 
database, select the database in the drop-down list. Approach 
displays the fields in the report in the order they appear in the 
Report Assistant.

To remove a field from the Fields to Place on View list, select the 
field name in the list and click Remove, or double-click the name.

6. Click Done.

The Fields tab appears 
when you select a 
SmartMaster layout that 
contains fields.

You can click a tab or use the 
Next and Back buttons to go 
to other tabs.

Add the fields for the 
body of the report to the 
Fields to Place on View 
list.
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The Define Main Database dialog box appears if you select fields 
from more than one joined database. Otherwise, Approach 
displays the new report.

7. If the Define Main Database dialog box appears, select a database 
in the Main Database drop-down list and click OK.

Approach displays the new report. 

You can create reports that contain a combination of database field 
information and summaries, or you can create reports that contain 
summary information only. The initial steps for creating a summary 
report are the same as those for creating a standard or columnar 
report. For more information, see “Creating a standard or columnar 
report” on page 8-5.

You can also add summaries to an existing columnar report using 
either the Summary command or Approach SmartIcons. The 
Summary command allows you to add a summary panel and define 
its calculation using a dialog box that looks very much like the 
summary panels in the Report Assistant. See “Adding a summary 
panel to a report” on page 8-16. Or, you can use PowerClick 
reporting to sort database records, add summary panels, and add 
calculated fields to summary panels. See “PowerClick reporting” on 
page 8-28.

To create a report with summaries:

1. Choose Report from the Create menu.

The Report Assistant appears.

2. Type a name for the report in the View Name & Title text box.

3. Select a SmartMaster style for the report in the SmartMaster Style 
drop-down list.

Select a main database 
for the view.

Creating a report 
with summaries
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4. Select one of the summary report layouts in the SmartMaster 
Layout list. 

Approach adds the Fields tab to the Report Assistant (for all but 
Summary Only reports) and either the Leading or Trailing 
Summary tab. Approach also adds an illustration in the Sample 
Report area.

5. Click the Fields tab and add the fields you want to show in the 
report. 

This SmartMaster layout Displays

Leading Grouped 
Summary

A columnar report sorted and subtotaled 
by the field you select with the sorting 
field in a leading summary panel and the 
subtotal in a trailing summary panel

Trailing Grouped 
Summary

A columnar report sorted and subtotaled 
by the field you select with the sorting 
field and the subtotal in a trailing 
summary panel

Columnar with Grand 
Summary

A columnar report with a grand total at 
the end

Summary Only Summaries of records grouped by the field 
you select, with a grand summary

The Fields and either 
Leading or Trailing 
Summary tabs appear 
when you select a 
SmartMaster layout that 
contains fields and a 
summary. If you select 
the Summary Only 
SmartMaster, only the 
Trailing Summary tab 
appears.

You can click a tab or use the 
Next and Back buttons to go 
to other tabs.
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When you click the tab, the Fields panel appears. 

To add a field to the Fields to Place on View list, select the field 
name in the Database Fields list and click Add, or double-click 
the name. If you want to add a field from a different joined 
database, select the database in the drop-down list. Approach 
displays the fields in the report in the order they appear in the 
Report Assistant.

To remove a field from the Fields to Place on View list, select the 
field name in the list and click Remove, or double-click the name.

6. Click the Leading or Trailing Summary tab and define the 
summary.

When you click the tab, the Leading or Trailing Summary tab 
appears. These two tabs are identical except for the location of 
the summary panel they create.

Add the fields for the 
body of the report to the 
Fields to Place on View 
list.

Select a field for grouping 
records.
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To define the summary, first select the field by which you want to 
group records in the summary. Next, select the calculation that 
you want to use. Finally, select the field you want to calculate. 

Be sure to select different fields for grouping and calculating. For 
example, if you want to see a subtotal of amounts by product, 
select Product as the field to group by and Amount as the field to 
calculate.

7. Click Done.

The Define Main Database dialog box appears if you select fields 
from more than one joined database. Otherwise, Approach 
displays the new report.

8. If the Define Main Database dialog box appears, select a database 
in the Main Database drop-down list and click OK.

When you design a report that uses joined data, it’s important to 
base a report on the database from which you want to display all 
of the records. For more information about joined databases, see 
“Main and detail databases in a view” on page 4-5.

You can create a repeating panel report that contains a combination 
of database fields from joined databases. It is the report equivalent to 
a form with a repeating panel (see “About repeating panels” on 
page 7-3). The initial steps for creating a repeating panel report are 
the same as those for creating a standard or columnar report. For 
more information, see “Creating a standard or columnar report” on 
page 8-5.

To create a repeating panel report:

1. Choose Report from the Create menu.

The Report Assistant appears.

Select a main database 
for the view.

Creating a 
repeating panel 
report
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2. Type a name for the report in the View Name & Title text box.

3. Select a SmartMaster style for the report in the SmartMaster Style 
drop-down list.

4. Select Repeating Panel Report in the SmartMaster Layout list. 

Approach adds the Fields tab, the Repeating Fields tab, and the 
Trailing Summary tab to the Report Assistant. Approach also 
adds an illustration in the Sample Report area.

5. Click the Fields tab and select a database and the field you want 
to show in the main section of the report. 

When you click the tab, the Fields panel appears. 

6. Click the Repeating Fields tab and select the database and fields 
you want for the repeating portion of the report.

The Fields, Repeating 
Panel and Trailing 
Summary tabs appear 
when you select the 
Repeating Panel Report 
SmartMaster layout.

You can click a tab or use the 
Next and Back buttons to go 
to other tabs.

Select one field for the 
main section of the 
report.

Select a database for 
the main section of the 
report.
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When you click the tab, the Repeating Fields panel appears.

7. Click the Trailing Summary tab and define the summary.

When you click the tab, the Trailing Summary tab appears. 

To define the summary, select the calculation that you want to 
use and the field you want to calculate. 

Be sure to select different fields for grouping and calculating. For 
example, if you want to see a subtotal of amounts by product, 
select Product as the field to group by and Amount as the field to 
calculate.

8. Click Done.

Approach displays the new report.

Select the fields for the 
repeating part of the 
report.

Select a database for 
the repeating fields.

Select a field to be 
calculated.
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The ability to display many different types of summary information 
is a powerful Approach reporting feature. Summary information 
might include subtotals, grand totals, and running totals, averages, 
counts, and many other types of calculations. You can summarize 
data from records in a single database or from records in joined 
databases.

Approach uses a summary panel to display summary and other 
information, and you can have more than one summary panel in a 
report. Each summary panel can include fields from the database, 
text you type, and calculated fields. Although a summary panel does 
not need to contain a calculated field, you must use a calculated field 
if you want to perform any type of calculation. 

You can place a summary panel in a leading position (at the 
beginning of a group of records) or in a trailing position (at the end of 
a group of records). This illustration shows some of the kinds of 
information you can display in a summary panel.

The above report contains two summary panels, a leading summary 
panel at the beginning of each group of sales reps and a trailing 
summary panel at the end of each group of sales reps. However, 
there is only one calculation: the group subtotal in the trailing 
summary. 

Summarizing data 
in a report

This leading summary 
panel contains a 
database field (Sales 
Rep). It displays the 
sales rep name just 
once for each group.

This trailing summary panel 
contains a text object, a 
database field (Sales Rep), and 
a calculated field 
(SSum(AMOUNT)).
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If you look at the same report with Show Data turned off, you can see 
how fields and other objects are placed in different panels.

Another way to use summary panels is for nested subtotals. You 
might, for example, sort and subtotal a report first by sales reps and 
then by product for each sales rep. When you use more than one 
summary panel, Approach starts calculating at the top of the report 
and calculates each subtotal in order to the end of the report. 

This illustration shows a report with nested subtotals. It contains two 
leading summary panels that display database fields and two trailing 
summary panels that each hold a database field and a calculated 
field. The text Subtotal for is the label for the database fields.

Leading summary panel 
with records grouped by 
Sales Rep

Trailing summary panel 
with records grouped by 
Sales Rep.

Field label

Database field

Database field

Body panel with database 
fields

Calculated field (SSum(Amount))

Header with text objects

Inner subtotaled group

Outer subtotaled group
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Without data showing, the previous report looks like this. Notice that 
the trailing summary panel for the inner group, Region, is above the 
trailing summary panel for the outer group, Product.

If you don’t want any detail line items on a report, you can create a 
summary report that is made up entirely of summary panels. 

Approach gives you two ways to add a summary panel to a report: 
through the Summary dialog box or with the Leading Summary and 
Trailing Summary icons. 

The Summary dialog box lets you specify how you want records to 
be summarized, where the summary is to appear, how the panel is 
aligned with the rest of the report, and whether you want a page 
break after the summary panel. 

The Leading and Trailing Summary icons automatically place a 
centered leading or trailing summary panel in the report. The 
summary panel summarizes records grouped by whatever field you 
select before clicking the appropriate icon. For more information 
about using these and other PowerClick reporting icons, see 
“PowerClick reporting” on page 8-28. 

When you add a summary panel to a report using the Summary 
dialog box, Approach gives you three ways to define summaries: 

• For a specified number of records

• For all records on the report

Summary panel for outer 
group (by Product)

Summary panel for inner 
group (by Region)

Adding a 
summary panel to 
a report
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• For groups of records that are sorted according to any field you 
select

The summarization option that you select affects the way Approach 
sorts records and summarizes data in the summary panel. For 
example, if you define a summary panel that summarizes groups of 
records grouped by product, Approach sorts records by product, 
even if you don’t actually calculate a summary for the records. 

To add a summary panel to a report:

1. Choose Summary from the Create menu.

The Summary dialog box appears.

90 Cabernet

90 Merlot

3,000
2,200
5,200

1,500

Product Sales Rep Amount

Lindsay
McLane
Subtotal

Washington
2,000
3,500

Wu
Subtotal

8,700Grand Total

90 Cabernet

90 Merlot

3,000

2,200
1,500

Product Sales Rep Amount

Lindsay

McLane
Washington

2,000Wu

90 Cabernet

90 Merlot

3,700Summary

This report has a summary after every 
two records. If you know how many 
records will appear on a page, you can 
calculate page subtotals. 

This report is sorted by product and 
has a summary after every group of 
records for the same product.

5,000Summary

Inserts a page 
break after each 
summarized group

Inserts the summary above (leading) or below 
(trailing) the records in the group

Inserts the summary on the 
left or right of the body, or 
above or beneath it if you 
click Center

Summarizes the values in a 
group of records that are 
sorted on the selected field

Summarizes an entire group 
of records

Summarizes a specified 
number of records

Specifies a field 
for sorting and 
grouping
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2. Click an option in the Summarize area. 

3. Specify an alignment for the summary panel. 

You can place the summary panel to the left of the report body, to 
the right of the report body, or centered above or below the 
report body.

4. Specify a location for the summary panel.

Leading places the summary panel before its group of records. 
Trailing places the summary after its group of records. 

5. To display one summary per page, turn on “Insert page break 
after each summary group.”

Approach inserts a page break after the summary panel each 
time it appears.

6. Click OK.

Approach displays the summary report in Design.

To move a summary panel, CONTROL-click the panel and drag it 
into position. To delete a summary panel, CONTROL-click the 
panel and press DELETE.

To insert a summary Click

After a specified number of 
records

“Every n records” and type the 
number of records you want 
summarized

For an entire group of records “All records”

After unique values in a 
sorted group of records

“Records grouped by” and select a 
field to use when sorting for the 
summary (Select the database 
carefully to be sure you are sorting 
on the correct field in the database 
you want.)

If you summarize a group of 
records sorted on a specified 
field, Approach sorts the 
records in ascending order.

You can use this option to 
calculate a page subtotal.



Designing Report s 8-19

You can use a summary calculated field to show a subtotal, total, 
average, count, or other summary on data in a summary panel. For 
example, if you have a summary panel that summarizes records 
grouped by product, you might use a calculated field to show the 
total sales amount for each product. Or, you can use a calculated field 
that has been defined as a running total to calculate a running sales 
total for each sales rep. You can specify a field as a running total in 
the Field Definition dialog box.

You can define a new summary calculated field for each summary 
panel, or you can use a field that has already been defined. If you 
define a field specifically for a summary panel, the summarize 
options for the field and those for the summary panel must match 
and you generally use the calculated field only in the summary panel 
you defined it for. For example, if you define a calculated field that 
summarizes records grouped by Sales Rep, you would use the field 
only in summary panels grouped by Sales Rep.

For more flexibility, however, you can use a calculated field that has 
been defined as where-placed, which you can reuse as often as you 
wish. A where-placed calculated field looks at the summary panel it’s 
placed in and automatically summarizes records based on how the 
summary panel is defined. You can specify a field as where-placed in 
the Field Definition dialog box.

This illustration shows a where-placed calculated field, Subtotal, 
used in two different summary panels. The formula for this field is 
SSum (Amount). The first trailing summary panel summarizes on 
records grouped by region, so the Subtotal field in this panel 
summarizes records by region. The second trailing summary panel 
summarizes on records grouped by product, so the Subtotal field 
here summarizes records by product. 

A calculated field in a summary panel is calculated when you 
preview the report or when you view the report in Design with data 
showing.

Adding a 
calculated field to 
a summary panel 

The same Subtotal field 
appears in two summary 
panels. But because it’s a 
where-placed field, it 
summarizes according to 
the panel where it’s 
located.
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To add a calculated field to a summary panel:

1. If you’re using a field that has already been defined, choose Add 
Field from the Summary menu and drag the field into the 
summary panel.

Be sure that the field is entirely within the borders of the 
summary panel.

2. If you’re creating a new field, use the Field Definition dialog box 
to name the field, define the formula the field uses, and define 
how the field summarizes records.

For more information about defining a field, see “Setting up a 
formula for a calculated field” on page 3-8. 

After you define the field, it appears in the Add Field dialog box 
and you can drag it into the summary panel. 

You can edit reports in a number of ways to change their appearance 
and their arrangement of data. You can:

• Change line and color setting to alter the appearance of the 
different panels that make up a report

• Change the alignment and location of summary panels

• Add a header or footer to a report

Try working with Show Data 
turned off when you create a 
new summary field.

This list shows all of the 
summary panels in any 
report in the Approach file.

Editing a report
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• Add a special title page to a report (The title page can contain 
different information than the subsequent pages.)

• Change the number of columns on a standard report

• Keep the fields in a record together on the same page or in the 
same column

• Move or resize report columns and their headers

Some of the procedures in this section use the InfoBox. If the InfoBox 
is not already open, click the Show Info icon, choose Style & 
Properties from the context-sensitive menu, or double-click the object 
you want to format. The InfoBox appears, and you can keep it on the 
screen as you work.

You must be in Design to format a report or summary panel. You 
may find it easier to format a report that has field names showing 
rather than data. To toggle between showing data and showing field 
names in Design, click the Show Data icon or choose Show Data from 
the View menu.

A report can be composed of several different panels, including a 
body panel, a header, a footer, and one or more summary panels. The 
body panel displays line items from the database. The header can 
display the report title, column headers, text you type, or the date, 
time, or page number. The footer can also display text you type, page 
numbers, the date, or the time. A summary panel displays any type 
of summary calculation you specify plus any text or graphics you 
add. 

This illustration shows typical report elements labeled for easy 
identification by choosing the Panel Labels command from the View 
menu. 

About report 
panels

The header displays the 
report name and column 
names.

The body displays 
database line items.
The summary panel 
displays a subtotal by 
Sales Rep. The footer displays the 

page number.

The formula is SSum(Amount).
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Before you can modify a report panel, you need to select the panel in 
Design. Be careful to select the panel itself and not one of the fields 
inside it.

A report panel has a dark border around it when it is selected.

■ To select a panel, click a border of the panel, CONTROL-click 
anywhere in the panel, or click the panel label.

If you’re showing field names rather than data in Design, you 
can also click any part of the panel’s interior that does not 
contain fields.

Like most other design objects, a report panel has borders and an 
interior fill area. You can set a line width and color for the borders 
between lines and around the outside of the panel, and a fill color for 
the background of the interior. You can also apply a three-
dimensional frame to each line and a drop shadow to the entire 
panel. 

Each type of report panel has its own InfoBox that you can use for 
changing the appearance of the panel. The settings in the InfoBox 
apply to all panels of a type.

To change line or color settings for a report panel:

1. Select a report panel and click the Show Info icon to open the 
panel’s InfoBox.

Selecting a report 
panel

A selected panel has a 
dark border.

You can click in any 
of these areas.

Changing line or 
color settings for a 
report panel
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2. Click the Lines and Colors tab in the InfoBox and set options in 
the Lines and Colors panel.

When your report includes a summary panel, you can change the 
alignment or location of the summary panel relative to the body 
panel.

To change the alignment or location of a summary panel:

1. Select a summary panel and click the Show Info icon to open the 
panel’s InfoBox.

To Do this

Change the width of borders in 
a panel

Select a width in the Border Width 
drop-down list.

Change the color of borders in 
a panel

Select a color in the Border Color 
drop-down palette. Select “T” for 
transparent.

Change the fill color of the 
interior of a panel

Select a color in the Fill Color 
drop-down palette. Select “T” for 
transparent.

Give the lines in a panel a 
raised or indented frame

Select a frame style in the Frame 
drop-down list.

Show outside borders around a 
panel

Turn on options in the Borders 
area.

Select a width and color 
for the borders.

Select a fill color for the 
interior of the panel.

Select a three-dimensional 
frame for the lines.

Turn on the outside borders 
you want.

Changing the 
alignment or 
location of a 
summary panel



8-24 User’s Guide

2. Click the Display tab in the InfoBox and set options in the 
Display panel.

When you create a report, Approach automatically adds a header 
and footer. The preset header contains either the report name (on 
standard and summary-only reports) or column headers (on 
columnar reports). The preset footer contains the date on the left and 
the page number on the right. 

If you’re working with a report that doesn’t already contain a header 
or footer, you can easily add one. You can also easily change the 
contents of a header or footer by adding or removing text, graphics, 
or other objects.

■ To add a header or footer, choose Insert Header or Insert Footer 
from the Report menu.

Approach adds the header at the top of the page or the footer at 
the bottom of the page. You may have to scroll down to the 
bottom of the page to see the footer.

■ To have Approach automatically insert the date, time, or page 
number in a header or footer, draw a text block and then, with 
the cursor still active in the text block, choose Date, Time, or 
Page # from the Report Insert submenu.

To Do this

Change the alignment of the 
summary panel relative to the 
report body

Select an alignment in the 
Alignment drop-down list.

Change the position of the 
summary panel

Select Leading or Trailing in the 
Location area.

Select an alignment for 
the summary panel.

Select a location for the 
summary panel.

Adding a header 
or footer

Use Show Panel Labels in the 
View menu to identify the 
header and footer panels.
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Approach inserts a placeholder for the date, time, or page 
number. The placeholders are <<DATE>>, <<TIME>>, and <<#>>.

A title page is a special first page that you can add to a report. It 
contains all the information that appears on the rest of the report 
pages, as well as a unique header and footer. You might, for example, 
have a report title or a special graphic in the header on the title page 
but have column names in the header on all following pages. 

■ To add a title page, choose Add Title Page from the Report menu.

Approach adds a title page, which looks exactly like a regular 
report page, except that the header and footer are blank. In 
Preview, the window’s title bar displays Title Page. You can resize 
the header and footer, add the date, time, or page number, or add 
graphics or text.

To remove a title page, choose Add Title Page from the Report 
menu again.

■ To view the title page of a report, choose Show Title Page from 
the Report menu.

To return to the standard page of your report, choose Show Title 
Page from the Report menu again.

When you create a standard or columnar report, Approach places 
fields in a single column that runs the length of each page. In a 
standard report, that single column contains only one field per row. 
In a columnar report, that single column may contain more than one 
field in a row. If it’s appropriate for your report, you can increase the 
number of columns in order to reduce the number of pages. When 
you have more than one column, Approach “snakes” records from 
one column to the next. 

Adding  a title p age

Use the Show Panel Labels 
command in the View menu 
to identify the blank header 
and footer panels on the title 
page.

Changing the 
number of 
columns in a 
report
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If you use multiple columns in a standard report, Approach 
automatically makes sure that records are not split between columns 
or pages.

To change the number of columns in a report:

1. Click the Show Info icon to open the InfoBox for the report.

2. Change the number in the Number of Columns text box in the 
Basics panel.

Approach displays your report with the new number of 
columns. If you’re showing field names instead of data, a vertical 
dashed line indicates the edge of each column.

Columnar report with one 
set of two columns. 

Columnar report with three 
sets of two columns each.

Records 
“snake” into 
the next 
column
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If your data spans more than one page in a standard report, you 
might want to keep them from starting on one page and ending on 
another. Approach automatically keeps the fields in a record together 
in one column if you have multiple columns on a page. 

To keep records together:

1. Click the Show Info icon to open the InfoBox for the report.

2. Turn on “Keep records together” in the Basics panel.

When you first create a columnar report, Approach displays the 
columns in the order you listed the fields in the Report Assistant. 
Approach automatically sets the width of each column and column 
header to the field size. However, you can easily move a column to a 
different position or resize it.

Approach lets you work in Design with whole report columns or 
with individual fields. When you work with whole columns, you can 
move or resize both the column and its header at the same time. 
Otherwise, the column fields and the column header behave like 
separate objects that you can resize or move independently. 

To turn columns on, choose Turn On Columns from the Report 
menu. If the Column Mode icon appears in an icon bar, you can click 
it instead of choosing the command. You add icons to the icon bars 
using the SmartIcons command in the Tools menu. 

■ To move a column, click the column to select it (the pointer 
changes to the move cursor) and drag it to another position.

Approach moves both the column and its header to the new 
position.

Keeping records 
together

Moving and sizing 
report columns

Move cursor
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■ To resize a column, click in the column to select it and drag its 
right border to a new position.

Approach resizes both the column and the column header, 
displaying as much data as will fit.

PowerClick reporting is a powerful Approach feature that allows 
you to organize and summarize data with just a few clicks. 
PowerClick reporting is WYSIWYG, which means that you can 
instantly see the results of your actions as you design a report. You 
can use PowerClick reporting to sort records, quickly add a summary 
panel to a report, or add a calculated field to a summary panel.

You can also achieve the same results by manually adding summary 
panels and calculated fields. For more information about adding a 
summary panel to a report, see “Adding a summary panel to a 
report” on page 8-16. For more information about adding a 
calculated field, see “Adding a calculated field to a summary panel” 
on page 8-19.

This section gives two examples of PowerClick reports you can 
build. Each of these reports is based on a columnar report created 
using the Report Assistant. 

The first example shows how to add a grand total to a simple 
columnar report. The second example starts with the same report 
and shows how to sort and subtotal by product. 

The resize cursor appears when you 
point to the column’s right border.

PowerClick 
reporting
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This example shows you how to add a grand total to a simple 
columnar report. The fields on the following sales report show the 
product name, the sales rep who sold it, and the amount sold. 

The report you start with looks something like this:

The finished report looks something like this:

You can also create this report using the Report Assistant and the 
Columnar with Grand Summary SmartMaster layout (see “Creating 
a report with summaries” on page 8-8).

To add a grand total to a report:

1. Use the Report Assistant to create a columnar report.

For more information about creating a columnar report, see 
“Creating a report” on page 8-3.

2. In Design with Show Data turned on, click in the column that 
contains the values you want to summarize.

Adding a grand 
total to a report
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90 Zinfandel

10,900Grand TotalThe words Grand Total 
are the field label for the 
summary field.
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To turn Show Data on, click the Show Data icon or choose Show 
Data from the View menu.

3. Click the Sum icon. 

Approach places a summary panel at the end of the report and 
automatically adds a calculating field that sums the values in the 
field you select. In Design, the first sample report looks like this.

Select a column to be 
summed.

You can display the field label 
and edit its contents using 
the summary field’s InfoBox. 

Summary panel with 
calculated grand total
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This example starts with the previous report. It sorts and groups 
records by product and adds a subtotal at the end of each group of 
records. It also shows you how to show repeated data only once in 
each group.

The finished report looks something like this:

You can also create this report using the Report Assistant and the 
Leading grouped summary SmartMaster layout (see “Creating a 
report with summaries” on page 8-8).

To group records and add subtotals to a report:

1. Start with the report from the first example and in Design with 
Show Data turned on, click in the column that you want to group 
on (in this example, it’s Product).

To turn Show Data on, click the Show Data icon or choose Show 
Data from the View menu.

Grouping records 
and adding 
subtotals to a report
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Subtotals calculated by a summary 
calculated field in the summary panel.

Summary panel with 
calculated grand total 
from Example 1

Select the column you 
want to sort on.



8-32 User’s Guide

2. Click the Trailing Summary icon. 

Approach places a trailing summary panel below the body of the 
report. If Approach asks if you want to sort the records displayed 
on the report according to the column you selected, click OK.

3. Click in the column that contains the values you want to 
summarize (in this example, it’s Amount).

4. Click the Sum icon. 

Approach adds a calculating field to the trailing summary panel. 
The calculating field sums the values in the column you select. 

5. To display the product name only once per group, click the 
column you first used for sorting (in this case, Product), and click 
the Leading Summary icon.

Select a column to be 
summed.

Subtotal of records 
for the same product
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Approach places a leading summary panel at the beginning of 
each product group.

6. Choose Turn on Columns from the Object menu to turn columns 
off (make sure the command is unchecked).

7. Select the first product item and move it into the leading 
summary panel you just created.

The final sample report looks like this. 

You may want to choose Turn on Columns from the Object menu 
again to turn columns on before doing any formatting on your 
report.

Blank leading summary 
panel

Leading summary with 
product name

Trailing summary with 
automatically calculating 
subtotal
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9 Designing Form Letters 

and Mailing Labels

A form letter is a one-page view that displays a combination of fields 
from the database and text you type in any of several typical business 
letter formats. A mailing label is a view that displays database fields 
and text you type in a typical mailing address format. A single page 
can contain multiple labels, depending on the label size you use.

This chapter describes how to create and modify form letters and 
mailing labels. 

Most of the instructions in this chapter require you to be in Design. 
To go to Design, click the Design icon, or choose Design from the 
View menu or from the environment pop-up menu in the status bar.

You can modify form letters and mailing labels as you can other 
types of views. For example, you can rearrange fields, assign macros, 
and change color properties in a form letter or mailing label. For 
information about modifying views, see Chapter 5, “Working in 
Design,” and Chapter 6, “Adding and Editing Fields in a View.”

You can combine data that Approach retrieves from name and 
address fields with text that you type to produce customized 
one-page form letters. Approach creates a copy of the form letter for 
each record in the current found set, adding the name and address 
information from each database record to the standard letter text you 
type when you create the form letter.

About form letters
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For example, you might want to send a year-end letter to each 
customer that you’ve done business with in the past year. Using the 
name and address data stored in your customer database, you can 
have Approach create a personalized letter for each customer.

A typical Approach form letter consists of database fields for the 
recipient’s name and address plus a salutation (also composed of 
database fields), the date, a closing that you type, and your return 
address. You can use all of these elements, or just select the ones that 
are appropriate. For example, if you plan to print your letter on 
company or personal letterhead, you’d omit the return address 
information. 

This illustration shows a formatted form letter with all possible 
components (including a database field in the body of the letter).

Company

Contact

Address

City

State_Prov

Zip_Postal

City Tales

Anna Madrigal

1 Bush St.

San Francisco

CA 

94105

Anna Madrigal
City Tales
1 Bush St.
San Francisco, CA 94105

Dear Anna Madrigal :

We’d like to take this opportunity
to thank you and all the folks at 
City  Tales for all your help in the
past year...

Database record Form letter

Date

Name and address fields

Salutation fields and text

Body of letter

Closing

Return address

Database field
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Because database fields might contain information of varying 
lengths, Approach automatically adjusts the space around fields (for 
example, the Company field in the illustration above) to create a 
smooth flow between typed text and database fields. 

The Approach Form Letter Assistant guides you through the process 
of creating the skeleton of the form letter (all of the fields, but no 
text). You use the Form Letter Assistant to give the new form letter a 
name, a SmartMaster style, and a SmartMaster layout. You also select 
the fields that appear on the form letter, and add a return address, 
salutation, and closing if you wish to use them. 

A SmartMaster style gives a form letter a set of properties, such as 
background color, text attributes, and specifications for field borders 
and frames. Approach provides predefined SmartMaster styles for 
form letters.

The three SmartMaster layouts determine where the date, the inside 
address, the return address, and the closing appear. You can use any 
of these SmartMaster layouts exactly as they are, or you can use a 
SmartMaster layout as the starting point and design your own 
custom form letter.

The first SmartMaster layout, Block, creates a standard blocked 
business letter with all elements aligned on the left. This all-purpose 
layout includes a return address and the date at the top of the page.

Creating a form 
letter

Anna Madrigal
City Tales
1 Bush St.
San Francisco, CA 94105

Dear Anna Madrigal :

We’d like to take this opportunity
to thank you and all the folks at 
City  Tales for all your help in the
past year...

Sincerely,

B. Rothschild

10 Zinfandel Lane
Napa, CA 94945Return address

Inside address

Salutation

Closing

Body of letter

8/27/94Date
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The second SmartMaster layout, Modified Block, creates a slight 
variation on a standard blocked business letter, with the return 
address, date, and the closing in blocks on the right side of the letter. 
You might use this layout when you’re printing on letterhead that 
contains a logo in the upper left.

The third SmartMaster layout, Personal, creates a letter that contains 
only the date, a salutation, and a closing. This type of letter is more 
suited for personal correspondence when you don’t need an inside 
address or a return address.

Anna Madrigal
City Tales
1 Bush St.
San Francisco, CA 94105

Dear Anna Madrigal :

We’d like to take this opportunity
to thank you and all the folks at 
City  Tales for all your help in the
past year...

Sincerely,

B. Rothschild

10 Zinfandel Lane
Napa, CA 94945

Return address

Inside address

Salutation

Closing

Body of letter

8/27/94Date

Dear Anna Madrigal :

We’d like to take this opportunity
to thank you and all the folks at 
City  Tales for all your help in the
past year...

Sincerely,

B. Rothschild

Salutation

Closing

Body of letter

8/27/94Date
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To create a form letter:

1. Choose Form Letter from the Create menu.

The Form Letter Assistant appears.

2. Type a name for the form letter in the View Name & Title text 
box.

A new form letter automatically has the name Form Letter and a 
number; you can use any name you want, up to 30 characters. 
The name you use appears on the form letter ’s view tab.

3. Select a SmartMaster style for the form letter in the Style drop-
down list.

The drop-down list shows SmartMaster styles that Approach 
provides. The styles specify properties, such as font and font size 
for text and fields.

4. Select a SmartMaster layout for the form letter from the Layout 
list.

Approach displays a sample form letter at the right of the dialog 
box so you can see what the layout looks like. 

5. Click the Return Address tab and type a return address if you 
wish to use one.

Type a name for the letter.

Select a named style.

Select a layout.

You can click a tab or use the 
Next and Previous buttons to 
go to other tabs.
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When you click the tab, the Return Address panel appears. If you 
select the Personal SmartMaster layout, Approach removes the 
Return Address and Inside Address tabs from the Form Letter 
Assistant.

Click None to omit the return address, or type a return address.

6. Click the Inside Address tab, select an address layout, and add 
the fields for the inside address section of the letter. 

When you click the tab, the Inside Address panel appears. 

The address layout determines the number of lines in the inside 
address area. To add a field to a box in the Fields for the Address 
layout, select a box, select the field name in the Database Fields 
list and click Add, or double-click the name. If you want to add a 
field from a different joined database, select the database in the 
drop-down list. 

Type a return address if 
you want one to appear 
in the form letter.

Click None to omit the 
return address.

Add the fields for the 
address portion of the 
form letter to the Fields 
for the Address area.
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7. Click the Salutation tab and specify the salutation.

When you click the tab, the Salutation panel appears. 

Click None to omit the salutation, or type a salutation and select 
the fields to be included.

8. Click the Close tab and type a closing.

When you click the tab, the Close panel appears. 

Click None to omit the close, or type a close.

Type text in the text box 
and select the fields to 
include in the salutation.

Click None to omit the 
salutation.

Type a close if you want 
one to appear in the form 
letter.

Click None to omit the 
close.
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9. Click Done.

The Define Main Database dialog box appears if you select fields 
from more than one joined database. Otherwise, Approach 
displays the new form letter.

10. If the Define Main Database dialog box appears, select a database 
in the Main Database drop-down list and click OK.

Approach creates and opens the form letter, arranging the fields 
you selected in the layout you specified.

The form letter appears on your screen as a text object. The field 
names appear between angle brackets in this format: 
<<Database.Field>>. 

Select a main database 
for the view.

Field names in the form 
letter include the database 
name and are enclosed in 
angle brackets.
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Most of the work you’ll do with form letters is in Design, where 
you’ll find a special icon bar that is tailored for the task of working 
with form letters. 

The default Design icon bar contains SmartIcons that make it easy to 
set the alignment or spacing of text, or to add such elements as the 
date or page number. You can also turn of horizontal and vertical 
rulers to help you with the placement of text on a page.

When you work in Design, this is the default icon bar you’ll see.

■ To turn on rulers for text placement, choose Show Ruler from 
the View menu.

For more information about using the rulers, see “Showing 
rulers” on page 5-8.

An Approach form letter is basically a single very large text object 
that contains text and fields (field names enclosed in angle brackets). 
Therefore, you can format the letter text the same way you would 
any text object. The text format changes you make can apply to the 
entire form letter or just to selected text.

For information about changing the format of the date, see “Setting a 
standard date format” on page 6-15.

To format the text in a form letter:

1. Select the text object or the text you want to format. Click the 
Show Info icon to open the form letter ’s InfoBox.

Working with form 
letters

Open File

Save Approach File

Send Mail

Print

Preview

Undo

Cut

Copy

Paste

Design

Browse

Fast Format

Show Info

Left Align

Center

Right Align

Single Space

Double Space

Date

Time

Insert Field

Spell Check

Next Icon Bar

Formatting the text 
in a form letter
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2. If necessary, click the Text tab and set the options in the Text 
panel.

The line and color settings for a form letter can apply to the letter as a 
whole, or to the form letter’s text object. 

To change the line and color settings for a form letter:

1. Select the form letter as a whole or select the text object and click 
the Show Info icon to open the form letter’s InfoBox.

To Do this

Change the font of text Select a font in the Font Name 
drop-down list.

Apply boldface, italics, 
underlining, or strikethrough 
to text

Select one or more styles in the 
Style/Effect list.

Change the font size of text Select a size in the Size drop-down 
list.

Apply a color to text Select a color in the Text Color 
drop-down list.

Change line spacing to single 
space, one and a half space, or 
double space

Select an option under Line 
Spacing.

Change alignment to left, 
center, right, or justified 

Select an option under Alignment.

Select a color for the text.Select a font for the text.

Select one or more text 
styles.

Select a font size.

Select a line spacing.

Select an alignment.

Alignment and line spacing 
affect all text in a text object, 
even if you’ve selected only 
some of the text in the object.

Changing the line 
and color settings 
for a form letter
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2. Click the Lines and Colors tab in the InfoBox, and set the options 
in the Lines and Colors panel.

When you first create a form letter, it contains the text and fields that 
you specified in the Form Letter Assistant panels, arranged 
according to the SmartMaster layout you selected. After you create 
the form letter with the Form Letter Assistant, the next step is to add 
the rest of the letter’s contents: text and additional fields. 

You add text simply by clicking where you want the text to appear 
and typing. You add fields either by typing field names or by 
choosing a field from the Add Field dialog box. 

To Do this

Change the width of a line or of 
the border of another object

Select a width in the Border Width 
drop-down list.

Change the color of a line or of 
the border of another object

Select a color in the Border Color 
drop-down palette. Select T for 
transparent.

Change the fill color of the 
interior of an object

Select a color in the Fill Color 
drop-down palette. Select T for 
transparent. (This is not available 
for lines.)

Give an object a raised or 
indented frame

Select a frame style in the Frame 
drop-down list.

A three-dimensional frame 
works best against a solid 
gray or colored background.

If you plan to print a view on 
a black-and-white printer, use 
grays rather than colors to get 
the best-looking printouts.

Select a width and color for 
the line or border.

Select a fill color for the 
interior.

Select a three-dimensional 
frame.

Adding to form 
letter contents
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The text you add around fields is the standard part of the form letter 
that doesn’t change unless you edit it. Because a form letter is a 
single large text object, you can add text wherever you want simply 
by clicking with the Text tool and typing. You can edit the text just as 
you would any other text in a text object, using Cut, Copy, and Paste. 
Text automatically wraps from one line to the next, so there’s no need 
to press ENTER unless you want to start a new line.

To type text in a form letter:

1. Double-click anywhere in the form letter to get the Text tool and 
click where you want to add text.

2. Type the text.

That’s all there is to it. You can type text before and after fields or 
anywhere else you wish. 

Although you can select fields for a form letter using the Form Letter 
Assistant, you can also add fields to a form letter later. For example, 
you might want to include the company name in the body of the 
letter. Approach displays fields in this format: <<Database.Field>>. 

One way to add a field is to simply type the database and field names 
separated by a period and enclosed in double angle brackets. The 
other way is to use the Insert Field dialog box.

To add a field to a form letter:

1. In Design, double-click to get the Text tool and click where you 
want the field to appear.

2. Click the Insert Field icon or choose Field from the Text Insert 
submenu.

The Insert Field dialog box appears.

3. Click a field in the list and click OK to add it to the form letter.

Typing text in a form 
letter

Adding a field to a 
form letter

Select a field from this 
list to add to the form 
letter.
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You can easily move or remove fields from a form letter. Because the 
fields you see in a form letter are just placeholders, you can use 
standard text editing commands (Cut and Paste) to move them. You 
can also add or delete text and space to position the fields where you 
want them. 

You cannot move a field in a form letter by dragging it.

To move a field in a form letter:

1. Select the field that you want to move and choose Cut from the 
Edit menu.

Approach places the field placeholder on the Clipboard.

2. Click where you want to place the field and choose Paste from 
the Edit menu.

Approach inserts the field at the insertion point.

■ To delete a field in a form letter, select it and choose Cut or press 
BACKSPACE or DELETE.

Mailing labels are a collection of database fields; they’re similar to a 
report in that data from multiple records appears on a single page, 
one record per label.

Moving or deleting 
form letter fields

About mailing 
labels

Paul Revere
Raiders Inc.
1776 State St.
Boston MA 02109

Database record Mailing labels

Company

Contact

Address

City

State_Prov

Zip_Postal

Raiders Inc.

Paul Revere

1776 State St.

Boston

MA 

02109
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The number of mailing labels you see on a page depends on the label 
size and the page layout you select when you create mailing labels. 
You can choose from more than 50 standard Avery mailing label 
formats or you can create other formats of your own. Either way, 
Approach automatically positions the fields you select to match your 
format and removes any extra space between fields.

Your mailing labels can be as plain or as fancy as you wish. Using the 
preset Approach mailing label style, you can quickly create simple 
mailing labels that contain just the names and addresses in your 
database. However, by adding text, background colors, or graphics, 
or by using different fonts, you can create highly specialized and 
attractive mailing labels.

You can use any of the three Approach environments—Preview, 
Browse, or Design—to view and work with your mailing labels. 

In Preview, you can see how your mailing labels will appear when 
they’re printed, with the extra space between fields automatically 
removed.

Plain mailing label

Customized mailing label

In Preview, you can see 
how printed labels will 
appear.
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In Browse, you can move from field to field and record to record, 
editing data as necessary. For information about editing the data in a 
mailing label, see “Entering data in fields” on page 10-7.

In Design, you can resize or move the fields around and add text 
(such as a comma between address fields or a message at the top of 
the label). You can also add colors or field borders, draw objects, 
change the font or font size, or add or remove fields. For information 
about the many ways you can change the appearance of a view, see 
“Editing objects and text” on page 5-18; for information about 
changing the appearance of fields, see “Editing fields” on page 6-22.

When you work in Design, this is the default icon bar you’ll see.

In Browse, you can edit 
the data that appears on 
labels.

In Design, you can move 
fields, resize them, or 
add text.

Open File

Save Approach File

Send Mail

Print

Preview

Undo

Cut

Copy

Paste

Design

Browse

Fast Format

Show Info

Bring Forward

Send Backward

Group

Ungroup

Show Grid

Show Ruler

Show Tools

Zoom In

Zoom Out

Next Icon Bar
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Approach provides a Mailing Label Assistant to help you create 
either standard-sized or custom mailing labels. When you create a 
mailing label, you select the SmartMaster layout you want to use, the 
fields to be included on the mailing label, and the mailing label 
format. You can use one of the predefined Avery label formats or 
create custom labels of your own. For information about creating 
custom mailing labels, see “Creating custom mailing labels” on 
page 9-18.

To create mailing labels:

1. Choose Mailing Labels from the Create menu.

The Mailing Label Assistant appears.

2. Type a name for the mailing labels in the Mailing Label Name 
text box.

A new mailing label automatically has the name Mailing Label 
and a number; you can use any name you want up, to 30 
characters. The name you use appears on the mailing label’s 
view tab.

3. Select a SmartMaster layout.

Creating mailing 
labels

Add fields to the label.

Type a name for the 
mailing labels.

Select a label code.

The field display changes to match 
the SmartMaster layout you select.

Select a SmartMaster 
layout.
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The SmartMaster layout determines how may lines of text 
appear on the labels. You can select from among 3-line, 4-line,  
5-line, and special formats.

4. If necessary, select the main database in the Database Fields 
drop-down list. 

Each record from the main database appears as a label.

5. Move fields from the Database Fields list to the boxes in the 
Fields to Place on Label area. 

To add a field to a Fields to Place on Label box, click the box to 
select it and then either double-click the field name or select the 
field name and click Add. The focus arrow automatically moves 
to the next box. 

6. Select a label code in the Label Type drop-down list.

The list includes more than 50 different label formats. If you’ve 
defined any custom label formats, they can also appear in the list.

7. To create your own custom labels, click the Options tab and set 
options in the Options panel.

For information about creating custom mailing labels, see 
“Creating custom mailing labels,” next. 

8. Click OK.

You can remove a field name 
from a box by selecting the 
slot and clicking Remove.

Click a box to select it.Focus arrow
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The Define Main Database dialog box appears if you select fields 
from more than one joined database. Otherwise, Approach 
displays the new mailing labels.

9. If the Define Main Database dialog box appears, select a database 
in the Main Database drop-down list and click OK.

Approach creates and displays the mailing labels. You may want 
to go to Preview to see how the labels will appear when printed. 
For information about moving fields or adding text to mailing 
labels, see “Changing the appearance of mailing labels” on 
page 9-20. If you want to use a different Avery label setting, you 
can create a new set of mailing labels.

If your mailing labels do not match any of the more than 50 standard 
Avery label formats, you can create your own custom mailing label 
and use it whenever you wish. Approach automatically displays the 
names of all custom label formats in the Mailing Label Assistant 
Label Type drop-down list. 

When you design a custom mailing label, you specify the label size, 
the page margins and space between labels, the number of labels on a 
page, the order in which the labels are printed, and printer options (if 
necessary).

To create custom mailing labels:

1. Choose Mailing Labels from the Create menu, type a name for 
the mailing labels, select a SmartMaster layout, and assign fields 
to the Fields to Place on Label boxes. 

If you need more information about any of these steps, see 
“Creating mailing labels” on page 9-16.

2. Click the Options tab.

Select a main database 
for the view.

Creating custom 
mailing labels
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The Options panel appears in the Mailing Label Assistant.

3. Type a name for the custom labels in the Custom Label text box.

4. Type new values for margin, label size, and gap dimensions.

As you change these values, the Sample Layout shows you how 
the labels will appear on a page. The Sample Layout area border 
turns red if the measurements you enter are not valid.

5. Specify the number of labels on each page.

The Across value sets the number of columns, and the Down 
number sets the number of rows.

This setting Controls

Top Margin The space between the top of the page and the 
first label

Left Margin The space between the left edge of the page and 
the left column of labels (not including tractor 
holes in tractor feed paper)

Width and Height The size of the mailing label

Vert. Gap The space between each label and the one below

Horiz. Gap The space between each label and the one 
beside it

If you want to modify an 
existing custom label, 
select it in this list.

Click to 
change 
printer 
settings.
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6. Select a printing order.

“Left to right” prints labels across the page, “Top to bottom” 
prints labels in columns.

7. If you’re using continuous feed labels, turn on “Tractor feed.”

Approach disables the top margin and vertical gap settings for 
continuous feed labels. You may also want to adjust printer 
settings for the correct paper size.

8. Click Add to add a new custom label layout.

9. Click OK.

Approach creates and displays the mailing labels. You may want 
to go to Preview to see how the labels will look on the printed 
page. 

For information about moving fields or adding text to mailing 
labels, see “Changing the appearance of mailing labels,” next. 

Once you’ve created mailing labels, you can change their appearance 
the same way you would a change form. You can:

• Move or resize fields manually, or set them to automatically slide 
to remove excess space.

• Add text to the label.

• Change the label size, the number of labels on a page, the gaps 
between labels, and their printing order.

In Design, you can also change the overall look of a mailing label by 
adding objects, changing the fonts used for field data, adding fill 
colors to objects, fields, or labels as a whole, or adding other graphic 
elements. 

• For more information about adding design elements, see 
“Adding objects to the background of a view” on page 5-12. 

• For more information about formatting text, see “Formatting the 
text in a form letter” on page 9-9.

• For more information about changing line and color settings, see 
“Changing the line and color settings for a form letter” on 
page 9-10.

• For more information about changing the appearance of fields, 
see “Editing fields” on page 6-22.

If the labels you specified 
won’t fit on a page, Approach 
alerts you so that you can 
readjust the label size.

Changing the 
appearance of 
mailing labels
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When you first create a mailing label, Approach automatically slides 
fields over or up to eliminate any empty space between them; this 
feature works both for fields that don’t contain data and for fields in 
which the data doesn’t fill all of the space allocated to it. 

If, however, you want to adjust the space between fields yourself, 
you can easily do so by dragging a field to a different location. You 
can also resize a field by dragging one of its handles. However, if you 
make a field too small, Approach shows only as much data as will fit.

■ To move a mailing label field, drag the field to the desired 
location. 

You can also use the left, right, up, and down arrow keys to move 
a field. Make sure that the whole field fits inside of the label 
boundaries so that all of its contents will be printed.

■ To resize a mailing label field, drag a handle to the desired size.

When you create mailing labels, Approach automatically slides fields 
up and to the left to remove any extra space. However, if you add a 
field to a mailing label after the labels have been created, you’ll need 
to set the field to slide. 

To set a field to slide:

1. In Design, select a field and open its InfoBox.

You can double-click the field or click the Show Info icon.

Moving or resizing 
mailing label fields

Go to Preview to see how 
Approach slides fields to 
eliminate any empty space.

The rounded rectangle 
shows the label’s 
boundaries.

Drag a handle to resize 
the field.

Setting a field to 
slide
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2. Click the Dimensions tab.

3. In the When Printing, Slide area, turn on Up and Left.

Approach slides the field you changed to remove the extra space. 
You’ll see the change in Preview.

In addition to the database fields that appear on a mailing label, you 
can also add text, such as a comma between address fields or a 
general message, to each label. Working in Design, you create text 
objects and type text in them. Once you’ve created a text object, you 
can use the InfoBox to change its appearance.

To type text in a mailing label:

1. In Design, create a text object on the label.

For more information about creating a text object, see “Entering 
text in a text object” on page 5-14.

2. Type in the object.

The text appears on every label.

Turn these options on to remove 
extra space between fields.

Typing text in a 
mailing label
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When you create mailing labels, you can either select an Avery label 
layout or create a customized layout of your own. Thereafter, you can 
change the size and arrangement of labels on a page using the Edit 
Label Settings button on the Basic panel of the mailing label InfoBox.

To change the mailing label layout:

1. In Design, click the Show Info icon to open the InfoBox for 
mailing labels.

2. Click Edit Label Settings in the Basics panel.

The Mailing Label Options dialog box appears. This dialog box is 
identical to the Options panel of the Mailing Label Assistant.

You can change the current custom label definition, select a 
different label definition, or create a new one. You can also delete 
a custom label definition.

3. Select the label layout you want to change in the Custom Label 
drop-down list.

If you’re adding a new label layout, type a name in the Custom 
Label text box.

Changing a mailing 
label layout

Click to change mailing 
label size or layout.

If you want to modify an 
existing custom label, 
select it in this list.

Click to change printer 
settings.
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4. Change the settings for the label as necessary.

These settings are described in “Creating custom mailing labels” 
on page 9-18.

5. Click Add to add a new label definition, or click Change to apply 
changes to the current label definition.

6. Click OK.

Approach applies the revised definition to the current mailing 
labels.

■ To delete a label layout, select it in the Custom Label drop-down 
list and click DELETE.
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10 Entering and Editing Data

After you have created a database and defined fields for it, you’re 
ready to enter information for the specific records. 

This chapter describes how to add and duplicate records, move to 
other records and fields, enter data in different types of fields, check 
the spelling in a database, and hide and delete records. 

The information in this chapter applies generally to all types of 
views. For more detailed information about entering and editing 
data in worksheets, see Chapter 12, “Designing Worksheets and 
Crosstabs.”

You can also enter data by importing it from another file or 
application or by inserting an OLE object in a field. For information 
about entering data in these ways, see Chapter 16, “Exchanging Data 
with Other Files or Applications.”

In Browse, you work with the information in a database rather than 
with the design of views. You can enter and edit data, add and delete 
entire records, find and sort records, and see different perspectives of 
your database.

As soon as you finish defining fields for a new database, Approach 
automatically takes you to a standard single-record form in Browse 
so that you can begin entering data. You can also change to Browse 
from another environment at any time.

■ To go to Browse, click the Browse icon or choose Browse from the 
View menu or the environment pop-up menu in the status bar.

About Browse
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The default icon bar in Browse has SmartIcons for many of the most 
commonly used commands for working with data and records. Click 
an icon to apply the command.

If the current view is a worksheet or a crosstab, the icon bar changes 
to provide commands specific to that type of view. For information 
about the worksheet and crosstab icon bars, see Chapter 12, 
“Designing Worksheets and Crosstabs.”

In the Browse menu bar, a context-sensitive menu changes depending 
on the current selection or the current view. Most often, this menu is 
named Browse and provides standard commands for finding, 
sorting, and editing records. But if a PicturePlus field is selected or if 
the current view is a worksheet or a crosstab, the menu changes 
names and has commands for working with that type of element.

The status bar in Browse gives information about the current 
Approach file. Most parts of the status bar have pop-up menus or 
other options you can use to navigate in the file or to modify your 
work area.

Open File

Save File

Send Mail

Print

Preview

First Record

Previous Record

Next Record

Last Record

Design

Browse

Find

Show All

Ascend Sort

Descend Sort

New Record

Delete Record

Duplicate Record

Date

Time

Previous Value

Spell Check

Enter

This menu changes to PicturePlus, 
Worksheet, or Crosstab.

View Environment Record number Records in the found set

Click an arrow to go to the previous 
or next record. Click the record 
number to go to a record by number.

Icon bars
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The parts of the status bar that show the view name and environment 
are pop-up menus. You can choose from them to change to another 
view or environment. The icon bar symbol at the right end of the 
status bar is also a pop-up menu, with the icon bars available in the 
current view.

Approach is very flexible in how it lets you work with data. You can 
enter and edit data in a variety of views—forms, reports, worksheets, 
form letters, and mailing labels. The type of view you use depends 
on how many records you want to see at a time and how you want 
their fields organized.

■ To change to another view, click the view tab or choose the name 
of the view from the view pop-up menu in the status bar.

The view tabs and the pop-up menu in the status bar show all the 
views in the current Approach file.

Forms are often the best type of view for entering data. A form shows 
one record at a time, so it can provide many fields for each record. 
You can design your forms in a graphic, easy-to-understand format 
for entering data.

But there may be occasions when you want to see more than one 
record at a time, perhaps to enter data quickly and with less detail for 
each record. In these cases, you can use a list-style report or a 
worksheet for entering data. Reports and worksheets can show 
multiple records on a single page, so they are often much more 
concise than forms.

In a worksheet, each column corresponds to a field. If you’re not 
interested in a particular field when entering data, you can collapse 
the field’s column to hide it from view. You can also rearrange 
columns to make entering data more convenient. 

Views for entering 
and editing data

If you use a particular view 
often, you may want to define 
a macro for changing to it.
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When entering and editing data, you work with one record at a 
time—the current record. In a form or form letter, the current record is 
the one showing; in a report or mailing label, the current record is the 
one with a solid border; in a worksheet, the current record is the line 
with the active field.

This section describes how to use commands to move through the 
records of a found set, in their current order in the Approach file. In a 
report, worksheet, or mailing label, you may also click in a visible 
record to move to it or tab to the next record from the last field of the 
current one.

If you have a field selected before you move to another record, the 
same field is selected in the other record.

You can set a default order for records from a database as they 
appear in an Approach file, and you can set a temporary sort order 
for the records. For information, see “Setting a default order for 
records” on page 19-5 and “Sorting records by data in fields” on 
page 11-14.

You can move forward or backward through a view one record at a 
time.

■ To move forward one record, click the Next Record icon, click the 
right arrow in the status bar, or press PAGE DOWN.

You can hold down the mouse button on the Next Record icon to 
“fast forward” through the records.

■ To move backward one record, click the Previous Record icon, 
click the left arrow in the status bar, or press PAGE UP.

You can hold down the mouse button on the Previous Record 
icon to “rewind” through the records.

Moving to another 
record

In a report, the current 
record has a border.

Moving one record 
at a time
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You can also move quickly to the first record or the last record in the 
current order of records.

■ To move to the first record, click the First Record icon or press 
CONTROL-HOME.

■ To move to the last record, click the Last Record icon or press 
CONTROL-END.

Each record has a number in the current order of records in an 
Approach file (from front to back). If you know the number of the 
record you want to go to, you can give Approach the number to 
move directly to that record. This is especially helpful in a large 
database.

The number of the current record appears in the status bar.

To move to a specific record:

1. Click the record number in the status bar.

The Go To Record dialog box appears.

2. Type the number of the record you want to move to.

3. Click OK.

You can put another record in a database by either adding a new 
record or making a duplicate of an existing one. You must be in 
Browse to add a record.

If you have set a default order for the records in a view, after you add 
data to a new record the record is placed in its proper position in the 
sequence. (It appears at the end of the database in your view until the 
first refresh.) 

If you have not set an order for the records, a new record remains at 
the end of the database.

Moving to the first or 
last record

Moving to a specific 
record

Keep in mind that the record 
number can change when you 
find or sort.

Type the number of 
the record.

Adding records
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When you add a new record to a database, the record is initially 
blank, except for fields that are defined to have data entered 
automatically.

■ To add a new record, click the New Record icon or choose New 
Record from the Browse, PicturePlus, or Worksheet menu.

The new record is active, with the insertion point in the first field 
in the tab order. 

In a repeating panel
When you’re working in a repeating panel on a form, you can add a 
record to the database the panel is based on.

If the join options are set for inserting a record automatically, you can 
just click in a field in the first blank line in a repeating panel to add a 
record. For information about this option, see “Setting options for a 
join” on page 4-17.

A new record appears at the bottom of a repeating panel. If the 
displayed rows in a panel are already full when you add a record, a 
scroll bar appears at the side of the panel.

You can make a duplicate of any existing record. Approach copies 
each field from the original record and places them in the duplicate.

If any fields are defined to have data entered automatically, note that 
they may not match the original record (such as if they specify a 
unique serial number or the time the record was created).

To duplicate a record:

1. Select the record you want to duplicate.

If you’re using a form, show the record. In a report, worksheet, 
repeating panel, or mailing label, click in a field in the record.

2. Click the Duplicate Record icon or choose Duplicate Record from 
the Browse, PicturePlus, or Worksheet menu.

The duplicate record is active, with the insertion point in the first 
field in the tab order.

Adding a new record

Duplicating a record

Duplicating a record is a 
quick way to create records 
with similar data.
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You can enter and edit data in the fields of a record when you’re in 
Browse. 

Any data you enter appears at the insertion point or replaces the 
current selection. You can choose Cut or Copy from the Edit menu to 
remove or copy a selection and place it on the Clipboard; then specify 
a location and choose Paste from the Edit menu to put the selection 
there. Press DELETE or choose Clear from the Edit menu to remove 
data without placing it on the Clipboard.

Approach saves the data you enter or edit as soon as you click in or 
tab to another field, move to another record, change to another view, 
click the Enter icon, or press ENTER. You do not need to save data 
yourself.

Approach may enter data automatically in a field because of how the 
field was defined—for example, a date or serial number is often 
entered this way. You can edit data that was entered automatically 
(unless the field is read-only or the Approach file has a password). 
You cannot edit data in a calculated field, however.

In a form, report, worksheet, or other view with specified field 
boundaries, you see only as much data as fits in a field’s boundaries 
even though the field may contain more data than is visible. 

This section explains how to enter data in different types of fields. To 
enter data in a variable field, follow the instructions for the type 
defined for the variable field.

You need to select a field before you can enter or edit data in it. When 
a field is selected, it has a solid border around it. In a report or 
mailing label, the border for a selected field is inside the border for 
the current record. 

You cannot select a calculated field.

■ To select a field, click in a field, or press TAB to go to the next field 
in the data entry order or SHIFT-TAB to go to the previous field in 
the data entry order.

Entering data in 
fields

In most respects, you can 
enter and edit data in 
Approach as you do in a word 
processing application.

If you need to make a field 
larger, drag a handle in 
Design. In a worksheet, make 
the column wider.

Selecting  a fiel d

In a report, the field border 
is inside the record border.

Approach lets you use either 
the TAB key or the ENTER 
key to move between fields for 
fast data entry.
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If your preferences are set this way, you can also press ENTER or 
SHIFT-ENTER to tab to the next or previous field. For more 
information, see “Setting general working preferences” on 
page 19-14.

Clicking in a field selects the field and places an insertion point in it. 
Any data you enter will appear at the insertion point.

Tabbing to a field selects the field and its entire contents. Any data 
you enter will replace the selected contents. If you tab out of the last 
field in the last record, Approach asks if you want to create a new 
record. Click OK to create the record.

Once a field is selected, you can move the insertion point or select 
other data in the field.

■ To change the insertion point, click where you want the insertion 
point to go, or press the left arrow key or right arrow key to 
move the insertion point one character at a time.

■ To change the selection, drag to select a range, double-click to 
select a word, or press SHIFT and the left arrow key or right arrow 
key to extend a selection by one character.

You can type letters, numbers, and symbols in a text or memo field. 

■ To enter data in a text or memo field, type any letters, numbers, 
or symbols, up to the limit of the text field length or the memo 
file size.

In a text field, the text must fit in the length specified in the field’s 
definition. Approach alerts you if you try to type characters beyond 
the length allowed.

You can type more text in a memo field because the text is stored in a 
separate file. The maximum size of a memo file depends on the file 
type of the database. For limits on the size of text and memo files, see 
Appendix B and Appendix C.

Changing the 
insertion point or 
selection

Entering text in a 
text or memo field

A sort on a text field is 
alphabetical. If you want to 
sort on a numeral, a date, or a 
time, use a numeric, date, or 
time field instead.
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A text format can specify all capitals, all lowercase, or first-letter 
capitals, and it applies only to letters in a field. If a field has a text 
format, the text changes to the format when you move out of the 
field. 

If a field has a text format and “Show data entry format” is on for the 
field, the text is formatted as you type and the formatted text is 
stored in the database.

You can also enter today’s date or the current time in a text or memo 
field, but you will not be able to sort the field chronologically on the 
date or time. Choose Today’s Date or Current Time from the Insert 
submenu in the Browse or Worksheet menu.

You can type numeric data in a numeric field. Approach does not 
save any text or non-numeric characters (such as * and ") in a 
numeric field.

■ To enter a value in a numeric field, type numeric data up to the 
length specified in the field’s definition.

Approach alerts you if you try to type characters beyond the length 
allowed.

If a field has a numeric format, the data is formatted when you move 
out of the field. Type a decimal point if the data needs one, but don’t 
type other characters like currency signs and commas. Let the format 
provide them.

If a field has a numeric format and “Show data entry format” is on, 
the fixed characters of the format appear in the field and underlines 
show the maximum number of characters. You can press the space 
bar to move the insertion point past the next separator.

As you type text, it 
appears the way you 
enter it.

The text is formatted 
when you move out of 
the field.

Entering a value in 
a numeric field

The “Show data entry 
format” setting is in the 
Format panel of a field’s 
InfoBox.

With “Show data entry 
format,” fixed characters 
appear in the field.

The data is formatted 
when you move out of 
the field.
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A numeric format can specify currency signs, separators, a fixed 
number of digits, and other properties. For more about numeric 
formats, see “Setting a numeric format” on page 6-19.

A Boolean field holds a value of true or false. If you refer to a Boolean 
field in a formula, Approach uses 1 for a true value and 0 for a false 
value to calculate the result.

■ To enter a value in a Boolean field, type Yes, Y, yes , y, or 1 for true. 
Type No, N, no , n, or 0 for false.

When you move out of the field, the value appears in the field as Yes 
or No.

You can type up to ten characters in a date field to represent one date, 
or you can use shortcuts to have Approach enter a date for you. Do 
not mix the date with other kinds of information.

■ To type a date in a date field, type the month, day, and year as 
numbers separated by non-numeric characters. 

■ To enter the current date, click the Date icon or choose Today’s 
Date from the Insert submenu in the Browse or Worksheet menu.

■ To enter another day for the current month and year, type a 
single number.

For example, in June 1994 you can type 15 to enter June 15, 1994.

When typing a date, you can type one, two, three, or four digits for 
the year. One-digit and two-digit years are assumed to mean the 
twentieth century. If you don’t type a year, Approach assumes the 
current year (based on your system settings) and enters it for you.

If a field has a date format, the date changes to the format when you 
move out of the field. Type the separators along with the numbers for 
the month, day, and year.

If a field has a date format and “Show data entry format” is on, 
slashes appear in the field as separators and underlines show the 
maximum number of characters. You can press the space bar to enter 
the current month, day, or year and move past the next slash.

Entering a value in 
a Boolean field

Entering a date in a 
date field

With “Show data entry 
format,” slashes 
appear in the field.

The date is formatted 
when you move out of 
the field.
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A date format can specify the order of the month, day, and year as 
they appear in views, whether the month appears as a word or a 
number, and other properties. For more about date formats, see 
“Setting a standard date format” on page 6-15.

International formats
Your system may require a different order for entering dates (such as 
“day, month, year” or “month, day, year”). Enter the date numbers in 
the order specified in your Windows International Control Panel.

You can type up to twelve characters in a time field to represent one 
time, or you can use shortcuts to have Approach provide a time for 
you. Do not mix the time with other kinds of information.

■ To type a time in a time field, type the time as hours and minutes 
separated by colons (HH:MM); as hours, minutes, and seconds 
separated by colons (HH:MM:SS); or as hours, minutes, seconds, 
and hundredths of a second separated by colons and a decimal 
(HH:MM:SS.00).

■ To enter the current time, click the Time icon or choose Current 
Time from the Insert submenu in the Browse or Worksheet menu.

■ To enter only an hour, type a single number.

For example, type 8 to enter 8:00.

When typing a time, you can use either a 12-hour or a 24-hour 
format. If you enter an hour less than 12 without a suffix of AM or 
PM, Approach assumes AM.

If a field has a time format, the time changes to the format when you 
move out of the field. Type the separators along with the numbers for 
the parts of the time.

If a field has a time format and “Show data entry format” is on, 
colons appear in the field as separators and underlines show the 
maximum number of characters. You can press the space bar to enter 
the current hour, minute, or second and move past the next colon.

A time format can specify which separators appear in views, whether 
seconds and hundredths appear, and other properties. For more 
about time formats, see “Setting a time format” on page 6-18.

Entering a time in a 
time field

The time is formatted 
when you move out of 
the field.

With “Show data entry 
format,” colons appear 
in the field.
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International formats
Your system may require a different time separator than the colon for 
entering times. Use whatever separator was specified in your 
Windows International Control Panel.

You can duplicate a value from another record in the database. For 
example, you may need to enter your name in the Sales Rep field in 
several orders in a row.

You can duplicate data in any type of field and with any type of 
value.

■ To duplicate a value from the last record modified, click the 
Previous Value icon or choose Previous Value from the Insert 
submenu in the Browse or Worksheet menu.

This enters the value from the same field in the last record you 
modified in your current session with Approach. If you have not 
entered or edited any data in the current session, the command does 
not enter a value.

In a form or report, a field can have a drop-down list, a set of radio 
buttons, or a checkbox. You enter a value by choosing from the list or 
by turning on a radio button or checkbox.

If you’re designing a view, you can set up a drop-down list, a set of 
radio buttons, or a checkbox as part of the view.

A drop-down list shows the possible values for a field. When you 
move to a field with a drop-down list, the list opens so that you can 
select a value. In some cases, a list is combined with a field box so 
that you can either select from the list or type a value.

Duplicating a value 
from the last record 
modified

Duplicating a value is a quick 
way to enter repeating data in 
a field.

Selecting a value 
for a field

Selecting from a 
drop-down list

A drop-down list shows 
the values you can 
enter in a field.

If a list is combined with 
a field box, use either 
the list or the text box.
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■ To select from a drop-down list, click the value you want. Or 
begin typing the value or press the up arrow key or down arrow 
key until the value is selected and then press TAB or ENTER.

A list can display up to nine items. If the list has more than nine 
items, Approach inserts a scroll bar.

For information about adding a drop-down list to a view, see 
“Displaying a field as a drop-down list” on page 6-4.

A radio button or checkbox assigns an on or off value to a field. You 
can enter a value in a field by turning on its radio button or checkbox.

Radio buttons identify a set of possible values for a field. Only one 
value in a set can be on at a time; when you turn on a radio button, if 
another button is on it is automatically turned off. A checkbox is 
normally used by itself to define two possible values for a field 
(Checked and Unchecked values).

■ To turn on a radio button or checkbox, click the radio button or 
checkbox. Or tab to the set of radio buttons or the checkbox and 
then press the space bar.

The value in a field with radio buttons or a checkbox is null until you 
turn the settings on or off. 

If you turn a checkbox on and then off, you enter the Unchecked 
value in the field.

For information about adding radio buttons or a checkbox to a view, 
see “Displaying a field as a checkbox” on page 6-10 and “Displaying 
a field as a set of radio buttons” on page 6-12.

If you want the cursor in the 
next field when you finish 
choosing, use an arrow key to 
make your selection and then 
press TAB.

Turning on a radio 
button or a 
checkbox

You can turn on one radio 
button in a set, as long as 
the buttons are based on 
the same field.

You can turn an individual 
checkbox on or off.

Once you have turned on a 
radio button, the only way to 
turn it off is by turning on 
another button in its set.
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To use a graphic in a PicturePlus field, you can paste a picture from 
another application, or you can draw in the field to create your own 
image. The graphic appears only in the PicturePlus field in the 
current record. It is part of the record’s data, not part of the design of 
a view. 

When a pasted picture is too large for a field, the picture is either 
cropped or reduced, depending on how this option is set for the field. 
Approach can also enlarge a picture to fit a field. For information 
about these settings, see “Changing display options for a PicturePlus 
field” on page 6-32.

For information about OLE objects in fields, see “About OLE and 
Approach” on page 16-18. 

You can paste a picture directly into a PicturePlus field. The type of 
the graphic file can be Windows bitmap (.BMP), Encapsulated 
PostScript (.EPS), graphics interchange (.GIF), Windows Paintbrush 
(.PCX), Targa (.TGA), Tagged Image File Format (.TIF), or Windows 
metafile (.WMF).

To paste a picture from a file:

1. In Browse, select the PicturePlus field.

2. Choose Paste from File from the Edit menu.

Putting a picture in 
a field

A picture can be 
part of a record’s 
data.

Be sure to work in Browse 
when adding graphics. If you 
are in Design, you’re adding 
the picture to a view rather 
than to a field in a record.

Pasting a picture 
from a file
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The Paste from File dialog box appears.

3. Select a graphic file type or *.* in the List Files of Type drop-
down list.

4. Select the name of the graphic file you want in the File Name list.

You can change the directory and disk if you need to look for the 
file.

5. Click OK.

Approach pastes a copy of the picture in the field.

Drag and drop
You can also use the drag-and-drop feature in Windows to paste a 
picture from a file. Open the Windows File Manager and the 
Approach file on your screen at the same time. Then drag the file icon 
for the picture from the File Manager to the PicturePlus field in the 
Approach file.

You can also paste a picture by copying it to the Clipboard in its 
source application. The Clipboard stores one item at a time.

To paste a picture from the Clipboard:

1. In the picture’s source application, select the picture and choose 
Copy from the Edit menu.

This places a copy of the picture on the Clipboard.

2. In Approach, select the PicturePlus field in Browse and click the 
Paste icon or choose Paste from the Edit menu.

Approach pastes the copy of the picture in the field.

Select the graphic file 
you want to paste.

Specify the 
location of the 
graphic file.

Select the type of the 
graphic file.

Pasting a picture 
from the Clipboard
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Paste Special
When a picture is stored on the Clipboard in more than one format, 
the Paste Special command is available in the Edit menu. You can 
choose Paste Special rather than Paste and select the format you want 
in the dialog box that appears.

If you select the object-type format in Paste Special, the picture is 
added to the field as an OLE object. For more information, see 
“Embedding an existing OLE object” on page 16-26.

If a PicturePlus field is defined to allow drawing, you can draw 
freehand lines in it. For information about setting fields to allow 
drawing, see “Changing display options for a PicturePlus field” on 
page 6-32.

To draw lines with the pointer:

1. In Browse, select the PicturePlus field.

2. While holding down the left mouse button, drag to draw the 
lines.

Lines appear wherever you drag in the field.

Pen colors and line widths
When you select a PicturePlus field, the Browse menu changes to the 
PicturePlus menu. If you want to change the pen color or line width 
for your freehand lines, choose PicturePlus Properties from the 
PicturePlus menu, and then select the color or width in the InfoBox. 
The color or width will be applied to any lines you draw until you 
choose a different color or width.

You can have Approach enter the same value in a particular field in 
every record you’re working with. 

If you’re showing a found set of records, Approach enters the value 
in the field for those records. If you’re showing the entire database, 
Approach enters the value for all the records.

For example, suppose a customer in your Orders database changed 
its company name from Barcelona Cafe to Caliente Cafe. You could 
use the Find command to show only the records with Barcelona Cafe 
in the ShipTo field, and then fill the ShipTo field in the found set with 
Caliente Cafe.

Drawing lines with 
the pointer

Filling a field with 
a new value



Entering and Editing Data 10-17

To fill a field with a new value:

1. If you want to fill the field only in a set of records, use the Find 
command to isolate the records.

For information about this command, see “Finding data in 
records” on page 11-1.

2. In one of the records, click in the field you want to fill.

If a record already has the value you want to use for the fill, click 
in the field in that record. The value will appear in the Fill Field 
dialog box.

3. Choose Fill Field from the Browse or Worksheet menu.

The Fill Field dialog box appears. The list in Fill Field shows the 
fill value for the selected field.

4. If necessary, edit the fill value.

For example, type Caliente  Cafe to fill the field with Caliente Cafe.

5. Click OK.

Approach fills the field in every record in the database or the 
current found set.

Approach can check the spelling of text in your databases and 
Approach files. The text it checks depends on which environment 
you’re in:

• In Browse, Approach checks the spelling of data in records, 
including text in memo fields.

• In Design, Approach checks the spelling of text in field labels and 
text objects, including text in the body of form letters.

The spelling checker is not available in Find and Preview.

Filling a field is a quick way 
to enter repetitive data, either 
in new records or in existing 
records in which you need to 
replace old data.

You can edit the fill value.

Checking spelling
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When you check spelling, Approach compares the text with entries 
in a main dictionary and a user dictionary. Lotus provides the main 
dictionary for your language; you cannot edit this dictionary. The 
user dictionary is for words that are not in the main dictionary, such 
as proper nouns and technical terms; you can add and delete words 
in this dictionary at any time.

You can use both the main dictionary and the user dictionary with 
other Lotus applications that have a spelling checker. The 
dictionaries are normally stored in your Lotus directory. 

You must be in Browse or Design to run the spelling checker.

To run the spelling checker:

1. If you want to check the spelling in only some text, select the text 
to check.

In Browse, you can select any text in a record.

In Design, you can select text in a text object or an entire text 
object. If you select an entire object, Approach will check all the 
text in the object.

2. Click the Spell Check icon or choose Spell Check from the Tools 
menu.

The first Spell Check dialog box appears.

3. Select the scope of the text you want to check.

Selection checks the spelling only in the selected text or text 
object.

“Current record” (in Browse) checks the spelling in all fields of 
the current record. “Current view” (in Design) checks the text in 
all text objects in the active view.

Running the 
spelling checker

Select a scope for the 
spell check.

The options that appear 
depend on whether you’re in 
Browse or Design.
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“Found set” (in Browse) checks the spelling of all text in all 
records in the current found set; if a field is selected, it checks 
only that field in each record. “Selection across found set” (in 
Browse) checks the selected text or text object in all records in the 
found set.

4. Click OK.

If Approach finds a word that is not in its dictionaries, the second 
Spell Check dialog box appears. It shows the questioned word 
and possible replacements for it.

If Approach does not question any words, an alert box appears 
letting you know that the spell check is complete. 

5. For each questioned word, specify what to do by responding to 
the dialog box.

To replace the word, either edit the text in the Replace With text 
box or select another word in the Alternatives list, and then click 
Replace All or Replace. Replace All changes the word wherever 
it occurs in the text you’re checking, and Replace changes only 
this occurrence of it.

To accept the word, click Skip All or Skip. Skip All accepts the 
word wherever it occurs in the text you’re checking, and Skip 
accepts only this occurrence of it.

To accept the word and add it to the user dictionary, click Add To 
Dictionary. Approach will not question the word in future spell 
checks.

After you respond to the dialog box, Approach continues 
checking and displays the next word it questions. When 
Approach finishes checking all the text, an alert box appears 
letting you know that the spell check is complete.

6. Click OK in the alert box.

The questioned word

Possible replacements 
for it

You can click Close to quit a 
spell check before Approach 
reaches the end of the text.
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A user dictionary is helpful when you have terms that do not appear 
in the main dictionary. Most often, these are proper nouns like 
product and company names or technical terms that aren’t found in a 
general-purpose dictionary.

If you click Add To Dictionary for a questioned word when you run 
the spelling checker, the word is added to your user dictionary. You 
can also add words directly to the user dictionary, and you can delete 
words from the dictionary.

To edit the user dictionary:

1. Click the Spell Check icon or choose Spell Check from the Tools 
menu.

The Spell Check dialog box appears.

2. Click Edit Dictionary.

The Edit Dictionary dialog box appears.

3. Add or delete the words you want.

To add a word to the dictionary, type the word in the New Word 
text box and click Add.

To delete a word from the dictionary, select the word in the 
Current Words list and click Delete. The Current Words list 
shows symbols first, then numbers, and then words in 
alphabetical order.

4. Click OK to return to the Spell Check dialog box.

5. Click OK to run the spelling checker or click Cancel to close the 
Spell Check dialog box.

Editing the user 
dictionary

Type a new word and click 
Add…

…or select a word and 
click Delete.

If you want to edit a word, 
you can delete the word and 
then re-add it with the new 
spelling.
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Approach comes with a main dictionary for your language. If you 
have another dictionary you want to use as the main dictionary, you 
can change to it within Approach.

To change to another main dictionary:

1. Click the Spell Check icon or choose Spell Check from the Tools 
menu.

2. In the Spell Check dialog box, click Language Options.

The Language Options dialog box appears.

3. Type the pathname of the new main dictionary in the Directory 
Path text box.

4. If a single dictionary file has more than one language in it, select 
the language you want in the Language drop-down list.

5. Click OK to return to the Spell Check dialog box.

6. Click OK to run the spelling checker or click Cancel to close the 
Spell Check dialog box.

You can specify several options for checking spelling, such as 
whether you want Approach to find repeated words. The options 
become a new default for the spelling checker and remain in effect 
until you change them.

To set options for checking spelling:

1. Click the Spell Check icon or choose Spell Check from the Tools 
menu.

2. In the Spell Check dialog box, click Options.

Changing to another 
main dictionary

Specify the path of the new 
dictionary.

Select the language of 
the dictionary.

Setting options for 
checking spelling



10-22 User’s Guide

The Speller Options dialog box appears.

3. Turn on the options you want.

4. Click OK to return to the Spell Check dialog box.

5. Click OK to run the spelling checker or click Cancel to close the 
Spell Check dialog box.

You can hide records from view to make them unavailable. This does 
not delete the records from the database, but just temporarily hides 
them from the group of records you’re browsing.

When a record is hidden, it is not included in sorts and calculations, 
and it is not printed or exported along with other records. 

To Turn on

Find words that appear twice in a 
row, such as the the

Check for repeated words

Check the spelling of words with 
numerals, such as Invoice2

Check words with numbers

Check the spelling of words that 
begin with a capital letter, such as 
London

Check words with initial caps

Show words from the user 
dictionary in the Alternatives list 
during a spell check

Include user dictionary 
alternatives

Finds words that appear 
twice in a row

Checks words that begin 
with a capital letter

Checks words that have 
numerals in them

Shows words from the user 
dictionary in the Alternatives list

Approach checks words at the 
beginning of sentences even if 
“Check words with initial 
caps” is off.

Hiding and 
showing records
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You can hide one record at a time in a form and more than one record 
at a time in a report or a worksheet.

To hide records:

1. Specify the records you want to hide.

If you’re using a form, show the record. If you’re using a report 
or worksheet, click in any field in the record. To select more than 
one record, SHIFT-click or CONTROL-click in the records.

2. Choose Hide Record from the Browse, PicturePlus, or Worksheet 
menu.

The records disappear from view.

When you’re ready to use hidden records, you can show them again. 
You can show either all the records in the database or only the 
records in the found set you used most recently.

■ To show all the records in the database, click the Show All icon or 
choose Show All from the Browse or PicturePlus menu or the 
Worksheet Find or Crosstab Find submenu.

■ To show the records in the found set you were using before you 
hid the records, choose Find Again from the Browse or 
PicturePlus menu or the Worksheet Find or Crosstab Find 
submenu. Then press ENTER.

You can delete individual records or a set of records from a database. 
The records are permanently removed from the database, not just 
from the Approach file you’re browsing. Deleting records also 
removes them from other Approach files that use the database.

Deleted records cannot be retrieved.

You can delete one record at a time in a form and more than one 
record at a time in a report or a worksheet.

To delete specific records:

1. Specify the records you want to delete.

If you’re using a form, show the record. If you’re using a report, 
click in any field in the record. To select more than one record, 
SHIFT-click or CONTROL-click in the records.

Hiding records

To select records that meet 
certain criteria in a report or 
worksheet, use Find to isolate 
the records and then choose 
Select All from the Edit 
menu.

Showing hidden 
records

Deleting records

Deleting specific 
records
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2. Click the Delete Record icon or choose Delete Record from the 
Browse, PicturePlus, or Worksheet menu.

Approach asks if you’re sure you want to delete the records.

3. Click Yes to delete the records.

The records are permanently removed from the database.

In a repeating panel
When you’re working in a repeating panel on a form, you can delete 
a record from the database the panel is based on. Click in the record 
in the panel, and delete the record. Approach asks if you’re sure you 
want to delete it. Click Yes to delete the records.

If you want to delete records that have certain criteria in common, 
you first fill out a find request that specifies the criteria. You can 
delete all records in a database this way by first finding all the 
records.

To delete a found set of records:

1. Use the Find command to isolate the records you want to delete.

If you want to delete all the records in a database, type an 
asterisk (*) in any field in the find request. The asterisk acts as a 
wildcard for any characters in the field.

For information about the Find command, see “Finding data in 
records” on page 11-1.

2. Choose Delete Found Set from the Browse, PicturePlus, or 
Worksheet menu.

Approach asks if you’re sure you want to delete the records.

3. Click Yes to delete the records.

The records are permanently removed from the database.

Deleting a found set 
of records

It’s a good idea to back up a 
database before deleting 
records, especially when 
deleting a found set.
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11 Finding and Sorting Records

You can specify which records to view in Browse or Preview and in 
what order by finding and sorting. Finding isolates and displays a set 
of records based on data in one or more fields; sorting reorganizes the 
current set of records in the order you prescribe.

This chapter explains how to use a find request to look for data in 
records, how to sort the records, and how to return a data set to its 
original sort order.

If you want to automate a particular find or sort, you can save the 
instructions for it in a macro. For information about this, see “Saving 
a find request as part of a macro” on page 11-11.

Approach can find the records in a database that match certain 
criteria, such as records for all products more than $200 or for all 
customers in San Francisco. When Approach finds records that 
match your criteria, it displays only those records rather than the 
entire database. 

Finding data in 
records

Before searching, you 
see all the records in a 
database.

In this report, Approach 
found and displayed only 
the records for customers 
in San Francisco.
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Finding records allows you to focus on a subset of your data. You 
may want to view, edit, print, delete, or export only those records 
that have a particular aspect in common. Or you may want to find 
records that have errors, such as blank fields or fields with values 
that are less than a specified minimum.

The group of records that Approach isolates is called the found set. 
The Browse or Preview status bar shows the number of records in the 
current found set and the number of records in the entire database.

When Approach searches for records, it looks through all the records 
in a database, not just those in the current found set. Thus, if you 
have Approach find a set of records while you’re already viewing 
another found set, the new set may include records you haven’t been 
viewing.

When you’re finished working with a found set, you can go back to 
seeing all the records in the database by clicking the Show All icon or 
by choosing Show All from the Browse menu. (In a worksheet or 
crosstab report, you’ll find Show All in the Worksheet Find or 
Crosstab Find submenu.) Show All also returns records to their 
original sort order.

You tell Approach what to search for by filling out one or more find 
requests. Each request has search criteria—the specific information to 
look for in the records.

You create a find request in Find. When you’re in Find, the default 
icon bar has icons you can click to insert operators in search criteria.

 

Number of records in the found set, 
in relation to the entire database

Creating a find 
request

Open File

Save Approach File Find

Show AllComparisons

WildcardsOr

And

Sounds Complex 

Range FormulaEnter

Design

Browse

Case-Sensitive

ExpressionLike
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A new find request is a blank copy of the view—the form, report, 
worksheet, or crosstab—you’re currently using. You enter the criteria 
in fields of the find request. If the view contains a summary field, you 
see the summary field along with all of the other fields in the find 
request. 

The first time you use a particular field for a find (or for a sort), 
Approach compiles all values in the field into a Smart Index. Once a 
field has an index, any future finds or sorts go much faster. After 
Approach has found the records that match the criteria, it returns to 
Browse and displays the found set in the current view.

This section provides general instructions for creating a find request. 
See the sections that follow for specifics about different types of 
requests.

To create a find request:

1. Change to the form or report you want to use for finding records.

2. Click the Find icon or choose Find from the Browse menu. In a 
worksheet or a crosstab, Find appears in the Worksheet Find or 
Crosstab Find submenu.

You go to Find, and a find request appears.

3. Type search criteria in the appropriate fields.

You can type criteria in a find request just as you type data in a 
regular form or report. Type criteria in as many fields as 
necessary to define the search.

Searching is faster in a main 
database than in a detail one. 
If possible, use a form or 
report that is based on the 
database you want to search.

A find request is a blank 
copy of the view you’re 
using.

The more fields you use for 
search criteria, the more 
limited the search will be.
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You can find on a summary field only when it summarizes a 
group of records sorted by a field. You can’t find on a grand total 
summary field or one that summarizes by a number of records.

You can use the following operators with search criteria. Either 
type an operator in the field, or click where you want the 
operator to go and then click its icon in the icon bar.

If you have Or criteria in more than one field, you need to set up 
a find request for each field. For more information, see “Finding 
records with one of several criteria (Or)” on page 11-5.

4. Click the Enter icon, click the OK button at the top of the find 
request, or press ENTER to begin the search.

This operator Specifies

< Less than

> Greater than

<= Less than or equal to

>= Greater than or equal to

= Equal to (if alone, finds blank fields)

<> Not equal to (if alone, finds nonblank fields)

, Or criteria within a field

& And criteria within a field

… Range of values (for example, A…D)

* Wildcard for zero or more characters

? Wildcard for one character

@ Comparison with the result of a formula (used 
with another operator, such as in =@Today() or 
another fieldname (=@Fieldname))

! Case-sensitive text search

~ Sounds like

If Complex expressions

If you want to cancel a find 
while Approach is still 
searching, press ESC.
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Approach finds the records that match the search criteria and 
displays the found set of records. When Approach finishes 
searching, you return to Browse, where you see the first record in 
the new found set.

When you enter criteria in more than one field in a find request, 
Approach finds the records that match all the criteria. This is known 
as an And search.

■ To find records with multiple criteria, type criteria in more than 
one field in a find request.

You can also use an If statement to specify an And search. For details, 
see “Using an If statement to find data” on page 11-10.

You can specify several criteria and have Approach find the records 
that match at least one of the criteria. This is known as an Or search.

If the Or search involves data in only one field, you can separate the 
criteria with a comma in that field of the find request. If the Or search 
involves data in more than one field, you need to set up a separate 
find request for each field. In this second case, a set of find requests 
defines the search criteria.

■ To find records with Or criteria in one field, separate the criteria 
with a comma in that field in one find request.

■ To find records with Or criteria in more than one field, create a 
separate find request for each field. 

After creating a find request for the first field, choose Find More 
from the Browse menu, click the Find More button at the top of 
the find request, or click the Find icon again to get a new blank 

Finding records 
with multiple 
criteria (And)

This request finds 
employees who work 
in Finance and live in 
San Francisco.

Finding records 
with one of several 
criteria (Or)

This request finds 
employees who work in 
Finance or Payroll and 
live in San Francisco.
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request for the next field. Do not click the Enter icon or the OK 
button or press ENTER until you’re finished creating the entire set 
of find requests.

 

When you’re viewing a find request in a set, you can change to other 
requests in the same set by clicking the Previous Record, Next 
Record, First Record, or Last Record icons in the icon bar or the 
arrow buttons in the status bar.

You can also use an If statement to specify an Or search. For details, 
see “Using an If statement to find data” on page 11-10.

Approach can find text that matches a string of characters, a word, or 
a phrase in a text field.

■ To find text, type the characters in a text field. 

Precede the characters with an equal sign (=) if you want the 
match to be exact. 

For example, the search text Payroll finds Payroll, Payroll Dept., 
and any other text that begins with the search text. =Payroll in a 
field finds only Payroll.

Wildcard characters
You can include asterisks (*) and question marks (?) as wildcards in a 
text search. 

The asterisk matches any number of characters in the field, including 
no characters. For example: 

• *past* finds records that contain the text past anywhere in the 
search field. (This is the best way to find text in a memo field, 
because it finds text beyond the first word in the field.)

• san* can find San Francisco and Santa Rosa.

• *r* can find red and green but not blue. (blue has no r)

• *o can find solo and trio but not dot. (dot does not end in o)

• g*s can find grants and goods but not green. (green starts with g but 
does not end in s)

This pair of requests 
finds invoices that are 
more than $200 or dated 
before April 30, 1994.

Finding text
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The question mark matches any single character. For example:

• to? can find toy and Tom but not today. (today has more than one 
letter after to)

• ?an can find ran and pan but not plan. (plan has more than one 
letter before an)

• to??y can find today and Tommy but not toy and Tom. (toy and Tom 
start with to but they don’t have two letters and a y)

• ?o? can find Tom and son but not today and Troy. (today has more 
than one letter after the o, and Troy has more than one letter 
before the o)

You can include an ampersand (&) in search text to look for a string 
that contains two text values. This is especially useful with 
wildcards. For example, the search text *Barb*&*Susan* finds records 
that contain both Barb and Susan anywhere in the search field.

Case-sensitive searches
Whether a search is case-sensitive depends on the file type of your 
database. A search in a dBASE, FoxPro, or Paradox 4.0 database is 
not normally case-sensitive, but a search is case-sensitive in a 
Paradox 3.5 database, a SQL table, or a database you open through 
ODBC. An Approach preference lets you make searches in a Paradox 
4.0 database case-sensitive (see “Setting database options for a 
Paradox file” on page 19-10 for instructions).

If you want to limit a search to be case-sensitive, you can precede the 
characters with an exclamation mark (!).

For example, in a database that is not case-sensitive, the search text 
Madrid finds text that begins with Madrid, madrid, and any other 
combination of uppercase and lowercase letters in the search text. 
!Madrid finds only text that begins with Madrid, with a capital M. (You 
cannot use the equal sign and the exclamation mark together.)

Approach can locate words that sound like other words. This is 
particularly useful when you know how a name or other proper 
noun sounds, but aren’t sure how to spell it.

■ To find a word that sounds like another, precede the search text 
with a tilde (~).

For example, the search text ~Philip finds Philip, Filip, Philippe, and 
similar-sounding words.

Be careful not to type any 
extra spaces in search text.

Finding a word 
that sounds like 
another



11-8 User’s Guide

You can find a value in a numeric, Boolean, date, or time field or in a 
calculated field that returns a number, Boolean value, date, or time. 

Typing numeric, date, and time search criteria is similar to entering 
these kinds of values in the fields of a regular view. For more detailed 
information about entering numbers, dates, and times, see “Entering 
data in fields” on page 10-7.

If you have a number, date, or time as search criteria, the match will 
be exact so you don’t need to precede the criteria with an equal sign. 
But you may want to use the operator <>, <, <=, >=, or > with the 
criteria. For example, >200 finds numbers that are greater than 200, 
and <>8:30 finds times that are not 8:30 AM.

■ To find a number, type the number in a numeric or calculated 
field.

Do not type other characters such as currency signs or commas 
with the number. If the field has a format, Approach provides 
these characters automatically.

■ To find a Boolean value, type 0 or 1 in a Boolean or calculated 
field.

■ To find a date, type the date as numbers in a date or calculated 
field. Separate the numbers with non-numeric characters such as 
slashes (/). 

Type one, two, three, or four digits for the year. One-digit and 
two-digit years are assumed to mean the twentieth century. If 
you don’t type a year, Approach assumes the current year (based 
on your system settings) and enters it for you.

■ To find a time, type the time as numbers in a time or calculated 
field. Separate the numbers with colons.

You can use either a 12-hour or a 24-hour format. If you enter an 
hour less than 12 without a suffix of AM or PM, Approach 
assumes AM.

Approach can look for values that fall within an inclusive range in a 
text, numeric, date, or time field or in a calculated field that returns a 
number, date, or time.

■ To find values in a range, enter an ellipsis (…) between the 
beginning value and the ending value of the range.

Finding numbers, 
dates, and times

You can type a single number 
to find a date for the current 
month and year.

You can type a single number 
to enter only an hour.

Finding values in a 
range
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For example, H…J in a text field finds all text strings that begin with 
H, I, or J. 7…9 in a numeric field finds the values 7, 8, and 9. 
5-1-94…5-31-94 finds all dates in the month of May 1994.

You cannot mix wildcards and other text operators with the ellipsis.

You can find the current date in a date field or in a calculated field 
that returns a date.

■ To find today’s date, enter a comparison operator and @Today() 
in a date or calculated field.

The operators you can use are  =, <>, <,<=, >=, and >.

The Today function returns the current date on your system clock, 
and the at sign (@) tells Approach to compare the system date from 
the Today function with values in the records.

For example, =@Today() specifies that you want an exact match with 
the system date.

You can look for all records that have a particular combination of 
radio button and checkbox settings. 

■ To find radio button and checkbox settings, turn on the radio 
buttons and checkboxes in the find request to specify the 
combination you want to find.

If you want to specify a No value for a checkbox, such as “payment 
not received” in the example above, click the checkbox to turn it on 
and then click it again to turn it off. A checkbox is Null until it is 
clicked at least once.

Approach can isolate records with blank values in a particular field. 
This can help you identify errors in data entry or find records that 
don’t have complete information yet. A field is considered blank if it 
has a Null value or no value. 

Approach can also find fields that are not blank.

Finding today’s 
date

Finding radio 
button and 
checkbox settings

This request finds 
invoices that are for 
restaurants and for 
which payment has 
been received.

Finding blank or 
nonblank fields
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■ To find blank fields, enter an equal sign (=) by itself in a field. To 
find nonblank fields, enter a not-equal sign (<>) by itself in a 
field.

An If statement is a concise and powerful tool for comparing data in 
two or more fields. You can use an If statement in a find request to 
build complex search criteria.

When you use an If statement for finding data, Approach returns a 
value of Yes or No based on the If statement for each record in the 
database. The records that return Yes are included in the found set.

■ To use an If statement to find data, type an If statement in an 
unused field in a find request.

The statement can include field references, constant values, and 
any of the other search operators. Enclose text, date, and time 
constants in single quotation marks. You can put the statement in 
any field in the request; it does not have to be one of the fields 
referred to in the statement. You do not have to begin the 
statement with an equal sign or an @ sign.

For example, this statement finds records that have a higher value in 
the ActualCost field than in the Budget field:

If(ActualCost>Budget) 

You can also combine expressions in an If statement with the And 
and Or operators. For example,

If((Department='Finance')And(City='San Francisco'))
If((Amount>200)Or(Date<'4/30/94'))
If((Today()–InvoiceDate<=90)And(BalanceDue>0))

To compare If statements to a search using multiple fields, see 
“Finding records with multiple criteria (And)” on page 11-5 and 
“Finding records with one of several criteria (Or)” on page 11-5.

If a field reference refers to a field in a joined database, include the 
name of the database in the reference. The database name must be in 
all capital letters. Separate the database name and the field name 
with a period. For example,

Using an If 
statement to find 
data

Combining expressions in an 
If statement is a more concise 
way to specify complex 
criteria than using multiple 
fields.

If(ORDERS.Quantity>SUPPLY.Quantity)
Database names

Field names
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Enclose a field name in double quotation marks if it begins with a 
number, or if it contains a space, a period, a comma, or one of the 
following characters:

/, #, +, –, <, >, (, )

Approach keeps track of your most recent search so that you can 
easily repeat it, as long as you are still in a view based on the same 
database and you have not used the Show All command.

To repeat a search:

1. Choose Find Again from the Browse menu. In a worksheet or 
crosstab, Find Again appears in the Worksheet Find or Crosstab 
Find submenu. 

The find request appears. You can edit the request if you’d like to 
redefine the found set.

2. Click the Browse icon or press ENTER.

If you’ve created a find request that you’d like to preserve for future 
use, Approach allows you to save that find request as part of a macro. 
When you create the macro, you can include the Find command in 
the macro and attach the current find request to the macro.

To save a find request as part of a macro:

1.  Create a new macro.

See “Defining a macro” on page 15-1 for information about 
creating a new macro. You might want to use a name for the 
macro that describes the find request.

2. In the Define Macro dialog box, select the Find command and 
add it to the command grid.

See “Example 2: Finding a set of records” on page 15-17 for 
information about creating a macro that finds records.

3. In the Find a Set of Records area, click “Perform a stored find 
when the macro is run.”

4. Click OK to create the macro and click Done to close the Macros 
dialog box.

To execute the stored find, simply run the macro.

Repeating a 
search

Note that if you have added or 
deleted records, you may get a 
different found set this time.

Saving a find 
request as part of 
a macro



11-12 User’s Guide

In addition to searching for specific information, you can also find all 
records that have either the same value in a field or a distinct value. 
With this type of find, Approach searches in the current found set 
(not the entire database) either for duplicates of any value or for each 
occurrence of a distinct value. 

Finding records with duplicate values can help you check for errors 
in data entry or remove redundant records from your database. 
Approach lets you find all records that share duplicate values or just 
the extra ones. 

For information about deleting records after finding them, see 
“Deleting a found set of records” on page 10-24.

Finding duplicate 
or distinct values

Before finding duplicate 
records, you see all the 
records in a database.

This report shows all 
duplicate records.

This report shows all 
extra duplicate records 
after the first one.

After finding duplicate 
records, you can see 
either all duplicate 
records or just the extra 
duplicates.
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Finding records with distinct values lets you weed out duplicate 
values to see what your unique value set is. For example, when you 
have multiple customer records for a company that has several 
locations, finding distinct records lets you see how many unique 
companies are in your customer database.

In an Approach file with joined databases, you can find duplicates or 
distinct records only in the current view’s main database.

When you’re finished working with a found set, you can go back to 
seeing all the records in the database by clicking the Show All icon or 
by choosing Show All from the Browse menu. In a worksheet or 
crosstab, Show All appears in the Worksheet Find or Crosstab Find 
submenu. This also returns records to their original sort order.

To find duplicate or distinct values:

1. Find the records in which you want to look for duplicate or 
distinct values, or show all records in the database.

2. Choose Find Special from the Browse menu. In a worksheet or 
crosstab, Find Special appears in the Worksheet Find or Crosstab 
Find submenu.

Before finding distinct 
records, you see all the 
records in a database.

In this report, Approach 
found and displayed one 
record for each distinct 
account number.

If you want to cancel a find 
while Approach is still 
searching, press ESC.
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The Find Special dialog box appears.

3. Click “Find duplicate records in the current found set” or “Find 
unique or distinct records in the current found set.”

If you select “Find duplicate records in the current found set,” 
you can exclude the first duplicate record in each set of 
duplicates. Otherwise, Approach finds all records that have the 
duplicate values in the fields you specify.

4. Move the fields you want to check from the Database Fields list 
to the Fields to Search list.

To move a field to the Fields to Search list, select the field name 
and click Add, or double-click the field name.

To move a field back to the Database Fields list, select the field 
name and click Remove, or double-click the field name. To move 
all the fields back to the Database Fields list, click Clear.

5. Click OK.

Approach finds records that have a duplicate or distinct value in 
any of the fields you specified. You see the first record in the new 
found set.

Approach stores records either in the order in which you add them to 
the database (creation order) or according to an order that you set as 
an Approach preference (see “Setting a default order for records” on 
page 19-5 for instructions). 

Move fields to the Fields 
to Search list.

Specify whether to find 
duplicate or distinct 
records.

Specify 
whether to 
show all 
duplicate 
records or 
only the 
extra ones.

Turn on “Exclude first 
record found in each set of 
duplicates” if you plan to 
delete the extras so that you’ll 
still have one of each set of 
duplicates.

Memo and calculated fields 
do not appear in the Database 
Fields list. You cannot find 
duplicates with these fields.

Sorting records 
by data in fields
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If neither of these is the order you want for viewing or for working 
with the records, you can sort the database to rearrange records 
according to data in a field or a set of fields.

You can sort records by text fields in alphabetical order, by numeric 
fields in numerical order, and by date and time fields in 
chronological order. A sort can be in either ascending order (A to Z, 
lowest to highest, earliest to latest) or descending order (Z to A, highest 
to lowest, latest to earliest).

When you’re working with a found set of records, a sort applies only 
to the records in the set rather than to the entire database.

The Browse status bar shows the position of the current record in the 
sort order.

Sorting only temporarily changes the order of records. You can 
re-sort records a different way or go back to the original order at any 
time. Approach also keeps track of the last sort you did so that you 
can perform the same sort again (as long as you are still in a view 
based on the same database).

When you’re ready to return records to their original order, you can 
click the Show All icon or choose Show All from the Browse menu. 
This also shows all records in the database.

Before sorting, records 
appear in the order they 
were added to the 
database.

In this report, the records 
are sorted by company 
name in ascending order.

Position of the current 
record in the sort order.
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You can sort records according to the contents of any field that 
appears in a view. You can sort in ascending order or descending 
order.

To sort records by a field:

1. Click the field to select it.

In a report or worksheet select the field column.

2. Click the Ascending Sort or Descending Sort icon.

Approach sorts the records in the found set according to the 
contents of the field you selected.

You need to tell Approach which field or fields to use for sorting and 
whether the sort in each field should be ascending or descending.

The first field you specify is the primary sort field. Approach sorts 
the records by the contents of that field. You can also specify other 
sort fields for Approach to use in case any records have the same 
value in the primary field. For example, you might use Last Name as 
a primary sort field and First Name as an additional sort field.

A sort field can be a text, numeric, Boolean, date, time, or calculated 
field.

To specify a sort order:

1. Find the records you want to sort, or show all records in the 
database.

2. Choose Define from the Browse Sort submenu. In a worksheet, 
Define appears in the Worksheet Sort submenu. In Preview, you 
can click the Sort icon.

The Sort dialog box appears.

Sorting by a field

Specifying a sort 
order

If you want to cancel a sort 
while Approach is still 
sorting, press ESC.

To save a sort, perform the 
sort once and then attach it to 
a macro. 

Specify a sort direction 
for each sort field.

Move the sort Fields 
to the Sort On list.

Click to sort on a 
summary field.
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3. Specify the primary sort field by moving a field from the 
Database Fields list to the Fields to Sort On list.

To move a field to the Fields to Sort On list, select the field name 
and click Add, or double-click the field name.

To move a field back to the Database Fields list, select the field 
name and click Remove, or double-click the field name. To move 
all the fields back to the Database Fields list, click Clear.

The Database Fields list shows the names of fields for the 
database selected in the Database Fields drop-down list (just 
above the list). If a field you want is in a different database joined 
to the current Approach file, select the name of the database in 
the drop-down list. The Database Fields list shows the fields for 
that database.

4. Click Ascending or Descending for the primary sort field.

Ascending sorts text from A to Z, numbers from lowest to 
highest, and dates and times from earliest to latest. If a text field 
has numbers and text, the sorting is 0 to 9 and then A to Z. 

Descending sorts data in the opposite direction. If a text field has 
numbers and text, the sorting is Z to A and then 9 to 0. Leading 
spaces are sorted after text and numbers.

5. If necessary, specify additional sort fields in the same way.

For each field, move the field name to the Fields to Sort On list, 
and click Ascending or Descending for each field.

You can have as many sort fields as you need. Approach sorts the 
records using the fields in the order in which they appear in the 
Fields to Sort On list.

6. To sort on a summary field, click Summaries.

The Sort dialog box expands to show a list of summary fields.

If a number, date, or time sort 
doesn’t seem right, make sure 
the field is defined as 
numeric, date, or time rather 
than as text.

The Summary Fields list 
shows all summary fields 
in the current view.
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7. Move any summary fields you want to sort on to the Fields to 
Sort On list. 

8. If you want to sort on a summary field that appears in more than 
one summary panel, select an option in the Summarized On 
drop-down list to identify the field.

9. Click OK.

Approach rearranges the records in the found set or the entire 
database. You see the first record in the new sort order.

The Sort dialog box stores the instructions you specified the last time 
you sorted. If you want to sort records a different way, you can open 
the dialog box again and make changes to it.

■ To add another field to the end of the sort order, select the field 
name in the Database Fields list and click Add, or double-click 
the field name.

■ To remove a field from the sort order, select the field name in the 
Fields to Sort On list and click Remove, or double-click the field 
name.

■ To remove all the fields from the sort order, click Clear.

■ To change the direction in which a field is sorted, select the field 
name and click Ascending or Descending.

You can show all the records in a database again, in their original sort 
order. This is the order in which they were entered, unless you’ve set 
the Approach preference for sorting order. Showing all records 
removes the effect of the most recent find and most recent sort you 
performed.

■ To show all records in their original order, click the Show All icon 
or choose Show All from the Browse menu.

In a worksheet or crosstab, Show All appears in the Worksheet 
Find or Crosstab Find submenu.

Approach shows all the records in the database. You see the first 
record.

Changing the sort 
order

Showing all 
records in original 
sort order
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12 Designing Worksheets and Crosstabs

Worksheets and cross-tabulation worksheets (crosstabs) are tabular 
views you can use to view and work with information from your 
database. The worksheet view presents database records in a grid of 
columns and rows. The columns are database fields; the rows are 
individual records. 

The crosstab view takes the worksheet one step further. It allows you 
to summarize data over two or more categories and to group records 
into hierarchies based on database fields, giving you a different 
perspective on your data. In a worksheet, for example, you might 
look at a found set of sales records. In a crosstab, you could view 
summaries of those same sales records, grouped and subtotaled by 
sales region, by product, or by product within a region.

This chapter describes how to create and modify worksheets and 
crosstabs.

An Approach worksheet is composed of columns that show database 
fields and rows that show individual database records. When you 
first create a worksheet, the column headers are the same as the field 
names, but you can change the headers to show any text you wish.

About worksheets 
and crosstabs

The column header 
shows the field name or 
other text.

A column shows values for a field.

A row shows values for a single record.
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An Approach crosstab expands on the worksheet model, allowing 
you to categorize and summarize database records. Instead of rows 
containing individual records, a crosstab shows you cells that 
summarize underlying records grouped or categorized by any fields 
you select. You can create a simple crosstab that either counts or 
summarizes data for groups of records, or a multiple-level crosstab 
that summarizes data for different groups of records by categories. A 
group (like a found set) is any set of records that have a common 
value in the field you specify. A category is a database field.

This illustration shows a simple crosstab that counts the number of 
records for each product where the Sales Rep field is filled in and 
summarizes the total amounts sold for each product.

This illustration shows a multiple-level crosstab, which summarizes 
sales by product and sales rep.

Worksheets and crosstabs give you a great deal of flexibility for 
viewing data. For example, you can move columns from one position 
to another, add or remove fields, or add columns (or crosstab rows) 
that perform calculations. You can also select a range of cells in a 
worksheet to edit multiple records at the same time. 

Summary of all 90 Cabernet sold

Count of all 91 Cabernet records 
with a value in the Sales Rep field

Unique values in 
Product field

SCount(Sales Rep 
per product)

SSum(Amount per 
product)

Summary of all cases 
sold by Lindsay

Summary of all 90 
Zinfandel sold

Summary of all 91 
Zinfandel sold by Lindsay
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A new worksheet or crosstab automatically opens in Browse, where 
you can edit your data and change the layout at the same time. 

You can change the way a worksheet or crosstab is organized by 
adding, removing, or moving fields. You can also change the 
worksheet’s appearance by resizing columns or rows, by editing the 
column header text, or by adding color to text or background. 

You can perform all of the same data functions in a worksheet that 
you can in other Approach views, including finding and sorting 
records, duplicating them, and editing database field values. Data in 
a crosstab cannot be edited or duplicated.

When you print a worksheet or crosstab, Approach automatically 
adds a title, page number, and date.

Approach provides a Worksheet Assistant to help you create a 
worksheet view. Using the Worksheet Assistant, you select the fields 
that will initially appear on the worksheet. You can easily add or 
remove fields once the worksheet has been created.

Approach automatically creates a worksheet when you open a 
database file directly (instead of opening an Approach file).

To create a worksheet:

1. Choose Worksheet from the Create menu.

In Browse, you can 
edit data, change the 
worksheet layout, edit 
column headers, and 
add color.

Creating a 
worksheet
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The Worksheet Assistant appears.

2. Select a different main database if necessary in the Database 
Fields drop-down list.

3. Add the fields you want to show on the worksheet to the Fields 
to Place on View list.

To add a field to the Fields to Place on View list, select the field in 
the Database Fields list and click Add, or double-click the field. 
Approach displays the fields in the order listed.

To remove a field from the Fields to Place on View list, select the 
field and click Remove, or double-click the field.

4. Click Done.

The Define Main Database dialog box appears if you select fields 
from more than one joined database. Otherwise, Approach 
displays the new worksheet.

5. If the Define Main Database dialog box appears, select a database 
in the Main Database drop-down list and click OK.

Approach creates the worksheet and opens it in Browse.

Select fields to display on 
the worksheet.

Select a main database 
for the view.
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Approach gives you two ways to create a crosstab: with the Crosstab 
Assistant or by dragging fields in a worksheet to summarizing 
positions.

Approach provides a Crosstab Assistant to help you create a crosstab. 
The Crosstab Assistant allows you to name the crosstab and select 
the fields that are displayed in the crosstab rows, those in the crosstab 
columns, the field whose data is summarized in the body of the 
crosstab, and the formula used to calculate body cells.

In addition to columns and rows for the fields that you select, 
Approach adds a summary row at the bottom of the crosstab and a 
summary column at the far right. You can remove these summaries if 
you don’t want them.

When you select more than one field for either columns or rows, 
Approach nests the fields in the order you list them, with the first 
field listed at the highest or outermost level. For example, if you list 
Country first and then City, Approach groups the cities within the 
countries.

If you want to create a simple crosstab (one without any categories), 
select a field for rows and one for body cell values, but don’t select a 
field for columns. Approach creates a simple crosstab with counts if 

Creating a 
crosstab

Creating a 
crosstab with the 
Crosstab Assistant

Field selected for crosstab 
columns is Sales Rep.

Field selected for crosstab 
rows is Product.

Field selected for 
crosstab body is Amount.
Formula for body cells is 
SSum(Amount).

Country 1 Country 2 Country 3

City 1 City 2 City 3 City 1 City 2 City 3 City 1 City 2 City 3

Crosstab headers 
when Country is listed 
first, and then City
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the Value field is text and with summaries if the Value field is 
numeric.

When you create a simple crosstab, you can drag fields from the Add 
Field dialog box to create additional columns or to convert the simple 
crosstab to a multiple-level crosstab.

To create a crosstab:

1. Choose Crosstab from the Create menu.

The Crosstab Assistant appears.

2. Select a different main database if necessary.

3. Add the fields you want to show as crosstab rows to the Fields to 
Place on View list.

To add fields to the Fields to Place on View list, select the fields in 
the Database Fields list and click Add, or double-click a field. 
Approach nests the fields in the order listed, with the first field at 
the highest level. 

To remove a field from the Fields to Place on View list, select the 
field and click Remove, or double-click the field.

4. Click the Columns tab and add the fields you want to show as 
crosstab columns to the Fields to Place on View list.

Formula for body cells is SSum.

Field selected for crosstab body 
is Amount.

Field selected for 
crosstab rows is Product.

Select fields for crosstab 
rows. Fields appear in 
the crosstab in the order 
you select them.

You can click a tab or use the 
Next and Back buttons to go 
to other tabs.
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When you click the tab the Columns panel appears.

Approach nests the fields in the order listed, with the first field at 
the highest level. 

5. Click the Values tab.

When you click the tab the Columns panel appears.

6. Select a formula in the Calculate list and a field in the Of Field 
list.

This is the formula Approach will use to calculate the values that 
appear in body cells. The same formula applies to all body cells 
except for special summary rows.

7. Click Done.

Select fields for crosstab 
columns. Fields appear 
in the crosstab in the 
order you select them.

Select a calculation type 
and the field to be 
calculated.
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The Define Main Database dialog box appears if you select fields 
from more than one joined database. Otherwise, Approach 
displays the new crosstab.

8. If the Define Main Database dialog box appears, select a database 
in the Main Database drop-down list and click OK.

Approach creates the crosstab and opens it in Browse.

Because worksheets and crosstabs are so similar, you can easily 
convert a worksheet to a simple crosstab by dragging a worksheet 
field to a summarizing position at the left side of the worksheet. 

Then, you can turn a simple crosstab into a multiple-level one by 
dragging other fields into the body of the crosstab, or into grouping 

Select a main database 
for the view.

Turning a 
worksheet into a 
crosstab

Product 1

Product 2

Product 3

Product 4

Product 5

Product 6

Sales Rep Amount
To turn a worksheet into 
a simple crosstab, just 
drag a column header to 
a grouping position.

Worksheet

Resulting simple crosstab
ProductAmountSales Rep

SCount SSum
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positions in the row gutter or in the column gutter at the top of the 
worksheet. 

Approach is preset to calculate a summary sum for each crosstab 
body cell. If you want the crosstab to calculate a different value, you 
can edit the crosstab formula (see “Editing a crosstab formula” on 
page 12-25). 

To turn a worksheet into a crosstab:

1. Drag a field from the column gutter at the top of the worksheet 
or from the Add Field dialog box to the row gutter on the left 
side of the worksheet.

If you drag too far, the move cursor becomes a trashcan and you 
remove the field from the worksheet.

Approach creates a simple crosstab as soon as you release the 
field, with all of the unique values for the field that you dragged 
to the row gutter along the left side. In the body of the crosstab, 
Approach displays counts for text fields and sums for numeric 
fields.

Simple crosstab

Resulting multiple-level crosstab
To turn a simple 
crosstab into a multiple-
level one, drag a column 
header into a grouping 
position at the top of the 
crosstab.

Product 1

Product 2

Product 3

Product 4

Product 5

Product 6

Amount Amount Amount Amount
Sales 1 Sales 2 Sales 3 Sales 4Product 1

Product 2

Product 3

Product 4

Product 5

Product 6

Sales Rep Amount

SSum(Amount)

Field dragged to row gutter

Summary of numeric Amount field 
values for all 90 Merlot records

Count of all 91 Zinfandel records with 
a value in the Sales Rep text field

Unique values in Product 
field
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2. To turn the simple crosstab you just created into a multiple-level 
one, drag a field (column or row header) to the column gutter at 
the top of the crosstab.

Approach displays guide lines to show when the database field 
is positioned correctly.

Approach groups and summarizes records by sales rep and 
displays calculated summary values in the crosstab cells.

Approach automatically opens a new worksheet or crosstab in 
Browse, where you can both edit your data and change the layout of 
the worksheet or crosstab. If there’s a password attached to the 
Approach file, you won’t be able to change the format in Browse 
(you won’t see any of the formatting tools, for example); you must go 
to Design to make formatting changes.

The Sales Rep field is 
dragged to a grouping 
position

Guide lines appear when the 
field is placed correctly.

The crosstab shows 
calculated summary 
values.

Working with 
worksheets and 
crosstabs
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This illustration shows the different parts of a typical worksheet.

When you work with a worksheet in Browse, these are the preset 
SmartIcons you’ll see.

This element Does this

Worksheet tab Displays the worksheet name and turns to the 
worksheet when you click it

Row marker Shows that the entire row, or one of its cells, is 
selected

Row gutter Holds row headers when you convert a 
worksheet to a crosstab; you drag a column 
header from the column gutter or from the Add 
Field dialog box and drop it in the row gutter

Pane dividers Divide the worksheet into independently 
scrolling panes when you drag them into place

Column gutter Holds column headers; you drag a field to the 
column gutter to add it to the worksheet

Column gutter

Pane divider

Row gutter

Row marker

Worksheet tab
Pane divider

Open File

Save Approach File

Send Mail

Design

Show All

Find

Descending Sort

Ascending Sort

Delete RecordPreview

Previous Record

First Record

Last Record

New Record

Select Column

Print Next Record

Browse

Fast FormatInsert Column

Show Info

Header

Add Field
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This illustration shows the different parts of a typical crosstab.

When you work with a crosstab in Browse, these are the preset 
SmartIcons you’ll see.

Approach also provides information about the crosstab in the status 
bar at the bottom of the Approach window.

This element Does this

Crosstab tab Displays the crosstab name and turns to the 
crosstab when you click it

Column gutter Holds column headers; you drag a field to the 
column gutter to add it to the crosstab

Row gutter Holds row headers; you drag a co lumn header 
from the column gutter or from the Add Field 
dialog box and drop it in the row gutter

Pane dividers Divides the crosstab into independently-scrolling 
panes when you drag them into place

Pane divider
Row gutter

Column gutter
Crosstab tab

Save Approach File

Show All

Find

Browse

Add Row

Add Column

SumPreview

Undo

Chart

Show Data

Average

Count

Print

Copy

Design

Column Header

Show Info

Fast Format

Select Column

Add Field

Open File

Send Mail

This area displays a description of the crosstab or a selected field.
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In an Approach worksheet or crosstab, you can select one or more 
contiguous columns, one or more contiguous rows, one or more 
column headers, individual cells, or a range of cells. You can also 
select all column headers and row markers or the entire worksheet or 
all columns and rows in a crosstab. 

You might, for example, want to select a column to resize it, or select 
its header to add a fill color. You might select a row to resize it, or a 
select range of cells in a worksheet to quickly edit several records at 
once.

■ To select a single cell, click in the cell.

In a worksheet, double-click to select the text in the cell for 
editing. The pointer changes to the text cursor.

■ To select a range of cells, click in a cell and drag in any direction.

■ To select a column, click the column header and keep the mouse 
down. Drag to select multiple columns.

■ To select just the column header, select the column and click the 
Column Header icon.

Selecting in a 
worksheet or 
crosstab

Worksheet row marker 
shows that a cell in this 
row is selected.

Worksheet row marker 
shows that a cell in this 
row is selected.

Click a header to select 
the column.
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You can also double-click the header, or select the column and 
then choose Header Only from the Worksheet Select or Crosstab 
Select submenu.

■ To select just the column cells (and not the column header), click 
the column header to select the column and click the Column 
icon. 

You can also select the column and choose Cells Only from the 
Worksheet Select or Crosstab Select submenu.

■ To select a worksheet row, click to the left of the row. Shift-click 
to select multiple rows.

A row marker appears to show that the worksheet row is 
selected.

■ To select a crosstab row, click the row header. Shift-click to select 
multiple rows.

Double-click a header to 
select it.

Shading indicates that 
the column header is not 
selected.

Click here to select a row.

Row marker

Click here to select a row.
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■ To select the entire worksheet or crosstab, click in the upper-left 
corner of the worksheet.

Click the upper-left corner of the worksheet a second time to 
select all of the column headers and all rows (but not the data). 
You might want to select the column headers and rows, for 
example, to resize all of the columns at the same time to the same 
size.

Once you’ve selected all or part of a worksheet or crosstab, you can 
copy the selection to the Clipboard for pasting, linking, or 
embedding in a document created by another applications. When 
you copy the entire worksheet or crosstab, Approach places several 
forms of the worksheet or crosstab on Clipboard:

• An object that you can embed

• A Windows Metafile format (WMF) image that you can paste as 
a graphic

• Tab-delimited text that you can paste into a spreadsheet program 

When you select a range of cells in a worksheet, Approach places it 
on the Clipboard as a pastable WMF object and as tab-delimited text.

■ To copy a selection to the Clipboard, select the portion of the 
worksheet or crosstab that you want to copy and choose Copy 
from the Edit menu.

For more information about linking and embedding object, see 
Chapter 16, “Exchanging Data with Other Files or Applications.”

Click here to select the 
entire worksheet.

Click here a second time 
to select all column 
headers and rows.

Copying a 
selection to the 
Clipboard
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When you select a range of cells in a worksheet, you can use either 
the TAB key or the ENTER key to move from one cell to the next. TAB 
moves you from left to right in a row before moving to the beginning 
of the next row; ENTER moves you down one column before moving 
to the top of the next. In either case, Approach selects the contents of 
the cell so that you can edit it.

If you’re looking at a worksheet or crosstab that contains a great deal 
of data, you might not be able to see all of the columns or rows on the 
screen at the same time. When data that you want to view is out of 
sight, you can divide a worksheet or crosstab horizontally or 
vertically into independently scrolling panes. 

You can, for example, divide a worksheet horizontally into two 
panes so that you can see the first few records and the last few. If you 
divide the worksheet vertically, you might be able to see the first and 
last columns.

When a worksheet is divided into panes, you can scroll any pane to 
display a particular cell you want to view, and you can select a cell in 
any pane just by clicking the cell.

This illustration shows a crosstab divided into four panes, each with 
its own scroll bar.

Navigating in a 
worksheet or 
crosstab

TAB moves from left to 
right across rows.

ENTER moves from top 
to bottom in columns.

Dividing a 
worksheet or 
crosstab into 
panes

Drag here to adjust the 
location of both divider 
bars at the same time.
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■ To divide a worksheet into panes, drag the pane divider to the 
desired location. 

You can adjust the position of the pane dividers by dragging 
them to a new position. You can adjust both pane dividers at the 
same time by dragging the point where they intersect.

Approach gives you many different ways to change the appearance 
of a worksheet or crosstab without affecting the data that’s 
displayed. You can:

• Add database fields

• Move or delete columns to a different location

• Resize columns and rows

• Insert a blank column (or crosstab row) for a special calculation

• Edit and format column header text

• Use the InfoBox to change the background color, or add borders 
to worksheet columns (and to crosstab columns or rows)

You can accomplish all of these tasks in Browse. If there’s a password 
associated with the Approach file, you must be in Design to alter the 
appearance of a worksheet.

You can easily add fields to either a worksheet or a crosstab using the 
Add Field dialog box. 

To add a database field to a worksheet or crosstab:

1. Click the Add Field icon or choose Add Field from the Worksheet 
or Crosstab menu.

Drag down 
to create 
horizontal 
panes.

Drag to the right to create 
vertical panes.

Changing the 
appearance of a 
worksheet or 
crosstab

Adding a database 
field to a 
worksheet or 
crosstab
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The Add Field dialog box appears. It shows all of the fields in the 
current main database.

2. Drag a field from the Add Field dialog box to the worksheet 
column gutter, or to either the column gutter or the row gutter of 
a crosstab.

Release the field name where you want the column to appear. A 
vertical guide line shows you where the column will be located.

You can move the column to another position later if you wish.

When you create a worksheet or crosstab, Approach arranges fields 
in the order you list them in the Worksheet Assistant or Crosstab 
Assistant. However, you can easily move a field from one location to 
another without affecting your data. If you no longer want to see a 
particular database field displayed on a worksheet or crosstab, you 
can easily remove it from the view. 

To move a column:

1. Select the field that you want to move.

This list shows all of the 
fields in the main 
database.

Select a different 
database in this list if 
necessary.

Placement guide

Moving o r removing 
a field in a view
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You can select multiple worksheet columns by dragging to select 
additional column headers and have Approach move them as a 
block. You can move only one crosstab field at a time.

2. Place the pointer on a selected column header. When the pointer 
becomes the move cursor, drag the column to the position you 
want.

A vertical guide shows you where the column will be placed 
when you release it.

■ To remove a field from a worksheet or crosstab, select the column 
or row header and drag it above the column gutter (the pointer 
shows a wastebasket).

You can also select the column or row header and press DELETE. 
Approach removes the column from the worksheet or crosstab.

Approach initially sizes worksheet and crosstab columns so that they 
are just large enough to display the field data. Worksheet and 
crosstab rows are also just large enough to display their data. If the 
data in a field is longer than the field name, you’ll only see as much 
data as will fit.

Move Cursor

Drag the column 
header to the 
position you want. 

Vertical guide shows you 
where column will appear.

The wastebasket shows 
that a field will be 
removed. 

Resizing columns 
and rows

If the column is too narrow, Approach 
shows only as much data as will fit.
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If you want to display hidden data or just improve the appearance of 
a worksheet or crosstab, you can easily resize columns or rows to 
meet your needs. In a worksheet, you can resize a single column or 
multiple columns to the same size. You can also resize all rows to the 
same size. In a crosstab, you can resize rows individually or as a 
group.

Approach uses two special resizing tools—the column sizer and the 
row sizer. The pointer changes to the column sizer when you 
position it between two column headers. It changes to the row sizer 
when you position it on the border between rows.

To resize columns:

1. Select the columns that you want to resize.

If you select more that one column, Approach will make them all 
the same size.

2. Place the pointer between column headers to the right of the 
column you want to resize and when the pointer becomes the 
column sizer, drag the column to the size you want.

A vertical guide shows you the right edge of the column as you 
drag it.

■ To resize rows, place the pointer in the row gutter at the bottom 
border of any row and when the pointer becomes the row sizer, 
drag the row to the size you want.

Column sizer

Drag the right 
column border to 
resize a column. 

Guide shows right edge 
of column as you drag.

The pointer becomes the column 
sizer when you position it between 
columns.

Row sizer
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In a worksheet, Approach resizes all rows to the same size. In a 
crosstab, Approach resizes only the row you drag. To resize all 
crosstab rows, select them before dragging a row (SHIFT-click to 
select multiple rows).

In addition to columns that display data from database fields, you 
can add a formula column to a worksheet or a blank column and use 
it for spacing. You might, for example, add a formula column that 
summarizes data, one that averages data, or one that shows the 
variance between two columns of data. 

Approach uses the wedge tool to add blank or formula columns to a 
worksheet. The pointer changes to the wedge when you position it 
between the tops of column headers.

To add a formula column:

1. Position the pointer between the tops of column headers where 
you want the column to appear. When the pointer changes to the 
wedge, click.

You can add a column between columns or at either end of the 
worksheet.

The Formula dialog box appears. 

2. Create the formula you want to use in the Formula dialog box 
and click OK.

To add a blank column, click Cancel in the Formula dialog box.

■ To remove a blank or formula column, select the column header 
and drag it above the column gutter (the pointer shows a 
wastebasket). You can also select the column header and press 
DELETE.

Drag the bottom row 
border to resize all 
worksheet rows to 
the same size.

Inserting a formula 
or blank column 
in a worksheet

Wedge

Pointer positioned to add 
a column
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■ To edit the formula in a formula column, double-click any cell in 
the column to open the Formula dialog box.

Approach calculates the formula for each cell in the column. You 
can use any of the Approach functions or compose your own 
formula.

Approach is preset to use field names as column headers in 
worksheets and crosstabs. However, you can change the header text 
to be anything you want—a more descriptive name, perhaps, or a 
shorter one.

To edit column header text:

1. Select the header you want to change.

To select header text, triple-click the header, or choose Edit 
Column Label from the Worksheet or Crosstab menu.

2. Edit the text.

Worksheets and crosstabs, like all other Approach views, have access 
to an InfoBox that lets you:

• Change the worksheet or crosstab name. The worksheet or 
crosstab name appears on the view tab and serves as the view 
title when you print it (See “Changing the basic properties of a 
view” on page 5-36.)

Formula typed in 
cell subtracts 
projected sales from 
actual sales.

Column shows the 
resulting calculated 
value for each 
record.

Editing column 
header text

The column header text 
is selected for editing.

Changing 
worksheet and 
crosstab settings
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• Attach a macro or custom menu to the view (See “Attaching a 
macro to a view” on page 15-15 or “Creating a custom menu bar” 
on page 19-18.)

• Add a background color to column headers or column cells and 
crosstab rows (See “Changing line or color settings for an object” 
on page 5-19.)

• Add a border to the cells in a column or in a crosstab row (See 
“Changing line or color settings for an object” on page 5-19.)

• Change the font, font size, or color of text that appears anywhere 
in a worksheet or crosstab (See “Changing text attributes” on 
page 5-23.) 

This illustration shows some of the cosmetic changes you can make 
to a worksheet using the InfoBox.

Although you add color to a crosstab the same way you do to a 
worksheet, the results are slightly different. In a crosstab, when you 
assign color to a column or row header, all columns or rows that are 
nested within that column or row also take on the new color.

For example, when you assign a color to Country 1, all City columns 
in Country 1 take on the same color. If you move Country 1 to 
another position, it still retains its color.

When you print a worksheet or a crosstab, you can add a header that 
contains the worksheet or crosstab title, and a footer that contains the 
page number (in the lower-right corner) and the current date (in the 
lower-left corner). 

To format a worksheet or crosstab for printing:

1. Click the Show Info icon to open the InfoBox for the worksheet 
or crosstab.

Header text style
Column text style

Column fill color

Header fill color

Column border

Country 1 Country 2 Country 3

City 1 City 2 City 3 City 1 City 2 City 3 City 1 City 2 City 3

All columns nested in 
Country 1 take on the 
same color.

Formatting a 
worksheet or 
crosstab for 
printing
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2. Click the Printing tab.

The InfoBox displays settings that affect how a worksheet or 
crosstab looks when it’s printed.

3. Change the settings as necessary and close the InfoBox.

Approach lets you add special summary columns or rows to a 
crosstab. A summary column uses the same formula as the other 
body cells in the crosstab. A summary row can use any formula you 
choose. You might, for example, add a row that averages all entries in 
a group. When you have nested fields in a crosstab, Approach adds a 
summary column or row to each nested field. For example, if you 
insert a summary column for Sales Reps, Approach adds the column 
to each Sales Rep group.

You can insert a summary column or row in three ways: by using the 
wedge, by using the Summarize Columns or Summarize Rows 
commands, or by using the Add Row or Add Column icons. Adding 
a column or row to a crosstab with the wedge is like adding a column 
to a worksheet. You simply position the pointer until it turns into the 
wedge and click. Approach inserts the appropriate columns or rows 
and uses the current summary function for calculations. 

Type a new title for the 
worksheet or crosstab.

Adding summaries 
to a crosstab

Approach adds a 
summary column to 
each group.

Adding a 
summary column 
or row
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When you add a column or row using an icon or a Crosstab menu 
command, Approach automatically places summaries at the end of 
each group in the crosstab. 

■ To add summaries to a crosstab, choose Summarize Columns or 
Summarize Rows from the Crosstab menu, or click the Add 
Column or Add Row icon.

Approach adds the appropriate blank columns or rows. You can 
then use the Formula command to select the calculation you 
want the column or row to perform.

■ To remove a summary from a crosstab, select the column or row 
and press the DELETE key.

Approach uses a single formula to calculate summary columns and 
the body cells in a crosstab. In addition, Approach can use different 
formulas to calculate special summary rows that you can add to 
crosstabs. 

Approach gets its initial formula when you create the crosstab. If you 
create a crosstab from a worksheet, Approach automatically uses the 
summary sum calculation for numeric fields and the summary count 
calculation for text fields. If you use the Crosstab Assistant, you can 
select a formula when you create the crosstab. 

You select the formula that Approach uses for special columns or 
rows when you insert them.

If you want to perform a different set of calculations, either for body 
cells or for special summary columns or rows, you can easily change 
the formula at any time.

To edit a crosstab formula:

1. Select a value header or the header for a summary row.

If you select a group column header, Approach applies the new 
formula to all body cells. If you select a summary row, Approach 
applies the new formula to that row.

New summary column

Editing a crosstab 
formula
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2. Click the Show Info icon to open the InfoBox for the crosstab and 
click the Formula tab.

You can also click one of the summary icons.

3. Select a formula in the Formula list.

Approach calculates the appropriate cells and displays the new 
results.

Select a formula in the list.
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13 Creating Charts

A chart is a view that shows data in a visual representation. In 
Approach, you create and work with charts using the Lotus Chart™ 
facility. You can create many popular chart types in two and three 
dimensions and in color. And after you create a chart, you can easily 
change the chart’s type, enhance it by working with its parts, and 
add text and graphics to it. A chart, like any other type of view, is 
stored in the Approach file.

This chapter describes how to create charts using the Chart Assistant, 
how to create an instant chart, how to change the type of a chart, and 
how to enhance the appearance of a chart. 

Most of the instructions in this chapter require you to be in Design. 
To go to Design, click the Design icon or choose Design from the 
View menu or from the environment pop-up menu in the status bar.

You can select and manipulate charts the same way you do other 
types of design objects—for example, you can resize, move, and 
group them. For information about working with design objects in 
general, see Chapter 5, “Working in Design.”

A great deal of the Lotus Chart documentation is online in Chart 
Help (click the Help icon or press F1 from a chart to open it). Chart 
Help contains information on enhancing charts, as well as a glossary 
of chart terms. It describes how to use the Chart InfoBox, how to 
decide which type of chart best displays your data, and how to 
change the attributes of chart components.

A chart is a graphic representation of data. Charts reveal the 
significance of data and often make complex data easier to 
understand. If you’re analyzing data, charts can help you identify 
trends and relationships. Charts are also dynamic; if you change the 
data a chart is based on, Approach updates the chart automatically.

About charts
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All charts except pie charts plot data against a horizontal x-axis and a 
vertical y-axis. The x-axis can include a scale or categories such as 
years, geographic areas, or age ranges. The y-axis can define the scale 
of values plotted in the chart. You can show tick marks and labels for 
units of measure with an axis, and you can title each axis to describe 
the data plotted against it.

In addition to graphic information, a chart can also include a title, a 
subtitle, a legend, and a note.

When you create a chart directly from a crosstab (it’s called an instant 
chart), Approach uses a preset chart type (initially set to bar chart). 
When you create a chart using the Chart Assistant, you can choose 
from four types of charts: bar, line, area, or pie. Regardless of how 
you create a chart, you can easily use the Chart InfoBox to change the 
chart’s type to one of the 20 chart types supported by Lotus Chart. 
You can also add, modify, or delete other chart elements using the 
InfoBox. 

Approach gives you two ways to create a chart: by using the Chart 
Assistant or directly from a crosstab. For more information about 
creating an instant chart, see “Creating an instant chart from a 
crosstab” on page 13-9.

The Approach Chart Assistant guides you through creating a chart. 
You use the Chart Assistant to give the chart a name, a SmartMaster 
style (two-dimensional or three-dimensional), and a SmartMaster 
layout (a chart type). You also select the fields that appear on the 
chart’s x-axis and y-axis, define the calculated values to be plotted, 
and if the chart contains a series (a set of values plotted along the 
x-axis), you select the field for grouping the series. If you’re creating 
a pie chart, you select the field that appears as pie wedges.

Subtitle

Y-axis

X-axis

Plotted area

Y-axis title

X-axis title

Title

Legend

Note

Creating a chart
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A SmartMaster style determines whether the chart is two- or three-
dimensional. The SmartMaster layout determines the chart type. 
When you create a chart using the Chart Assistant, you can choose 
from among four chart types: bar, line, area, and pie.

Bar, line, and area charts each display information along the x-axis 
and y-axis.

Bar charts are the most common type of business chart. The 
SmartMaster Bar chart layout is a standard vertical bar chart, where 
each bar represents a single value in a series. The height of each bar 
shows a value at a point in time. The left-to-right orientation gives 
the viewer a sense of movement with time. Bar charts are good for 
comparing individual values.

Line charts trace the changes in sets of data over time. Each point 
along a line represents a value at a particular time period or point in 
time, and each line represents a category of data. Line charts are often 
the best choice for time series data, especially when you have a lot of 
data points. You might use a line chart, for example, to show daily 
sales over two months.

Creating a bar, 
line, or area chart
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Area charts show trends in data over time by emphasizing the area 
under the curve created by each data series. Like line charts, area 
charts downplay individual values and emphasize trends and totals. 
Use area charts to see relationships between sets of data rather than 
the individual data points. You might use an area chart to show 
trends in sales from one quarter to the next.

To create a bar, line, or area chart:

1. Choose Chart from the Create menu.

The Chart Assistant appears.

2. Type a name for the chart in the View Name & Title text box.

A new chart automatically has the name Chart and a number; 
you can use any name you want, up to 30 characters. The name 
you use appears on the chart’s view tab and as a default on 
printed charts.

3. Select a SmartMaster style for the chart in the SmartMaster Style 
drop-down list.

Type a name for the chart.

Select a named style.

Select a chart type.



Creating Charts 13-5

The drop-down list shows SmartMaster styles that Approach 
provides. The styles specify properties such as background color 
for the chart and text attributes for data and field labels.

4. Select a SmartMaster layout for the chart in the SmartMaster 
Layout list. 

5. Click the X-axis tab and select a field for the x-axis of the chart.

When you click the tab, the X-axis panel appears. 

6. Click the Y-axis tab and define the calculation for the y-axis.

When you click the tab, the Y-axis panel appears. 

To define the y-axis calculation, first select the calculation that 
you want to use. Next, select the field that you want to calculate. 

If you want to calculate a field from a different joined database, 
select the database in the drop-down list.

You can click a tab or use the 
Next and Back buttons to go 
to other tabs.

Select a field for the chart’s 
x-axis.

Select a field for the chart’s 
y-axis.
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7. If you want to include a series in the chart, click the Series tab 
and select a field for the series.

When you click the tab, the Series panel appears. A series is a set 
of values plotted in a chart along the x-axis.

8. Click Done.

The Define Main Database dialog box appears if you select fields 
from more than one joined database. Otherwise, Approach 
displays the new chart.

9. If the Define Main Database dialog box appears, select a database 
in the Main Database drop-down list and click OK.

Approach creates the chart, and because the chart displays 
summary information, Approach places it in a large summary 
panel.

Select a field for the chart’s 
series.

Select a main database 
for the view.
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Pie charts show the relationships of various parts to the whole. Each 
data value is represented by a slice of the pie, and the size of the slice 
corresponds to the percentage of the total. Use a pie chart when you 
want to compare five or six values in a single series to a total.

To create a pie chart:

1. Choose Chart from the Create menu.

The Chart Assistant appears.

2. Type a name for the chart in the View Name & Title text box.

A new chart automatically has the name Chart and a number; 
you can use any name you want, up to 30 characters. The name 
you use will appear on the chart’s tab card and as a default on 
printed charts.

3. Select a SmartMaster style for the chart in the SmartMaster Style 
drop-down list.

The drop-down list shows SmartMaster styles that Approach 
provides. The styles specify properties such as background color 
for the chart and text attributes for data and field labels.

4. Select Pie chart in the SmartMaster Layout list. 

Creating a pie 
chart
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Approach adds a Pie Fields tab and changes the illustration in 
the Sample Chart area.

5. Click the Pie Fields tab, select a field for each pie wedge, select a 
calculation, and select a field to be calculated. 

When you click the tab, the Pie Field panel appears. 

6. Click Done.

The Define Main Database dialog box appears if you select fields 
from more than one joined database. Otherwise, Approach 
displays the new chart.

7. If the Define Main Database dialog box appears, select a database 
in the Main Database drop-down list and click OK.

Approach creates the chart, and because the chart displays 
summary information, Approach places it in a large summary 
panel.

The Pie Fields tab 
appears when you 
select the Pie chart type.

You can click a tab or use the 
Next and Back buttons to go 
to other tabs.

Select a field for the pie 
wedges.

Select a calculation and a 
field to be calculated for 
the pie wedges.
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You can also create a chart directly from a crosstab by clicking the 
Chart icon. Approach creates a vertical bar chart displaying the data 
in the crosstab. The values in the body of the crosstab are plotted as 
the chart bars. The crosstab rows are charted along the x-axis with 
crosstab groups (from columns) as the series. This illustration shows 
a crosstab and the resulting instant chart. 

Approach creates a default title, axis titles, and legend.

To create an instant chart from a crosstab:

1. Make sure that the crosstab contains the data that you want to 
chart. 

If necessary, you can change to a different set of data later. See 
“Charting a different data set,” next.

2. Click the Chart icon.

Approach creates the chart and displays it with a default title and 
default axis titles.

Creating an 
instant chart from 
a crosstab

This crosstab...

...yields this chart.

Fields from the crosstab’s 
rows are plotted along the 
x-axis.

Fields from the crosstab 
columns are plotted as 
x-axis series and appear 
in the legend.

Crosstab body values 
are plotted on chart bars.
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Once you’ve created a chart, you can change the set of data that it 
displays by specifying a new data source. If you use the Find 
command to create a found set of records, Approach automatically 
charts the found set. 

To chart a different data set:

1. Choose Chart Data Source from the Chart menu.

The Chart Data Source Assistant appears. This dialog box 
contains three panels that are identical to the last three panels of 
the Chart Assistant.

2. Select a field to appear on the x-axis.

3. Click the Y-axis tab and define the calculation for the y-axis.

When you click the tab, the Y-axis panel appears. 

Charting a 
different data set

Select a field for the chart’s 
x-axis.

Select a field for the chart’s 
y-axis.
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To define the y-axis calculation, first select the calculation that 
you want to use. Next, select the field that you want to calculate. 

If you want to calculate a field from a different joined database, 
select the database in the drop-down list.

4. Click the Series tab and select a field for the series.

When you click the tab, the Series panel appears. A series is a set 
of values plotted in a chart along the x-axis.

5. Click Done.

The Define Main Database dialog box appears if you select fields 
from more than one joined database. Otherwise, Approach charts 
the new data.

6. If the Define Main Database dialog box appears, select a database 
in the Main Database drop-down list and click OK.

Approach charts the new data.

Select a field for the chart’s 
series.

Select a main database 
for the view.
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Approach provides a total of 20 different chart types, including 
three-dimensional bar, line, area, mixed, and pie charts. After 
creating a chart, you can change it to the type you want. Which type 
you use depends on how you want to present your data.

This section describes how to change the type of an existing chart. 
For information about the different chart types see the online Chart 
Help; for advice on which chart type to use, see “Choosing the best 
type of chart” on page 13-13.

To change the type of a chart:

1. To open the Chart InfoBox, select the chart and click the InfoBox 
icon or double-click the chart.

The Chart InfoBox appears.

2. Select a chart type from the palette.

Approach displays the chart as the new type.

This section illustrates the different types of charts you can use in 
Approach. “Choosing the best type of chart,” next, is a table with 
advice about which type of chart to use for your needs.

Keep in mind that Approach offers three-dimensional versions of 
bar, line, area, mixed, and pie charts. Three-dimensional charts look 
dramatic and are ideal for presentations.

Changing the type 
of a chart

Click here to open the 
palette of chart types.

Types of chart
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You can select from these 20 types of charts.

When charting data, think about which chart type most clearly 
represents the data. The table below provides some suggestions for 
choosing the right chart for the job.

To show Use this chart type For example

Items that change over 
time

Bar, line, stacked bar, area Annual sales from 1988–1993; 
30-day stock trend

Items at a specific point 
in time

Horizontal bar, horizontal stacked 
bar

1993 sales for five products; 1993 
costs by month

Parts of the whole Pie, 100% horizontal stacked bar, 
100% area

Market share by company; 
percentage of office space used in 
New York by an industry

Frequency distributions Bar Number of homes in various price 
ranges; number of employees in 
various age ranges

Relationships between 
variables

Bar, Scatter (XY) Level of education compared to 
hours spent watching TV; average 
drop in asking price for home 
versus length of time on market

Ranges of data Bar Daily temperature ranges in 
February for Juneau, Alaska

Area Area depth 3D area Bar Horizontal bar

Stacked bar Horizontal
stacked bar

Bar depth Stacked bar
depth

3D bar

HLCO Line Line depth 3D line Mixed

Mixed depth 3D mixed Pie 3D pie Scatter (XY)

Choosing the best 
type of chart
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The Chart InfoBox provides you with tremendous flexibility in 
styling your charts. With separate panels for each chart component, 
the Chart InfoBox lets you make a wide variety of stylistic changes to 
a chart. For more information about using the Chart InfoBox, see the 
comprehensive online Chart Help.

The table that follows lists the types of settings you can change for 
each chart element.

For this element You can

Whole chart Change the chart type and layout, data presentation, 
and other options that vary with the chart type

Title Select the first line, second line, or title frame for 
formatting, and change the title’s position on the chart

Legend Select the text or frame for formatting, change the 
layout of the legend, and change its position

X-axis Change parts of the x-axis, including the title, subtitle, 
line, tick mark labels, and major and minor tick marks 
and grid lines

Y-axis Change parts of the y-axis, including the title, subtitle, 
line, tick mark labels, and major and minor tick marks 
and grid lines

Series Select a series and plot it against a second y-axis on the 
right side of the chart using a different symbol and 
change other elements depending on chart type

Plot Change the position of the plot area

Note Select the first line, second line, or note frame for 
formatting, and change the note’s position at the 
bottom of the chart

Using the Chart 
InfoBox

Click to select a different chart component.

Click to change the chart type.

Click to change the chart layout.

Click a tab to display additional settings.
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A second section of the Chart InfoBox, the Style Panel, controls text, 
line, and fill styles.

■ To open the Chart InfoBox, select the chart and click the Show 
Info icon or double-click the chart.

Text style settings include color, font, 
alignment, and numeric formats.

Line style settings include color, style, and shadow.

Fill style settings include color and pattern.
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14 Previewing and Printing

You can print all the records in a database or a found set of records, in 
any view. You can also print a single record if you’re using a form.

This chapter explains how to specify printer and print setup options 
and how to preview and print views.

When you print a view in Approach, the data and design objects 
appear in the printed copy as they do on screen in Preview. If you 
have any objects you don’t want to appear in printed copy (such as 
buttons to click to run a macro), you can define those objects as non-
printing using their InfoBox in Design.

When you print a report, worksheet, or crosstab that has a header or 
footer, the header or footer appears on every printed page. The area 
between a header and footer is the body of the view. Approach prints 
as many records on a page as will fit in the body. 

If a view has any summary calculations that apply to a range of 
records, in most cases Approach calculates the summaries only when 
you preview or print. (The exception is a summary for line items in a 

How a view looks 
when printed

A form has one record per 
printed page. If you want to 
show more records per page, 
use a report or worksheet.

Approach calculates summaries 
when you preview or print.

If a view has a header 
or footer, it appears on 
every printed page.

Annual Report  1

Region
Sales

Region Total

District
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repeating panel, which is summarized in Browse and in Design if 
you’re showing data.) A summary panel in a report can appear 
before or after the records it summarizes.

If a view has fields or other objects that need to slide up or left, the 
fields slide when you preview or print.

If a report has a title page, Approach prints a copy of the page at the 
beginning of the view. A title page can have its own header and 
footer.

Before printing a view, you need to select a printer and specify other 
print setup options. The printer, paper size, and page orientation 
together determine the printable area on a page.

When you start Approach, the default printer is the one selected in 
the Windows Control Panel. If you are working on a network, you 
may also have other printers available.

To specify the printer, paper, and orientation:

1. Choose Print Setup from the File menu.

The Print Setup dialog box appears.

2. Select a printer in the Printer area.

Default Printer uses the printer selected in the Windows Control 
Panel.

If you want a different printer, select Specific Printer and select 
the name of the printer in the drop-down list. The list shows up 
to eight printers set up for use with your computer.

3. Select a page orientation in the Orientation area.

Specifying the 
printer, paper, and 
orientation

Select a printer.

Select which direction to 
place the view on the page.

Select a size 
and a source 
for the paper.

If a view won’t fit on a 
printed page, check the page 
orientation.
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Portrait places the view on the page vertically, and Landscape 
places the view on the page horizontally.

4. Select a paper size and a source in the drop-down lists in the 
Paper area.

5. Click OK.

Additional settings
The Options button in Printer Setup displays an Options dialog box 
with more settings specific to your printer. For information about 
these settings, click the Help button in the Options dialog box.

The Preview environment shows what a view will look like when 
printed. It’s good practice to preview a view before printing so that 
you can make any necessary corrections—this may save you some 
time and paper later.

■ To go to Preview, click the Preview icon or choose Preview from 
the File menu or from the environment pop-up menu in the 
status bar.

When you first go to Preview, you see your current view reduced to 
75 percent of its normal size. 

The pointer turns into a zoom cursor in Preview. You can change to 
another zoom setting by clicking the left mouse button to zoom in or 
the right mouse button to zoom out, by choosing Zoom In or Zoom 
Out from the View menu, by pressing CONTROL and the up arrow or 

Previewing a view

The current view initially 
appears at 75 percent of 
its normal size.

Zoom cursor
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down arrow key, or by choosing from the zoom pop-up menu in the 
status bar. The possible zoom settings in Preview are 25, 50, 75, 100, 
and 200 percent. 

You can change to 100 percent in one step by choosing Actual Size 
from the View menu or 100 from the zoom pop-up menu.

All of the data from Browse also appears in Preview. You can move 
through records in Preview as you can in Browse, but you cannot 
click in fields, edit data, or edit design objects. Go to Browse if you 
need to make changes to data, and go to Design if you need to make 
changes to objects.

You can make a non-printing object appear in Preview by turning on 
Non-printing in the Basics panel of the object’s InfoBox. If a macro 
button appears in Preview, the zoom cursor turns into a pointer 
when you move over the button so that you can click it to run a 
macro.

If a view has any fields that summarize data from multiple records, 
Approach calculates the summary in Preview and shows the results. 
If a view has fields or other objects that slide up or left, the fields 
slide into position in Preview and in Design if you’re showing data.

The default icon bar in Preview has icons for creating and opening 
files, printing, moving from one record to another, and finding and 
sorting records. You click an icon to apply the command.

The status bar in Preview is the same as it is in Browse, except that it 
shows the zoom setting. If the view is paginated, you see the page 
numbers in the status bar rather than the record numbers.

Zoom settings affect only how 
a view appears on the screen. 
Approach always prints at 
100 percent.

You may want to show a non-
printing button in Preview so 
that you can run its macro.

Open File

Save File

Send Mail

Print

Preview

First Record

Previous Record

Next Record

Last Record

Design

Browse

Find

Show All

Sort

View name Environment Record number Records in the found set

Click an arrow to go to the previous or 
next record. Click the record number to 
go to a record by number.

Icon bars

Zoom setting
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The parts of the status bar that show the view name, environment, 
and zoom setting are pop-up menus. You can choose from them to 
change to another view, environment, or zoom setting. The icon bar 
symbol at the right end of the status bar is also a pop-up menu, with 
the icon bars available in the current view.

If you’re working on a network database along with other users, the 
data in the database may change after you go to Preview. You can 
have Approach download a copy of the database on your hard disk 
every time you go to Preview to make sure you’re looking at the data 
that will actually be printed. For more information, see “Setting 
general working preferences” on page 19-14 .

When you’re ready to print, you specify the view, the range of 
records, and the number of copies you want.

To print a view:

1. If necessary, specify the printer and print setup options.

These items determine the printable area of the page. For more 
information, see “Specifying the printer, paper, and orientation” 
on page 14-2.

2. Browse the records you want to print.

Approach prints from the set of records you’re currently using. 
You can show all the records in a database or use a find request to 
show only a found set of records.

3. Change to the view you want to print.

4. If necessary, sort the records.

Approach prints records in the current sort order.

5. Preview the view and make any corrections you need.

Previewing shows how the view will look when printed. For 
more information, see “Previewing a view” on page 14-3.

6. Click the Print icon or choose Print from the File menu.

Printing a view

Before previewing, make sure 
you’ve already selected a 
printer, paper size, and 
orientation so that the 
preview will be accurate.
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The Print dialog box appears.

7. Specify a range of records in the Print Range area.

All prints all the records you’re currently browsing. “Current 
form” prints the current record (this is available only when 
you’re using a form).

Pages prints a range of pages. Type the number of the first page 
of the range in From and the number of the last page in To.

8. Select a print quality in the Print Quality drop-down list.

The choices available depend on the printer.

9. Type the number of copies you want in the Copies text box.

10. If necessary, turn on printing options.

“Print to file” sends the print copies to a file rather than to a 
printer. If you turn this setting on, the Print to File dialog box 
appears when you click OK in the Print dialog box. Specify a 
name and location for the print file.

“Collate copies” prints an entire copy before printing the next 
copy. Otherwise, Approach prints all copies of page 1, then all 
copies of page 2, and so on.

11. Click OK.

Approach prints the records you requested in the current view.

Specify the range of 
records to print.

Select a print quality. Type the number of 
copies you want.

This sends the print 
copies to a file.

This prints an entire copy 
before printing the next copy.

Print to a file on disk if you 
want to use a printer not 
connected to your computer.

If you want to cancel a print 
job, press ESC or click Cancel 
in the print alert box.
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15 Automating Your Work with Macros

A macro is a single command that instructs Approach to carry out a 
sequence of tasks. The sequence can be a single step, such as 
switching from a form to a report, or it can involve multiple steps, 
such as finding all unpaid invoices, sorting them by date in 
ascending order, switching to a past-due notice form letter, and 
printing individual past-due notices. 

By chaining macros together (instructing one macro to run another 
macro), you can automate a sophisticated series of tasks; and by 
attaching a macro to a button or a field, you can put the full power of 
a wide variety of Approach commands right in the middle of a form 
or report.

In another creative way of using macros, you can create an otherwise 
blank form containing a series of macro buttons that substitute for 
menu commands. The macro buttons can take users to a different 
view, for example, for data entry.

This chapter explains how to define a macro, run a macro, and attach 
a macro to a button or other object, to a field, or to a view. It also 
describes how to set Approach to run specific macros when you open 
or close an Approach file.

You can use Approach macros to perform many different types of 
tasks—from finding a set of records to fully automating your data 
entry or invoicing process. Your only limit is your imagination.

You define a macro using the Define Macro dialog box, in which you 
list the tasks you want the macro to do in the order you want them 
performed. Depending on the commands you select, you can also set 
the appropriate options. For example, if your macro definition 
includes the Find command, you can specify the find criteria you 
want. 

Defining a macro
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To define a macro:

1. Choose Macros from the Tools menu.

The Macros dialog box appears. You can also open the Macros 
dialog box by clicking the Define Macro button in a field’s 
InfoBox.

2. Click New.

The Define Macro dialog box appears. Approach is preset to 
show View as the first command in all new macros.

3. Type a name for the macro in the Macro Name text box. 

4. If you want to execute the macro using a function key, select a 
key in the Function Key drop-down list.

Click to create a new macro.

Enter a name and assign 
a function key.

The commands you 
select here...

...determine which 
options you can set here.

If you want to automatically 
run a macro when you open 
or close an Approach file, 
name it Open or Close.
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Defining a function key allows you to run the macro directly 
from the keyboard. Therefore, the drop-down list shows only the 
function keys you haven’t already used. Leave the drop-down 
list set to None if you don’t want to use a function key.

5. Define the actions you want the macro to perform by adding 
commands to the Command grid and specifying the appropriate 
options.

To add a command, click in any cell in the Command column 
and click the down arrow to display a list of available 
commands. Click a command to select it.

Each time you add a command, Approach displays the options 
for that command in the bottom half of the Define Macro dialog 
box and adds a blank line at the end of the Command grid. To 
add another command, click in the next blank cell in the 
Command column and select a command. 

Be sure to list commands in the order you want them carried out. 
For example, if you want Approach to go to the next record 
before printing, make sure that Records appears before Print in 
the Command grid.

You can click the Insert button to add a line within the Command 
grid, or click Delete to delete a selected one.

6. When your macro definition is complete, click OK.

When you select a 
command from this list...

...this panel changes to 
show the options you can 
set for the command.

Click the down arrow to 
see a list of all available 
commands.
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You return to the Macros dialog box, and the macro you just 
defined appears in the Macros list.

7. To display the new macro in the Run Macro menu, select the 
macro name and turn on “Show in menus.”

8. Click Done to close the Macros dialog box.

If you need to add or remove commands in a macro, you can use the 
Insert and Delete buttons to add a new row in the middle of the 
Command grid or to remove a selected row. 

■ To add a command row to a macro, select the row where you 
want the new command to be inserted (click to the left of the 
command to select the row) and click Insert.

Approach adds a blank row above the one you selected.

■ To remove a command row from a macro, select the command 
row (click to the left of the command) and click Delete.

If you need to change the order of the commands you’ve listed in a 
macro, you can easily drag a command to a new location.

To move a command in a macro:

1. Select the row that holds the command you want to move.

New macro

Click to display selected 
macro in Run Macro 
submenu.

Adding and 
removing 
commands 
in a macro

Row marker indicates 
row is selected.

Moving a command 
in a macro
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Click to the left of the command to select the row. The row 
marker indicates that the row is selected.

2. Position the pointer over the selected command.

The pointer changes to a move cursor.

3. Drag the command to the new position.

Guide lines show you where the row will be positioned when 
you release the mouse.

There are more than two dozen commands you can include in an 
Approach macro, many of which have options you can set. These 
options affect the way Approach carries out the command. 

You can select these commands and set these options:

Use this command To do this

Browse Switch to Browse.

Close Close the current Approach file. You can set 
Approach to automatically disconnect from the 
server while the macro runs.

Delete Delete the current record, found set, or Approach file. 
The “Show warning” option opens alert boxes while 
the macro runs that you need to OK before deleting. 

Dial Dial the telephone number in the field you select. 
Approach uses the modem settings you specify in the 
Dialer panel of the Preferences dialog box. See 
“Setting dialing preferences” on page 19-8. 

Row marker indicates 
row is selected.

Move Cursor

Guide lines show you 
where the row will be 
positioned.

About macro 
commands

Continued
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Edit Use these commands from the Edit menu: Cut, Copy, 
Paste, or Select All. You can also have the macro open 
the Paste Special dialog box and wait for input while 
the macro runs. The Edit command is used mostly 
for putting data on the Clipboard or pasting it.

Enter Accept the current record (this is the same as 
pressing the ENTER key or clicking the Enter icon).

Exit Exit Approach.

Export Set export options now (click Edit Export to select the 
records and fields to be exported as well as the 
filename) or set Approach to open the Export Data 
dialog box and wait for input while the macro runs. 
For more information about export options, see 
“Exporting data from Approach” on page 16-12.

Find Perform a stored Find request, show all records in the 
database file, or refresh the found set. You can also 
set Approach to open a Find request or the Find 
Again dialog box and wait for input while the macro 
runs. The stored Find request can be a new one that 
you define now (click New Find) or one that has 
already been defined. You can also edit a stored find 
by clicking Edit Find. If no records are found, you 
can select another macro for Approach to run. See 
“Example 2: Finding a set of records” on page 15-17 
for an example of a macro that finds a set of records. 
See also “Creating a find request” on page 11-2.

Find Special Set Find Special options now (click Edit Find Special) 
or set Approach to open the Find Special dialog box 
and wait for input while the macro runs. For more 
information about Find Special options, see “Finding 
duplicate or distinct values” on page 11-12.

Import Set import options now or set Approach to open the 
Import Data dialog box and wait for input while the 
macro runs. You can set up a new import (click New 
Import) or edit an existing import set up (click Edit 
Import). For more information about import options, 
see “Importing a database file” on page 16-2. 

Use this command To do this

Continued
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Mail Set mailing options now (click Edit Send Mail) or set 
Approach to open the Send Mail dialog box and wait 
for input while the macro runs. See “Sending e-mail 
from Approach” on page 16-16 for more information.

Menu Switch Switch to the menu bar you specify. You can also 
create a custom menu now (click Customize Menus). 
For more information on customizing a menu, see 
“Customizing menus” on page 19-18.

Message Display a message box that contains the title and the 
text you enter. 

Open Set file opening options now (click Files) or set 
Approach to open the File Open dialog box and wait 
for input while the macro runs. The file can be 
another Approach file, a different database file, or 
another application, such as Lotus 1-2-3. You could 
even open a communication application that uses a 
script to upload your data to another computer. For 
more information about opening files, see “Creating 
and opening files” on page 2-3.

Preview Go to Preview.

Print Set printing options now (click Edit Print) or set 
Approach to open the Print dialog box and wait for 
input while the macro runs. For more information 
about printing, see “Printing a view” on page 14-5.

Records Go to a record, hide a record, duplicate a record, or 
create a new record.

Replicate Set replication options now (click Edit Replicate) or 
set Approach to open the Replicate with Notes Server 
dialog box and wait for input while the macro runs. 
For more information about replicating, see 
“Replicating a Lotus Notes database” on page 17-4.

Run Run another macro you select (or continue running 
the current macro) under the conditions that you 
specify in a formula (click Define Formula). You can 
also select a macro to be run when the condition is 
false and you can return to the current macro after 
running that macro. You might also want to use Run 
to perform an initial check before running a second 
macro (see “Example 5: Defining a conditional 
macro” on page 15-23). 

Use this command To do this

Continued



15-8 User’s Guide

You can create a macro that loops through all the records in a found 
set and either ends when it encounters the last record in the found 
set, or continues running. As the macro loops, it can perform 
operations you specify, such as setting a field to a value. Looping 
macros use the Records command to go to the next record and the 
Run command to repeat the same macro. 

To create a looping macro that ends when it reaches the last 
record:

1. Add commands to the macro to be performed within the loop.

2. Select the Records command and use the next record option.

Save Set file saving options now (click Files) or set 
Approach to open the Save As dialog box and wait 
for input while the macro runs. For more information 
about Save As options, see “Saving a copy of an 
Approach file and a database file” on page 2-19.

Set Set the field you specify to the value you enter or the 
formula you define (click the Formula button). You 
can use Set for any uncalculated field. For more 
information about formulas, see “Setting up a 
formula for a calculated field” on page 3-8.

Sort Set sort criteria now or set Approach to open the Sort 
dialog box and wait for input while the macro runs. 
For more information, see “Sorting by a field” on 
page 11-16.

Spell Check Check the spelling of data in records and text in 
memo fields (in Browse) or text in text objects (in 
Design). For more information, see “Checking 
spelling” on page 10-17.

Tab Tab to field or macro button number. Use the Show 
Data Entry Order command (View menu) in Design 
to view or change the data entry order for fields and 
buttons in a form. For more information about data 
entry order, see “Changing the data entry order for 
fields” on page 6-32.

View Go to another view in the Approach file, show a 
view, or hide a view.

Zoom Scale the current window by zooming in or out.

Use this command To do this

Creating a 
looping macro
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3. Select the Run command and run the current macro again. 

Approach automatically ends a looping macro when it 
encounters the last record.

To create a looping macro that runs another macro after it 
reaches the last record:

1. Select the Records command and use the next record option.

2. Select the Run command and click If. Type IsLastRecord() in the If 
formula box.

3. Select “run macro” in the Is True drop-down list and select the 
macro to be run when the last record is encountered in the drop-
down list to the right.

4. Select the Run command and run the current macro again. 

5. Click OK in the Formula dialog box.

After you define a macro, you can edit it to change any aspect of the 
macro. You edit a macro definition the same way you create it—using 
the Macro and Define Macro dialog boxes. You can also use the 
Macros dialog box to delete a macro you no longer need.

To edit a macro:

1. Choose Macros from the Tools menu.

The Macros dialog box appears.

2. Select the macro you want to edit and click Edit.

The Define Macro dialog box appears.

3. Make your changes.

For faster running loops, 
remove any commands from 
the macro that switch to 
another view each time the 
macro is run.

Editing or deleting 
a macro

Select a macro to edit.

Click to edit the selected macro.

Click to create a new copy of 
the selected macro.

If you want to add a new 
macro that performs the same 
tasks as the current macro, 
click Copy instead of Edit.
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You can change any aspect of the macro. To change the macro 
name, type the new name. To add or delete commands, use the 
Insert or Delete buttons.

4. Click OK to close the Define Macro dialog box.

You return to the Macros dialog box.

5. Click Done.

To delete a macro:

1. Choose Macros from the Tools menu.

The Macros dialog box appears.

2. Select the macro you want to delete and click Delete.

3. Click Done.

If the macro is attached to a macro button, the button no longer 
does anything. You may want to delete the button or attach 
another macro to it.

Approach lets you attach a macro to a macro button or an object (text 
or graphic), to a field, or to a view. 

If you attach a macro to a button or object, you can run the macro 
simply by clicking the button or object. Macro buttons make it easy 
to run macros if you’re automating a complex procedure that uses 
lots of macros or setting up a file for other users. 

In addition to attaching a macro to a button or object, you can also 
attach a macro to a field in a view or to the view itself. This allows 
you to set up macros that run automatically when you tab into or out 
of a specific field, when the data in a field changes, or when you 
switch to or from a view.

Select a macro to delete it.

Click to delete the selected macro.

Attaching macros 
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You can add a button to a view and attach a macro to the button. In 
Browse, Approach will run the macro whenever you click, tab into, 
or tab out of the button (depending on how you set up the macro).

You can add a macro button to a view and either attach an existing 
macro or define a new macro for the button. If both the button and 
the macro already exist, you can also attach the macro to the button.

To add a macro button:

1. In Design, click the Macro Button icon or choose Macro Button 
from the Create Drawing submenu.

The Macro Button icon is in the Tools palette.

If you plan to draw more than one macro button, you can 
double-click the icon. The icon stays selected until you select a 
different one. On a color monitor, the icon changes to blue.

2. Drag to draw the button.

The InfoBox shows the Macros panel for the button.

3. Select one or more macros for the button in the drop-down lists 
in the Attached Macros area.

You can have Approach run a macro when you click the button 
or when you tab into or out of it.

4. If you need to define a macro, click Define Macro and use the 
dialog box that appears.

5. Click the Basics tab in the InfoBox.

Adding a macro 
button and 
attaching a macro

You click or tab to a 
button to run its macro.

Select macros for the 
button.

Click here if you need 
to define a macro.
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The InfoBox shows the Basics panel for the button.

6. Type a label for the button in the Button Text box.

7. If you want, set options to change the appearance of the button.

To attach a macro to an existing button:

1. In Design, select the button and open its InfoBox.

You can click the Show Info icon or double-click the button. 

2. Click the Macros tab.

The InfoBox shows the macro settings for the button or object.

To Do this

Give a button a drop shadow Select a color in the drop-down 
palette. Select T for transparent 
(no shadow).

Apply a named style with 
width, color, and text 
properties already defined

Select a style in the Named Style 
drop-down list.

Make a button non-printing Turn on Non-printing.

Show a non-printing button in 
Preview

Turn on Show in Preview. (This is 
available only if Non-printing is 
on.)

Type a label for the button.

Select a color for the 
button’s drop shadow.

Select a named style with 
predefined properties.

Turn these on to make the 
button non-printing or to 
show it in Preview.

Select a macro in one of 
these lists.
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3. Select a macro name in one of the three lists.

If you include the macro button in the view’s data entry order 
you can have a macro activated when you tab to the button or 
away from it. Use the Show Data Entry Order command in 
Design to view or change the data entry order for fields and 
buttons in a form. For more information about data entry order, 
see “Changing the data entry order for fields” on page 6-32.

You can attach a macro to any object. In Browse, Approach will run 
the macro when you click the object. (You must click a part of the 
object that does not have a transparent border or fill color to run the 
macro.)

To attach a macro to an object:

1. In Design, select the object and open its InfoBox.

You can click the Show Info icon or double-click the button. 

2. Click the Macros tab in the InfoBox, and set the options in the 
Macros panel.

To attach a macro that runs Select a macro name in the

When you tab to the button “On tab into” list

When you tab away from the button “On tab out of” list

When you click the button “On clicked” list

To Do this

Run a macro when you click an 
object in Browse

Select a macro in the Attached 
Macros drop-down list.

Attaching a macro 
to an object

Select a macro for the 
object. Click here if you need to 

define a macro.

Continued
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You can attach up to three macros to a field. In Browse, Approach 
will run a macro whenever you tab into or out of the field or edit data 
in it (it depends on how you set up the macro). 

You might set up a macro that sets an initial value in a field when you 
tab into it, or one that skips fields in a form based on the data 
entered. For example, in an order entry form, you might run a macro 
when you leave the last address field that skips the sales tax field 
when the order is being shipped to a location that does not collect 
sales tax.

To attach a macro to a field:

1. In Design, select the field and click the Show Info icon.

You can also double-click the field.

2. Click the Macros tab and set the options in the Macros panel.

3. Select the macros you want to run

4. If you want to define a new macro, click Define Macro and use 
the Define Macro dialog box to name and define the macro.

Define a new macro or redefine 
an existing one

Click Define Macro and use the 
dialog box that appears.

To attach a macro that runs Select a macro name in the

When you tab or click into the field “On tab into” list

When you tab out of the field or click 
another field

“On tab out of” list

When the value in the field changes “On data change” list

To Do this

Attaching a macro 
to a field

Click here if you need to 
define a macro.

Select macros for the field.
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You can attach up to two macros to a view. In Browse, Approach will 
run a macro whenever you change into or out of the view 
(depending on how you set up the macro). 

To attach a macro to a view:

1. In Design, click in the background of the view and open its 
InfoBox.

You can click the Show Info icon or double-click in the 
background of the view.

2. Click the Macros tab in the InfoBox, and set the options in the 
Macros panel.

Approach gives you four ways to run a macro: from a function key, 
from a menu command, from the Macros dialog box, or from a 
button (or other object). If a macro is attached to a field or a view, 
Approach automatically runs the macro at an appropriate time. You 
don’t need to do anything else to run it.

The way you run the macro depends on how it is defined. For 
example, to run a macro from a function key the macro must have a 
function key assigned. Likewise, to run a macro from the Run Macro 
submenu the macro must be defined to appear in the menu.

To Do this

Run a macro when you change 
into or out of a view in Browse

Select a macro in one or both drop-
down lists under Attached 
Macros.

Define a new macro or redefine 
an existing one

Click Define Macro and use the 
dialog box that appears.

Attaching a macro 
to a view

Select macros for the view.

Click here if you need to 
define a macro.

Running a macro
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■ To run a macro from the menu, choose Run Macro from the Tools 
menu and choose the macro you want from the submenu.

If you have more macros than fit in the submenu, choose More 
Macros. Approach opens a dialog box that lists your macros.

■ To run a macro using an assigned function key, press the function 
key.

■ To run a macro that’s attached to a button or other object, click 
the button or object.

■ To run a macro that’s attached to a field, tab to or from the field 
or change data in the field.

■ To run a macro that’s attached to a view, switch to or from the 
view.

■ To run any macro, choose Macros from the Tools menu, select the 
macro in the Macros dialog box, and click Run.

A good way to learn about macros (and to get ideas for ways you can 
use them) is to look at some sample macros.

In the sections that follow, you’ll find five sample macros that 
perform different types of tasks, ranging from switching from one 
view to another (the simplest example), to updating fields based on a 
conditional formula (a more complex example), to a macro that 
performs an initial check before either continuing or running another 
macro (the most complex example).

The first sample macro simply takes you from the starting view to 
another view in the same Approach file. You might use a macro like 
this any time you need to switch from one view to another.

To create a macro that switches to another view:

1. Choose Macros from the Tools menu.

The Macros dialog box appears.

2. Click New.

The Define Macro dialog box appears.

3. Type a name for the macro and assign a function key if you wish.

Approach is preset to show View as the first command in all new 
macros.

Press Esc to cancel a macro 
that’s running.

Creating sample 
macros

Example 1: 
Switching to 
another view
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The Define Macro dialog box shows the options you can set for 
the View command.

4. In the options area, click “Switch the current view to” and select 
a view in the list.

You can also show or hide a view.

5. Click OK to create the macro.

6. Click Done to close the Macros dialog box. 

Approach gives you several different ways to find a set of records 
using a macro. You can perform a stored find (one that was in effect 
when you created the macro), you can edit an existing find request, 
you can create a new find request, or you can create a macro that goes 
to a blank find request and waits for you to supply the criteria while 
the macro is running. You can also use the Find command to show all 
records or to refresh the database.

This sample macro defines a new find request. You might use a 
macro like this when you want to work with a specific found set of 
records, for example, all records for sales in N. America. 

To create a macro that finds a set of records:

1. Choose Macros from the Tools menu.

The Macros dialog box appears.

Type a name for the 
macro.

Click here and select the 
view you want to go to.

Example 2: 
Finding a set of 
records
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2. Click New.

The Define Macro dialog box appears.

3. Type a name for the macro and assign a function key if you wish.

4. In the Command grid, select Find in the list of commands.

The Define Macro dialog box shows the options you can set.

5. Select “Perform stored find when macro is run” and click New 
Find.

Approach opens a find request for the current form. These are 
the other Find options you might select.

To Select this option

Edit an existing find request for 
the macro.

“Perform stored find when 
macro is run” and click Edit Find

Go to a blank find request while 
the macro runs and wait for 
criteria to be entered. 

Go to Find and wait for input

Go to a partially filled in find 
request while the macro runs and 
wait for additional criteria to be 
entered. 

Find Again and wait for input

Show all records in the database. Show All records

Select the Find command.

Click to create a new 
find request or to edit 
an existing one.

Click to go to a blank 
Find request, and wait 
for input while the 
macro runs.

Continued
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6. Complete the find request and click OK.

7. In the Define Macro dialog box, click OK to create the macro.

8. Click Done to close the Macros dialog box. 

Using a variable field in a Find macro—Power tip
Using a variable field in a find request, you can create a flexible 
macro that allows users to find differing sets of records. For example, 
you can create a macro that allows users to find all records that have 
a customer ID that they enter. You begin by defining a variable field 
with a text option. Next, you place the variable field in a view and 
type a customer ID in it. Then, you create a macro that includes a find 
request with this criterion =@Variable field in the customer ID field. 
You might want to add a view that contains the variable field and a 
macro button that says Find Customer. The view could also include 
instructions to type the customer ID you want to find in the variable 
field.

The third sample macro changes the value in a field for all records in 
a database file, in this case setting the tax rate to 8.25 percent. It also 
automatically goes to the next record and repeats itself until all 
records are updated. The macro stops running when it reaches the 
last record in the database file. A macro that repeats itself is called a 
looping macro. 

To create a macro that sets a value in a field:

1. Choose Macros from the Tools menu.

The Macros dialog box appears.

Update the current state of the 
database with regard to the 
found set.

Refresh the found set

To Select this option

This find request shows 
criteria in the Product 
field.

Example 3: 
Setting a value in 
a field

Macros run starting from the 
current record. Be sure to 
move to the first record if you 
want to update all records.
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2. Click New.

The Define Macro dialog box appears.

3. Type a name for the macro and assign a function key if you wish.

4. In the Command grid, make Set the first command, select a field 
in the Set this Field list, and type a value in the To This Value box.

5. In the Command grid, add Records to the list and click Next 
Record.

6. In the Command grid, add Run to the list and select the current 
macro.

This command causes the macro to continue repeating itself until 
it encounters the last record in the found set.

This command sets the 
value of the field you 
select in the Set This 
Field list to the value you 
specify in the To This 
Value text box.

This command moves to 
the next record.
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The Define Macro dialog box should look something like this:

7. Click OK to save the changes to the new macro and click Done in 
the Macros dialog box.

The fourth sample macro has a conditional formula associated with 
the Set command that sets different tax rates depending on the value 
in the State field. Like the previous sample macro, this macro also 
loops through all the records in the database file until it reaches the 
last record. 

You define the condition by composing a formula in the Formula 
dialog box.

To define a macro that uses an IF calculation:

1. Choose Macros from the Tools menu.

The Macros dialog box appears.

2. Click New.

The Define Macro dialog box appears.

3. Type a name for the macro and assign a function key if you wish.

4. In the Command grid, make Set the first command in the list, 
select a field, click Formula, and type a value in the To This Value 
text box.

This command runs the 
current macro again. 
The current macro 
repeats until it reaches 
the last record in the 
found set.

Example 4: Using 
an IF calculation 
in a macro
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In this case, the formula is: If (BILL_STATE = ‘CA’, 0.0825,0.075) . If 
you’re working with percentages in a formula, be sure to enter 
the decimal value you need to multiply by, and not the 
percentage. Also, be sure to allow enough decimal places in the 
field to show the results of the calculation.

5. In the Command grid, add Records to the list and click Next 
Record.

6. In the Command grid, add Run to the list and select the current 
macro to continue running it until it reaches the last record in the 
found set.

The Define Macro dialog box should look something like this:

You can type a formula 
here or click the Formula 
button and enter a 
formula in the Formula 
dialog box.

This command moves to 
the next record.

The full formula appears 
in the Options cell.

This command runs the 
current macro again. 
The current macro 
repeats until it reaches 
the last record in the 
found set.
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7. Click OK to save the changes to the new macro and click Done in 
the Macros dialog box. 

A conditional macro verifies that a certain condition exists in the 
current record before either continuing with the current macro or 
running a second macro. An example of a condition might be a 
specific value in a certain field. If the initial check condition is not 
met, you can instruct Approach to run a second macro instead of 
continuing with the current one. 

You set up a conditional macro using the Run command, and you 
define the condition by selecting a field and typing a value or by 
defining a formula (click the Formula button). 

As part of the Run command options, you specify the macro to be 
run when the check condition is True, as well as the macro to be run if 
the condition is False. 

In this example, the first macro (Invoice Paid) checks to see if a 
customer has paid the latest invoice. If so, Approach prints a “thank 
you” form letter. If not, Approach runs a second macro, Payment 
Due, which prints a form letter asking for payment. 

The Payment Due macro switches back to the view that displays the 
field you’re checking (in this case Paid), goes to the next record, and 
runs Invoice Paid again.

Example 5: 
Defining a 
conditional macro

These commands print 
the “payment due” form 
letter for the current 
record.
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After Payment Due runs, Approach returns to Invoice Paid and goes 
to the next record. In order to run the Payment Due from the Invoice 
Paid, you must define Payment Due before you create the Invoice 
Paid.

Here’s a map of the logic in these two sample macros:

To use an initial check in a macro:

1. Choose Macros from the Tools menu.

The Macros dialog box appears.

2. Click New.

The Define Macro dialog box appears.

3. Type a name for the macro and assign a function key if you wish.

4. In the Command grid, make Run the first command in the list of 
commands. In the Run a Macro area, click If, click Formula, and 
type the formula in the Formula dialog box.

This step sets up the condition. In this sample macro the 
condition is the value in the Paid field.

5. To specify the action to take when the condition is true, select 
“continue this macro” in the Is True drop-down list.

This instructs Approach to continue running the current macro 
when the condition is true (the Paid value is “Yes”).

6. To run a different macro when the condition is false, turn on 
“else,” select “run macro” in the Else drop-down list, and select 
the macro you want to run. 

Invoice Paid 
Yes

No

Print “thank you” letter Check next record

Run Payment Due macro Return to next line
Has invoice 

of Invoice Paid macro
been paid?macro starts

Print “payment due” letter

Click this button to make the 
macro conditional and type 
a condition formula or click 
Formula and define one in 
the Formula dialog box.
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This option instructs Approach to run the Payment Due macro 
when the value in Paid is “No.” Other Run command options let 
you run another macro, run another macro and return to the 
current one, or end the macro.

7. Add the other actions you want Approach to perform if the 
initial check is true.

In this example, Approach switches to a form letter, prints the 
current record, and returns to the starting form (the one that 
displays the field you’re checking).

8. In the Command grid, add Records to the list and click Next 
Record.

9. In the Command grid, add Run to the list and select the current 
macro.

The Define Macro dialog box should look something like this:

10. Click OK to save the changes to the new macro and click Done in 
the Macros dialog box. 

These commands print 
the “thank you” form letter 
for the current record.

This command repeats 
the current macro until 
it reaches the last 
record.
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16 Exchanging Data with Other Files or 

Applications

Approach is designed to make it easy for you to work with data 
created in other Windows applications. 

This chapter explains how to import data or views into Approach, 
export data from Approach in a format that other applications can 
read, copy a picture currently in a PicturePlus field to a separate file, 
link or embed OLE objects from other applications, and create an 
OLE object in Approach that can be used in another application.

One of the key ways that Approach works with other database 
applications is by opening their files directly. For more information 
about opening files created in other applications, see “Opening a 
database created in another application” on page 2-9.

Approach lets you open database files in a wide variety of formats. 
Because Approach does not use a proprietary file format, there’s no 
need to convert data into a different format before opening the 
database file. For example, you can open an existing database or 
Lotus 1-2-3 file and work in it directly in Approach.

When you want to use data from one database file to add to or 
update the information in another database file, you can import and 
export the data. You might also want to import a spreadsheet file to 
convert it to a database. Approach allows you to import or export 
data using the same database file formats you can open directly in 
Approach.

You can import data from these database file formats: dBASE III+, 
dBASE IV, Paradox 3.5, Paradox 4.0 (and Paradox for Windows), 
FoxPro 2.1, Access, and SQL. Approach can also import data from 
other applications that can save or export to the above formats, such 
as Q&A®, SuperBase® IV, AceFile™, Professional File®, r:Base®, 
FileMaker® Pro, and Lotus Works or Microsoft Works. 

About file formats

If you want to work with a 
spreadsheet file other than 
Lotus 1-2-3 or Excel, first 
create a new Approach file 
and then import your 
spreadsheet data into the 
Approach file.
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If you have the appropriate server software, you can import Oracle 
SQL, Microsoft/Sybase SQL Server, or IBM DB2 tables. In addition, 
you can also import data from fixed-length or delimited ASCII text 
files and from Lotus 1-2-3 and Microsoft Excel spreadsheets.

When you export data, you can use any of these formats: dBASE III, 
dBASE IV, FoxPro, Paradox, Access, Lotus 1-2-3, Excel, 1-2-3 Ranges, 
Lotus Notes, Text–Fixed-Length, Text–Delimited, Oracle, SQL, DB2, 
and ODBC.

For more information about the file formats that Approach supports, 
turn to Appendix B. For more information about SQL tables, turn to 
Appendix C.

You can import data into an existing database file in Browse or you 
can transfer the views from one Approach file to another in Design. 
Importing data allows you to add to or update the records in your 
database without changing the appearance of any of the views in 
your Approach file. Importing views lets you add the views from 
another Approach file without affecting your data.

When you import data, Approach can update existing records and 
add imported records to the existing database, matching fields 
according to the relationships you define (this is called field mapping). 
If fields in the imported database have the same names as fields in 
the Approach database file, Approach automatically maps them. If 
the names don’t match, you can indicate how the fields correspond 
to each other. 

You can’t import data into a calculated field. The values in a 
calculated field must come from the Approach formula for the field. 
However, you can export the value in a calculated field.

When you import views from one Approach file to another, you also 
map the relationships between the fields referenced in the imported 
Approach file and those used in the current Approach file.

When you import into a database, Approach can either update 
existing records with the data that you’re importing, add the data 
from the import file in new records at the end of the current database 
file, or do a combination of the two: update existing records and 
import new ones. 

If you want to write to a SQL 
database, set the ReadOnly 
line to 0 in your 
APPROACH.INI file.

Importing data or 
Approach files

Importing a 
database file
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Adding records places all of the records in the imported file at the 
end of the existing database (unless you have a custom default sort 
order). For example, if the existing database starts with 30 records 
and you import 20 records, the existing database will contain 50 
records after importing.

As an alternative to adding the records in the imported database to 
the existing database, Approach lets you use selected data in the 
imported database to update records in the existing database. A third 
option combines the first two, allowing you to update records that 
have matching data and add new records for data that doesn’t match.

When you update records at import, Approach checks the data in 
match fields that you specify looking for any records in the existing 
database that contain a value that matches a record in the imported 
database. When Approach finds a match, it uses imported data to 
update only the fields you specify in the matching records. 

This powerful feature lets you update only the records you want, 
using only the fields you specify. For example, you can update the 
customer names only in the records where the customer IDs match. 
In the illustration below, Approach looks for ID numbers and then 
updates just the name field when the ID numbers match.

Existing database Imported database After importingAdding records places 
the imported records 
after any existing 
records.

Record A
Record B
Record C

Record XX
Record YY
Record ZZ

Record XX
Record YY
Record ZZ

Record A
Record B
Record C

Existing database Imported database After importingUpdating records that 
have matching data 
updates only the fields 
you specify and only in 
matching records. 
Updating does not add 
records to the database.

Record 1 
ID=11, Name=A

Record 2
ID=22, Name=B

Record 3
ID=33, Name=C

Record 1 
ID=11, Name=XX

Record 2
ID=99, Name=YY

Record 3
ID=33, Name=ZZ

Record 1 
ID=11, Name=XX

Record 2
ID=22, Name=B

Record 3
ID=33, Name=ZZ
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Notice that the ID in the imported Record 2 doesn’t match any IDs in 
the existing database, so Record 2 is not updated. However, the IDs 
for Records 1 and 3 do match, so Approach has updated the Name 
fields.

The third import alternative combines the actions of the first two. 
Approach looks for records that have matching values and updates 
them as appropriate. Any records in the imported database that don’t 
match the existing database are added at the end of the existing 
database. 

In this example, the IDs in Records 1 and 3 match, so Approach 
updates the existing records with the imported data. Record 2 in the 
imported database doesn’t match any records in the existing 
database, so Approach adds it to the end of the existing database as a 
new record: Record 4.

Because you’re adding data to a database file, you must be in Browse. 
If you’re working with a found set rather than the entire database, 
Approach updates only the found set.

The first step in importing a database file is to select the type of file 
you want to import. Then you select the file to be imported, specify 
the way you want to import data (by adding records, updating 
records, or both), and map the fields in the import file to those in the 
current Approach database file. 

To import a database file:

1. Open the database file into which you want to import data.

You can open the database file or one of its Approach files. If you 
have joined database files, you can import into only one file at a 
time.

Existing database Imported database After importingUpdating and adding 
records updates records 
that have matching data 
and adds new records for 
data that doesn’t match.

Record 1 
ID=11, Name=A

Record 2
ID=22, Name=B

Record 3
ID=33, Name=C

Record 1 
ID=11, Name=XX

Record 2
ID=99, Name=YY

Record 3
ID=33, Name=ZZ

Record 1 
ID=11, Name=XX

Record 2
ID=22, Name=B

Record 3
ID=33, Name=ZZ

Record 4
ID=99, Name=YY
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2. In Browse, choose Import Data from the File menu.

The Import Data dialog box appears.

3. Select the file type of the import file if necessary.

If you select the Text - Delimited file type, Approach opens the 
Text File Options dialog box. 

A delimited ASCII text file uses separators—special characters in 
the text file—to show where one field ends and the next one 
begins. You may want to refer to the manual for the application 
that was used to create the delimited ASCII text file to see what 
field separator it uses.

You can also specify which character set is used in the import file. 
If you’re importing DOS text with international characters, 
change the character set of the current database before importing 
into it. DOS text with international characters uses the DOS or 
OS/2 (PC-8) character set.

Select a file type.

…or select a file.

Type a filename…

Click a field separator.

If necessary, change the 
character set.
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If you select the Text - Fixed-Length file type, Approach opens 
the Fixed Length Text File Setup dialog box. 

In a fixed-length text file, a specific field is always the same 
length in each record, regardless of how much data it contains. 
When you import a fixed-length text file, you must provide the 
names, data types, and widths of each field. You enter the 
starting position of the first field and the widths of each 
subsequent field. Approach automatically calculates the starting 
position for all fields after the first one. 

For example, the first field might be Name with a fixed-length of 
30 characters. Approach calculates that the next field begins with 
character 31. This illustration shows typical records in a fixed-
length file.

If you select Oracle, SQL Server, DB2, or a server-based ODBC 
application, Approach opens the appropriate Connect dialog 
box. Use this dialog box to connect to the server. For more 
information, see Appendix C.

Select the character set 
used in the file.

Type a field name.

Select a data type.

Type the position of the 
starting character for the 
first field.

Type the number of 
characters in the field.

Click if the first record 
contains field names.

Name
1 30 31 5051

Address City
70

Johnson
Schmidt
Ramirez

New York
Bonn
Madrid

1234 Fifth Ave.
1234 Strausstrasse
1234 Calle Carlos V

Field names

Character numbers

Records

Type the server name.
Type your user name.

Type your password.
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4. In the Import Data dialog box, select the file you want to import 
in the File Name list.

You can also type the filename in the File Name text box. If 
necessary, you can change the directory and disk if you need to 
look for the file.

5. Click OK.

The Import Setup dialog box appears. The fields on the left, in 
the Data From list, are from the imported file. Those on the right, 
in the Fields In list, are from the current file. Arrows between the 
two sets of fields show automatic mapping of fields that have 
matching names. If you’re working with joined databases, you 
can select another database in the Fields In drop-down list.

If you’re importing a database file, Approach initially displays 
the field names on the left side of the Import Setup dialog box. If 
you’re importing a spreadsheet file, Approach shows the data in 
the first row of the spreadsheet. If you’re importing a delimited 
text file, Approach shows Field for each field it detects.

You can also view the actual data that will be imported, record 
by record, by clicking the previous and next record buttons at the 
bottom left.

6. Arrange the fields in the Fields In list so that they align with the 
corresponding data in the imported file’s Data From list.

This list can show field 
names or data from the 
imported database file; it 
shows only data from 
other file types.

Arrows show automatic 
mapping between fields 
with the same name.

Click to see the data in 
other records in the 
imported file.

This list shows the fields in 
the current database file.

This list gives import options for adding records, 
updating records, or updating and adding records.
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To move a field, drag it up or down to a new position. When you 
release the mouse button, the two fields exchange positions. 

7. Map the fields in the imported file’s Data From list with the 
fields that you want to update in the current database file’s 
Fields In list.

Field mapping tells Approach which imported data matches 
fields in the current database. 

To map two fields, double-click in the mapping column between 
them to turn on an arrow. 

To unmap specific fields, double-click the mapping arrow beside 
the field name to turn it off. To unmap all fields, click Clear. To 
remap any fields with matching names, click Map Fields.

If you want to map the import fields to those in a joined 
database, select the database file in the Fields In drop-down list.

If a field in the imported file is not mapped to a field in the 
current database file, Approach ignores the field. Approach also 
ignores any fields in the current database that are not mapped. 
Therefore, if you want to update only specific fields when you 
import data, be sure that those fields are the only ones mapped (a 
mapped field has an arrow connecting it to a field in the 
imported file).

8. Select an import option in the Import Options drop-down list.

This option Does this

Add imported records as new 
records

Adds the imported data as new 
records at the end of the database; 
the new records have data only in 
the fields that you map

These two 
fields trade 
positions when 
you release 
the mouse 
button.

Continued
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If you select either of the update options, a new column appears 
on the right side of the Import Setup dialog box. You use this 
column to select the fields that must have matching data before 
their records can be updated.

9. If you’re updating matching records, select the fields you want to 
match. 

To select a field for matching, click in the check mark column to 
the right of the Fields In column. 

10. Click OK.

Approach imports the database file, either adding records, 
updating records, or both. The status bar shows the new number 
of records. If you import the same file twice using the Add 

Use imported data to update 
existing records

Updates the data in existing 
records (only for the fields you 
map) when the records contain 
data (in the fields you specify) that 
matches the data in the imported 
file

Use imported data to update 
& add to existing records

Updates the data in matching 
records and adds new records for 
the data that does not match 
existing records

This option Does this

Click in this column to 
select fields for matching.
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option, you’ll get duplicate records. For information about 
deleting duplicate records, see “Finding duplicate or distinct 
values” on page 11-12.

How to reserialize an incrementing numeric al fiel d
You can also use import to reserialize an incrementing numerical 
field. Choose Save As from the File menu and save the file using the 
New Data option. This creates a blank copy of your file. In the Field 
Definition dialog box, reset the starting number for the incrementing 
field. In Browse, import the original data without the numbered field 
(don’t map that field). Approach increments the numeric field as 
records are imported.

If you have views in an Approach file that you want to reuse with 
other databases, you can easily import the Approach file (including 
all of its forms, reports, tables, charts, letters, and mailing labels) and 
add it to an existing Approach file. Because this is essentially a 
design function, you must be in Design to import an Approach file.

As part of the import process, you map fields of the imported 
Approach file to those in the current Approach file. 

To import an Approach file:

1. Open the Approach file you want to import into.

2. In Design, choose Import Approach File from the File menu.

The Import Approach File dialog box appears.

Importing an 
Approach file

Field mapping does not add 
data to a database file. It 
merely tells Approach where 
the new data fits into the 
existing structure.

…or select a file.

Type a filename…
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3. Select the Approach file you want to import and click OK.

The Import Approach File Setup dialog box appears. The fields 
listed on the left are from the imported Approach file. Those on 
the right are from the current Approach file. Arrows between the 
two sets of fields show automatic mapping of fields that have 
matching names. 

4. Arrange the fields in the current file’s Fields In list so that they 
align with the corresponding fields in the imported file’s Fields 
In list.

To move a field, drag it to a new position. When you release the 
mouse button, the two fields exchange positions. 

5. Map the fields in the import file’s Fields In list with the fields that 
you want to update in the current Approach file.

Field mapping tells Approach which imported fields match 
fields in the current Approach file. 

To map two fields, double-click in the mapping column between 
them to turn on an arrow. 

To unmap specific fields, double-click the mapping arrow beside 
the field name to turn it off. To unmap all fields, click Clear. To 
remap any fields with matching names, click Map Fields.

If a field in the imported Approach file is not mapped to a field in 
the current Approach file, Approach displays the message 
NO_FIELD_REFERENCE in Design instead of a name for the field. 
In Browse, you get an error telling you that you cannot edit the 
field and must assign a database field to the current field.

Arrows show automatic 
mapping between fields 
with matching names.

This list shows field 
names from an import 
Approach file.

This list shows the fields in 
the current Approach file.
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6. When you’re finished mapping fields, click OK.

Approach imports the Approach file. You return to Design, where 
you can switch to a newly-imported view.

When you export an Approach database file, you take selected data 
and save it in a format that can be used by other applications. You 
can export all the records in a database or use Find to select a subset 
to export. You can also export all of the fields in a record or just some 
of them.

Exporting creates a new database file that can include all types of 
fields except calculated fields that perform a summary function. You 
can export other calculated fields, but their values are converted to a 
set text, numeric, date, or time value before exporting. If you export a 
variable field, Approach creates a database field with the same value 
for each record.

PicturePlus fields can be exported, but only another Approach 
database file can read them. Macros cannot be exported.

If you want to reuse an existing Approach file, complete with 
calculated and PicturePlus fields, you don’t need to export it. Just 
choose Save As from the File menu and use the “New data” option to 
save a copy of the complete Approach file with a blank database. 
Your calculated, variable, and PicturePlus fields remain part of the 
Approach file. Then you can import data into the new file.

To export a database:

1. In Browse, open the database file you want to export and select 
the records to be exported.

If necessary, use Find to locate specific records you want to 
export. Approach exports records in the default database order. If 
you want to export records in a different order, use Sort to 
arrange them in the order you want.

2. Choose Export Data from the File menu.

Exporting data 
from Approach

A calculated or variable field 
is part of an Approach file. 
Approach converts it to a 
database field in the export 
file during export.
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The Export Data dialog box appears.

3. Type a name for the file to which you’re exporting data and 
specify where you want the file to be saved.

4. Select a database file type in the List Files of Type drop-down list.

If you select the Text file type, Approach opens the Text File 
Options dialog box. You can specify the character used to 
separate fields in the export file.

Select a file type.

Select the fields you 
want to export.

Specify 
whether to 
export the 
found set or 
all records.

Type the name of the 
export file (where the 
data is going).

Select a database.

Select a field separator.

Turn on this option if the first 
record contains text you want 
to use as field names.
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If you select the Text - Fixed-Length file type, Approach opens 
the Fixed Length Text File Setup dialog box so that you can 
specify the names, data types, and widths of each field. 

If you select Oracle, SQL Server, DB2, or a server-based ODBC 
application, Approach opens the appropriate Connect dialog 
box. Use this dialog box to connect to the server. For more 
information, see Appendix C.

5. Click “Found set only” or “All records” in the Records to Export 
area of the Export Data dialog box.

“Found set only” exports only the records you’ve located with 
the current find request. “All records” exports all records in the 
database.

6. Move the fields you want to export to the Fields to Export list.

To move a field to the Fields to Export list, select the field name 
in the Database Fields list and click Add, or double-click the field 
name. Approach exports fields in the order you list them. If 
you’re working in joined databases, you can select a different 
database and select files from the second database as well.

To move a field back to the Database Fields list, select the field 
name in the Fields to Export list and click Remove, or double-
click the field name.

7. Click OK.

Select the character set 
used in the file.

Type a field name.

Select a data type.

Type the position of the 
starting character for the 
first field.

Type the number of 
characters in the field.
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You can easily copy a picture in a PicturePlus field to a new file in 
whatever graphics file type you specify. You can then edit the picture 
if you wish, or use it for another purpose. You must be in Browse to 
copy a PicturePlus picture to a file.

To copy a PicturePlus picture to a file:

1. In Browse, select the PicturePlus field that contains the image 
you want to copy.

2. Choose Copy to File from the Edit menu.

The Copy to File dialog box appears.

3. Type a filename for the file you’re creating in the File Name text 
box.

4. Select the file type you want in the List Files of Type drop-down 
list.

The file types available depend on the type of picture you’re 
copying.

5. Click OK.

Copying a 
PicturePlus 
picture to a file

Type a filename.

Select a file type.
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If you are connected to a network and have access to an e-mail 
package (such as Lotus Notes or cc:Mail), you can include Approach 
views and data in your e-mail messages. Approach lets you e-mail an 
image of the current view, or attach all or part of the current 
Approach file. If you attach the current view to a mail message, you 
can include the current record or the current found set. If you attach 
the entire Approach file, you can include all data, or just the empty 
database file (without any data).

After you select the data to be e-mailed, Approach opens your e-mail 
package so that you can specify the recipient, add comments, and 
actually send the mail.

To send e-mail from Approach:

1. Open an Approach file and use the Find command to locate the 
set of records you want to mail.

If you want to mail all records, use the Show All command.

2. Choose Send Mail from the File menu.

The Send Mail dialog box appears.

3. Select the amount of information you want to send.

“Send snapshot of the current view” sends a Windows Metafile 
(WMF) image of the current Approach file view. “Attach 
Approach file with” sends the current Approach file with the 
views and data you select. You can send the current view or all of 
the views in the file. You can also select the level of data you 
want to include in the drop-down list.

4. Click OK.

Sending e-mail 
from Approach

The Send Mail command is 
not available unless you have 
an e-mail package installed.

Click to send an image of 
the current view.

Click to attach the current 
Approach file with the 
data you select.
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Send dialog box appears so that you can specify the recipient and 
add a message. 

5. Select “Route to addressees in sequence” in the drop-down list.

6. Type the names of the addressees in the order you want them to 
receive the message in the To text box. 

Press ENTER after each addressee to add a new line.

7. Type a subject in the Subject text box and a message in the 
Message text box if you wish.

The subject you type appears as the subject of the e-mail 
message, the message appears as the body of the e-mail message, 
and the Approach file appears as an attachment in the message.

8. Click Options to set return notification and delivery priority 
options.

9. Click Send.

Select a routing option.

Type a message subject.

Click to open the 
Notes Address Book.

Click to set delivery 
priority and receipt 
notification options.

Type message text.

Type the names of 
addressees in the order 
you want them to 
receive the message.
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Notes routes the message to the first addressee on your list. 
When the first addressee reads and closes the message, Notes 
prompts the first addressee to send the message on to the second 
addressee.

Object Linking and Embedding (OLE) is a system that allows 
different Windows applications to share live data freely. You create 
the data to be shared (the object) in the server application. Objects can 
be reports, forms, graphics, charts, sounds, or text.

The application in which the object is linked or embedded is the 
container application, and the document that holds it is a compound 
document. 

Approach can be either a server application or a container 
application. When you use Approach as a container application, you 
can place OLE objects in a PicturePlus field in Browse (this is the 
most common way) or directly on a form, report, letter, or mailing 
label in Design. An object embedded or linked in Design appears as a 
design element in the background of every record in a form, form 
letter, or mailing label, or on every page of a report, worksheet, or 
crosstab.

Depending on the server application, you see the actual linked or 
embedded object, such as a Lotus 1-2-3 graph, or you see an icon that 
represents the object, such as an Ami Pro icon. 

The main difference between linking and embedding is where the 
data is stored. If you link to an object from Approach, the object stays 
in its original source file, with a link to the Approach field. You must 
have the server application installed in order to edit the object. 
Linking is useful when you want to maintain the object in a separate 
file, or if the object is a sound or video.

About OLE and 
Approach

You can double-click an OLE 
object to activate a linked or 
embedded sound or video.

This icon represents 
an Ami Pro object.
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If you embed an OLE object, the entire object is stored in the field, 
along with all of the information required for you to be able to edit 
the object. An embedded object becomes part of your Approach file 
or database (depending on where it’s embedded). 

In either case, the object maintains its connection to its server 
application. This connection allows you to edit the object using the 
tools from the server application without ever leaving Approach.

You can create Approach objects that consist of either an individual 
view (such as a report or form) or an entire Approach file. When you 
insert an Approach OLE object into another application, it generally 
appears as an Approach icon. 

You can create an Approach object from within Approach or from 
another application. 

When you create an Approach OLE object from within Approach, it 
becomes available to any other application for linking. You can create 
two types of Approach objects: a data object or a view object. A data 
object consists of a worksheet or crosstab that you CONTROL-drag 
and drop into an OLE 2 drop target application. You might use a data 
object to place a range of Approach worksheet cells in a Lotus 1-2-3 
worksheet. 

A view object can be either a single view, such as a worksheet or 
chart, or the entire Approach file. You can also choose whether to 
include data in a view object and which data is included.

If you include data in a view object, the object and its data are a self-
contained unit. This format is convenient for sending an Approach 
form to someone via e-mail. The recipient could then enter data into 
the form and send it back to you.

If you choose not to include data in the object, Approach adds 
references to the data source so that you can still see data in the OLE 
object as long as the object and the database file it points to are on the 
same network or local hard drive. If the database file cannot be 
located, Approach allows you to open a new database with the view 
object.

Creating 
Approach OLE 
objects

Creating an 
Approach OLE 
object in Approach
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To create an Approach OLE object in Approach:

1. Open your Approach file in Browse or Preview and go to a view 
that you want to include in the OLE object. 

2. Make sure that nothing is selected in the view.

3. Choose Copy View from the Edit menu.

The Copy View to Clipboard dialog box appears.

4. To create an object that consists only of the current view, click 
“Copy current view only.”

5. To create an object that includes all of the views in the current 
Approach file, click “Copy all views.”

The object will also include the Approach application so that the 
object can be edited from the container application.

6. To include data in the object, turn on “Include data” and select a 
data option. 

You can send a new blank record, the current record, the current 
found set, or all data in the database.

When you create an Approach OLE object from within another 
application, it can contain the entire Approach application or only a 
single view. You begin by selecting the type of object: the Approach 
application or a type of view. Next, you select the database that you 
want to use. And finally, if you select a view, you create the view 
using the appropriate Approach Assistant dialog box.

To create an Approach OLE object from another application:

1. Follow any instructions that are available for embedding a new 
OLE object in the container application.

As part of this process, you must select either the Approach 
application or the type of Approach view you want to use in the 
object. After you select the type of view, Approach opens a dialog 
box that looks very much like the standard Approach Open 
dialog box. The only difference is that this dialog box lists only 
database files and not .APR files.

Click to create an object 
that consists of the 
current view only.

Click to create an object 
that includes all of the views 
in the Approach file.

Creating an 
Approach OLE 
object from 
another 
application
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2. Select the database that you want to use.

If you selected a view, Approach opens an Assistant for the type 
of view you select. For example, if you select Approach Report, 
the Report Assistant appears.

3. Use the Assistant to create the view and click Done.

Approach creates the view and opens it.

4. Close Approach.

You return to the container application, which will now contain 
an embedded Approach object.

When you add a linked OLE object to a record in a PicturePlus field, 
you create a connection between the PicturePlus field and an object 
created by another application. A copy of the object appears in the 
Approach file, but the original object remains in its own format. 
Updating the OLE object in Approach automatically updates the 
original. And changes made to the original are reflected in Approach.

OLE lets you include different kinds of information in your 
database—including graphics, charts, sounds, and text—limited only 
by the server applications installed on your computer.

Linking places a reference to the OLE object in your Approach file. 
You can place a linked object as a design element on every record or 
in a PicturePlus field on a single record. Depending on the server 
application, the object appears right in the record or as an icon. Any 
change you make to the linked object from within Approach updates 
the original object. 

Before you can link, however, you must first create the object in the 
server application. You can then either copy the object to the 
Clipboard or create a link to the object’s file.

To insert a linked object from the Clipboard:

1. In the server application, create the object you want to link to.

Create the object by selecting the chart, graphic, range of data, or 
other information, and then copy it to the Clipboard.

Linking OLE 
objects from other 
applications

Inserting a linked 
object
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The server application must be running, and you must use the 
Copy command (not the Cut command) to place the OLE object 
on the Clipboard. Most server applications require you to save 
the source file before you can create an object.

2. Prepare the Approach file to receive the linked object.

Open the Approach file in which you want to insert the object, 
and go to the view you want to use. 

If you plan to paste the OLE object as a design element, go to 
Design and click where you want the object to appear. 

If you’re placing the linked object in a PicturePlus field, go to 
Browse, go to the record, and select the field.

3. Choose Paste Special from the Edit menu.

The Paste Special dialog box appears.

4. Click Paste Link. Turn on Display As Icon if you want the OLE 
object to appear as an icon.

The linked object may appear as an icon, depending on the 
server application. For example, if the server application is Lotus 
1-2-3, you see the object. If the server application is Ami Pro, you 
see an icon that you can double-click to open the object.

5. Click OK.

Approach displays the object in the current view.

To delete a linked object, select the object and choose Cut or 
Clear from the Edit menu.

Select a format for the 
object.
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To link to an object’s file:

1. Prepare the Approach file to receive the linked object.

Open the Approach file in which you want to insert the object, 
and go to the form, report, or other view you want to use. In 
Browse, go to the record, and select a PicturePlus field.

2. Choose Object from the Create menu.

The Insert Object dialog box appears. 

3. Click “Create from File.”

The Insert Object dialog box displays a text box where you can 
type the filename of the file you want to link to.

4. Type the name of the file you want to link to or click Browse and 
select a file in the Browse dialog box.

5. Turn on Link to create a linked object (instead of an embedded 
object).

6. If you want the linked object to appear as an icon, turn on 
Display As Icon.

7. Click OK.

You can easily edit a linked object by double-clicking it. If the 
container application is an in-place server (Approach is not), you can 
edit the object without leaving the container application. The menus 
from the server application simply replace those in the container 
application until you finish editing. If the container application is not 
an in-place server, the server application actually opens so that you 
can edit the object.

Select an object type.

The Result area 
describes the type of 
object you’re creating.

Editing a linked 
object
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To edit a linked object:

1. Double-click the object to open the source document.

2. Make your changes to the object.

3. Choose Update from the File menu of the server application.

4. Choose Exit or Exit & Return from the File menu of the server 
application.

The server application closes and you return to the Approach 
view. The server application also updates the source file.

Once a link is inserted, you can modify it in a number of ways. You 
can specify when the object is updated, you can manually update an 
object, you can activate a linked object, you can link the object to 
another source (when you change the name of the source file, for 
example), and you can break the link altogether.

You can update a linked object either automatically or manually. 
Automatic updating means that the object is updated whenever the 
source object changes. Manual updating means that the object is 
updated only when you specifically update it. If you’re making 
frequent changes to an object, you might want to wait until you’re 
finished before manually updating it.

When Approach is the container application, it updates linked 
objects only if the source application is running. If you have a linked 
object in a PicturePlus field, Approach updates the object only when 
you manually update it. 

To modify a link:

1. Open the Approach file that contains the linked object. 

If the object is a design element, go to Design. If the object is in a 
PicturePlus field, go to the record that contains the object and 
select the PicturePlus field.

2. Choose Links from the Edit menu.

When you break a link, the 
object remains in the view but 
you can no longer use it to 
open its server application.

Modifying a link
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The Links dialog box appears.

3. Select the link you want to modify and make the necessary 
changes.

Embedding an OLE object in an Approach file creates a link to the 
server application the same way linking to an object does. The main 
difference between linking and embedding is that an embedded 
object is the only version of the object, whereas a linked object refers 
back to and can update the original source object.

When you embed an object, you simply paste it into an Approach 
view. You can embed an object as a design element on a report or on 
every record of a form, or in a PicturePlus field on a single record. 
You can embed an object that already exists, or embed and create the 
object at the same time. Either way, you can easily edit and update an 
embedded OLE object in an Approach file.

To do this Click

Change when the link is updated Automatic or Manual 

Manually update the link Update Now

Activate a linked object Open Source

Change the link to another source 
file (if, for example, you change the 
name or location of the source file)

Change Source and select a 
new file or path for the link in 
the Change Link dialog box

Break a link and convert the object 
to a graphic element

Break Link

Select an object to 
modify its link.

These settings determine 
when the link is updated.

Embedding an 
OLE object
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You can create an OLE object by copying from any application that 
supports OLE, and you embed it by pasting it in an Approach file.

To embed an existing OLE object:

1. In the server application, create the object you want to embed.

Create the object by selecting the chart, graphic, range of data, or 
other information, and then copy it to the Clipboard.

You must use the Copy command (not the Cut command) to 
place the OLE object on the Clipboard. Most server applications 
require you to save the source file before you can create an object.

2. Prepare the Approach file to receive the embedded object.

Open the Approach file in which you want to insert the object, 
and go to the view you want to use. 

To paste the OLE object as a design element, go to Design and 
click where you want the object to appear. 

If you’re placing the embedded object in a PicturePlus field, go to 
Browse, go to the record, and select the field.

3. Choose Paste Special from the Edit menu.

The Paste Special dialog box appears.

4. Click Paste.

Approach embeds the object in the view you selected. The 
embedded object may appear as an icon, depending on the 
server application. For example, if the server application is Lotus 
1-2-3, you see the object. If the server application is Ami Pro, you 
see an icon that you can double-click to open the object.

To delete an embedded object, select the object and choose Cut 
from the Edit menu.

Embedding an 
existing OLE 
object

The server application does 
not need to be running when 
you paste.

Select a format for the 
object.
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You can embed an OLE object without actually creating the object 
first. Instead, you can create and embed an object at the same time.

To embed a new OLE object:

1. Prepare the Approach file to receive the embedded object.

Open the Approach file in which you want to insert the object, 
and go to the form, report, or other view you want to use. 

To paste the OLE object as a design element, go to Design and 
click where you want the object to appear. 

If you’re placing the embedded object in a PicturePlus field, go to 
Browse, go to the record, and select the field.

2. Choose Object from the Create menu.

The Insert Object dialog box appears. The Object Type list 
contains all the formats that can be created by server applications 
installed on your computer.

3. To create an object from a specific file, click “Create from File” 
and select a file.

4. To create a totally new object, click “Create New” and select the 
type of object you want to create.

5. Click OK.

Approach opens the application you select in a new blank 
window.

6. Create the object in the server application window and choose 
Update from that application’s File menu.

7. Close the server application window and return to Approach.

Embedding a new 
OLE object

Select an object type.

The Result area 
describes the type of 
object you’re creating.
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Once you’ve embedded an object, you can easily edit it. 

To edit an embedded object:

1. Double-click the object you want to edit.

In a PicturePlus field, you can also right-click the object and 
choose Edit Object from the pop-up menu.

2. Make the changes you want in the embedded object and choose 
Update from the server application’s File menu.

3. Close the server application window and return to the 
Approach.

Editing an 
embedded object



17-1

17 Working Together with Other 

Lotus Applications

Approach is designed to work together closely with other Lotus 
applications, such as Lotus Notes and Lotus 1-2-3. The strategy is 
called “Working Together,” and its goal is to connect you to the 
information you need. 

You can use Approach to open views or forms in a Lotus Notes 
database, and to replicate a Notes database. You can also use the 
powerful Notes F/X 1.1 feature to share key information between 
Notes and Approach.

When you open a Notes view (such as the list of messages in an 
e-mail database), the view is read-only. You can see the view’s 
contents, but you cannot edit them.

When you open a Notes form (such as an individual message), the 
form is normally read/write. You can edit its contents or add new 
records to create new documents. To create a new document, just add 
a record and fill in the fields that appear on the form.

If you want to make Notes forms read-only in Approach, turn on 
“Open all SQL tables as read-only” in the SQL Database panel of 
Preferences. For more information, see “Setting database options for 
all SQL, Access, ODBC, and Lotus Notes tables” on page 19-11.

A Notes text field is displayed in an Approach text field, which can 
show up to 254 characters. When you open an existing Notes form, 
you may see only the first 254 characters of any text field. Likewise, 
when you create a new document, its text fields can be only 254 
characters long.

Working together 
with Lotus Notes
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You can open a view or form from a Notes database stored on your 
local drive. The data from the view or form appears in a standard 
Approach form.

To open a view or form from a local Notes database:

1. Click the Open File icon or choose Open from the File menu. Or 
if the Welcome dialog box is on the screen, select “Open an 
existing file” and click OK.

The Open dialog box appears.

2. Select Lotus Notes – Local in the List Files of Type drop-down 
list.

The names of Notes databases on your local drive appear in the 
Directories list with a filecard icon in front of them and with the 
filename extension .NSF.

3. Double-click a Notes database in the Directories list.

The names of the views and forms in that database appear in the 
File Name list.

4. Select the name of the view or form you want to open in the File 
Name list and click OK.

5. If an alert box appears, click OK.

An alert box appears if you open a Notes form and your 
preferences are set for displaying Notes forms read-only.

You can open a view or form from a database stored on a Notes file 
server. The data from the view or form appears in a standard 
Approach form.

When you quit Approach, you are disconnected from any Notes 
servers you connected to in that session. You can also use the Open 
dialog box to disconnect from a particular server. Select the 
connection name in the Server drop-down list and click Disconnect.

To open a view or form from a Notes server database:

1. Click the Open File icon or choose Open from the File menu. Or 
if the Welcome dialog box is on the screen, select “Open an 
existing file” and click OK.

Opening a view or 
form from a local 
Notes database

Opening a view or 
form from a Notes 
server database
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2. Select Lotus Notes – Server in the List Files of Type drop-down 
list.

The Drives drop-down list changes to Server and shows the 
names of Notes servers you can connect to.

3. Select a server in the Server drop-down list.

The Notes databases and subdirectories on the server appear in 
the Directories list. The names of Notes databases have a filecard 
icon in front of them and have the filename extension .NSF. The 
names of Notes subdirectories are enclosed in brackets.

4. If a Setup dialog box appears, fill in the information and click 
OK.

The dialog box appears if you are not already connected to the 
server. 

5. Double-click a Notes database in the Directories list, or double-
click a Notes subdirectory to see its contents and then double-
click a database.

If you double-click a subdirectory, the names of databases in that 
subdirectory appear in the Directories list, indented below the 
subdirectory.

When you double-click a database, the names of the views and 
forms in that database appear in the File Name list.

6. Select the name of the view or form you want to open in the File 
Name list and click OK.

7. If an alert box appears, click OK.

An alert box appears if you open a Notes form and your 
preferences are set for displaying Notes forms read-only.

“Quick connecting” to a Notes server database
Once you specify the name of a Notes server and database in the 
Open dialog box, Approach keeps track of that connection for your 
current work session. The next time you open the dialog box and 
select Lotus Notes – Server, the name of the connection you used 
before will appear in the Server drop-down list; for example, 
AccountsPayable @ Accounting.

If you select the connection name in the Server drop-down list, the 
File Name list shows the views and forms in the Notes database you 
used before on that server. This way, you don’t need to establish a 
connection and select a name in the Directories list.
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Lotus Notes uses the process of database replication to distribute and 
update copies of the same database, stored on different servers. This 
allows users on different networks, in different time zones, or even in 
different countries to share information. 

Replication makes all copies of a database essentially identical, over 
time. If you make changes in one copy of a database, replication 
ensures that those changes are added to all copies.

Approach offers two types of replication: replication of a new 
database, which essentially creates a new copy of an existing 
database on your local hard drive, and replication with server, which 
updates both your replica and the server ’s replica with changes 
made to either.

The two Approach replication commands are available only when 
you create a custom menu or a macro that includes them. For more 
information about creating a custom menu, see “Customizing 
menus” on page 19-18.

To replicate a new Notes database:

1. Choose the Notes New Replica command from its custom menu.

The New Notes Replica dialog box appears.

2. Select the server where the database you want to copy is stored 
in the Server drop-down list.

3. Select the database file in the list of files or type the filename in 
the FileName box.

Replicating a 
Lotus Notes 
database

Select the server where 
the database you want to 
replicate is stored.

Select the database you 
want to replicate from 
this list.

Type a filename for the 
new local replica.

Turn this option on to 
replicate documents saved in 
a specific time period.
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4. Type a filename for the new replica in the Filename text box in 
the New Local Replica area.

5. If you want to replicate only those documents replicated in a 
specific period of time, turn on “Only replicate documents saved 
in the last nn days” and type the number of days.

6. Click New to replicate the database.

Click Done to leave the New Notes Replica without replicating a 
database.

To replicate a Notes database with the server:

1. Choose the Notes Replicate with Server command from its 
custom menu.

The Replicate with Notes Server dialog box appears.

2. Type the database replica filename in the Filename text box.

3. Select the server where the database you want to copy is stored 
in the Server drop-down list.

4. Turn on Replication Options as appropriate.

Turn this option on To

Exchange document 
read marks

Update both the local replica and the 
server replica with read marks on 
documents (Read marks tell whether a 
document has been read.)

Receive documents from 
server

Update the local replica with documents 
from the server replica

Send documents to 
server

Update the server replica with 
documents from the local replica

Select the server where 
the database you want to 
replicate is stored.

Select replication options.

Type the database filename.

Continued
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5. Click OK.

Notes F/X 1.1 is a powerful feature that allows Notes and Approach 
to share information. From the Approach end, the sharing is 
accomplished with variable fields that have been enabled for Notes 
F/X 1.1. When a variable field is enabled, Notes can write to the field 
and can read its contents without having to open an Approach view.

To enable variable fields for Notes F/X 1.1:

1. Choose Approach File Info from the File menu.

The Approach File Info dialog box appears. It shows information 
that you supply about the Approach file (Author, Description, 
and Keywords) as well as lists of databases, views, macros, and 
variable fields.

2. Click a variable field to enable it.

3. Click OK.

Replicate database 
templates

Replicate database templates associated 
with the database.

Turn this option on To

Enabling Approach 
variable fields for 
Notes F/X 1.1

Click a variable field to 
enable it for Notes F/X 1.1.
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Approach and Lotus 1-2-3 can share data in a number of ways. For 
example, you can open Lotus 1-2-3 spreadsheets in Approach and 
have Approach create a database file from the spreadsheet.

A second set of alternatives lets you work with “live” 1-2-3 data in 
Approach, starting either from 1-2-3 or from Approach. Working in 
Approach, with 1-2-3 running in the background, you can open a 
named 1-2-3 range. If you wish to start from 1-2-3, you can create an 
Approach view in 1-2-3 that allows you to display, edit, or report on 
selected spreadsheet data. 

You can open a Lotus 1-2-3 spreadsheet, and Approach will create a 
database file with a copy of the spreadsheet data. Approach also 
creates a new Approach file for the database. 

When you open the spreadsheet in Approach, you specify a sheet or 
range of data you want to use for the new database. The rows in the 
spreadsheet data become records in the database, and the columns 
become fields.

The fields in the new database file are initially named A, B, C, and so 
on, but you can rename them in the Field Definition dialog box. If the 
first row of the spreadsheet has text that identifies the rest of the 
contents, you can use this row to provide the field names.

To create a database from a Lotus 1-2-3 spreadsheet:

1. Click the Open File icon or choose Open from the File menu. Or 
if the Welcome dialog box is on the screen, select “Open an 
existing file” and click OK.

2. Select Lotus 1-2-3 in the List Files of Type drop-down list.

3. Select the name of the spreadsheet in the File Name list and click 
OK.

Working together 
with Lotus 1-2-3

Creating a 
database from a 
Lotus 1-2-3 
spreadsheet

In a spreadsheet, the 
data is divided into rows 
and columns.

In a database, the rows 
become records, and 
the columns become 

1st Qtr
101.97

57.22

2nd Qtr
97.42

118.93

3rd Qtr
93.69
89.15

83.48 79.00 98.75

4th Qtr
84.32

103.99
93.79

1
2

A
1st Qtr
101.97

B
2nd Qtr

97.42

C
3rd Qtr

93.69
3 57.22 118.93 89.15

D
4th Qtr

84.32
103.99

4 83.48 79.00 98.75 93.79

The first row of a 
spreadsheet can 
provide field names 
for a database.
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You can change the directory and disk if you need to look for the 
file.

The Select Range dialog box appears.

4. Select a sheet or named range with the data you want to use in 
the new database.

Named ranges appear in all capital letters in the list.

5. To use the text in the first row of the spreadsheet as field names, 
turn on “First row contains field names.”

6. Click OK.

The Convert To dialog box appears.

7. Type a name for the database file in the File Name text box.

You can change the directory and disk if you want to specify a 
different location for the file.

8. Select a database file type in the List Files of Type drop-down list.

9. Click OK.

The Approach file for the new database opens to a standard 
form. 

Select a sheet or named 
range of data to use.

Turn this on if you want to 
use the first row as field 
names.

Type a name for the new 
database file.

Select a file type for the 
database file.

Specify a 
location for the 
database file.
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You can open a “live” named range from a Lotus 1-2-3 spreadsheet in 
Approach and view or edit the range in an Approach file. This does 
not convert the range to a database file. If you make any changes to 
data in the range, the changes are saved in the spreadsheet.

For you to be able to open a named range in Approach, Lotus 1-2-3 
must be running and the spreadsheet with the range must be open.

To open a named range from a Lotus 1-2-3 spreadsheet:

1. Click the Open File icon or choose Open from the File menu. Or 
if the Welcome dialog box is on the screen, select “Open an 
existing file” and click OK.

2. Select 1-2-3 Ranges in the List Files of Type drop-down list.

The Directories list shows the open 1-2-3 spreadsheets.

3. Select the name of the spreadsheet with the range you want in 
the Directories list.

The File Name list shows the named ranges in the selected 
spreadsheet.

4. Select the named range in the File Name list.

5. Click OK.

When you work in Lotus 1-2-3 (any version later than 4.0), you can 
create four types of Approach views to display selected worksheet 
data: reports, forms, dynamic crosstabs, and mailing labels. The 
Approach views appear as icons embedded in the 1-2-3 worksheet.

You can modify data in your Approach view. When you refresh the 
view these changes appear in your 1-2-3 database table. However, 
you can't modify formulas or field definitions while working with 
data in the view, nor can you create a chart from an Approach 
dynamic crosstab. If you wish to chart data that appears in a dynamic 
crosstab, you can copy the data back to 1-2-3 and chart it from there.

1-2-3 allows up to 512 characters of text in a database table field. 
Approach allows up to 256 characters of text in a field. If you refresh 
the Approach view, any text longer than 256 characters in a field will 
be truncated in your 1-2-3 database table.

Opening a named 
range from a Lotus 
1-2-3 spreadsheet

If you want to convert a 
range to a database, use Save 
As to save it as a database.

Creating an 
Approach view in 
Lotus 1-2-3
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To create an Approach view in Lotus 1-2-3:

1. Select the 1-2-3 database table range you want to view in the 
Approach form.

Be sure to include column headings when you select the 
database table range.

2. Choose Form, Report, Dynamic Crosstab, or Mailing Label from 
the Tools Database submenu.

3. Click OK.

The appropriate Approach Assistant opens. 

4. Modify the view if you wish and return to 1-2-3.

Choose Exit and Return from the File menu to close Approach. 
Choose Close and Return from the File menu to leave Approach 
running in the background.

1-2-3 embeds the Approach view as an icon in your 1-2-3 
worksheet. To connect to Approach and open the view again, 
double-click the icon. If you've changed data in your 1-2-3 
database table, Approach updates the view.

For information about the See

Form Assistant “Creating a form” on page 7-4

Crosstab Assistant “Creating a crosstab” on page 12-5

Mailing Label Assistant “Creating mailing labels” on page 9-16

Report Assistant “Creating a report” on page 8-3
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18 Sharing Data on a Network

You can keep an Approach database on a network and share it with 
other users. This is a powerful and efficient way to work. A network 
saves disk space by storing files in a central location, and it lets you 
use data simultaneously with other members of your work group.

This chapter describes how to set up your network environment and 
work with a database on a network.

Most of the information in this chapter applies to databases of any 
file type. If you’re using a SQL table on a network, see Appendix C 
for additional details.

You can store any Approach file and any database file supported by 
Approach on a network. Users who work on the network can create, 
open, and save files and work with data in them just as if the files 
were stored on their own local drives.

Most often, you set up a server by placing files on a central device that 
users have access to through the network. The server is usually a 
more powerful computer than the local devices, with a large drive 
and network software to process users’ requests. The users will work 
with the files on their own client computers.

With some network systems, users can also have access to files on 
other local drives. See “Network requirements” on page xiii for the 
types of network software you can use with Approach.

In general, each Approach user must have his or her own license, 
even if Approach is run from a server. For details on restrictions on 
network use, see your Approach license agreement.

About networking 
with Approach
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As you work with a database on a network, the original database 
remains in its network location—what you see on the screen is just a 
copy of those records in your computer’s memory. If you have write 
access to the database, you can make changes to the data and the 
changes are saved in the original database on the network.

Before sharing dBASE and Paradox files on a network, you need to 
specify several network settings. (You can open FoxPro files on a 
network, but you cannot share them concurrently with other users in 
Approach.)

The network settings are saved in the APPROACH.INI file, a text file 
in your Windows directory that stores default settings. Once you’ve 
made the settings, they’ll stay in effect from one work session to 
another unless you change them.

You can set options in Preferences to use optimistic record locking on 
a network and to download your working set of network data 
whenever you change to Preview. For more information about these 
options, see “Setting general working preferences” on page 19-14.

For dBASE files, you can specify whether other users can open 
network files you already have open, whether your local files are 
available to other users, and whether to optimize performance for 
Approach-only files.

If you have any files open when you set the file-sharing options, you 
need to close those files for the settings to affect them.

To set file-sharing options for dBASE files:

1. Open the New, Open, Save Database As, Import Data, or Export 
Data dialog box, and select dBASE IV or dBASE III+ in the List 
Files of Type drop-down list.

You can specify the options at the same time that you create, 
open, or save a database file or import or export data. Or you can 
open one of these dialog boxes just to use its Connect button.

2. Click Connect.

Setting up your 
network 
environment

Setting file-sharing 
options for 
dBASE files

It doesn’t matter which file is 
active. The options will affect 
all dBASE files you open.
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The dBASE Network Connection dialog box appears.

3. To allow other users to work with network files you have open, 
turn on “Database sharing.”

This setting lets other users open and make changes to a network 
dBASE file you already have open. If the setting is off, no one 
else will be able to open the file until you close it.

If this setting is on, you need to make sure that everyone you 
work with on a network uses the same protocol for dBASE files. 
For more information about this, see “Specifying a locking 
protocol for shared dBASE files,” next.

4. To make open files on your local drive available to other users, 
turn on “Local databases are shared.”

If you’re using a peer-to-peer network system such as LANtastic 
and the system is set up for sharing local files, this setting allows 
other users to open dBASE files on your local drive that you 
already have open.

If this setting is off, other users will be able to open a dBASE file 
on your local drive only if you do not already have the file open. 
This is true even if “Database sharing” is on and your network 
software allows you to share local files.

5. To optimize performance for files used only with Approach, turn 
on “Sharing data only with other Approach users.”

Turn this setting off only if you or other network users plan to 
use dBASE files with other applications.

6. Click OK.

You return to the New, Open, Save Database As, Import Data, or 
Export Data dialog box.

7. Close and reopen any dBASE files for the changes to affect them.

Gives other users access 
to network files you have 
open

Gives other users access 
to local files you have 
openOptimizes performance 

for Approach-only files
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If you’re sharing dBASE files with other users, you and the other 
users must all specify Approach, dBASE IV, or dBASE III+ as the 
locking protocol for the files. The default protocol is Approach.

To maintain the integrity of data, make sure that all the users specify 
the same protocol.

To specify a locking protocol for shared dBASE files:

1. Use a text editor to open the APPROACH.INI file.

The APPROACH.INI file is in your Windows directory.

2. Set the sdBASEFileSharingMethod line to Approach, dBASE4, or 
dBASE3.

For example,

sdBASEFileSharingMethod=Approach

If all users are working with the dBASE files only through 
Approach, leave the locking protocol as Approach.

If any of the users are working through a dBASE IV application, 
change the protocol to dBASE4. If any users are working through 
a dBASE III+ application, change the protocol to dBASE3.

3. Save and close the APPROACH.INI file.

4. Restart Approach for the change to take effect.

For Paradox files, you can specify Paradox 3.5 or Paradox 4.x 
networking and the location of the Paradox control files. 

Paradox databases use network control files to monitor user count 
and to control database sharing on a network. In Paradox 4.x 
(including Paradox for Windows), the network control file is called 
PDOXUSRS.NET; in Paradox 3.5, the file is called PARADOX.NET.

The location of the Paradox control files is stored in APPROACH.INI. 
When you open a Paradox database on a network, Approach gets the 
location from APPROACH.INI and looks for the appropriate control 
file. If Approach cannot find the file, it creates one in the specified 
location. The file will remain there for future use.

If you do not specify a location for the control files, you will open 
Paradox databases on a network as a single user.

Specifying a 
locking protocol for 
shared dBASE files

The Approach protocol will 
usually give you the best 
performance.

Setting file-sharing 
options for 
Paradox files

Users of Paradox 4.x cannot 
share data concurrently with 
users of Paradox 3.5.
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To set file-sharing options for Paradox files:

1. Open the New, Open, Save Database As, Import Data, or Export 
Data dialog box, and select Paradox from the List Files of Type 
drop-down list.

You can specify the options at the same time that you create, 
open, or save a database file or import or export data. Or you can 
open one of these dialog boxes just to use its Connect button.

2. Click Connect.

The Paradox Network Connection dialog box appears.

3. To change the type of networking, select “Use Paradox 3.5 
networking” or “Use Paradox 4.x networking.”

If “Use Paradox 3.5 networking” is selected, you can open 
Paradox 3.5 files but not Paradox 4 files on a network. When you 
create or export Paradox files (whether or not you are using a 
network), the files are in the 3.5 type.

If “Use Paradox 4.x networking” is selected, you can open both 
Paradox 3.5 and Paradox 4.x files on a network. When you create 
or export Paradox files (whether or not you are using a network), 
the files are in the 4.x type.

4. Type your user name in the User Name text box.

5. Type the directory location for the control files in the Network 
Control File Path text box.

Give only the pathname and not a filename. For example, if the 
control files are in the SHARE directory on the f drive, type 
f:\SHARE (not f:\SHARE\PDOXUSRS.NET). Check with your 
network administrator for the location of these files.

The network control files for Paradox 3.5 and Paradox 4.x should 
be in the same directory.

6. Click OK.

You return to the New, Open, Save Database As, Import Data, or 
Export Data dialog box. 

It doesn’t matter which file is 
active. The options will affect 
all Paradox files you open.

Type your user name.
Type the pathname 
for the control file.

Select a networking 
type.

Paradox 4.x includes Paradox 
for Windows.

If you don’t want other users 
to have access to a Paradox 
file you have open, leave the 
text boxes blank.
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7. Close and reopen any Paradox files for the changes to affect 
them.

In most ways, you can create, open, and save databases and import 
and export data on a network just as you can on your local drive. Use 
the same dialog boxes you use with your local files, and provide the 
location of the network drive and directory.

If you try to use a SQL table and are not yet connected to a SQL 
server, a dialog box appears that lets you connect to the server. For 
information about this, see Appendix C.

You can find and sort records, specify printing options, and change 
to Browse, Design, Find, and Preview in a network database as you 
can with local files. And if you have read/write access to the 
database, you can also enter and edit data in it.

This section covers the ways in which using a network database can 
differ from using a local database.

In general, you’ll probably want to share network databases with 
other users because this is the most efficient way to work. But there 
may be times when you want to open a particular database as a 
single user—for example, if you need to make structural changes to 
the database or if you have a lot of previewing and printing to do. 
You can temporarily change your network environment to let you 
open databases as a single user.

Working with a 
database on a 
network

You can specify a network 
drive and directory in 
Approach dialog boxes.

Changing your 
status to 
single-user
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■ To change your status to single-user for a dBASE database, turn 
off “Database sharing” in the dBASE Network Connection dialog 
box.

For details, see “Setting file-sharing options for dBASE files” on 
page 18-2.

■ To change your status to single-user for a Paradox database, 
delete the text in the User Name and Network Control File Path 
text boxes in the Paradox Network Connection dialog box.

For details, see “Specifying a locking protocol for shared dBASE 
files” on page 18-4.

Change the settings back to the way they were when you’re finished 
working with a database as a single user.

Files on a network often have one or more passwords so that only 
some users can read or edit the files. In Approach, both database files 
and Approach files can have passwords:

• A database file can have two passwords: a read/write password 
that gives users complete access to the file, and a read-only 
password that allows users to read data but not modify it. Each 
database can have a read/write password or both a read/write 
and a read-only password.

• An Approach file can have one password. In this case, the 
password gives users the ability to modify the design of forms, 
reports, and other views.

For information about setting passwords, see “Defining passwords 
for files” on page 19-6.

If a database has passwords, the Enter Password dialog box appears 
when you try to open an Approach file that uses the database. If an 
Approach file has a password, Enter Password appears when you try 
to change to Design, join database files, or create a view.

■ To enter a password, type the password in the Enter Password 
text box and click OK.

Entering a password

Database passwords protect 
data, and Approach file 
passwords protect the design 
of views.

Type the password.
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You must spell a password exactly as it was defined, except that 
a password is case-insensitive.

As you work in a network database, Approach places a copy of the 
data you see on the screen in your computer’s memory. If other users 
are working in the database at the same time you are and make 
changes to its data, their changes do not always appear instantly in 
the image on your screen. 

Approach refreshes the data from a network database when you edit, 
find, or sort data, when you preview or print, and when you change 
what you see on the screen (such as move to another record or go to 
Design). You can also refresh the data yourself.

■ To refresh the network data on your screen, choose Refresh from 
the Browse menu. (If a PicturePlus field is selected or if the 
current view is a worksheet or crosstab, the command is in the 
PicturePlus, Worksheet, or Crosstab menu.)

The data on your screen is updated to match the database on the 
network. If you’ve made any changes that you haven’t entered, 
this command also enters those changes.

If you’re working with a found set or with sorted data, Refresh 
inserts any new records into the found set or the sort order as 
appropriate.

About downloading data in Preview
When you print data from a network, Approach normally refreshes 
the data from the network database. If you preview data before 
printing and other users make changes to the database after you 
preview, the data you print may not be the same as the data you 
previewed.

You can have Approach download a copy of the current set of 
network data to your hard disk whenever you change to Preview to 
“freeze” the data you see on the screen. The copy of the data that 
Approach downloads is only temporary. and is deleted when you 
change to Browse or Design.

When you download data in Preview, the data set you print will be 
the version on your hard disk rather than refreshed data from the 
network. This way, you can be sure you’re looking at what will 
actually be printed.

For information about setting this option, see “Setting general 
working preferences” on page 19-14.

Refreshing the 
network data on 
your screen

Refresh data periodically as 
you work, to be sure you’re 
seeing the most recent version 
of it.

Downloading is helpful when 
you preview a report that uses 
a summary or any view or 
data set that many users are 
working on.
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It’s usually possible for more than one network user to edit a record 
at the same time. This method of data-sharing, called optimistic record 
locking, is an efficient way to work—and Approach helps you make 
careful use of it. 

If you have optimistic record locking set for your network 
environment, other users will be able to edit a record at the same 
time you do. When two users edit the same record, the changes are 
saved in the database for the first user to enter the changes. When the 
second user tries to enter his or her changes, an alert box warns that 
the changes may overwrite those made by the first user.

■ To save changes to a shared record, click Yes to save your 
changes and overwrite changes made by other users.

This overwrites all changes made to the record since your view 
of it was last refreshed.

■ To cancel your changes and refresh your copy, click No.

This lets you see changes made to the record by other users. You 
can then make your changes on top of theirs.

If you don’t want other users to edit a record at the same time as you, 
you can turn off optimistic record locking. This way, once you’ve 
clicked in a record, other network users can view the record but not 
make changes to it until you go to another record.

For information about setting this option, see “Setting general 
working preferences” on page 19-14.

Saving changes to 
a shared record

Saves your changes 
and overwrites those 
of other users

Refreshes your data to 
see changes made by 
other users

Approach runs faster with 
optimistic record locking 
because it does not have to 
check whether to lock a record 
when a user tries to view it.
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19 Customizing Approach

Defaults are the preset values that Approach uses for a number of 
settings, such as units of measure for rulers, spacing of grid lines, pen 
color and width for new objects, and treatment of oversized pictures 
in a PicturePlus field. 

You can change any of these values as you work, but the next time 
you choose a drawing icon or create a field, Approach reverts back to 
its default settings. The defaults are stored in the APPROACH.INI file 
in your Windows directory.

If you change settings only once in a while, you may want to leave 
the defaults as they are. But if you find that you always adjust the 
same setting, such as the pen width, you may want to change the 
default so that Approach automatically uses the setting you like. 

This chapter explains how to change the default settings for a wide 
variety of features in the Approach work area, how to change the 
SmartIcons that appear in the icon bar, and how to create or modify 
custom menus.

To specify a working directory for Approach, use the Properties 
command in the File menu of the Windows Program Manager.

You can customize many aspects of your work area in Approach 
using the Preferences dialog box. These settings include a default sort 
order for records, window elements that appear in the work area, 
passwords for database files and Approach files, and database 
settings such as indexes and character sets.

To set Approach preferences:

1. Choose Preferences from the Tools menu.

Setting Approach 
preferences
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The Preferences dialog box appears.

2. Set the options in the panels of the dialog box.

The sections that follow describe each panel. Click a tab in the 
dialog box to go to another panel.

3. Click OK or Save Default.

If you click OK, the settings are saved only for your current 
session with Approach. If you click Save Default, the settings 
become the new defaults.

The display defaults determine the window elements that appear in 
the Approach work area (such as icon bars, view tabs, and the status 
bar), the default style available in Assistants (for creating views), and 
the design elements that appear in Design.

You can also show or hide SmartIcons, view tabs, the status bar, data, 
rulers, and the grid using commands in the View menu. These 
commands show or hide the elements only for the current work 
session and do not change the defaults.

For more information about working with data, rulers, and the grid 
showing, see “Customizing the Design work area” on page 5-7. 

Click tabs to go to other 
panels of settings.

Click OK to save the settings 
for the current work session. 
Click Save Default to make 
them the new defaults.

Setting display 
defaults
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To set display defaults:

1. Click the Display tab in the Preferences dialog box.

The Display panel appears.

2. In the Show area, turn on the window elements you want to 
display.

Turn on To display

SmartIcons An icon bar (preset to appear at the 
top of the Approach window)

Status bar A status bar at the bottom of the 
Approach window

View tabs Tabs with view names at the top of 
the Approach window

Title bar help Command descriptions in the title 
bar, whenever you point on a menu 
command

Welcome dialog A dialog box for opening and 
creating files, whenever you start 
Approach or close all open files

Find bar A bar with buttons for finding 
records, whenever you go to Find

Turn on the window 
elements to display.

Define a default style for 
new views.

Turn on the design 
elements to display 
in Design.

Set options for the 
design grid.
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3. In the Style area, click Edit Default Style and define a default 
style to be available in the Assistants when you create views.

A style specifies design properties, such as colors and text 
attributes, for all new objects and for the background of new 
views. When you create a new view, you can use the default style 
or select a predefined SmartMaster style in the Assistant.

When you click Edit Default Style, the Define Style dialog box 
appears. For information about it, see “Working with named 
styles” on page 5-26.

4. In the Show in Design area, turn on the design elements you 
want to display.

5. In the Grid area, specify the grid settings.

Turn on To display

Data Data from the first record or page 
of records in field boxes in Design 
(Otherwise, field names appear in 
the boxes.)

Rulers Rulers along the top and left sides 
of the Design work area

Add Field dialog The Add Field dialog box in Design

Drawing tools A floating palette of icons for 
drawing tools in Design

Use the option To do this

Show grid Show a design grid behind objects 
in the Design work area

Snap to grid Make objects align with increments 
on the grid, when you draw, move, 
or resize the objects

Grid units Specify a unit of measure (inches or 
centimeters) for the increments on 
the grid

Grid width Specify a width for the increments 
on the grid (First select a grid unit 
to see a list of widths here.)
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Approach stores records in a database file in the order you add them 
to the database (the creation order). But for each Approach file, you 
can set a particular order for the records and then move through 
them in that order in Browse.

When you specify an order for records, this becomes the new default 
order in that Approach file (replacing the creation order). If you later 
rearrange the records with the Sort command in the Browse menu, 
when you click the Show All icon, the records return to their default 
order.

You specify one or more sort fields for reordering records and 
whether the sort in each field should be ascending or descending. 
The first field is the primary sort field. Approach sorts the records by 
the contents of that field. You can also specify other sort fields for 
Approach to use in case any records have the same value in the 
primary field. For example, you might use Last Name as the primary 
sort field and First Name as an additional sort field.

The order of records in an Approach file does not affect the order of 
records in the actual database. A database still stores records in their 
creation order.

To set a default order for records:

1. Click the Order tab in the Preferences dialog box.

The Order panel appears.

2. If you need to change to another database, select a database in 
the Maintain Default Sort For drop-down list.

The list shows all databases joined in the current Approach file.

Setting a default 
order for records

If you want to change the 
order of records only 
temporarily, use the Sort 
command instead.

Select the database with 
records you want to sort.

Move the sort 
fields to the 
Fields to Sort 
On list.

Select a sort direction for 
each sort field.
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3. Specify the primary sort field by moving a field name to the 
Fields to Sort On list.

To move a field to the Fields to Sort On list, select the field name 
and click Add, or double-click the field name.

To move a field back to the Database Fields list, select the field 
name and click Remove, or double-click the field name. To move 
all the fields back to the Database Fields list, click Clear.

4. Click Ascending or Descending for the primary sort field.

Ascending sorts text from A to Z, numbers from lowest to 
highest, and dates and times from earliest to latest. If a text field 
has numbers and text, the sorting is 0 to 9 and then A to Z. 
Leading spaces are sorted before numbers and text.

Descending sorts data in the opposite direction. If a text field has 
numbers and text, the sorting is Z to A and then 9 to 0. Leading 
spaces are sorted at the end.

5. If necessary, specify additional sort fields in the same way.

For each field, move the field name to the Fields to Sort On list 
and click Ascending or Descending.

You can have as many sort fields as you need. Approach sorts the 
records using the fields in the order in which they appear in the 
Fields to Sort On list.

You can define passwords for database files and Approach files. This 
allows you to share data and views with other users—without 
compromising the security of your data or the design of your views.

A database file can have two kinds of passwords. A read/write 
password gives users complete access to the file, including the ability 
to modify data. A read-only password allows users to read data, but 
not modify it. A database file password you assign in Approach 
encrypts the data in the file, so you will not be able to read and edit 
the data in another application.

You can give a database file a read/write password or both a read/
write and a read-only password. (The file needs the read/write 
password because at least one user should have write access to it.) 
When you try to open an Approach file that uses a database file with 
one or both passwords, a dialog box appears asking for a password.

If a record appears to be 
sorted out of order, check for 
leading spaces.

Defining passwords 
for files
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An Approach file password protects the design of views in the file. In 
this case, a dialog box asks for the password when you try to join 
database files, go to Design, or use an Assistant to create a view.

To define passwords for files:

1. Click the Password tab in the Preferences dialog box.

The Password panel appears.

2. To define a password for the current Approach file, type the 
password in the Password for This Approach File text box.

Passwords are not case-sensitive and can have up to 16 
characters. Asterisks appear in the text box as you type the 
characters of the password.

If a user enters this password correctly, he or she will be able to 
join database files, create new views, and redesign existing views 
in the file.

When you click in or tab to another text box, click a panel tab, or 
close the Preferences dialog box, the Confirm Approach File 
Password dialog box appears. Type the password a second time 
and click OK.

3. To define passwords for a database file, type the passwords in 
the Read/Write Password and Read-Only Password text boxes.

You can also set an Approach 
file password in Save As.

Type a password for the 
current Approach file.

Select a database and 
type one or two 
passwords for it.

Database passwords protect 
data. Approach file passwords 
protect the design of views.

Type the password a 
second time to confirm it.
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If you need to change to another database, select a database in 
the Database Name drop-down list. The list shows all databases 
joined in the current Approach file.

A read/write password gives a user complete access to a 
database. A read-only password allows a user to read data in the 
database, but not to modify it.

When you click in or tab to another text box, click a panel tab, or 
close the Preferences dialog box, the Confirm Password dialog 
box appears. Type the password a second time and click OK.

The Approach dialing preferences let you define standard modem 
settings to be used whenever you have Approach dial a telephone 
number. Modem settings include the name of the serial port, the 
modem’s baud rate (speed), and the type of dialing service to use. 

To set dialing preferences:

1. Click the Dialer tab in the Preferences dialog box.

The Dialer panel appears.

2. Set the modem options you want to be used whenever Approach 
dials a telephone number.

If you want to make a file 
read-only without setting a 
password, use the Database 
panel instead.

Type the password a 
second time to confirm it.

Setting dialing 
preferences

Select a communications 
port. Set the speed of 

the modem.
Type a prefix and suffix for 
dialing.

Type a command for 
initializing your modem.

Type a command 
for hanging up.

Type numbers to omit while 
dialing.

Type numbers to dial for access to 
a phone system or outside line.

Specify a dial type 
for your modem.
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For more information about the options, see the documentation 
that came with your modem. 

For a dBASE or FoxPro database file, you can make the file read-only 
in the current Approach file, change to another character set, and 
compress the file for more efficient storage.

You can use either the DOS character set or the Windows character 
set in Approach. The character set you use determines how you type 
special characters that are not on the keyboard. For example, if you’re 
using the DOS set and want to type the symbol for Yen (¥), you press 
ALT and type 157 on the numeric keypad; with the Windows 
character set, you press ALT and type 165 on the numeric keypad.

To set database options for a dBASE or FoxPro file:

1. Click the Database tab in the Preferences dialog box.

Use this option To set 

Modem port The communications port your modem is 
connected to

Baud rate The speed of the modem

Dial prefix/suffix The command string for both before 
(prefix) and after (suffix) you dial

Hangup The command string you use to hang up

Initialize The command string that initializes your 
modem

Access code Any numbers you need to dial to get access 
to a particular exchange or phone system, 
and (if necessary) a comma for a pause (For 
example, to dial 9 for an outside line, type 
9 and then a comma; the comma inserts a 
pause to wait for the outside line.)

Do not dial Any numbers to omit while dialing

Dial type Whether your modem line is tone or pulse

Setting database 
options for a 
dBASE or 
FoxPro file

Most telephones use the tone 
dial type.

Use “Do not dial” to remove 
the area code or international 
dialing code from the 
beginning of a phone number.
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The Database panel appears.

2. If you need to change to another database, select a database in 
the Database Name drop-down list.

The list shows all databases joined in the current Approach file.

When you change to another database, the panel shows options 
for databases of that type.

3. To set the database to read-only in the current Approach file, turn 
on “Make all fields in database read-only.”

4. To change the character set for the database, click an option in the 
Character Set area.

5. To compress the database, click Compress.

For a Paradox database file, you can make the file read-only in the 
current Approach file, change to another character set, and (for 
Paradox 4.0) change case-sensitivity for searches.

You can use either the DOS character set or the Windows character 
set in Approach. The character set you use determines how you type 
special characters that are not on the keyboard. For example, if you’re 
using the DOS set and want to type the symbol for Yen (¥), you press 
ALT and type 157 on the numeric keypad; with the Windows 
character set, you press ALT and type 165 on the numeric keypad.

Searches in Paradox 3.5 files are always case-sensitive. In Paradox 4.0 
files searches are initially not case-sensitive, but you can change them 
to case-sensitive in Approach.

Select the database.

Turn this on to make 
the database read-
only in the current 
Approach file.

Select a character set for the 
database.

Click Compress to 
compress the file.

You may want to compress a 
database if you’ve deleted 
many records. Approach does 
not remove the space left by 
deleted records.

Setting database 
options for a 
Paradox file
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To set database options for a Paradox file:

1. Click the Database tab in the Preferences dialog box.

The Database panel appears.

2. If you need to change to another database, select a database in 
the Database Name drop-down list.

3. To set the database to read-only in the current Approach file, turn 
on “Make all fields in database read-only.”

4. To change the character set for the database, click an option in the 
Character Set area.

5. To change the case-sensitivity for searches in the database, click 
an option in the Paradox Case Sensitivity area.

These options are not available for Paradox 3.5 files.

For SQL, Microsoft Access, and ODBC tables, you can specify read-
only access, display SQL system tables in the lists of filenames in 
dialog boxes, and cache the names of tables. The read-only setting in 
these options also applies to Lotus Notes tables.

The database options for SQL, Access, ODBC, and Lotus Notes affect 
all of the tables you create or open in Approach, not just the table 
selected in Preferences.

Select the database.

Turn this on to make 
the database read-
only in the current 
Approach file.

Select a character set for the 
database.

Select a case option for 
searches in the database.

Setting database 
options for all SQL, 
Access, ODBC, and 
Lotus Notes tables
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To set database options for all SQL, Access, ODBC, and Lotus 
Notes tables:

1. Click the Database tab in the Preferences dialog box.

The Database panel appears.

2. If you need to change to a SQL, Access, ODBC, or Lotus Notes 
table, select a table in the Database Name drop-down list.

The options will apply to all of these tables you open or create 
through Approach.

3. To display SQL system tables in the lists of filenames in 
Approach dialog boxes, turn on “Show system tables in Open 
dialog.”

4. To cache a table name the first time you open a table, turn on 
“Cache table names for use in Open dialog.”

5. To set tables to read-only in Approach, turn on “Open all SQL 
tables as read-only.”

In dBASE and FoxPro database files, Approach uses and maintains 
its own indexes to keep track of records. If you have any indexes 
created in dBASE or FoxPro that you want Approach to maintain, 
you can associate those indexes with your database file. 

Approach does not use these external indexes, but maintains them 
for the other applications.

To maintain external indexes for a dBASE or FoxPro database:

1. Click the Index tab in the Preferences dialog box.

Turn this on to display SQL 
system tables in file dialog 
boxes. Turn this on to 

cache a table 
name the first time 
you open the table.

Turn this on to have read-
only access to SQL, 
Access, ODBC, and Notes.

Select any SQL, Access, 
ODBC, or Notes table.

If you cache table names, each 
table will open faster after the 
first time.

Maintaining 
external indexes for 
a dBASE or FoxPro 
database
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The Index panel appears.

2. If you need to change to another database, select a database in 
the Database Name drop-down list.

3. To add an external index to the database so that it will be 
maintained for other applications, click Add Index, select the 
index in the dialog box that appears, and click OK.

When you click Add Index, the Add Index dialog box appears.

After you add the index, it appears in the list in the Index panel.

4. To close an external index so that it will no longer be maintained, 
select the index in the list of indexes and click Close Index.

In a Paradox database file, a primary index is built on the key field 
specified when the file is created. You can create additional, 
secondary indexes for the file in Approach.

Approach automatically uses and maintains all indexes for Paradox 
database files. 

To close an external index, 
select the index and click 
Close Index.

Select the database.

To add an external 
index, click Add 
Index and use the 
dialog box that 
appears.

Select the index you want 
to add.

Select the type of the 
index.

Specify the 
location of the 
index.

Creating secondary 
indexes for a 
Paradox database
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To create secondary indexes for a Paradox database:

1. Click the Index tab in the Preferences dialog box.

The Index panel appears.

2. If you need to change to another database, select a database in 
the Database Name drop-down list.

3. To add a secondary index to the database, click Add Index, type 
the name in the Paradox Secondary Index text box, and move the 
index fields to the Fields to Index list.

To move a field to the Fields to Index list, select the field name in 
the Database Fields list and click Add, or double-click the field 
name.

To move a field back to the Database Fields list, select the field 
name and click Remove, or double-click the field name. To move 
all the fields back to the Database Fields list, click Clear.

4. To delete a secondary index from the database, select the index in 
the Paradox Secondary Index drop-down list and click Delete 
Index.

Approach provides other options that make working with data as 
efficient as possible. You can make the ENTER key work in Browse 
just like the TAB key, open the Add Field dialog box automatically 
right after you define a field, show a Cancel Macro dialog box 
whenever you run a macro, allow joins on calculated fields, 
download the current data set whenever you go to Preview, and 
allow two network users to edit a record at the same time using 
optimistic record locking.

To add a secondary index, 
click Add Index, type the 
name, and specify the 
fields.

Select the database.

To delete a 
secondary index, 
select the name 
and click Delete 
Index.

Setting general 
working preferences
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To set general working preferences:

1. Click the General tab in the Preferences dialog box.

The General panel appears.

2. To make the ENTER key work in Browse just like the TAB key, turn 
on “Use Enter key to move or tab between fields in Browse.”

When you press ENTER, any new data in the current field is 
entered and you move to the next field in the data entry order. 

If this setting is off, pressing ENTER enters the data but does not 
move you to the next field.

3. To open the Add Field dialog box automatically whenever you 
define new fields or edit existing ones, turn on “Show the Add 
Field dialog after creating new fields.”

When you close the Field Definition dialog box, the Add Field 
dialog box appears in the work area so that you can easily add 
the fields to a view. In this case, Add Field shows only the fields 
you just defined or edited; it has an additional Show All Fields 
button that you can click to list all the fields. For information 
about using Add Field this way, see “Adding a field to a form, 
report, or mailing label” on page 6-1.

4. To show the Cancel Macro dialog box whenever you run a macro 
in Approach, turn on “Show the Cancel Macro dialog when 
running macros.”

You can click Cancel in the dialog box to cancel a macro in 
progress.

Turn this on to tab with 
the ENTER key.

Turn this on to show a 
cancel dialog box when a 
macro is running.

Turn this on to download 
the data set when you 
preview.

Turn this on to 
open Add Fields 
right after defining 
a field.

Turn this on to 
allow joins on 
calculated fields.

Turn this on to allow two users to 
modify a record at the same time.
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5. To allow joins on calculated fields in the current Approach file, 
turn on “Show calculated fields in the Join dialog.”

Join fields appear italicized in a field list in the Join dialog box, 
after other fields in the database. You can join on calculated fields 
as you do with other types of fields.

6. To have Approach download a copy of the current data set to 
your hard disk whenever you preview, turn on “Download data 
before previewing.”

If you download data in Preview, the data set you print will be 
the version on your hard disk rather than the one in the network 
database, so you can be sure you’re printing what you 
previewed. For more information, see “About downloading data 
in Preview” on page 18-8.

7. To allow two network users to edit a record at the same time, 
turn on “Lock records using optimistic record locking.”

With optimistic record locking, when two users edit the same 
record, the changes are saved in the database for the first user to 
enter them. When the second user tries to enter changes, 
Approach asks if he or she wants to save the changes and 
overwrite those of the first user, or cancel the changes. 

If this setting is off, two users can view a record at the same time, 
but only the first user to go to the record can edit it. This is 
sometimes called full record locking.

SmartIcons give you single-click access to common Approach 
functions such as opening, saving, and closing files; going to Browse, 
Design, and Preview; finding and sorting records in Browse; and 
choosing drawing tools in Design.

Approach comes with a default set of SmartIcons for Browse, Find, 
and Preview. For Design, Approach provides three default sets of 
icons for the icon bar and a floating palette of icons that are used for 
drawing. You’ll also find sets of icons for Browse and Design that 
duplicate the Approach 2.0 look that may already be familiar to you.

Because not everyone likes to work the same way, you can add or 
remove icons in any of the default sets of icons or create your own set 
of icons. You can also change the location of the icon bar in the 
Approach window and change the size of icons in the icon bar.

It takes time to download a 
copy of data, so you may not 
want to do it when network 
activity is heavy.

Approach runs faster with 
optimistic record locking on 
because it does not have to 
check whether to lock a record 
when a user tries to view it.

Customizing the 
SmartIcons
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The icon bar pop-up menu at the right end of the status bar lists all 
the sets of icons you can use in the current environment, including 
any custom icon bars you’ve created. You can choose from this pop-
up menu to change to another icon bar.

You can also click the Next Icon Bar icon to change to the next bar in 
the list.

To customize the SmartIcons:

1. Go to Browse, Design, Find, or Preview, and choose SmartIcons 
from the Tools menu.

The SmartIcons dialog box appears, displaying a list of the 
available icons (on the left) and the set of icons in the current icon 
bar (on the right).

2. If you need to change to a different set of icons, select a set in the 
drop-down list at the top of the dialog box.

3. Add, remove, and arrange icons in the order you want them in 
the current set (the list on the right).

To add an icon, drag it from the Available Icons list to the 
position you want in current set.

To remove an icon from the current set, drag it from the current 
set to the Available Icons list.

To change the position of an icon in the current set, drag it up or 
down to the position you want.

You see only the icons that are 
appropriate for the current 
environment.

Select a 
location for the 
icon bar.

Click to save changes 
as a new set of icons.

Click to change the size 
of icons in the icon bar.

Select a set of icons.

Turn this on to see a description of icons 
when you move over them in the icon bar.

Click to remove 
a set of icons.

Use spacers (1/2-size blank 
icons) to separate logical 
groupings of icons.
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4. To save changes to the current set as a new icon bar, click Save 
Set, specify a name and file location in the Save Set of SmartIcons 
dialog box, and click OK.

5. To remove a set of icons, click Delete Set, select a set of icons to 
delete in the Delete Sets dialog box, and click OK.

6. To change the size of all icons in the icon bar, click Icon Size, 
select a size in the Icon Size dialog box, and click OK.

7. To change the location of the icon bar, select an option in the 
Position drop-down list.

If you select Floating, you can move or resize the icon bar in the 
Approach work area.

8. To see descriptions of icons when you move the pointer over 
them in the icon bar, turn on “Show icon descriptions.”

An icon description appears in a “bubble.” If this setting is off, 
you can still see the description by right-clicking the icon.

9. Click OK.

Approach allows you to create your own custom menu bars, which 
you can attach to selected views in an Approach file. You can base a 
new menu bar on an existing one, or you can create a menu bar from 
scratch.

Each menu can have as many or as few commands as you want. For 
example, if you’ve designed a data entry form, you might also create 
a menu that contains only the commands that the people entering 
data will need.

A custom menu bar can appear only in Browse.

Creating a custom menu bar is a two-step process. First you decide 
whether to base your menu bar on an existing one, and then you 
specify the menus and items it will contain. You must be in Design to 
create a menu bar.

You can base a custom menu bar on the default Approach menu bar, 
a default set of short menus, or any other menu bar you’ve already 
created. The short menus are a subset of the default menus; they do 
not include commands for modifying the Approach file. For 
example, the short menus do not have the Create Form and Define 
Macro commands.

Customizing 
menus

Creating a custom 
menu bar

Short menus are assigned to 
an Approach file with a 
password, unless you assign 
custom menus to it.
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To create a custom menu bar:

1. In Design, choose Customize Menus from the Tools menu.

The Customize Menus dialog box appears.

2. Click New or select an existing menu bar and click Copy.

The Define Custom Menu Bar dialog box appears. If you clicked 
Copy, the dialog box shows the menus and items for the selected 
menu bar. If you clicked New, the dialog box does not have any 
menu information.

3. Type a name for the menu bar.

The name appears in the list of menu bars in the Basics panel of 
the InfoBox for views. You use this list to attach a custom menu 
bar to a view.

Click New to create a 
new menu bar…

…or select a menu bar 
and click Copy to make a 
duplicate.

The names of existing 
menu bars appear here.

Unless the menus you’re 
creating have few commands, 
it’s usually most efficient to 
base them on existing menus.

Type a name for the new 
menu bar.

Define menus for the 
menu bar.

Define items for the 
menus.
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4. For the first menu in the menu bar, select a type in the Menu 
Type drop-down list and enter a name in the Menu Name text 
box.

You’ll also see the type Context Menu in the drop-down list. This 
is used by Approach for menus that appear only in certain 
environments or only with certain types of views active. It is not 
an editable menu type for custom menu bars.

To underline a letter in a menu name, type an ampersand (&) 
right before the letter in the name; for example, &File underlines 
the letter F. You’ll be able to open the menu in Browse by 
pressing ALT and the underlined letter.

5. For each item in the menu, select an action in the Item Action 
drop-down list and enter a name in the Item Name text box. 

The Item Action drop-down list shows all the commands you 
can use, the names of the main sections in the on-line Help, the 
names of all views and macros in the Approach file, a blank line, 
and a menu divider (with a line of hyphens). 

You can also type keyboard shortcuts for items along with their 
names.

To underline a letter in an item name, type an ampersand (&) 
right before the letter in the name; for example, Save &As 
underlines the letter A. You’ll be able to choose the item in 
Browse by pressing ALT and the underlined letter for the menu 
and then pressing the underlined letter for the item.

To add a new item to the menu, click Add Item. To remove an 
item, select it and click Delete Item. 

Use this menu type To display

Standard A list of commands

Menu + Files A list of commands, followed by the 
filenames of the last four Approach files 
used

Window Menu A list of commands, followed by the 
pathname of the current Approach file

Macro List A list of macros

View List A list of views
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To move an item to another position in the menu, select the item 
by clicking in the cell to the left of it, and then drag the item up or 
down. You can select more than one item to move by SHIFT-
clicking the items.

6. Continue adding and defining menus in the same manner.

For each menu, specify a type and a name, and define items for 
the menu.

To add a new menu to the menu bar, click Add Menu. To remove 
a menu, select it and click Delete Menu. 

To move a menu to another position in the menu bar, select the 
menu by clicking in the cell to the left of it and then drag the 
menu up or down. You can select more than one menu to move 
by SHIFT-clicking the menus.

7. Click OK.

8. Attach the menu bar to a view using the Basics panel of the 
view’s InfoBox.

For information about this, see “Changing the basic properties of 
a view” on page 5-36. 

Once you’ve created a custom menu bar, you can easily edit it or 
delete it. If you delete a menu bar that is attached to a view, 
Approach substitutes the default menu bar for the view. You must be 
in Design to edit or delete a custom menu bar.

To edit or delete a custom menu bar:

1. In Design, choose Customize Menus from the Tools menu.

These are the menus 
and items for the default 
menu bar.

An ampersand (&) 
signifies that the next 
letter is underlined as an 
ALT-key shortcut.

Editing or deleting a 
custom menu bar
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The Customize Menus dialog box appears.

2. Select the name of the menu bar you want to edit or delete.

You can edit or delete only menu bars you’ve created.

3. To redefine the menu bar, click Edit and change the menus or 
items in the Define Custom Menu Bar dialog box.

For information about working with Design Custom Menu Bar, 
see “Creating a custom menu bar” on page 19-18.

4. To remove the menu bar, click Delete.

Approach asks if you’re sure you want to remove the menu bar. 
Click OK in the alert box.

5. Click Done.

Select the menu bar you 
want to edit or delete. Click Edit to redefine 

the menu bar…

…or click Delete to 
remove the menu bar.
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A Formulas for Calculated Fields

This appendix covers what you need to know to use formulas in 
calculated fields. It gives an overview of formulas and functions and 
describes the types of expressions you can create. 

At the end of this appendix are syntax descriptions and examples for 
the predefined functions that come with Approach.

To use a calculated value in a field, you need to define a formula that 
specifies the operation to perform and the values to operate on. 
Approach evaluates the formula and returns the result to the field.

A formula can be made up of operators, operands, functions, and 
expressions.

Operators are symbols that specify the type of calculation or other 
evaluation you want to perform. Approach provides operators for 
arithmetic calculations (such as addition and multiplication), 
comparisons (such as greater than and equal to), and logical 
operations (such as AND and OR).

For example, in the following formulas the multiplication sign (*) 
and greater-than sign (>) are the operators:

Subtotal * .06
ShipDate > '1/1/93'

The Approach operators are covered in more detail in “Types of 
expressions” on page A-4.

Elements of a 
formula

Operators
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Operands are the values in a formula. An Approach formula can use 
constants or field references as operands. Very often, formulas use a 
mix of the two.

Constants
A constant is a value that you enter directly in a formula. This value 
will be used exactly as you type it and will not change from one 
record to another.

For example, in the formula

48 * 8.95

the numbers 48 and 8.95 are numeric constants. 

In many cases, you can also use a text, date, or time string as a 
constant. You must enclose one of these values in single quotation 
marks, like this:

'1/1/94' + 15

When entering date and time constants, use the separator specified 
in the Windows International Control Panel for your system. For 
dates, also enter the month, day, and year in the order given in the 
International Control Panel. For example, the standard numerical 
date format for the United States is 4/30/94 but for Sweden it is 
1994-04-30.

Field references
A field reference is a pointer to the contents of a field. You supply the 
field name as the reference, and Approach uses the value from that 
field for the current record in the formula. The value for a field 
reference can change from record to record.

For example, in the formula

Quantity * 8.95

the name Quantity is a reference to a field. In one record, this formula 
might calculate 48 * 8.95; in another, it might calculate 31 * 8.95.

Normally, a field name does not need any delimiters. But you must 
enclose the name in double quotation marks if it begins with a 
number, or if it contains a space, a period, a comma, or any of the 
following characters:

/, *, +, -, <, >, (, )

Operands
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For example,

"Monthly Expenses" * 12

If a field reference is to a field in a joined database, you include the 
name of the database in the reference. Separate the database name 
and the field name with a period. For example,

ORDERS.Quantity * 8.95

The name of the database must be in all capitals. If you select a field 
in the Formula panel of the Field Definition dialog box, Approach 
provides the database name for you.

If you use a reference to a calculated field or a variable field, you do 
not include the database name. These fields are part of an Approach 
file rather than part of a database file.

Functions are predefined routines that perform specific operations. 
Approach provides functions for many common tasks you may need 
in your work—for example, to calculate a monthly payment on a 
loan or to compare two fields for different spellings of a name. Rather 
than defining a routine yourself, you can use one of these functions 
to tell Approach what to do.

For example, the function

SSum(AmtDue)

calculates a total for the values in the AmtDue field in a range of 
records.

You can use a function by itself or combine it with operators, 
operands, and other functions to build a more complex formula.

For more detailed information about working with functions, see 
“How to use functions” on page A-6. “Descriptions of functions” on 
page A-10 gives syntax and examples for all the Approach functions.

An expression is a combination of operators, operands, and functions 
that yields a single result. A formula can consist of one expression—
or it can be made up of many expressions.

For example, in the formula

If(Orders > (Inventory + 50),'Reorder','In Stock')

Inventory + 50 is one expression, Orders > (Inventory + 50) is another 
expression, and the entire formula is also an expression. 

Functions

Expressions 



A-4 User’s Guide

If a formula has more than one expression, Approach evaluates each 
expression until it reaches a single, final result for the entire formula. 
Approach goes through the formula from left to right, evaluating the 
expressions in the innermost parentheses first and working its way 
out. Thus, to evaluate the If formula above, Approach evaluates 
Inventory + 50 first, uses that result to evaluate Orders > (Inventory + 50) , 
and so on.

You can create three types of expressions in Approach: arithmetic, 
comparison, and logical. The three types use different operators and 
operands and return different kinds of results. You can combine 
different types of expressions in a single formula.

Arithmetic expressions perform basic calculations on two numeric, 
date, or time values. These are the operators you can use:

For example, 

• 60000 / 12 equals 5,000

• Subtotal * .06 multiples the value in the current record’s Subtotal 
field by 6 percent

• ShipDate + 15 returns a date equal to 15 days from the date in the 
current record’s ShipDate field

If a formula has more than one arithmetic expression, Approach 
evaluates the expressions from left to right, performing 
multiplication and division first and then addition and subtraction. 
To change the order of evaluation, put the expressions you want 
evaluated first in parentheses. For example,

• 4 + 8 * 3 equals 28

• (4 + 8) * 3 equals 36

Operator Definition

+ Adds the two values

– Subtracts the second value from the first

* Multiples the two values

/ Divides the first value by the second

Types of 
expressions

Arithmetic 
expressions 

Use a function for more 
complex calculations, such as 
to calculate an interest rate 
on a loan.
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Comparison expressions compare two values and return a result of 
Yes or No. The values can be numbers, text, dates, or times, but they 
should both be of the same type. These are the operators you can use:

For example,

• 75 >= 50 equals Yes

• Total < 100 equals Yes if the value in the current record’s Total 
field is less than 100, and No if the value is 100 or greater

• Contact = 'Marcus' equals Yes if the current record’s Contact field 
contains the text Marcus, and No if the field is blank or has any 
other contents

Comparison expressions are often used to define conditions that 
must be met before a calculation or other operation can be 
performed. For example, this formula specifies that if the price of an 
item is $20 or more (if Price >= 20 equals Yes) the shipping cost is 15 
percent of the price:

If(Price >= 20,Price * .15,4)

If the price is under $20 (if Price >= 20 equals No), the shipping cost 
is $4.

Operator Definition

< Returns Yes if the value on the left is less than the 
value on the right

<= Returns Yes if the value on the left is less than or 
equal to the value on the right

= Returns Yes if the two values are equal

<> Returns Yes if the two values are not equal

> Returns Yes if the value on the left is greater than the 
value on the right

>= Returns Yes if the value on the left is greater than or 
equal to the value on the right

Comparison 
expressions 

Use a function for more 
complex comparisons, such as 
to see if two strings match in 
part.
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Logical expressions compare or change the result of comparison 
expressions and return a result of Yes or No. A logical expression 
allows you to define more complex conditions than you can with 
comparison expressions alone. Approach provides three logical 
operators:

AND and OR require an expression operand on both sides. NOT 
requires only one operand.

For example, suppose the Orders field contains 462 and the ShipDate 
field contains the date 1/15/94:

• Orders >= 500 AND ShipDate >= '1/1/94' equals No

• Orders >= 500 OR ShipDate >= '1/1/94' equals Yes

• NOT (Orders >= 500) equals Yes

With NOT, you put the expression to the right of the operator and in 
parentheses. In a formula with more than one expression, Approach 
evaluates a NOT expression first, before the arithmetic, comparison, 
and other logical expressions.

A function has a name, a pair of parentheses, and usually a set of 
values called parameters for the function to evaluate. Functions are 
really a type of formula. The operator is implicit in the function 
name, and the parameters specify the operands.

Operator Definition

AND Returns Yes only if both expressions are true

OR Returns Yes if either or both of the expressions are 
true

NOT Converts a comparison result from Yes to No or 
from No to Yes

Logical 
expressions 

How to use 
functions
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For the parameters in a function, you can use constants (such as 28.5, 
'Cola', or '1/1/94'), field references (such as the field name PartNo), 
and other functions. Enclose a set of parameters in parentheses, and 
separate individual parameters in a set with commas. 

For example, the following function tells Approach to retrieve the 
value in the Total field, or to use the value 50 if the field is blank.

If you’re using Approach in a language other than U.S. English, your 
system may require a different delimiter than the comma. Use 
whatever list separator is specified in the Windows International 
Control Panel. Also enter date and time parameters using the format 
specified in the International Control Panel.

You treat parameters as you do operands in a formula: Enclose text, 
date, and time constants in single quotation marks. Enclose a field 
name in double quotation marks if it begins with a number, or if it 
contains a space, a period, a comma, or any of the following 
characters:

/, *, +, -, <, >, (, )

A few functions do not use any parameters, but you must include 
parentheses with them. For example, this function returns the current 
time on the system clock, so it does not need any information from 
you:

CurrTime()

Every function has a syntax description that defines whether each 
parameter should be text, a number, a date, or a time. These 
descriptions begin on page A-10.

You can use functions as parameters in other functions, thus 
manipulating your data in powerful ways. Approach calculates the 
nested, or inner, function first and then uses its result as a value in 
the outer function. 

Parameters in 
functions

Blank(Total,50)

Enclose parameters in parentheses.

Separate parameters with commas.

Functions within 
other functions
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In this formula, the Like function checks to see if the value in the 
SalesRep field matches the value in the Contact field:

If(Like(SalesRep,Contact),'Match','No Match')

If the Like function returns Yes, the If function inserts the string 
Match in the field with the formula; if Like returns No, the If function 
inserts the string No Match.

You can nest functions more than two levels. Approach always solves 
the innermost functions first and then works its way out until it 
reaches a single, final result.

To determine whether you can use a function as a parameter, look at 
the syntax description for the outer function (with the parameter). 
The inner function must return a result that matches the type 
specified for the parameter. For example, this is the syntax for the If 
function used above:

If(condition,true value,false value)

The syntax shows that first parameter must be a condition, so a 
function that returns Yes or No (such as Like) is appropriate here.

Approach provides functions in ten categories: conversion, date, 
financial, logical, mathematical, statistical, summary, text, time, and 
trigonometric. This section summarizes the functions by category.

Functions

Conversion DateToText(date,format) NumToText(number, 
format)

TextToBool(text)

TextToDate(text) TextToTime(text)

Date Date(month,day,year) Day(date) DayName(number or date)

DayOfWeek(date) DayOfYear(date) Month(date)

MonthName(date or 
number)

Today() WeekOfYear(date)

Year(date)

Financial FV(payment,rate,periods) NPeriods(rate,principal, 
payment)

PMT(principal,rate,periods)

Summary of 
functions

Continued
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Financial PV(payment,rate,periods) SLN(cost,salvage,lift)

Logical Blank(text1,text2) If(condition,true value, 
false value)

IsBlank(field)

Mathematical Abs(number) Exp(number) Factorial(number)

Ln(number) Log((number) Mod(number1,number2)

Pi() Pow(number1,number2) Random()

Round(number,precision) Sign(number) Sqrt(number)

Trunc(number,precision)

Statistical Avg(number list) STD(number list) Var(number list)

Summary SAverage(number field) SCount(field) SMax(number field)

SMin(number field) SNPV(value,discount rate) SSTD(number field)

SSUM(number field) SVAR(number field)

Text Asc(character) Chr(number) Combine(list)

Fill(text,number) Left(text,number) Length(text)

Like(text1,text2) Lower(text) Middle(text,start,size)

Position(text,search 
string,start)

Prefix(text1,text2) Proper(text)

Replace(original text, start 
size, replacement text)

Right(text,number) Soundslike(text1,text2)

Span(text1,text2) SpanUntil(text1,text2) Translate(text,character1,  
character2)

Trim(text) Upper(text)

Time CurrTime() Hour(time) Hundredth(time)

Minute(time) Second(time) Time(hours,minutes, 
seconds,hundredths)

Trigonometric Acos(number) Asin(number) Atan(number)

Atan2(number1,number2) Cos(angle) Degree(radians)

Radian(degrees) Sin(angle) Tan(angle)

Functions
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This section describes the functions that come with Approach. When 
you add one of these functions to a formula, you can click the 
function name in the Define Formula panel of the Field Definition 
dialog box or type the function name and its parentheses. 

Replace the parameter names shown in the function’s syntax with 
the actual parameters you want to use. You must use the same 
number of parameters given in the syntax and match the order 
shown for them. Separate multiple parameters with commas (or with 
another list separator specified in the Windows International Control 
Panel).

For example, you could enter the function

Left(text,number)

as

Left('California',2)

Returns the absolute value of a number. The absolute value is the 
positive equivalent of the number.

Format Abs(number)

Examples
Abs(6.8) equals 6.8

Abs(0) equals 0

Abs(Total) equals 10, where the Total field contains –10

Returns the trigonometric arc cosine of a number between –1 and 1. 
The arc cosine is expressed in radians in the range 0 to pi.

Format Acos(number)

Example
Acos(0.75) equals 0.7227342478134

Returns the ASCII numeric value of a character. If a string is entered 
as a parameter, Asc returns a value only for the first character in the 
string.

Format Asc(character)

Descriptions of 
functions

If the flag in the Define 
Formula panel is crossed out, 
the formula you’re defining 
has a syntax error.

Abs (Absolute 
value)

Acos (Arc cosine)

Asc (ASCII)
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Examples
Asc('a') equals 97

Asc('Aqua') equals 65

Returns the trigonometric arc sine of a number between –1 and 1. The 
arc sine is expressed in radians in the range –pi/2 to pi/2.

Format Asin(number)

Example
Asin(0.5) equals 0.5235987755983

Returns the arc tangent of a number. The arc tangent is expressed in 
radians in the range –pi/2 to pi/2.

Format Atan(number)

Example
Atan(-1.25) equals –0.8960553845713

Returns the arc tangent of number1/number2. The arc tangent is 
expressed in radians in the range –pi to pi.

Format Atan2(number1,number2)

Example
Atan2(0.75,-1.25) equals 2.6011731533192

Calculates the average of values in a number list within a record. If 
any fields in the number list are blank, those fields are not included in 
the average.

The fields for Avg must all be in the same record. To average values 
over a range of records, use the SAverage (summary average) 
function.

Format Avg(number list)

Examples
Avg(2.8,-5.6,14,5.9) equals 4.275

Avg(Score1,Score2,Score3) equals 4, where the Score1 field contains 3, 
Score2 contains 8, and Score3 contains 1

Asin (Arc sine)

Atan (Arc tangent)

Atan2 (Arc tangent 
2)

Avg (Average)
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Avg(Score1,Score2,Score3) equals 5.5, where the Score1 field contains 
3, Score2 contains 8, and Score3 is blank

Returns a value if the field is blank; otherwise, returns the value in the 
field.

Format Blank(field,value)

Examples
Blank(Cost,2.75) equals 3.95, where the Cost field contains 3.95

Blank(Cost,Minimum) equals 2.5, where the Cost field is blank and 
Minimum contains 2.5

Returns the ASCII character for a number.

Format Chr(number)

Examples

Chr(97) equals a

Chr(65) equals A

Concatenates all text strings in a list to form one text string.

Format Combine(list)

Examples

Combine('Monthly ','Expenses') equals Monthly Expenses

Combine(FirstName,' ',LastName) equals Mary Jones, where the 
FirstName field contains Mary and LastName contains Jones (The 
second parameter is a space; you can enclose a space in single 
quotation marks, as you can any other text string.)

Combine(City,', ',State,' ',Zip) equals San Francisco, California 94504, 
where the City field contains San Francisco, State contains California, 
and Zip contains 94504

Combine(Company,Chr(10),Chr(13)) equals Blue Moon followed by a 
return and a new line, where the Company field contains Blue Moon

Blank

Chr (Character)

Combine
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Returns the trigonometric cosine of an angle. The angle must be 
expressed in radians. The result is always between –1 and 1.

Format Cos(angle)

Example
Cos(1.243) equals 0.3219574751143

Returns the current time on the system clock. This function does not 
use any parameters.

Format CurrTime()

Example
CurrTime() equals 1:15:00, when the system-clock time is 1:15:00

Returns a date corresponding to numbers in the month, day, and year 
parameters. 

Format Date(month,day,year)

Example
Date(10,31,1993) equals October 31, 1993

Converts a date to a text string, for use with formulas involving text 
or text-oriented functions or for display or export. 

The format of the string is determined by the format parameter.

Format DateToText(date,format)

Example
DateToText(Date,'MMM DD, YYYY') equals Jan 11, 1994, where the Date 
field contains the date 1/11/94

Returns a number from 1 to 31 representing the day of the month for 
a date.

Format Day(date)

Examples
Day('10/31/93') equals 31

Day(Date) equals 25, where the Date field contains the date 
3/25/94

Cos (Cosine)

CurrTime (Current 
time)

Date

DateToText

Day
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Returns the name of the day corresponding to a number or a date. The 
number must be from 1 to 7, with 1 being Sunday.

Format DayName(number) or DayName(date)

Examples
DayName(5) equals Thursday

DayName('1/1/94') equals Saturday

DayName(Date) equals Sunday, where the Date field contains the date 
1/2/94

Returns a number representing the day of the week in a date. The 
number is from 1 to 7, with 1 being Sunday.

Format DayOfWeek(date)

Examples
DayOfWeek('1/1/94') equals 7

DayOfWeek(Date) equals 7, where the Date field contains the date 
1/1/94

Returns a number representing the number of days since January 1 of 
the year in a date.

Format DayOfYear(date)

Example
DayOfYear('2/1/94') equals 32

Converts a number from radians to degrees. Radians are the result of 
all trigonometric functions.

The formula used is

Format Degree(radians)

Example
Degree(2) equals 114.5915590261646

DayName

DayOfWeek

DayOfYear

Degree

radians * 180
pi
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Performs a case-sensitve comparison of text1 and text2. If the two 
strings match exactly, the function returns Yes; if they do not match, 
the function returns No.

Format Exact(text1,text2)

Examples
Exact('receipts','receipts') equals Yes

Exact ('ORDER','Order') equals No

Calculates the constant e to the power of a number. The constant e is 
the base of the natural logarithm, equal to 2.718281828545904.

Format Exp(number)

Example
Exp(5) equals 148.413159102657660

Returns the factorial of a number.

Format Factorial(number)

Example
Factorial(4) equals 4*3*2*1 equals 24

Returns a text result containing repeated instances of text. The text is 
repeated the number of times specified by a number.

Format Fill(text,number)

Example
Fill('Baden',2) equals BadenBaden

Calculates the future value of an investment given a payment, a 
periodic interest rate, and a number of periods.

The formula used is

Format FV(payment,rate,periods)

Exact

Exp 
(Exponentiation)

Factorial

Fill

FV (Future value)

(payment * ((rate + 1)periods –1))
i
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Example
To calculate the value of an investment in which you pay $50 per 
month for five years at 11% annual interest, the formula is as follows:

FV(50,.11/12,5*12) equals 3975.90 (The second parameter specifies the 
rate as 11% over 12 months.)

Returns a number representing the hours in a time.

Format Hour(time)

Examples
Hour('10:12:19') equals 10

Hour(Time) equals 9, where the Time field contains the time 9:12:19

Returns a number representing the hundredths of a second in a time.

Format Hundredth(time)

Examples
Hundredth('12:15:23.34') equals 34

Hundredth(Time) equals 14, where the Time field contains the time 
8:15:30.14

Evaluates a condition for true or false, and returns a true value or a 
false value.

You can nest another If function inside the main If function to 
evaluate a true value or false value.

Format If(condition,true value,false value)

Examples
If(State='CA','Yes','No') equals No, where the State field contains the 
text AZ

If(Total>=1000,50,0) equals 50, where the Total field contains a value 
greater than or equal to 1000

If(Amount<1000,0,If(Amount<2000,50,100))

equals 0, where the Amount field contains a value less than 1000

equals 50, where the Amount field contains a value greater than 
1000 and less than 2000

Hour

Hundredth

If
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equals 100, where the Amount field contains a value greater than 
2000

If(Amount>1000 AND Type='B',200,100)

equals 200, where the Amount field contains a value greater than 
1000 and the Type field contains B

equals 100, where the Amount field contains a value less than 
1000 or the Type field does not contain B

Returns Yes if a field is blank; otherwise, returns No.

Format IsBlank(field)

Examples
IsBlank(Customer) equals No, where the Customer field contains a 
value

If(IsBlank(Quantity),0,100) 

equals 0, where the Quantity field is blank 

equals 100, where the Quantity field contains a value

Returns Yes if the current record is the last record in the sort order of 
the found set; otherwise, returns No.

Format IsLastRecord()

Returns a text result containing the specified number of characters in 
text, counting from the left.

Format Left(text,number)

Examples
Left('Mississippi',2) equals Mi

Left(State,2) equals Ca, where the State field contains California

Combine(Alpha1,Left(Alpha2,3)) equals ABCDEF, where the Alpha1 
field contains ABC and the Alpha2 field contains DEFG

IsBlank

IsLastRecord

Left
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Returns the number of characters in a text string, including all spaces, 
numbers, and special characters.

Format Length(text)

Examples
Length('Customer No.') equals 12

Length(SalesRep) equals 5, where the SalesRep field contains Jerry

Length(Combine(Item1,Item2)) equals 11, where the Item1 field contains 
Orange and the Item2 field contains Lemon

Performs a case-insensitive comparison of text1 and text2. If the two 
strings match (without considering case), the function returns Yes; if 
they do not match, the function returns No.

You can use a wildcard in text2. An asterisk (*) represents any 
number of characters including zero or no characters, and a question 
mark (?) represents one character.

Format Like(text1,text2)

Examples
Like('Cola','cola') equals Yes

Like ('their','th*r') equals Yes

Like('their','th?r') equals No

Like(Color1,Color2) equals Yes, where the Color1 field contains red and 
Color2 contains R?D

Like(SalesRep,Combine('*',Contact,'*')) 

equals Yes, where the SalesRep field contains Jerry and Contact 
contains er (evaluated as *er*)

equals No, where the SalesRep field contains Jerry and Contact 
contains H (evaluated as *H*)

If(Like(SalesRep,Contact),'Match','No Match')

equals Match, where the SalesRep field contains Sue and Contact 
contains Sue

equals No Match, where the SalesRep field contains Sue and 
Contact contains Marcus

Length

Like
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Returns the natural logarithm of a positive number. This is the 
logarithm to the base e.

Format Ln(number)

Example
Ln(10) equals 2.302851

Calculates the logarithm of a number to the base 10 (decimal 
logarithm). The value calculated is the power to which 10 is raised to 
produce the number.

Format Log(number)

Example
Log(1000) equals 3

Converts all letters in text to lowercase.

Format Lower(text)

Examples
Lower('Gourmet Emporium') equals gourmet emporium

Lower(Country) equals usa, where the Country field contains USA

Extracts characters from text, beginning at the start position and 
containing the number of characters specified by size.

Format Middle(text,start,size)

Examples
Middle('Germany',4,3) equals man

Middle(Product,2,4) equals ppro, where the Product field contains 
Approach

Returns a number representing the minutes in a time.

Format Minute(time)

Examples
Minute('12:10:05') equals 10

Minute(Time) equals 11, where the Time field contains the time 12:11:05

Ln (Natural 
logarithm)

Log (Logarithm)

Lower 
(Lowercase)

Middle

Minute
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Divides number1 by number2 and returns the remainder. The result is 
the modulus.

Format Mod(number1,number2)

Examples
Mod(12,5) equals 2

Mod(Order,3) equals 1, where the Order field contains 16

Mod(Order,Stock) equals 3, where the Order field contains 8 and Stock 
contains 5

If(Mod(Total,2)=0,'Even','Odd')

equals Even, where the Total field contains 8

equals Odd, where the Total field contains 3

Returns a number representing the month in a date.

Format Month(date)

Examples
Month('10/20/93') equals 10

Month(Date) equals 12, where the Date field contains the date 
12/05/94

Returns the name of the month corresponding to a number or a date. 
The number must be from 1 to 12, with 1 being January.

Format MonthName(number) or MonthName(date)

Examples
MonthName(9) equals September

MonthName('10/20/93') equals October

MonthName(Date) equals March, where the Date field contains the 
date 3/29/94

Combine('Sales for ',MonthName(Date),' ',Year(Date)) equals Sales for July 
1994, where the Date field contains the date 7/6/94

Mod

Month

MonthName
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Calculates the number of periods necessary to pay off a principal with 
a periodic payment at a given periodic interest rate.

The formula used is

Format NPeriods(rate,principal,payment)

Example
To calculate the number of $100 monthly payments required to pay 
off a $1000 loan with a monthly interest rate of 1 percent, the formula 
is as follows:

NPeriods(.01,1000,100) equals 11

Converts a number to a text string, for use with formulas involving 
text or text-oriented functions or for display or export. 

The format of the string is determined by the format parameter. A 
zero (0) in the parameter specifies a required digit, and a number 
sign (#) specifies a non-required digit. For more information about 
the syntax of a number format, see “Setting a numeric format” on 
page 6-19.

Format NumToText(number,format)

Examples
NumToText(200,'##0.00') equals the text string 200.00

NumToText(5694.08,'$##,##0.00') equals the text string $5,694.08

Returns the constant 3.14159. This function does not use any 
parameters.

Format Pi()

Example
Pi() * 15 equals 47.124

NPeriods 
(Number of 
periods)

log (payment / payment – (principal * rate)
log (1 + rate)

NumToText 
(Number to text)

Pi
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Calculates the payment required to pay off a loan given a principal, a 
periodic interest rate, and a number of periods.

The formula used is

Format PMT(principal,rate,periods)

Example
To finance $92,000 toward the purchase of office equipment at an 
annual interest rate of 6.9% over 48 monthly payments, the formula 
is as follows:

PMT(92000,.069/12,48) equals $2198.79 (The second parameter 
specifies the rate as 6.9% over 12 months.)

Beginning at the start position, scans text for the first occurrence of a 
search string and returns a number indicating where the string was 
found in text. If text does not contain the search string, the result is 
zero.

Format Position(text,search string,start)

Examples
Position('Mississippi','iss',3) equals 5

Position(City,' ',1) equals 7, where the City field contains Mexico City 
(The space is the search string.)

Left(Region,Position(Region,' ',1)-1) equals West, where the Region field 
contains West Central

Returns the value of number1 raised to the power of number2.

Format Pow(number1,number2)

Examples
Pow(2,3) equals 8

Pow(30,8) equals 656,100,000,000

PMT (Payment)

principal * rate * (1 + rate)periods

(1 + rate)periods – 1

Position

Pow (Power)
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Returns Yes if all the characters in text1 match the same number of 
characters at the start of text2; otherwise, returns No.

Format Prefix(text1,text2)

Example
Prefix('quo','quantity') equals No

Prefix(Item1,Item2) equals Yes, where the Item1 field contains Aqua 
and the Item2 field contains Aqua Spring Water

Converts the first letter of each word in text to uppercase and all 
other letters to lowercase.

Format Proper(text)

Examples
Proper('SOS') equals Sos

Proper('europe') equals Europe

Proper(Region) equals Asia, where the Region field contains asia

Calculates the present value of an ordinary annunity given a 
payment, a periodic interest rate, and a number of periods. An ordinary 
annunity is a series of payments to be made at equally spaced 
intervals. The present value is the value in today’s dollars of the 
payments to be made or received later.

The formula used is

Format PV(payment,rate,periods)

Example
If an annuity returns $250.50 per year for 5 years and the discount 
rate is 12%, the formula is as follows:

PV(250.5,0.12,5) equals 902.996438

This means that the present value of the annuity is $903.

Prefix

Proper

PV (Present 
value)

payment * ((1 + rate)periods – 1)

rate * (1 + rate)periods
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Converts a number from degrees to radians.

Format Radian(degrees)

Examples
Radian(90) equals 1.5708

Radian(30) equals 0.5236

Returns a random number between 0 and 1. This function does not 
use any parameters.

Format Random()

Examples
Random() equals a random number between 0 and 1

Trunc(Random()*10)+1 equals a random number between 1 and 10

Beginning at the start position, substitutes the series of characters in 
original text with others in replacement text. The size parameter 
specifies the number of characters to replace in the original text. The 
replacement text can be longer or shorter than the number specified in 
size, resulting in a new character string of a different length.

Format Replace(original text,start,size,replacement text)

Example
Replace('Alan',3,1,'le') equals Allen

Returns a text result containing the specified number of characters in 
text, counting from the right.

Format Right(text,number)

Examples
Right('sideview',4) equals view

Right(Region,4) equals Asia, where the Region field contains 
Southeast Asia

Right(Item,Length(Item)-Position(Item,' ',1)) equals Cola, where the Item 
field contains Diet Cola (This returns the text to the right of the space 
in Item, as specified by the Position function.)

Radian

Random

Replace

Right
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Combine(Alpha1,Right(Alpha2,3)) equals ABCGHI, where the Alpha1 
field contains ABC and the Alpha2 field contains DEFGHI

Rounds a number to the number of decimal places specified by 
precision. If the precision is zero or not specified, Approach rounds the 
number to the nearest integer.

Format Round(number,precision)

Examples
Round(23.789) equals 24

Round(Amount,1) equals 23.8, where the Amount field contains 23.789

Returns the average of the values in a number field for a summary 
range of records. If the field is blank in any of the records, those 
records are not included in the average.

Format SAverage(number field)

Example
SAverage(Amount) equals 3, where the Amount field contains 2, 3, 1, 
and 6 in a summary range of records

SAverage(Amount) equals 2, where the Amount field contains 2, 3, and 
1 in three records and is blank in the fourth record in a summary 
range of records

Returns the number of nonblank occurrences in a field for a summary 
range of records. Fields with blank values are not counted.

Format SCount(field)

Example
SCount(Paid) equals 2, where the Paid field contains a value in two 
records in a summary range of records

Returns a number representing the number of seconds in a time.

Format Second(time)

Examples
Second('10:35:18') equals 18

Second(Time) equals 20, where the Time field contains the time 8:45:20

Round

SAverage 
(Summary 
average)

SCount (Summary 
count)

Second
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Returns –1, 0, or 1, representing whether a number is negative, zero, 
or positive.

Format Sign(number)

Examples
Sign(21) equals 1

Sign(-21) equals –1

Returns the trigonometric sine of an angle. The angle must be 
expressed in radians.

Format Sin(angle)

Example
Sin(1.243) equals 0.946754131

Calculates the straight-line depreciation of an asset for a single 
period, given a cost, salvage, and life.

The formula used is 

Format SLN(cost,salvage,life)

Example
SLN(7500,3000,10) equals 450

Returns the largest number or latest date or time in a field for a 
summary range of records. The field can be a number, date, or time 
field.

Format SMax(field)

Example
SMax(Amount) equals 200, where the Amount field contains 25, 40, 
200, and 75 in a summary range of records

Sign

Sin (Sine)

SLN (Straight-line 
depreciation)

cost – salvage

life

SMax (Summary 
maximum)
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Returns the smallest number or earliest date or time in a field for a 
summary range of records. The field can be a number, date, or time 
field.

Format SMin(field)

Example
SMin(Amount) equals 25, where the Amount field contains 25, 40, 200, 
and 75 in a summary range of records

Calculates the net present value of an investment based on a series of 
periodic cash flows (value) and a discount rate. The net present value 
of an investment is today’s value of a series of future payments 
(negative values) and income (positive values).

Format SNPV(value,discount rate)

Example
Suppose that if you invested $12,000 one year from today, the 
investment would generate an annual income of $1500, $4000, $3500, 
and $4100 in the four following years. Assuming an annual discount 
rate of 8 percent, the formula is as follows:

SNPV(Payment,.08) equals –1286.78

where the Payment field contains the values –12000, 1500, 4000, 3500, 
and 4100.

Returns Yes if text1 sounds phonetically like text2.

Format Soundslike(text1,text2)

Example
Soundslike('fill','Phil') equals Yes

Returns the number of characters in text1 that also exist in text2 until 
a character is found that is not in text2. 

Format Span(text1,text2)

Examples
Span('automobile','muato') equals 6

Span(OrderNo,PartNo) equals 0, where the OrderNo field contains 
23241 and the PartNo field contains 413

SMin (Summary 
minimum)

SNPV (Summary 
net present value)

Soundslike

Span
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Returns the number of characters in text1 that are not in text2 until a 
character is found that is also in text2.

Format SpanUntil(text1,text2)

Example
SpanUntil('radio','eiu') equals 3

Returns the square root of a number.

Format Sqrt(number)

Examples
Sqrt(13.69) equals 3.7

Sqrt(100) equals 10

Calculates the standard deviation of a population given the entire 
population as a field within a summary range of records. The 
standard deviation is a measure of how widely values are dispersed 
from the average value (the mean).

The formula used is

where x is the values in a number field in a summary range of records 
and n is the number of these values.

Format SSTD(number field)

Examples
SSTD(Score) equals 1.87, where the Score field contains 2, 3, 1, and 6 
in a summary range of records

Returns the sum of all the values in a number field for a summary 
range of records.

Format SSum(number field)

Examples
SSum(Amount) equals 375, where the Amount field contains 100, 25, 
50, and 200 in a summary range of records

SpanUntil

Sqrt (Square root)

SSTD (Summary 
standard 
deviation)

nΣx2 Σx( ) 2–( )
n2-----------------------------------------

SSum (Summary 
sum)
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Calculates the standard deviation of a population given the entire 
population as parameters. The standard deviation is a measure of 
how widely values are dispersed from the average value (the mean).

The formula used is

where x is the values in a number list within a record and n is the 
number of these values.

To calculate for a field over a range of records, use the SSTD function 
instead.

Format STD(number list)

Example
STD(4,5,9,2) equals 2.549510

Calculates the variance of a population given the entire population as 
a summary range of records.

The formula used is

where x is the values in a number field in a summary range of records 
and n is the number of these values.

Format SVAR(number field)

Example
SVar(Score) equals 3.5, where the Score field contains 2, 3, 1, and 6 in a 
summary range of records

Returns the trigonometric tangent of an angle. The angle must be 
expressed in radians.

Format Tan(angle)

STD (Standard 
deviation)

nΣx2 Σx( ) 2–( )
n2-----------------------------------------

SVAR (Summary 
variance)

nΣx2 Σx( ) 2–( )
n2-----------------------------------------

Tan (Tangent)
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Example
Tan(1) equals 1.557407725

Returns No if the first character in text is F, f, N, n, or zero; otherwise, 
returns Yes.

Format TextToBool(text)

Example
TextToBool(False) equals No

Converts text to a date value, for use with formulas involving dates 
or date-oriented functions. 

The date string must in the format MM/DD/YY (or whatever date 
format is specified in the Windows International Control Panel).

Format TextToDate(text)

Example
TextToDate('1/11/94') + 30 equals 2/10/94

Converts text to a time value, for use with formulas involving times 
or time-oriented functions. 

The time string must be in the format HH:MM:SS.00 (the seconds are 
optional). You can also use AM or PM at the end of the time. (Some 
countries use a different separator than the colon. Use whatever time 
separator is specified in the Windows International Control Panel.)

Format TextToTime(text)

Example
TextToTime('11:30PM') equals 23:30:0.0

Returns a time corresponding to numbers in the hours, minutes, 
seconds, and hundredths parameters. 

Format Time(hours,minutes,seconds,hundredths)

Example
Time(2,15,30,0) equals 2:15:30

TextToBool (Text 
to Boolean)

TextToDate

TextToTime

Time
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Returns the current system date. This function does not use any 
parameters.

Format Today()

Example
Today() equals 2/14/94, when the system date is February 14, 1994

Replaces all occurrences of character1 with character2 in text.

Format Translate(text,character1,character2)

Example
Translate('grey','e','a') equals gray

Returns a text string without its leading and trailing spaces.

Format Trim(text)

Examples
Trim('New York   ') equals New York

Trim(City) equals Paris, where the City field contains ' Paris '

Truncates a number to the number of decimal places specified by 
precision. If the precision is zero or not specified, Approach truncates 
the number to an integer.

Format Trunc(number,precision)

Examples
Trunc(13.1374,2) equals 13.13

Trunc(13.1374) equals 13

Converts all letters in text to uppercase.

Format Upper(text)

Examples
Upper('Ca') equals CA

Upper(Country) equals KENYA, where the Country field contains 
Kenya

Today

Translate

Trim

Trunc (Truncate)

Upper 
(Uppercase)
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Returns the variance of a population given the entire population as 
parameters.

The formula used is

where x is the values in a number list within a record and n is the 
number of these values.

To calculate for a field over a range of records, use the SVar function 
instead.

Format Var(number list)

Example
Var(1,4,7) equals 6

Returns a number representing the number of weeks since January 1 
of the year in a date.

Format WeekOfYear(date)

Example
WeekOfYear('11/15/1993') equals 47

Returns a number representing the year within which a date occurs. 

Format Year(date)

Examples
Year('10/21/93') equals 1993

Year(Date) equals 1994, where the Date field contains the date 
1/1/94

Var (Variance)

nΣx2 Σx( ) 2–( )
n2-----------------------------------------

WeekOfYear

Year
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B Supported File Types

A database in Approach can be a dBASE, Paradox, or FoxPro file, a 
Microsoft Access table, a SQL table, or an ODBC data source. This 
allows you to share data with people who use other applications. 
With any type of database, you work with the data through an 
Approach file, which is always in the same Approach file type.

Approach also supports several graphic file types for importing 
graphics and several text and spreadsheet file types for importing 
and exporting data.

This appendix describes the dBASE, Paradox, FoxPro, and Access file 
types. It also lists the filename extensions you’re likely to see when 
working in Approach. See Appendix C for information about SQL 
tables and Appendix D for information about ODBC data sources.

Approach lets you create and use dBASE III+ and dBASE IV files. 
When you create a new database in Approach, the default file type 
for it is dBASE IV. The filename extension for dBASE database files is 
.DBF.

These are the main differences between viewing dBASE files in 
Approach and in other dBASE applications:

• In a dBASE file created in Approach, you can use field names 
with any characters, up to 32 characters long. If you view the file 
in other dBASE applications, you may see a modified version of 
your field names.

• Memo fields greater than 5000 characters cannot be viewed in the 
internal memo editor for dBASE III+.

• Memo fields greater than 64,000 characters cannot be viewed in 
the internal memo editor for dBASE IV.

• Approach PicturePlus fields cannot be viewed in other dBASE 
applications.

dBASE III+ and 
dBASE IV
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You can share Approach dBASE files on a network. For information 
about network options, see “Setting file-sharing options for dBASE 
files” on page 18-2.

dBASE files in Approach have the following restrictions on field 
names and field lengths.

Field names
The names of fields can be up to 32 characters long. You can use any 
characters in a field name, including letters, whole numbers, spaces, 
commas, periods, and arithmetic signs.

Other dBASE applications have more restrictions on the length of 
field names and on the characters you can use. For field names that 
do not satisfy other applications, Approach saves both the name you 
give the field and a modified name that other applications can read. 
If you open the database in another dBASE application, you’ll see the 
modified field names.

Field lengths
You must specify a field length for text and numeric fields. The 
length for a text field can be from 1 to 254. The length for a numeric 
field can be from 1 to 19. If you want to display numbers with high 
precision, you can also specify up to 15 decimal places for a numeric 
field.

The other fields are fixed in length or do not require a specified 
length.

Approach uses its own indexes for keeping track of records in a 
dBASE file. 

If you have any other dBASE-type index files you want Approach to 
maintain, you can associate those indexes with a dBASE file in 
Approach. Approach does not use the external indexes but maintains 
them for other dBASE applications. For more information, see 
“Maintaining external indexes for a dBASE or FoxPro database” on 
page 19-12.

Restrictions on 
field definitions

Index files
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These are the limits on files, records, and fields for the dBASE file 
types.

You can create and use Paradox 3.5 and Paradox 4.0 database files in 
Approach. The filename extension for Paradox database files is .DB.

All of the characteristics of Paradox 4.0 described in this section also 
apply to Paradox for Windows.

This is the main difference between viewing Paradox files in 
Approach and in other Paradox applications:

• Memo and PicturePlus fields cannot be viewed in Paradox 3.5. 
You can view PicturePlus fields and view and edit memo fields 
in Paradox 4.0, unless the database was created in the Paradox 
3.5 file type.

The Paradox file types require a key field—a field or group of fields 
that uniquely identifies each record in the database. When you create 
a Paradox database in Approach or try to use one that does not have 
a key field, a dialog box appears so that you can assign one. For more 
information, see “Specifying a key field for a Paradox database” on 
page 3-19.

You can share Approach Paradox files on a network. For information 
about network options, see “Setting file-sharing options for Paradox 
files” on page 18-4.

Item Limit

File size 2GB

Database files open at a time Up to 255 (depending on available 
memory)

Records per database 1,000,000,000

Record size 4KB

Fields per record 128 (dBASE III+) or 255 (dBASE IV)

Fields used in a sort 255

Size of a memo field 5KB (dBASE III+) or 64KB (dBASE IV)

Indexes per database 255

Limits on files, 
records, and fields

Paradox 3.5 and 
Paradox 4.0
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Paradox files in Approach have the following restrictions on field 
names and field lengths.

Field names
The names of text, numeric, and date fields can be up to 25 characters 
long. The names of time, memo, Boolean, and PicturePlus fields can 
be up to 18 characters long in Paradox. These characters can include 
letters, whole numbers, spaces, commas, periods, and arithmetic 
signs. 

A field name in Paradox cannot begin with a space and cannot 
contain these characters anywhere in the name:

[, ], {, }, (, ), ", ->

You cannot use a number sign (#) by itself in a field name, but you 
can combine it with other characters, such as Invoice #.

When using a Paradox field name in a formula, you must enclose it 
in double quotation marks if it contains a space, a period, a comma, 
or any of the following characters:

/, *, +, -, <, >

Field lengths
You must specify a field length for text fields. The length for a text 
field can be from 1 to 255. 

The other fields are fixed in length or do not require a specified 
length.

In a Paradox database file, a primary index is built on the key field 
specified when the file is created. You can create additional, 
secondary indexes for the file in Approach. For more information, 
see “Creating secondary indexes for a Paradox database” on 
page 19-13.

Approach automatically uses and maintains all indexes for Paradox 
database files.

Indexes, searches, and sorts in Paradox 3.5 are case-sensitive and in 
Paradox 4.0 are case-insensitive. If you want to change a Paradox 4.0 
search to case-sensitive, see “Setting database options for a Paradox 
file” on page 19-10.

Restrictions on 
field definitions

Index files
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These are the limits on files, records, and fields for the Paradox file 
types.

You can create and use FoxPro 2.1 database files in Approach. The 
filename extension for all FoxPro files is .DBF. The FoxPro file type is 
similar to dBASE IV but uses a different format for memo files.

These are the main differences between viewing FoxPro files in 
Approach and in other FoxPro applications:

• In a FoxPro file created in Approach, you can use field names 
with any characters, up to 32 characters long. If you view the file 
in other FoxPro applications, you may see a modified version of 
your field names.

• Approach PicturePlus fields cannot be viewed in other FoxPro 
applications.

Unlike dBASE and Paradox database files, FoxPro files cannot be 
shared on a network in Approach. (You can open a FoxPro file on a 
network, but other users will not be able to open it at the same time.)

FoxPro files in Approach have the following restrictions on field 
names and field lengths.

Field names
The names of fields can be up to 32 characters long. You can use any 
characters in a field name, including letters, whole numbers, spaces, 
commas, periods, and arithmetic signs.

Item Limit

File size 4GB

Database files open at a time 2 to 10 (depending on the number of 
secondary index files open)

Records per database 2,000,000,000

Record size 1350 bytes

Fields per record 255

Fields used in a sort 255

Indexes per database 255

Limits on files, 
records, and fields

FoxPro 2.1

Restrictions on 
field definitions
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Other FoxPro applications have more restrictions on the length of 
field names and on the characters you can use. For field names that 
do not satisfy other applications, Approach saves both the name you 
give the field and a modified name that other applications can read. 
If you open the database in another FoxPro application, you’ll see the 
modified field names.

Field lengths
You must specify a field length for text and numeric fields. The 
length for a text field can be from 1 to 254. The length for a numeric 
field can be from 1 to 19. If you want to display numbers with high 
precision, you can also specify up to 15 decimal places.

The other fields are fixed in length or do not require a specified 
length.

Approach uses its own indexes for keeping track of records in a 
FoxPro file. 

If you have any other FoxPro-type index files you want Approach to 
maintain, you can associate those indexes with a FoxPro file in 
Approach. Approach does not use the external indexes but maintains 
them for other FoxPro applications. For more information, see 
“Maintaining external indexes for a dBASE or FoxPro database” on 
page 19-12.

These are the limits on files, records, and fields for the FoxPro file 
type.

Item Limit

File size 2GB

Database files open at a time Up to 255 (depending on available 
memory)

Records per database 1,000,000,000

Record size 4KB

Fields per record 255

Fields used in a sort 255

Size of a memo field 64K

Indexes per database 255

Index files

Limits on files, 
records, and fields
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You can create and use Microsoft Access database tables in 
Approach. The filename extension for Access databases is .MDB.

To be able to create an Access table in Approach, you need to have an 
Access database already set up. You add the table to your database 
using the Approach New dialog box. The table is in the Access file 
type version 1.0, 1.1, or 2.0, depending on the version of the database. 

These are the main differences between viewing Access tables in 
Approach and in the Microsoft Access application:

• Approach PicturePlus fields cannot be viewed in Access.

• In Approach, fields in the Access currency field type are 
converted to numeric fields.

• Timestamp fields in Access include both a date and a time. In 
Approach, these fields appear as two fields: a date field and a 
time field. The extension “_Time” is added to the time field.

For example, suppose an Access timestamp field Shipped has the 
value “5/10/94 10:35PM”. Approach displays a date field 
Shipped with the value “5/10/94” and a time field 
Shipped_Time with the value “10:35PM”.

If you read an Access table without a unique index, Approach opens 
a read-only copy of the file.

You can share Access tables on a network in Approach. To set up an 
Access database for multiple users, see the Access documentation.

Access files in Approach have the following restrictions on field 
names and field lengths.

Field names
The first character in a field name must be a letter. After that, the 
name can have letters and whole numbers. Spaces and ODBC 
keywords are not allowed.

The names of text, numeric (numeric/currency), memo, and Boolean 
(bit) fields can be up to 32 characters long. The names of date, time, 
and PicturePlus (OLE object) fields can be up to 26 characters long.

Field lengths
You must specify a field length for text fields, from 1 to 255. 

The other fields are fixed in length or do not require a specified 
length.

Microsoft Access 
1.0, 1.1, and 2.0

To see the Access file type in 
the New dialog box, set the 
ReadOnly line to 0 in your 
APPROACH.INI file.

Restrictions on 
field definitions



B-8 User’s Guide

These are the limits on files, records, and fields for the Access file 
type.

The filename extensions you’ll probably see most often in Approach 
are .DBF for dBASE and FoxPro database files, .DB for Paradox 
database files, .APR for Approach files, and .MDB for Access files. You 
may see additional extensions in the file dialog boxes if you select a 
different file type or All Files in the List Files of Type drop-down list. 

These are the extensions for Approach files and data-related files that 
Approach creates or uses. The n’s in some of the extensions are 
wildcards for individual numbers; for example, the extension .Xnn 
might appear in a filename as .X24.

You may see other extensions for files that a dBASE, Paradox, or 
FoxPro application has created for its own purposes. For information 
about those extensions, see the documentation that came with the 
application.

Item Limit

File size 1GB (1.1/2.0), 128MB (1.0)

Database files open at a time Up to 255 (depending on available 
memory)

Records per database Limited by the size of the database

Record size Limited by the number of fields

Fields per record 255

Fields used in a sort 10

Size of a memo field 32KB

Size of a PicturePlus field 1GB (1.1/2.0), 128MB (1.0)

Indexes per database 32

Extension Approach file type

.ADX Approach dBASE index

.APR Approach file (for storing views)

Limits on files, 
records, and fields

Filename 
extensions

Files created or 
used by Approach

Continued
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Approach creates an .OYZ file only if it needs to create an index and 
an .ADX file already exists for another application.

.APT Approach data and views (created when you 
attach an .APR file to Notes)

.APX Approach-specific Paradox information file

.CDX FoxPro compound index

.DB Paradox database file

.DBF dBASE or FoxPro database file

.DBQ Paradox 3.5 memo file (Approach only)

.DBT dBASE memo file

.FPT FoxPro memo file

.IDX FoxPro 2.0 index

.LCK Paradox lock file

.MB Paradox 4.0/Windows memo file

.MDB Microsoft Access database file

.MDX Maintained dBASE index

.NDX Non-maintained dBASE index

.NSF Notes database file

.OYZ Approach alternate dBASE index

.PX Paradox primary index

.QRY Approach query file

.SMI Lotus SmartIcon file

.VEW Approach file (for storing views; versions 
earlier than 3.0)

.Xnn Paradox single secondary index

.Ynn Paradox single secondary index

.XGn Paradox composite secondary index

.YGn Paradox composite secondary index

Extension Approach file type
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You can use text and spreadsheet files for creating database files and 
for importing and exporting data. These are the filename extensions 
for supported file types.

You can use graphic files for importing images into a PicturePlus 
field and for putting an object on a view as a design element. These 
are the filename extensions for supported file types.

Extension Text or spreadsheet file type

.TXT Delimited or fixed-length ASCII text

.WKS Lotus 1-2-3 release 1A

.WK1 Lotus 1-2-3 release 2

.WK3 Lotus 1-2-3 release 3

.WK4 Lotus 1-2-3 release 4

.WRK Symphony® release 1 or 1.01

.WR1 Symphony release 1.1, 1.2, or 2

.XLS Microsoft Excel release 3.0, 4.0, or 5.0

Extension Graphic file type

.BMP Windows bitmap

.EPS Encapsulated Postscript

.GIF Graphics interchange

.PCX Windows Paintbrush

.TGA Targa

.TIF TIFF (Tagged Image File Format)

.WMF Windows metafile

Text and 
spreadsheet files

Graph ic file s
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C SQL Tables

You can use Approach to view and work with SQL data right at your 
desktop. The data can be stored in Oracle SQL, Microsoft/Sybase 
SQL Server, or IBM DB2 tables. If you have other SQL tables that can 
be opened through an ODBC driver, you also have access to those 
tables in Approach.

When you use Approach with SQL tables, you work in the same 
intuitive Approach interface you use with any other type of database. 
Rather than having to build report and query definitions in SQL, you 
can use Approach as a quick tool for all your reporting and querying.

This appendix describes how to set Approach options for working 
with SQL tables; how to connect to Oracle, SQL Server, and DB2; and 
how to use Select statements. For information about the file types for 
applications you use through ODBC, see the documentation that 
came with the applications.

You can use Approach to work with tables in Oracle SQL, versions 6 
and 7. These are the main differences between viewing tables in 
Approach and in other Oracle SQL applications:

• Approach PicturePlus fields cannot be viewed in other Oracle 
SQL applications.

• In Oracle SQL, null and blank field values sort greater than 
nonblank field values.

• Date fields in Oracle SQL include both a date and a time. In 
Approach, these fields appear as two fields: a date field and a 
time field. The extension “_Time” is added to the time field.

For example, suppose an Oracle SQL date field Shipped has the 
value “5/10/94 10:35PM”. Approach displays a date field 
Shipped with the value “5/10/94” and a time field 
Shipped_Time with the value “10:35PM”.

The online Help has 
troubleshooting tips and other 
technical information about 
SQL tables.

Oracle SQL
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• When reading Oracle SQL 7 tables, Approach treats varchar2 
fields with more than 255 characters as memo fields.

If you read an Oracle view file based on more than one Oracle table, 
Approach opens a read-only copy of the view file.

In Oracle, each table is assigned a user as its owner. When Oracle 
tables are showing in file dialog boxes, the names of tables appear in 
the File Name list, the names of table owners appear in the 
Directories list, and the names of servers you’re connected to appear 
in the Drives drop-down list.

You can work with an Oracle table on a server or on your local drive.

You can connect to an Oracle server from within Approach. If you’re 
not already connected to one when you select Oracle in a List Files of 
Type drop-down list, Approach opens a dialog box to let you 
connect. You can be connected to more than one server at a time. 

You can disconnect from an Oracle server in the Approach Open 
dialog box. When you quit Approach, you are disconnected from all 
the servers at once.

Before connecting to an Oracle server, you must have SQL*Net 
drivers installed for the type of server and client you’re using. For 
more information, see the Oracle SQL section under File Types in the 
online Help.

To connect to an Oracle server:

1. Open the New, Open, Save Database As, Import Data, or Export 
Data dialog box.

You can connect to a server at the same time you create, open, or 
save a table or import or export data. Or you can open one of 
these dialog boxes just to establish the connection.

2. Select Oracle in the List Files of Type drop-down list.

Connecting to an 
Oracle server

To see the SQL file types in 
the New dialog box, set the 
ReadOnly line to 0 in your 
APPROACH.INI file.
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If you are not connected to an Oracle server, the Connect to 
Oracle dialog box appears. If you are already connected to a 
server but want to connect to an additional one, click Connect 
after selecting Oracle to see the dialog box.

The Prior Connection drop-down list shows the last eight SQL 
servers you connected to. If you’re connecting to one of these 
servers again, you can select the connection from the list rather 
than typing the protocol, server name, and user name.

3. Type a letter identifying the protocol you want in the Network 
text box.

Check with your system administrator to find out which 
protocol you should use. These are some of the most common 
ones:

If you leave this text box blank, Approach defaults to the Local 
protocol setting in your CONFIG.ORA or ORACLE.INI file. For 
example, Local=X:ORASRV automatically sets the protocol to X.

4. Type the name of the server in the Server Name text box.

For this protocol Type

Named Pipes P

SPX X

NetBIOS B

TCP/IP T

DECnet™ D

ORACLE Async A

Type the network protocol.

Type the server name.

Type your user name.

Type your password.
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If you leave this text box blank, Approach defaults to the Local 
server setting in your CONFIG.ORA or ORACLE.INI file. For 
example, Local=X:ORASRV automatically sets the server to 
ORASRV.

5. Type your user name in the User Name text box.

6. Type your password in the Password text box.

Asterisks appear in the text box as you type the password.

7. Click OK.

You return to the New, Open, Save Database As, Import Data, or 
Export Data dialog box. 

You can also connect to an Oracle table on your local drive. To do 
this, you must be running Windows 3.0a or later in Standard mode.

Before you connect to a local Oracle table, type the following 
commands in DOS to start Oracle and Windows. Replace c with the 
letter of your drive that contains the Oracle table.

c:\>sqlpme (loads the Oracle memory manager)
c:\>oracle6 or c:\>oracle7 (starts the Oracle application)
c:\>sqldba (starts SQL for Oracle)
c:\>startup (starts the Oracle database)
c:\>exit (exits the SQL command mode)
c:\>win/s (starts Windows in Standard mode)

Once you have Oracle, Windows, and Approach running, you’re 
ready to connect to the table.

To connect to Oracle on your local drive:

1. Open the New, Open, Save Database As, Import Data, or Export 
Data dialog box.

2. Select Oracle in the List Files of Type drop-down list.

If you are not connected to an Oracle server, the Connect to 
Oracle dialog box appears. If you are already connected to a 
server but want to connect to an additional one, click Connect 
after selecting Oracle to see the dialog box.

Leave the Network and Server Name text boxes blank.

3. Type your user name in the User Name text box.

4. Type your password in the Password text box.

5. Click OK.

Connecting to 
Oracle on your local 
drive
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Oracle SQL tables have the following restrictions on field names and 
field lengths.

Field names
The names of text, numeric, and memo fields can be up to 30 
characters long. The names of date, time, Boolean, and PicturePlus 
fields can be up to 23 characters long. An Oracle field name can 
include any character except for the double quotation mark (").

When using an Oracle field name in a formula, you must enclose it in 
double quotation marks if it contains a space, a period, a comma, or 
any of the following characters:

/, *, +, -, <, >, (, )

Field names in Oracle are not case-sensitive.

Field lengths
You must specify a field length for text fields. The length for a text 
field can be from 1 to 255. (In Oracle SQL 7, a text field can be up to 
2000 characters. If you create a text field that is longer than 255 
characters, Approach treats it as a memo field.)

The other fields are fixed in length or do not require a specified 
length.

These are the limits on tables, records, and fields for Oracle SQL in 
Approach.

Item Limit

Table size Limited only by disk space 

Tables open at a time 255

Records per table Limited only by disk space 

Record size Limited by the number of fields and the 
size of the field type

Fields per record 254

Fields used in a sort As many fields as are in the table

Size of a memo or picture field 64KB (Oracle 6) or 2GB (Oracle 7)

Restrictions on field 
definitions

Limits on tables, 
records, and fields

Continued
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You can use Approach to work with tables in Microsoft/Sybase 
SQL Server. These are the main differences between viewing tables in 
Approach and in other SQL Server applications:

• Approach PicturePlus fields cannot be viewed in other SQL 
Server applications.

• SQL Server has a field type for money. In Approach, this is 
converted to a numeric field.

• Date fields in SQL Server include both a date and a time. In 
Approach, these fields appear as two fields: a date field and a 
time field. The extension “_Time” is added to the time field.

For example, suppose an SQL Server date field Shipped has the 
value “5/10/94 10:35PM”. Approach displays a date field 
Shipped with the value “5/10/94” and a time field 
Shipped_Time with the value “10:35PM”.

If you read a SQL Server view file or a SQL Server table without a 
unique index or timestamp, Approach opens a read-only copy of the 
view file or table.

When SQL Server tables are showing in file dialog boxes, the names 
of tables appear in the File Name list, the names of databases (groups 
of tables) appear in the Directories list, and the names of servers 
you’re connected to appear in the Drives drop-down list.

You can connect to a server in SQL Server from within Approach. If 
you’re not already connected to one when you select SQL Server in a 
List Files of Type drop-down list, Approach opens a dialog box to let 
you connect. You can be connected to more than one server at a time.

You can disconnect from a server in SQL Server in the Approach 
Open dialog box. When you quit Approach, you are disconnected 
from all the servers at once.

Memo and picture fields per 
table

1 memo field or 1 picture field
(but varchar2 fields already in an 
Oracle 7 table are treated as memo 
fields)

Item Limit

SQL Server

Connecting to a 
server in 
SQL Server
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To connect to a server in SQL Server:

1. Open the New, Open, Save Database As, Import Data, or Export 
Data dialog box.

You can connect to a server at the same time you create, open, or 
save a table or import or export data. Or you can open one of 
these dialog boxes just to establish the connection.

2. Select SQL Server in the List Files of Type drop-down list.

If you are not connected to a server in SQL Server, the Connect to 
SQL Server dialog box appears. If you are already connected to a 
server but want to connect to an additional one, click Connect 
after selecting SQL Server to see the dialog box.

The Prior Connection drop-down list shows the last eight SQL 
servers you connected to. If you’re connecting to one of these 
servers again, you can select the connection in the list rather than 
typing the server name and user name.

3. Type the name of the server in the Server Name text box.

4. Type your user name in the User Name text box.

5. Type your password in the Password text box.

Asterisks appear in the text box as you type the password.

6. Click OK.

You return to the New, Open, Save Database As, Import Data, or 
Export Data dialog box. 

SQL Server tables have the following restrictions on field names and 
field lengths.

Field names
The names of text, numeric, memo, and Boolean fields can be up to 
30 characters long. The names of date, time, and PicturePlus fields 
can be up to 24 characters long. 

To see the SQL file types in 
the New dialog box, set the 
ReadOnly line to 0 in your 
APPROACH.INI file.

Type the server name.

Type your password.
Type your user name.

Restrictions on field 
definitions
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The first character in a field name must be a letter, the number sign 
(#), or the underscore character (_). After that, the name can have 
letters, whole numbers, and the symbols #, _, and $. Spaces are not 
allowed.

Field lengths
You must specify a field length for text fields. The length for a text 
field can be from 1 to 255. 

The other fields are fixed in length or do not require a specified 
length.

A table name that begins with a number sign (#) is for a temporary 
table. Other object names cannot begin with a #.

Table names have the same restrictions as field names.

These are the limits on tables, records, and fields for SQL Server in 
Approach.

Item Limit

Table size Limited only by disk space 

Tables open at one time 255

Records per table Limited only by disk space 

Record size 1962 bytes, not including picture and 
memo fields

Fields per record 250

Fields used in a sort 16

Size of a memo or picture field 2GB

Memo and picture fields per 
table

Limited only by disk space

Table names

Limits on tables, 
records, and fields
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You can open IBM DB2 tables through ODBC support or through the 
Micro Decisionware Database Gateway™ (MDI), version 2.0 or later. 

These are the main difference between viewing DB2 tables in 
Approach and in other DB2 applications:

• Date fields in DB2 include both a date and a time. In Approach, 
these fields appear as two fields: a date field and a time field. The 
extension “_Time” is added to the time field.

For example, suppose a DB2 date field Shipped has the value 
“5/10/94 10:35PM”. Approach displays a date field Shipped 
with the value “5/10/94” and a time field Shipped_Time with 
the value “10:35PM”.

• You can create memo and PicturePlus fields in a DB2 table you 
open through ODBC support, but not in a DB2 table you open 
through MDI. Approach PicturePlus fields cannot be viewed in 
other DB2 applications.

If you read a DB2 table without a unique index, Approach opens a 
read-only copy of the table.

In DB2, each table is assigned a user as its owner. When DB2 tables 
are showing in file dialog boxes, the names of tables appear in the 
File Name list, the names of table owners appear in the Directories 
list, and the names of servers you’re connected to appear in the 
Drives drop-down list.

You can open IBM DB2/2, DB2/6000, and DB2/HP-UX tables 
directly in Approach through ODBC support, or IBM DB2, DB2/400, 
and SQL/DS tables via IBM Distributed Database Connection 
Services (DDCS) through ODBC support. You can be connected to 
more than one server at a time. 

You can disconnect from an DB2 server in the Approach dialog box. 
When you quit Approach, you are disconnected from all the servers 
at once.

To connect to an IBM DB2 or SQL/DS server through ODBC:

1. Open the New, Open, Save Database As, Import Data, or Export 
Data dialog box.

You can connect to a server at the same time you create, open, or 
save a table or import or export data. Or you can open one of 
these dialog boxes just to establish the connection.

IBM DB2

Connecting to an 
IBM DB2 or SQL/DS 
server through 
ODBC

To see the SQL file types in 
the New dialog box, set the 
ReadOnly line to 0 in your 
APPROACH.INI file.
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2. Select DB2 in the List Files of Type drop-down list.

The Drives drop-down list changes to Server and shows the 
names of DB2 servers you can connect to.

3. Select a server in the Server drop-down list.

The names of owners on the server appear in the Directories list.

4. If a Setup dialog box appears, fill it in and click OK.

The dialog box appears if your ODBC.INI file does not have setup 
information for DB2.

5. Double-click the name of the owner in the Directories list.

When you double-click the name, the tables in the database 
appear in the File Name list.

6. Select the name of the table in the File Name list.

7. Click OK.

8. If an alert box appears, click OK to open the table.

The alert box appears if your Preferences are set for displaying 
SQL and ODBC databases as read-only.

You can connect to an IBM DB2 server in Approach through MDI. If 
you’re not already connected to a DB2-MDI server when you select 
DB2-MDI in a List Files of Type drop-down list, Approach opens a 
dialog box to let you connect. You can be connected to more than one 
server at a time.

You can disconnect from an DB2 server in the Approach Open dialog 
box. When you quit Approach, you are disconnected from all the 
servers at once.

To connect to an IBM DB2 server through MDI:

1. Open the New, Open, Save Database As, Import Data, or Export 
Data dialog box.

You can connect to a server at the same time you create, open, or 
save a table or import or export data. Or you can open one of 
these dialog boxes just to establish the connection.

2. Select DB2-MDI in the List Files of Type drop-down list.

Connecting to an 
IBM DB2 server 
through MDI
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If you are not connected to a DB2 server, the Connect to DB2-
MDI dialog box appears. If you are already connected to a server 
but want to connect to an additional one, click Connect after 
selecting DB2-MDI to see the dialog box.

The Prior Connection drop-down list shows the last eight SQL 
servers you connected to. If you’re connecting to one of these 
servers again, you can select the connection in the list rather than 
typing the server name and authorization ID.

3. Type the name of the server in the Server Name text box.

4. Type your authorization ID in the Authorization ID text box.

Check with your system administrator to find out what ID you 
should use.

5. Type your password in the Password text box.

Asterisks appear in the text box as you type the password.

6. Click OK.

You return to the New, Open, Save Database As, Import Data, or 
Export Data dialog box. 

Options for DB2-MDI connections
You may need to set some options when connecting to a DB2 server 
through MDI. To do this, click Options in Connect to DB2-MDI, type 
the information in the Connect Options dialog box, and click OK.

System Catalog is the ID of the account that owns the views of 
system tables. Normally, the tables are owned by SYSIBM. If you do 
not have access to SYSIBM, the system administrator should create a 
view of the tables in another account. Type the authorization ID for 
that account here.

Type the server name.

Type your password.

Type your DB2-
MDI ID.

ID of the owner of the 
views of system tables The tablespace in which 

new tables are stored
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Tablespace is the name of the database that stores new tables. Tables 
are normally created in the DSNDB04 database. If you receive errors 
when creating or modifying tables, you may not have permission to 
create tables in DSNDB04. For more information about where to store 
new tables, read about the Create Table statement in the reference 
manual for your DB2 system.

IBM DB2 tables have the following restrictions on field names and 
field lengths.

Field names
In a DB2 table you open through ODBC, the names of PicturePlus 
fields can be up to 12 characters long and of Boolean fields can be up 
to 11 characters long. The names of other types of fields can be up to 
18 characters long. The first character in a field name must be a letter. 
After that, the name can have letters and whole numbers. Spaces and 
ODBC keywords are not allowed. 

In a DB2 table you open through MDI, the names of Boolean fields 
can be up to 11 characters long, and the names of other types of fields 
can be up to 18 characters long. These characters can include letters, 
whole numbers, and the underscore character (_). The first character 
in a field name must be a letter.

Field lengths
You must specify a field length for text fields. The length for a text 
field can be from 1 to 254. 

The other fields are fixed in length or do not require a specified 
length.

These are the limits on tables, records, and fields for IBM DB2 in 
Approach.

Item Limit

Table size Limited only by disk space 

Tables open at one time 255

Records per table Limited only by disk space 

Record size 2KB or 4KB

Fields per record 300

Restrictions on field 
definitions

Limits on tables, 
records, and fields

Continued
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A SQL query file is a text file that contains log-on information and a 
Select statement for a SQL table. 

When you open a query file in Approach, you automatically connect 
to a server using the log-on information in the file. Then the Select 
statement in the file is sent to the server, and the data requested by 
the statement is returned and downloaded into a read-only data file 
on your local drive.

You can create a query file in a text editor or in Approach when a 
SQL table is active. If you create a query file in Approach, the file 
stores the log-on information you used when you connected to the 
current table’s server. And if you have executed a find or sort in the 
table, the search and sort conditions are stored in the query file as the 
Select statement (if they can be translated into SQL).

A query file creates a temporary data file in your Windows TEMP 
directory and deletes the file when you close it. If you want to keep a 
copy of the data file, you can save it or export it.

The filename extension for query files is .QRY.

You can create or edit a query file using any text editor.

These are the commands for a query file:

Type=Oracle or SQLServer or DB2 or Notes or ODBC type
Network=protocol letter (for Oracle only)
Path=name of the database server
User=your name
Password=your password
Database=name of the database  (for SQL Server only)
Select valid Select statement

The commands for a query file are case-insensitive. They can be in 
any order except that the Select statement must be last. 

Fields used in a sort As many fields as are in the table

Memo and picture fields per 
table

Limited only by disk space 
(available only for DB2 tables you 
open through ODBC)

Item Limit

SQL query files

Query files allow you to 
quickly connect to a server 
and get access to specific 
information in a SQL table.

Make sure you have enough 
space in the TEMP directory 
for the query data file.

Creating or editing 
a query file in a  text 
editor
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All of the commands except for Type and Select are optional. If the 
query file does not contain enough log-on information, a Connect 
dialog box appears when you open the file so that you can fill in the 
remaining information.

If you include spaces or non-alphanumeric characters in a parameter, 
the parameter must be enclosed in double quotation marks ("). 

This is an example of an Oracle query file:

Type=Oracle
Network=X
Path=ORASRV
User=Rich
Password=sequoia
Select Name,Address,City From Employee

If you have a SQL table open in Approach, you can save a query file 
for it. When you create a query file this way, the file has an Approach 
file. You’ll be able to open the query file by opening its Approach file.

To create a query file by saving:

1. With a SQL table active, choose Save As from the File menu.

The Save Approach File As dialog box appears.

2. Specify a name and location for the Approach file.

3. Select “Exact copy” in the Databases area and click OK.

The Save Database As dialog box appears.

4. Select Query in the List Files of Type drop-down list.

5. Specify a name and location for the query file and click OK.

If you have a SQL table open in Approach, you can create a query file 
for it by exporting. When you create a query file this way, the 
exported data does not have an Approach file. You can create an 
Approach file by using the Save As command.

When exporting data, you can specify the particular fields you want 
stored for the Select statement.

To create a query file by exporting:

1. With a SQL table active, choose Export Data from the File menu.

The Export Data dialog box appears.

2. Select Query in the List Files of Type drop-down list.

You can leave the Password 
command out, and the user 
will be prompted for a 
password.

Creating a query file 
by saving

Creating a query file 
by exporting
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3. Specify a name and location for the query file.

4. In the Database Fields list, select the fields you want returned 
when the Select statement is executed.

To select a field, click the field name and click Add, or double-
click the name.

5. Click OK.

You can open a query file as you can any other type of file in 
Approach. When you open the query file, you are automatically 
connected to a SQL server using the file’s log-on information, and the 
Select statement in the file executes a find or sort.

To open a query file in Approach:

1. Choose Open from the File menu.

The Open dialog box appears.

2. Select Query in the List Files of Type drop-down list.

If the query file you want has an Approach file, you can leave 
this as Approach Files.

3. Select the file you want to open in the File Name list and click 
OK.

If the query file does not have all the log-on information it needs 
to connect to a server, a Connect dialog box appears so that you 
can fill in the rest of the information. For information about these 
dialog boxes, see the relevant section about connecting to a SQL 
server earlier in this appendix.

A query file’s Select statement returns data to a temporary read-only 
file on your local drive. You can save the data in a read/write 
database file. This also saves an Approach file for the data.

To save data from a query:

1. With the temporary data file active, choose Save As from the File 
menu.

The Save Approach File As dialog box appears.

2. Specify a name and location for the Approach file.

3. Select “Exact copy” in the Databases area and click OK.

The Save Database As dialog box appears.

If you export only some fields, 
the query file will open faster 
because it won’t have to find 
or sort every field in the table.

Opening a query file 
in Approach

Saving data from a 
query



C-16 User’s Guide

4. Select a database file type in the List Files of Type drop-down list.

5. Specify a name and location for the database file and click OK.

A query file’s Select statement returns data to a temporary read-only 
data file on your local drive. You can export the data to a new 
database file. Exporting allows you to save only the particular fields 
you want.

To export data from a query:

1. With the temporary data file active, choose Export Data from the 
File menu.

The Export Data dialog box appears.

2. Specify a name and location for the database file.

3. Select a database file type in the List Files of Type drop-down list.

4. In the Database Fields list, select the fields you want to export.

To select a field, click the field name and click Add, or double-
click the name.

5. Click OK.

Exporting data from 
a query
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D ODBC Data Sources

Approach is fully compatible with the Open Database Connectivity 
standard (ODBC). If you have databases in applications that use an 
ODBC driver, you can work with those databases in Approach.

An ODBC driver installed on your system appears in the List Files of 
Type drop-down list in Approach file dialog boxes. In most cases, the 
name of the driver appears just like other names in the list; for 
example, Btrieve. But if the application is also available as a 
PowerKey in Approach, the name is prefixed with “ODBC”; for 
example, ODBC:Oracle.

This appendix explains restrictions and limits on ODBC data sources 
in Approach, and it describes how to open an ODBC data source, 
install ODBC drivers, and set up data sources on your system. You 
must already have the appropriate drivers from the vendors of the 
other database applications.

You can use a Level 1 Tier 1 ODBC drive engine or a Level 1 Tier 2 
ODBC driver to get access to ODBC data sources in Approach. These 
are the main differences between working with ODBC data in 
Approach and in other applications:

• You can add PicturePlus fields to an ODBC data source in 
Approach only if the driver supports the Long Var Binary field 
type. You can add memo fields only if the driver supports the 
Long Var Char field type.

• You cannot view Approach PicturePlus fields in other ODBC 
applications. 

• In Approach, fields in the ODBC field types Big Int, Tiny Int, 
Small Int, Real, Numeric, Decimal, Integer, Double, and Float are 
converted to numeric fields.

Restrictions and 
limits on ODBC
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• Timestamp fields in ODBC include both a date and a time. In 
Approach, these fields appear as two fields: a date field and a 
time field. The extension “_Time” is added to the time field.

For example, suppose an ODBC timestamp field Shipped has the 
value “5/10/94 10:35PM”. Approach displays a date field 
Shipped with the value “5/10/94” and a time field 
Shipped_Time with the value “10:35PM”.

If you read an ODBC data source without a unique index or 
timestamp, Approach opens a read-only copy of the view file or 
table.

ODBC data sources have the following restrictions on field names 
and field lengths.

Field names
The first character in a field name must be a letter. After that, the 
name can have letters and whole numbers. Spaces and ODBC 
keywords are not allowed.

The limits on the length of a field name depend on whether the 
ODBC driver supports the field’s data type:

Data type (ODBC data 
types in parentheses)

If the driver supports 
the data type

If the driver does not 
support the data type

Text (Char or Var 
Char)

30 or limit of driver Not applicable

Numeric (Big Int, 
Tiny Int, Small Int, 
Real, Numeric, 
Decimal, Integer, 
Double, or Float)

30 or limit of driver 30 or limit of driver; 
stored as text

Memo (Long Var 
Char)

30 or limit of driver Field is disabled

Boolean (Bit) 30 or limit of driver (30 or limit of driver) – 7; 
stored as text

Date (Date) 30 or limit of driver (30 or limit of driver) – 6; 
stored as timestamp (if 
supported) or as text

Restrictions on field 
definitions

Continued
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If two lengths are given for a field name (such as “30 or limit of 
driver”), the field name can be the shorter of the two lengths.

Field lengths
You must specify a field length for text fields, from 1 to the limit of 
the ODBC driver. Most drivers have a limit of 255.

The other fields are fixed in length or do not require a specified 
length.

In an ODBC data source, the size of the table and the number of 
records in it are limited only by disk space. You can have up to 255 
tables open at a time.

The limits on record size, fields per record, fields in a sort, and memo 
and picture fields are determined by the database application for the 
ODBC data source. For more information, consult the documentation 
for the ODBC driver or for the database application.

You can open an ODBC data source you have access to within 
Approach.

The List Files of Type drop-down list in the Open dialog box lists all 
the ODBC drivers installed on your system and the option ODBC 
Data Sources, which gives you quick access to data sources set up on 
your system.

In most cases, the name of an ODBC driver appears in List Files of 
Type just like other names in the list; for example, Access. But if the 
application is also available as a PowerKey in Approach, the name is 
prefixed with “ODBC”; for example, ODBC:Oracle.

Time (Time) 30 or limit of driver (30 or limit of driver) – 6; 
stored as timestamp (if 
supported) or as text

PicturePlus (Long 
Var Binary)

(30 or limit of 
driver) – 6

Field is disabled

Data type (ODBC data 
types in parentheses)

If the driver supports 
the data type

If the driver does not 
support the data type

Limits on tables, 
records, and fields

Opening an ODBC 
data source
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The procedure for opening an ODBC data source varies slightly 
depending on the type of the data source. Some sources are database 
files like .DBF files. In these cases, you can open the file just as you 
open a dBASE, Paradox, or FoxPro file: After selecting the ODBC 
driver in the List Files of Type drop-down list, you find and select the 
file in the Open dialog box. For more information, see “Opening a 
database created in another application” on page 2-9.

ODBC data sources can also be database tables, tables in server 
applications, and data sources set up on your system.

You can use ODBC to get access to data that is organized in database 
tables. You need to see the contents of the database first and then 
select the table in it you want.

To open a database table through ODBC:

1. Click the Open File icon or choose Open from the File menu. Or 
if the Welcome dialog box is on the screen, select “Open an 
existing file” and click OK.

The Open dialog box appears.

2. Select an ODBC driver for a database table application in the List 
Files of Type drop-down list.

The databases in the application appear in the Directories list 
with a filecard icon in front of them.

3. Double-click the name of the database in the Directories list.

You can change the the drive if you need to look for the database. 
When you double-click the name, the tables in the database 
appear in the File Name list.

4. Select the name of the table in the File Name list.

5. Click OK.

6. If an alert box appears, click OK to open the table.

The alert box appears if your preferences are set for displaying 
SQL and ODBC databases as read-only.

Opening a database 
table through ODBC
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You can use ODBC to open a database table on a server. You may be 
prompted to connect to a server if Approach cannot find the server 
information in your ODBC.INI file. You can be connected to more than 
one server at a time.

When you select an ODBC driver for a server application in the List 
Files of Type drop-down list, the information that appears in the 
Open dialog box varies depending on the driver:

• If an ODBC driver supports qualifiers for table names, the names 
of the qualifiers appear in the Directories list. If the driver also 
supports ownership, the names of owners and the names of 
tables appear in the File Name list (such as DBA.EMPLOYEE); if 
the driver does not support ownership, only the names of tables 
appear in File Name.

• If an ODBC driver supports ownership but not qualifiers, the 
names of owners appear in the Directories list and the names of 
tables appear in the File Name list.

• If an ODBC driver supports neither qualifiers nor ownership, the 
names of servers appear in the Directories list and the names of 
tables appear in the File Name list.

To open a database table on a server through ODBC:

1. Click the Open File icon or choose Open from the File menu. Or if 
the Welcome dialog box is on the screen, select “Open an existing 
file” and click OK.

2. Select an ODBC driver for a server application in the List Files of 
Type drop-down list.

The Drives drop-down list changes to Server and shows the 
names of servers you can connect to through the ODBC driver.

3. Select a server in the Server drop-down list.

The names of databases, qualifiers, or owners on the server 
appear in the Directories list.

4. If a Setup dialog box appears, fill in the information and click 
OK.

The dialog box appears if your ODBC.INI file does not have setup 
information for the selected server. See the documentation that 
came with the driver for details.

Opening a database 
table on a server 
through ODBC
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5. Double-click the name of the database, qualifier, or owner in the 
Directories list.

When you double-click the name, the tables in the database 
appear in the File Name list.

6. Select the name of the table in the File Name list.

7. Click OK.

8. If an alert box appears, click OK to open the table.

The alert box appears if your Preferences are set for displaying 
SQL and ODBC databases as read-only.

“Quick connecting” to a server database
Once you specify the name of a server and database in the Open 
dialog box, Approach keeps track of that connection for your current 
work session. The next time you open the dialog box and select the 
ODBC driver, the name of the connection you used for it before will 
appear in the Server drop-down list; for example, Joann Willis @ 
Accounting.

If you select the connection name in the Server drop-down list, the 
File Name list shows the tables you used before on that server. This 
way, you don’t need to establish a connection and select in the 
Directories list.

When you quit Approach, you are disconnected from any servers 
you connected to in that session. You can also use the Open dialog 
box to disconnect from a particular server. Select the connection 
name in the Server drop-down list and click Disconnect.

If you have an ODBC data source already set up on your system, you 
can open it quickly with very little navigating through the Open 
dialog box.

For information about setting up a data source to open this way, see 
“Setting up a data source for an ODBC driver” on page D-8.

To open an ODBC data source set up on your system:

1. Click the Open File icon or choose Open from the File menu. Or 
if the Welcome dialog box is on the screen, select “Open an 
existing file” and click OK.

Opening an ODBC 
data source set up 
on your system
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2. Select ODBC Data Sources in the List Files of Type drop-down 
list.

The names of the data sources you have set up appear in the 
Directories list.

3. Double-click the name of a data source in the Directories list.

The tables in the data source appear in the File Name list.

4. If a Setup dialog box appears, fill it in and click OK.

The dialog box appears if your ODBC.INI file does not have all of 
the required information about the data source for the driver.

5. Select the name of the table in the File Name list.

6. Click OK.

7. If an alert box appears, click OK to open the table.

The alert box appears if your preferences are set for displaying 
SQL and ODBC databases as read-only.

If ODBC is installed on your computer, you can usually install an 
ODBC driver in the Windows Control Panel following the 
instructions in this section.

Some vendors of ODBC drivers have a different procedure for 
installation. In those cases, see the documentation that came with the 
driver.

To install an ODBC driver:

1. In the Main group in the Windows Program Manager, double-
click the Control Panel icon to open the Control Panel.

An ODBC icon appears in the Control Panel if ODBC is installed.

2. Double-click the ODBC icon.

The Data Sources dialog box appears.

3. Click Drivers.

The Drivers dialog box appears.

4. Click Add.

The Add Driver dialog box appears.

5. Type the name of the drive and directory for the driver in the text 
box, or click Browse to select a drive and directory name.

Installing an ODBC 
driver
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6. Click OK.

The Install Drivers dialog box appears.

7. Select the driver you want to install in the Available ODBC 
Drivers list.

8. Click OK.

After installing an ODBC driver, you can set up data sources for the 
driver within Approach. This stores information about the data’s 
location in your ODBC.INI file and tells Approach where to find the 
data when you try to open it.

To set up a data source for an ODBC driver:

1. Click the Open File icon or choose Open from the File menu. Or 
if the Welcome dialog box is on the screen, select “Open an 
existing file” and click OK.

2. Select the ODBC driver in the List Files of Type drop-down list.

3. Click Setup.

The Setup dialog box for the selected driver appears.

4. Fill in the Setup dialog box.

For information about the dialog box, see the documentation that 
came with the driver.

5. Click OK.

Setting up a data 
source for an 
ODBC driver
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Glossary

alias A “copy” of a database file, for use in special types of joins. An alias 
is not an actual duplicate of a database, but another listing of it for the 
purposes of joining. Most often, you use an alias to join a database to 
itself.

Approach file A file that stores forms, reports, and other views. The Approach file 
does not store any data, but provides a window into data in 
associated database files. When you create a database file, Approach 
automatically creates an Approach file for it. Compare database file.

Approach file password A text string a user must enter to be able to create views, join 
databases, or go to Design in an Approach file. You can give your 
Approach files a password to keep other users from making design 
changes to them. Compare database password.

area chart A chart that shows trends in data over time by emphasizing the area 
under the curve created by each data series. See also bar chart, line 
chart, and pie chart.

arithmetic expression An expression that performs a basic calculation on two numeric, date, 
or time values. See also expression. Compare comparison expression and 
logical expression.

ascending order A sort order that sorts records from A to Z for text (case-insensitive), 
lowest to highest for numbers, and earliest to latest for dates and 
times. Compare descending order.

bar chart A chart that shows individual values represented by bars. See also 
area chart, line chart, and pie chart.

body The part of a report that shows data from records. A body appears 
between a header and footer.

Boolean field A field that stores a value of True or False.
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Browse The environment in Approach that you use to work with information 
in a database. You can enter and edit data, find and sort records, and 
print views in Browse. Compare Design, Find, and Preview.

calculated field A field that stores the result of a formula. You enter the formula as 
part of the field’s definition, and Approach calculates the result and 
displays it in the field. A calculated field is stored in an Approach file.

checkbox A type of field object that has a Checked value and an Unchecked 
value. You turn the checkbox on or off in Browse to enter the value in 
the field. Usually, a field has only one checkbox. See also radio button.

client A computer used to get access to files or applications on a network. 
Compare server.

column gutter The area near the top of worksheets and crosstabs. You drag fields 
into the column gutter to add them to a worksheet or crosstab. See 
also row gutter. 

comparison expression An expression that compares two values and returns a result of Yes or 
No. See also expression. Compare arithmetic expression and logical 
expression.

compound document A document that contains a linked or embedded OLE object. If you 
have an OLE object from another application in an Approach file, the 
Approach file is a compound document. See also container application 
and server application. 

constant A literal value in a formula. When calculating a formula, Approach 
uses the constant in every record. Compare field reference.

container application An application that contains an OLE object. If you have an OLE object 
from another application in an Approach file, Approach is the 
container application. See also compound document. Compare server 
application.

context-sensitive menu A menu in Design that changes depending on the current view or the 
current selection. The context-sensitive menu can be called Form, 
Report, Letter, Mailing Label, Worksheet, Crosstab, Chart, Object, 
Text, Panel, or Summary.
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crosstab A view used for organizing and summarizing data from many 
records into categories and groups. A crosstab shows summaries of 
underlying database records that are grouped by any database field. 
Compare form, report, and worksheet.

current record The active record in a view in Browse. You can enter and edit data in 
the current record.

data entry order The order in which you move through the fields in a view when you 
press TAB. (You can also press ENTER to move through fields if your 
preferences are set this way.) Sometimes referred to as tab order in 
other applications.

data object An OLE object you can create in Approach from a range of worksheet 
or crosstab cells. See also view object.

database A collection of data organized into fields and records. See also field 
and records.

database file A file that stores data. The data you see and work with in an 
Approach file is stored in one or more database files. Compare 
Approach file.

database password A text string a user must enter to be able to open an Approach file. The 
password grants the user read-only access or read/write access to 
data associated with the file. See also read-only access and read/write 
access. Compare Approach file password.

date field A field that can hold a single date. You can perform finds and sorts on 
dates in a date field.

default style A named style that you define to be the preset style for new views. 
When you create a view using an Assistant, you can apply the default 
style or one of the SmartMaster styles to the view. See also named style 
and SmartMaster style.

descending order A sort order that sorts records from Z to A for text (case-insensitive), 
highest to lowest for numbers, and latest to earliest for dates and 
times. Compare ascending order.

delimited text file A text file that uses separators such as commas, spaces, or tabs to 
break up the text into discrete units. If you open a delimited text file 
as a database in Approach, the units of text become fields. See also 
fixed-length text file.
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Design The environment in Approach that you use for laying out forms, 
reports, form letters, and mailing labels. Compare Browse, Find, and 
Preview.

design object A graphic element that you can move, resize, and modify as a whole 
in Design. Fields, lines, rectangles, and macro buttons are examples of 
design objects.

detail database A joined database that provides secondary information in a view. For 
example, a detail database for an invoice form might provide 
customer names and addresses. A view can have one main database 
and many detail databases. Compare main database.

drop-down list A predefined list of values from which you select in Browse to enter 
data in a field. The drop-down list appears when you click in or tab to 
the field.

embed To insert an OLE object in Approach. You can embed an object in a 
PicturePlus field or in the background of a view. See also OLE object. 
Compare link.

expression A combination of operators, operands, and functions that yields a 
single result. A formula can consist of one or more expressions. See 
also arithmetic expression, comparison expression, and logical expression.

field A category of information in a database. For example, in an invoice 
database the fields might be for invoice number, date, and amount 
due. Compare record.

field box An editable area in a view that holds a field value. You type in the 
field box in Browse to enter data in the field.

field definition A set of attributes that includes the field name, the type of data the 
field can contain, a maximum field length for some field types, and 
optional data entry settings. Every field in a database must have a 
definition.

field label The text used to identify a field in a view. A field label often 
corresponds to the field name.

field mapping The relationship between fields in two databases (when importing 
data) and between fields in an Approach file and a database file. See 
also map.
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field name A name for a field stored as part of the field definition.

field reference In a formula, a reference to another field. When calculating the 
formula, Approach uses the value in the referenced field from the 
current record. Compare constant.

field type A specification for the type of data you can enter in a field. The 
possible field types are Boolean, calculated, date, memo, numeric, 
PicturePlus, text, time, and variable.

file See Approach file and database file.

file type A specification for the way a program stores and organizes data in 
files. In Approach, you can use a variety of database file types.

find To search for and display a set of records based on data in one or more 
fields. See also Find, find request, found set, and search criteria.

Find The environment in Approach that you use to search for data in 
records. You specify search criteria in Find; when Approach finds 
records that match the criteria, it returns you to Browse and displays 
only those records. See also find, find request, found set, and search 
criteria. Compare Browse, Design, and Preview.

find request A blank view used for entering search criteria.

fixed-length text file A text file in which the text is broken into blocks of a specific length. 
If you open a fixed-length text file as a database in Approach, the 
blocks of text become fixed-length fields. See also delimited text file.

font A set of characters in one design, size, and style. 

footer A design element that repeats at the bottom of each page in a 
previewed or printed report, worksheet, or crosstab. Compare header.

form A view typically used for entering data. When working in a form, you 
see one record at a time. Compare crosstab, report, and worksheet.

form letter A letter view that usually combines typed text with names and 
addresses from a database record.

found set A group of records that match your search criteria. When Approach 
finds records that match the criteria, it displays them in Browse as the 
found set.
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full record locking A method of network data-sharing in which only one user at a time 
can edit a record. Compare optimistic record locking.

function A predefined formula you can use in a calculated field. Approach 
provides functions for conversion, date, financial, logical, 
mathematical, statistical, summary, text, time, and trigonometric 
operations.

grid A non-printing matrix of dotted lines that you can show in Design. 
The grid provides a background to help you lay out objects in a view. 
See also snap.

handles Squares at the edges of a selected design object. You can drag a handle 
to resize the object.

header A design element that repeats at the top of each page in a previewed 
or printed report, worksheet, or crosstab. Compare footer.

icon bar A bar at the top of the Approach work area that has SmartIcons you 
can click to apply a command. Approach provides default icon bars, 
and you can create custom icon bars of your own. See also SmartIcons.

index A compilation of all the values in a field. Finds and sorts on a field go 
faster if the field has an index. Approach can compile the index as you 
enter data or when you first find or sort.

InfoBox A window that stores object properties, such as lines and colors, text 
attributes, and macro settings. Every design object in a view has an 
InfoBox with properties. You can keep the InfoBox open as you work, 
and use it to edit objects. See also named style.

join To link two databases on a common field. When multiple databases 
are joined in an Approach file, the file can have views that use data 
from all the joined databases.

join field The linked field in two joined databases. Often, a join field is an ID 
field created specifically for joining.

key field A field or group of fields with a value that uniquely identifies each 
record (for example, an invoice number). Paradox database files in 
Approach require a key field.

line chart A chart that shows each value in a data series as a data point 
connected by a line. See also area chart, bar chart, and pie chart.
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link To place a copy of an OLE object in Approach, with a connection to 
the original object in the source application. If the original object 
changes, the copy also changes in Approach. You can link an OLE 
object in a PicturePlus field or in the background of a view. See also 
OLE object. Compare embed.

logical expression An expression that compares or changes the result of comparison 
expressions and returns a result of Yes or No. A logical expression 
allows you to define more complex conditions than you can with 
comparison expressions alone. See also expression. Compare arithmetic 
expression and comparison expression.

lookup An automatic display of data from a many-to-one or one-to-one 
relationship.

macro A single command that executes a sequence of other commands. You 
define this sequence when you create the macro.

macro button An object that you can add to a form, report, or other view. When you 
click a button, it executes an attached macro. See also macro.

mailing label A view that displays database fields and text you type in a mailing 
address format.

main database A joined database that provides the basis for a view. For example, an 
invoice view would use an invoice database as its main database. A 
view shows all of the records from the main database. Compare detail 
database.

many-to-many A relationship in which two or more records in one database are 
related to two or more records in a joined database. For example, each 
order can include several products, and each product can appear on 
several orders. Compare many-to-one, one-to-many, and one-to-one.

many-to-one A relationship in which two or more records in one database are 
related to only one record in a joined database. For example, several 
employees can be in the same department. Compare many-to-many, 
one-to-many, and one-to-one.

map To associate fields in an Approach file with fields in a database file. 
You need to map fields when importing data or an Approach file. You 
may also need to map fields when opening an Approach file if you 
have made changes to a database file without saving them in the 
Approach file. See also field mapping.
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memo field A field that corresponds to a memo file. Because the data is stored in 
a separate file, you can store much more data in a memo field than 
you can in other types of fields.

named style A set of InfoBox properties that you name and save as a group. You 
can apply a named style to an object, rather than applying individual 
properties to it using the InfoBox. See also InfoBox.

numeric field A field that can hold numbers and numeric symbols (such as a 
decimal point and a currency sign). You can perform arithmetic 
calculations on data in a numeric field.

object See design object.

A method for transferring and sharing objects between applications. 
See also OLE object.

OLE object An object you embed or link in Approach through OLE. You can 
double-click an OLE object to edit it using the tools from the source 
application without leaving Approach. Charts, sound files, and data 
ranges are examples of OLE objects. See also embed and link.

one-to-many A relationship in which a record in one database is related to two or 
more records in a joined database. For example, one department can 
have several employees. In a form, you use a repeating panel to 
represent the “many” data from a one-to-many relationship. 
Compare many-to-many, many-to-one, and one-to-one.

one-to-one A relationship in which a record in one database is related to only one 
record in a joined database. For example, a vehicle number can be 
related to a license number for a single vehicle. Compare many-to-
many, many-to-one, and one-to-many.

operand A value to be operated on in a formula. Operands can be either 
constants or field references. See also constant and field reference.

operator A symbol in a formula that defines the calculation or other evaluation 
to be performed. A plus sign (+) and a less-than sign (<) are examples 
of operators.

A method of network data-sharing in which two users can edit a 
record at the same time. When the second user tries to enter changes, 
Approach warns that they will overwrite those of the first user. 
Compare full record locking.

(OLE) Object Linking 
and Embedding

optimistic record 
locking
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page margins When printing a view, the area between the printable part of the view 
and the edge of the paper.

parameter A value to be operated on in a function. Parameters are enclosed in 
parentheses after the function name and can be either constants or 
field references. See also constant and field reference.

PicturePlus field A field that can contain graphics and OLE objects. You can also allow 
drawing in a PicturePlus field.

pie chart A chart that shows each value in a data series as a slice of a pie. See 
also area chart, bar chart, and line chart.

point A typographic unit of measure; about 1/72 inch.

Preview The environment in Approach that shows views on the screen as they 
will appear when printed. Compare Browse, Find, and Design.

query file A text file that contains log-on information and a Select statement for 
a SQL table. Query files allow you to quickly connect to a server and 
get access to specific information in a table.

radio button A field object that can have a Clicked value. You usually use a set of 
two or more radio buttons for a field; you turn on one button in the 
set in Browse to enter its value in the field. See also checkbox.

read-only access Permission to read data in a database but not to modify it. You can 
assign a database password to your files to grant read-only access to 
users who know the password. See also database password. Compare 
read/write access.

read/write access Permission to read and modify data in a database. You can assign a 
database password to your files to grant read/write access to users 
who know the password. See also database password. Compare read-
only access.

record One set of related information in a database. For example, in an 
invoice database each invoice is a record. Compare field.

A database application that lets you bring together data from more 
than one database in a single form, report, or other view. Approach is 
a relational database application.

relational database 
application
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repeating panel A design element that displays the “many” side of a one-to-many 
relationship. You use a repeating panel in a form to show data from 
multiple records in a detail database. For example, a repeating panel 
in a department form might list all the department’s employees.

report A view used for organizing, summarizing, and presenting data from 
many records. A report shows all the records in the database or the 
current found set on one page (or on a series of pages). Compare 
crosstab, form, and worksheet.

row gutter The area at the left side of a worksheet or crosstab that holds row 
headers. You drag a column header from a worksheet and drop it in 
the row gutter to convert a worksheet to a crosstab. See also column 
gutter.

search criteria A set of data to look for in a database, such as Tokyo in the City field. 
When Approach finds records that match the search criteria, it 
displays only those records.

server A central computer that stores files and applications to which users 
have access across a network. Compare client.

server application An application used to create an OLE object. See also compound 
document. Compare container application.

slide To move data up or left to fill empty space in a view.

SmartIcons Icons appearing in a bar at the top of the Approach work area. Each 
of the SmartIcons represents a command; you can click an icon to 
apply the command. See also icon bar.

SmartMaster layout A predefined layout of fields on a view. You select a SmartMaster 
layout when you create a new view. See also SmartMaster style.

SmartMaster style A predefined set of InfoBox properties for a view. You select a 
SmartMaster style when you create a new view. See also SmartMaster 
layout.

snap To align objects automatically to increments on a grid in Design. The 
grid does not have to be showing for objects to “snap” to it. See also 
grid.

sort To organize records alphabetically, numerically, or chronologically by 
data in a field. See also ascending order and descending order.



Glossary-11

sort field A text, numeric, date, or time field used for sorting records in a 
database.

status bar A bar at the bottom of the Approach work area. The status bar has 
pop-up menus for changing the view, the environment, and the icon 
bar. It also provides information such as the number of records and 
the point size of text.

summary function A function that applies to a range of records. For example, the 
SSum(Amount) summary function adds the values in the Amount field 
in a range of records you specify.

summary panel An area in a report containing a calculated field that summarizes 
data.

summary report A report that omits record-by-record detail and displays only 
summary information.

template A predefined set of field definitions. Approach comes with templates 
already set up for several common business applications, such as a 
customer database and an employee database. You can use a template 
to create a new database rather than defining all of your fields from 
scratch.

text field A field that can hold any characters you can type, including letters, 
numbers, and symbols. You can search on a text field using any 
character in the field.

time field A field that can hold a single time. You can perform finds and sorts on 
times in a time field.

Tools palette A set of tools in Design for drawing lines, fields, and other objects. 
You can drag the title bar of the Tools palette to move the palette 
around in the work area.

variable field A field that temporarily stores a value used in calculations and 
macros. A variable field is part of an Approach file.

view A form, report, form letter, set of mailing labels, worksheet, crosstab, 
or chart. Views are stored in an Approach file. Approach provides a 
standard form and worksheet in each Approach file, and you can also 
design as many custom views as you need. 
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view object An OLE object you can create in Approach from a single view or an 
entire Approach file. You can also include data in a view object. See 
also data object.

view tabs “Folder” tabs that appear at the top of the window for each view in 
the Approach file. You can click a tab to go to that view.

worksheet A view used for organizing, summarizing, and presenting data from 
many records in a grid of columns and rows. A worksheet shows all 
the records in the database or the current found set on one page (or on 
a series of pages). Each record occupies a single row in the worksheet. 
Compare crosstab, form, and report.

x-axis The horizontal axis in an area, bar, or line chart. An x-axis usually 
shows categories that represent information from the database, such 
as years or geographic areas. Compare y-axis.

y-axis The vertical axis in an area, bar, or line chart. A y-axis defines the scale 
of values plotted in the chart. Compare x-axis.

zoom To change the magnification of a view on the screen. You can zoom in 
for a closer look or zoom out for the big picture. Zooming does not 
affect the size of a view when you print it, only how it appears on the 
screen.
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Symbols
& (ampersand) as search operator  11-4, 

11-7

<< >> (angle brackets)

on form letters  9-8, 9-12

in report headers and footers  8-24

on views  9-8

* (asterisk)

as arithmetic operator  A-4

as search operator  11-4, 11-6

@ as search operator  11-4

: (colon) in numeric formats  6-19

, (comma)

in numeric formats  6-19

as search operator  11-4

<<DATE>>. See Date, current

. (decimal point) in numeric formats  6-19

$ (dollar sign) in numeric formats  6-19

" (double quotation marks) in numeric 
formats  6-19

... (ellipsis) as search operator  11-4

= (equal to)

as comparison operator  A-5

in numeric formats  6-20

as search operator  11-4

! (exclamation point) 
as search operator  11-4

> (greater than)

as comparison operator  A-5

in numeric formats  6-20

as search operator  11-4

>= (greater than or equal to)

as comparison operator  A-5

as search operator  11-4

< (less than)

as comparison operator  A-5

in numeric formats  6-20

as search operator  11-4

<= (less than or equal to)

as comparison operator  A-5

as search operator  11-4

- (minus sign)

as arithmetic operator  A-4

in numeric formats  6-19

<> (not equal to)

as comparison operator  A-5

as search operator  11-4

# (number sign) in numeric formats  6-19

<<#>>. See Page numbers

() (parentheses) in numeric formats  6-20

% (percent sign) in numeric formats  6-19

. (period) in numeric formats  6-19

+ (plus sign)

as arithmetic operator  A-4

in numeric formats  6-19

? (question mark) 
as search operator  11-4, 11-7

; (semicolon) in numeric formats  6-20

/ (slash) as arithmetic operator  A-4

~ (tilde) as search operator  11-4

<<TIME>>. See Time, current

| (vertical bar) in numeric formats  6-20

0 (zero) in numeric formats  6-19

A
Abs (Absolute value) function  A-10

Accuracy of data, verifying 
automatically  3-15

Acos (Arc cosine) function  A-10

Activating linked OLE objects  16-25

Add Field dialog box, displaying 
automatically  19-14

Adding

See also Creating; Displaying

calculated fields to summary 
panels  8-19

columns to crosstabs  12-17

columns to worksheets  12-17, 12-21

commands to macros  15-4

current date  5-37

current time  5-37

design objects to views  5-12

embedded OLE 
objects  16-26–16-28

fields to crosstabs  12-17

fields to databases  3-1–3-20

fields to form letters  9-12

fields to views  6-1

to form letter contents  9-11–9-13

formulas to crosstabs  12-24

geometric objects  5-12

linked OLE objects  16-21

macro buttons  15-11

page numbers on report headers and 
footers  8-24

pictures as design objects  5-13

records  10-5–10-6

records automatically, join options 
for  4-17

records by importing data.
See Importing

repeating panels to forms.
See Repeating panels

rows to crosstabs  12-17

series on charts  13-6

summary columns and rows to 
crosstabs  12-24

summary panels to reports  8-14

text as design objects  5-14
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text to mailing labels  9-22

Addition operator (+)  A-4

Address labels. See Mailing labels

Addresses

on form letters.See Form letters, 
addresses on

on mailing labels.See Mailing 
labels

.ADX filename extension  B-8

Alias joins  4-11

Aligning

data in fields  6-24

design objects  5-34

field labels  6-27

summary report panels  8-18

text in text objects  5-23

Ampersand (&) as search 
operator  11-4, 11-7

AND operator in logical expressions  A-6

“And”  searches  11-5

Angle brackets (<<>>)

on form letters  9-8, 9-12

in report headers and footers  8-24

on views  5-37

ANSI. See Character sets

Approach

customizing  19-1–19-22

filename extensions  B-8–B-10

Approach files  1-1, 2-1

closing  2-22

creating, automatically  2-3, 2-5

creating backups of  2-19

creating several, for one set of 
data  2-22

defining passwords for  19-6

deleting  2-22

entering passwords for  2-6, 18-7

importing  16-10

importing text files into  2-14–2-18

inserting OLE objects in  16-21, 
16-26–16-28

mailing, electronically   16-16

mapping changed fields when 
opening  2-7

opening  2-5–2-7

saving  2-18–2-22

saving copies of  2-19–2-22

updating, by importing. See 
Importing

Approach OLE objects, creating

See also OLE (Object Linking and 
Embedding) objects

in Approach  16-19

from other applications  16-20

APPROACH.INI file  19-1

.APR filename extension  2-5, B-9

.APT filename extension  2-5, B-9

.APX filename extension  B-9

Arc cosine (Acos) function  A-10

Arc sine (Asin) function  A-11

Arc tangent/Arc tangent2 (Atan/Atan2) 
functions  A-11

Area charts  13-4

Arguments in functions  A-6

Arithmetic expressions  A-4

Asc (ASCII) function  A-10

Ascending sort order  11-15

ASCII files

creating databases from  2-14–2-18

filename extension for  B-10

importing  2-16, 16-5

Asin (Arc sine) function  A-11

Asterisk (*)

as arithmetic operator  A-4

as search operator  11-4, 11-6

Atan/Atan2 (Arc tangent/Arc tangent2) 
functions  A-11

Attaching macros

to design objects  15-13

to fields  15-14

to macro buttons  15-12

to views  15-15

Automatic data entry, setting up  3-13

Automatic data verification, 
setting up  3-15

Averages

for data in repeating panels  7-15

in summary panels  8-19

Avery formats for mailing labels  9-16

Avg (Average) function  A-11

B
Back, moving design objects to  5-33

Background, page  5-38

Backup files, creating  2-20

Bar charts  13-3

Baseline for fields, showing  6-25

Baud rate, modem  19-8

Bitmap (Windows) filename 
extension  B-10

Blank

columns, adding, to 
worksheets  12-21

database files, creating  2-4

fields, finding  11-9

function  A-12

.BMP filename extension  B-10

BMP pictures

adding, to views  5-13

pasting, into fields  10-14–10-16

Body cells. See Cells

Boolean fields  3-2

See also Entering data

adding, to databases  3-2

automatic data entry in, setting up 
for  3-13

automatic data verification of, 
setting up for  3-15

editing definitions of  3-11

entering data in  10-10

Boolean values, finding  11-8

Borders

of design objects  5-19

of fields  6-25

named styles for  5-26–5-31

of page margins  5-38

of repeating panels  7-12

of report panels  8-22

of views  5-38

of worksheet cells  12-22

Bottom, moving design objects to  5-33

Branch. See Conditional
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Browse environment  1-13, 10-1

appearance of joined data in  4-4

checking spelling in  10-17–10-22

context-sensitive menu in  10-2

customizing icon bar for  19-16

default icon bar for  10-2

entering and editing data in.
See Entering data

formatting worksheets and crosstabs 
in  12-17

hiding page margins in  5-36

hiding views in  5-36

insertion point in  10-7, 10-8

selecting in  10-7

status bar in  10-2

Business letters.See Form letters

Buttons

See also Pushbuttons

See also Radio buttons

Buttons, macro.See Macro buttons

C
Caching SQL tables  19-11

Calculated fields  3-3

See also Formulas; Functions

adding, to databases  3-3

creating formulas for  3-5

displaying, for repeating panel 
data  7-15

displaying, in summary 
panels  8-19–8-20

editing definitions of  3-11

example of, on forms  7-19

joining on  4-17

where-placed option for  8-19

Calculations

See also Calculated fields; Formulas; 
Functions

excluding records from  10-22

when performed  14-1

Cancel Macro dialog box, displaying 
when running macros  19-14

Capitalization in text fields  6-22

Case-sensitivity of searches  11-7

in Paradox files  19-10

Categories on crosstabs  12-2

cc:Mail  16-16

.CDX filename extension  B-9

Cells

crosstab  12-12

crosstab, changing formula 
for  12-25

worksheet  12-16

worksheet, border and fill of   12-22

Centering

data in fields  6-24

design objects  5-34

field labels  6-27

summary panels in reports  8-23

text in design objects  5-23

Changing. See Editing

Character (Chr) function  A-12

Character sets

for dBASE files  19-9

for FoxPro files  19-9

for Paradox files  19-10

Chart notes  13-2

Charts  1-8, 13-1–13-12

axes on  13-2, 13-5, 13-14

changing data for  13-10

changing layout of  13-14

changing type of  13-12, 13-14

creating  13-2–13-9

creating, from crosstabs  13-9

formatting components on  13-14

formatting text on  13-15

instant, from crosstabs  13-9

legends on  13-2, 13-14

main databases for  13-6

notes on  13-2, 13-14

online help for  13-1

parts of  13-2

plotted area on  13-2, 13-14

position of components on  13-14

properties of  13-14

series on  13-2, 13-14

SmartMaster styles and layouts 
for  13-3

titles on  13-2, 13-14

x-axis on  13-2, 13-5, 13-14

y-axis on  13-2, 13-5, 13-14

format and position of  13-14

Chart types  13-12–13-13

area charts  13-3

bar charts  13-3

line charts  13-3

pie charts  13-7

switching  13-12, 13-14

three-dimensional  13-12

tips for choosing  13-13

Checkboxes for fields

changing values for  6-23

creating  6-10

finding  11-9

turning on and off  10-13

Checking

data accuracy automatically  3-15

data type automatically  3-15

spelling  10-17–10-22

Chr (Character) function  A-12

Circles

See also Design objects

drawing on views  5-12

reshaping  5-21

Clipping graphics in PicturePlus fields 
(cropping)  6-32

Closing

Approach files  2-22

on form letters  9-2

Colon (:) in numeric formats  6-19

Color

See also Fill color

of data in fields  6-24

of design objects  5-19–5-20

of field borders  6-25

of field labels  6-27

of lines drawn in PicturePlus 
fields  10-16

of page background  5-38

of repeating panels  7-12
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of report panels  8-22

of text in text objects  5-23

of worksheet column headers and 
cells  12-22

Column gutters on worksheets  12-9

Column headers on worksheets  12-1

background color of  12-22

editing text in  12-22

selecting  12-13

Columnar forms  7-4

Columnar reports  8-3, 8-5

Columns on crosstabs  12-12

adding, for fields  12-17

adding summary  12-24

changing formulas for  12-25

deleting  12-18

moving  12-19

resizing  12-19

Columns on reports

changing number of  8-25

moving  8-27

resizing  8-28

Columns on worksheets  12-1

adding, blank  12-21

adding, for fields  12-17

adding, for formulas  12-21

background color of  12-22

cell borders for  12-22

moving  12-18

removing  12-18

resizing  12-19

selecting  12-13

Combine function  A-12

Comma (,)

in numeric formats  6-20

as search operator  11-4

Comma-delimited text files

importing  2-14, 16-5

Commands

See also specific commands; specific 

menus

adding, to macros  15-4

allowed in macros  15-5

moving, in macros  15-4

online help for  1-10

online help for, preference for  19-2

removing, from macros  15-3

Comparison expressions  A-5

Compatibility, software  16-1, B-1–B-10, 
C-1–C-16, D-1–D-3

summarized  1-2

Compound documents  16-18

Compression in dBASE and FoxPro 
files  19-9

Concatenate. See Combine function

Conditional

calculations in macros, example 
of  15-21

drop-down lists  6-7

function  A-16

macros, example of  15-21

searches  11-10

Connecting

to IBM DB2  C-9–C-12

to Microsoft SQL Server  C-6

to Oracle SQL  C-4

Constants in formulas  A-2

Container applications  16-18

Context-sensitive menus

in Browse  10-2

in Design  5-3

Contexts. See Environments; specific 

environments

Control menu  1-9

Conventions  xii

Conversion functions, summarized  A-8

Converting

linked OLE objects to graphic 
elements  16-25

worksheets to crosstabs  12-8

Coordinates of objects, displaying, in 
status bar  5-21

Copying. See Duplicating

Cos (Cosine) function  A-13

Count

in repeating panels  7-15, 7-19

in summary report panels  8-19

Creating

See also Adding; Displaying

Approach files 
automatically  2-3, 2-5

Approach files, several, for one set of 
data  2-22

Approach OLE objects  16-19–16-21

backup files  2-20

charts  13-2

charts from crosstabs  13-9

checkboxes for fields  6-10

crosstabs  12-5–12-10

databases, basic steps for  1-16

databases from spreadsheets  2-11

databases from text files  2-14–2-18

drop-down lists for fields  6-4

embedded OLE objects  16-27

fields in a database  3-1–3-20

find requests  11-2

form letters  9-3

forms  7-4

formulas  3-8

joins  4-13

macros  15-1–15-9

mailing labels  9-16–9-20

named styles  5-27

radio buttons for fields  6-12

reports  8-3–8-13

SQL query files  C-13–C-15

views in Lotus 1-2-3  17-9

worksheets  12-3

Cropping graphics in PicturePlus 
fields  6-32

Crosstabs  1-7, 12-1–12-26

adding columns and rows to  12-17

adding summary columns and rows 
to  12-24

body cells on  12-12

in Browse  12-3

column gutters on  12-12

columns on. See Columns on 
crosstabs

converting, from worksheets  12-8

copying, to Clipboard  12-15
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creating  12-5–12-10

creating charts from  13-9

creating, in Lotus 1-2-3  17-9

deleting summary columns and rows 
from  12-24

in Design  12-3

displaying fields on  12-17

editing formulas on  12-25

formatting, for printing  12-23

formatting text on  12-23

formulas on, editing  12-25

main databases for  12-8

moving between cells on  12-16

moving columns and rows on  12-18

moving fields on  12-18

pane dividers on  12-12

removing fields from  12-19

resizing columns and rows on  12-19

row gutters on  12-12

selecting on  12-13

status bar for  12-12

summarized data on  12-24–12-26

text properties on  12-23

Current date.See Date, current

Current time.See Time, current

CurrTime (Current time) function  A-13

Customizing

Approach  19-1–19-22

data entry  3-13–3-18

icon bars  19-16

menus  19-18–19-22

D
Data

See also Summarized data

aligning, in fields  6-24

automatic entry of, setting up 
for  3-13

automatic verification of, setting up 
for  3-15

changing, for charts  13-10

color of, in fields  6-24

copying, cutting, and pasting, in 
fields  10-7

downloading, for Preview  19-14

duplicating, in fields  10-12

entering. See Entering data

exporting  16-12

finding, in records.See Finding

formats for  6-14–6-22

importing, from database 
files  16-2–16-10

importing, from text files  16-5

mailing, electronically  16-16

saving, from SQL queries  C-14

sharing, on networks.See Networks

sharing, with other applications.See 
OLE (Object Linking and 
Embedding) objects

showing, in Design  5-9

showing, in Design, preference 
for  19-2

text properties of  6-24

Data entry order  6-32

Data entry type of fields  6-23

Database files  1-1, 2-1

adding fields to  3-1–3-20

case-sensitivity of searches in  19-10

creating  2-3

creating backups of  2-20

creating, from spreadsheets  2-11

creating, from text files  2-14–2-18

dBASE. See dBASE files

defining passwords for  19-6

deleting  2-22

deleting fields from  3-20

deleting records from  10-23–10-24

detail, for views  4-5

entering passwords for  2-6, 18-7

exporting data from  16-12

field order in  3-12

file types  2-5

FoxPro. See FoxPro files

IBM DB2. See IBM DB2

importing  16-2–16-10

join options for inserting and 
deleting records 
automatically  4-17

joining  4-13

joining. See Joins

mailing, electronically  16-16

main, for views  4-5, 5-36

Microsoft SQL Server.See 
Microsoft SQL Server

opening, from another 
application  2-9

Oracle SQL.See Oracle SQL

Paradox.See Paradox files

read-only  19-9

saving copies of  2-20

sharing, on networks.See Networks

templates for  2-3, 2-20, 3-5

unjoining  4-20

Database programs, compatibility with. 
See Software compatibility

Databases

See also Database files

joined. See Joins

main. See Main database

template  xii

<<DATE>>. See Date, current

Date, current

finding  11-9

on form letters  9-2

in report headers and footers  8-24

on views  5-37

Date fields  3-3

See also Entering data

adding, to databases  3-3

automatic data entry in, setting up 
for  3-13

automatic data verification of, 
setting up for  3-15

displaying formatting characters in, 
when entering data  6-16

editing definitions of  3-11

entering data in  10-10

formatting  6-15–6-18

international formats for  10-11

sort sequence for  11-16

Date function  A-13

Date-related functions summarized  A-8
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Dates

See also Date, current

entering, in date fields  10-10

finding  11-8

in formulas  A-2

international, in date fields  10-11

international, in formulas  A-2

DateToText function  A-13

Day function  A-13

DayName function  A-14

DayOfWeek function  A-14

DayOfYear function  A-14

.DB filename extension  2-5, B-9

DB2 (IBM). See IBM DB2

dBASE files

See also Database files

case-sensitivity of searches in  11-7

character sets for  19-9

compatibility with  B-1–B-3

compression in  19-9

database options for  19-9

field definitions and  B-2

filename extensions of  B-9

indexing and  19-12, B-2

locking protocol for  18-4

read-only  19-9

sharing on networks, options 
for  18-2

size limitations in  B-3

.DBF filename extension  2-5, B-9

.DBQ filename extension  B-9

.DBT filename extension  B-9

Decimal point (.) in numeric formats  6-19

Default settings.See Preferences

Defining. See Adding; Creating

Degree function  A-14

Deleting

columns from worksheets  12-18

columns and rows from 
crosstabs  12-18

commands from macros  15-3

data in fields  10-7

fields from databases  3-20

fields from form letters  9-13

fields from views  5-25

files  2-22

linked OLE objects  16-25

macros  15-10

named styles  5-31

objects from views  5-25

records  10-23–10-24

records automatically, join options 
for  4-17

report panels  5-25

text in design objects  5-25

views  5-40

Delimited text files

creating databases from  2-14

exporting  16-13

importing  2-14, 16-5

Descending sort order  11-15

Deselecting fields and design 
objects  5-17

Design environment  1-11, 5-1–5-40

See also Views

appearance of joined data in  4-5

checking spelling in  10-17–10-22

context-sensitive menu in  5-3

customizing icon bars for  19-16

default icon bars for  5-2

displaying data or field names in  5-9

displaying data or field names in, 
preference for  19-2

grid. See Design grid

menu bar in  5-3

pop-up menu in  5-6

rulers in  5-8

saving changes in  5-1

showing Add Field dialog box in, 
preference for  19-2, 19-14

status bar in  5-3

Tools palette in  5-9

zooming in and out  5-11

Design grid

preferences for  19-2

showing or hiding  5-7

snapping objects to  5-8

Design objects  5-4

See also Objects; Text; Text objects

adding  5-12–5-16

aligning  5-34

applying named styles to  5-19

applying properties to, from another 
object  5-25

attaching macros to  15-13

borders of  5-19–5-20

color of  5-19–5-20

color of text in  5-23

coordinates of, displaying in status 
bar  5-21

deleting  5-25

deselecting  5-17

dimensions of, displaying in status 
bar  5-21

distributing  5-34

drop shadows for  5-19

duplicating  5-24

editing  5-18–5-25, 5-32–5-35

equal spacing between  5-34

Fill pattern of  5-19

grouping  5-32

InfoBox and  5-5

moving  5-22, 5-24

moving, automatically when printing 
(sliding)  5-22

multiple, working with  5-32–5-35

named styles for  5-19, 5-26–5-31, 
19-2

non-printing  5-19

OLE objects as  16-19–16-28

properties of  5-19–5-24, 5-25

resizing and reshaping  5-21

selecting  5-17

stacking order of  5-34

three-dimensional  5-20

ungrouping  5-32

Detail database files, for views  4-5

Dialing preferences  19-8

Dialog boxes, online help for  1-10
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Dictionaries

editing user  10-20

main and user  10-18

switching main  10-21

Dimensions of objects, displaying in 
status bar  5-21

Dimmed OK button in Join dialog 
box  4-16

Displaying

See also Adding; Creating

Add Field dialog box 
automatically  19-2

baseline for fields  6-25

calculated fields for repeating panel 
data  7-15

calculated fields on summary report 
panels  8-19–8-20

coordinates of design objects in 
status bar  5-21

data in Design  5-9

data in Design, preference for  19-2

design grid  5-7

dialog box for canceling 
macros  19-14

dimensions of design objects in 
status bar  5-21

field names in Design  5-9

field names in Design, preference 
for  19-2

fields on crosstabs  12-17

fields on form letters  9-8

fields on forms  6-1–6-14, 7-6

fields on mailing labels  6-1–6-14, 
9-17

fields in repeating panels  7-14

fields on reports  6-1–6-14, 8-7

fields on views  6-29–6-32

find bar, preference for  19-2

formatting characters in fields  6-15

hidden records  10-23

icon bar  1-10

icon bar, preference for  19-2

InfoBox for design objects  5-5

InfoBox for fields  6-15

Lotus 1-2-3 data  17-7–17-9

Lotus Notes data  17-1

non-printing design objects  5-19

non-printing fields  6-23

non-printing PicturePlus fields  6-31

PicturePlus fields  6-29–6-32

records  10-4–10-5

report panel labels  8-21

SQL system table filenames in 
dialog boxes  19-11

status bar  1-10

status bar, preference for  19-2

title page for reports  8-25

view tabs  1-10

view tabs, preference for  19-2

Welcome dialog box when starting 
Approach  2-3, 19-2

Distinct values, finding  11-12

Distributing objects  5-34

Divider tabs. See View tabs

Division operator  A-4

Dollar sign ($) in numeric formats  6-19

DOS character set.See character sets

Double quotation marks (") in numeric 
formats  6-19

Downloading data for Preview  19-14

Drawing

allowing, in PicturePlus fields  6-32

geometric objects on views  5-12

in PicturePlus fields  10-16

Drop shadows

for design objects  5-19

for fields  6-25

for repeating panels  7-12

for report panels  8-22

Drop-down lists for fields

changing values for  6-23

creating  6-4

displaying a subset of data in  6-7

entering data in  10-12

Duplicate values, finding  11-12

Duplicating

data in fields  10-7, 10-12

design objects  5-24

files  2-19

records  10-6

report panels  5-24

views  5-39

E
Editing

checkbox values  6-23

data. See Entering data

design objects  5-18–5-25, 
5-32–5-35

drop-down list values  6-23

embedded OLE objects  16-28

field definitions  3-11, 6-23

field labels  6-27

field properties  6-22–6-29, 
6-31–6-32

formulas on crosstabs  12-25

formulas in field 
definitions  3-12, 6-23

layout of mailing labels  9-23

linked OLE objects  16-23–16-25

locking records for  19-14

macros  15-9

named styles  5-31

on networks.See Networks

radio button values  6-23

serial numbers of records  3-4

sort order  11-18

SQL query files  C-13

text in design objects  5-18–5-25, 
5-32–5-35

text in worksheet column 
headers  12-22

Ellipses

See also Design objects

drawing on views  5-12

reshaping  5-21

Ellipsis (...) as search operator  11-4

E-mail  16-16

limiting amount of data in  16-16

sending from Approach  16-16
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Embedded OLE objects  16-26–16-28

See also Linked OLE objects; OLE 
(Object Linking and Embedding) 
objects

editing  16-28

inserting in Approach files  
16-26–16-28

Encapsulated PostScript (EPS)

filename extension  B-10

pictures, adding to views  5-13

pictures, pasting into 
fields  10-14–10-16

Enlarging

graphics in PicturePlus fields  6-32

views in Design  5-11

ENTER key, using as TAB key  19-14

Entering data  10-7

by adding records  10-6

by adding records in repeating 
panels  10-6

automatic verification when  3-15

automatically  3-13

in Boolean fields  10-10

in checkboxes  10-13

copying, cutting, and pasting 
when  10-7

customization for  3-13–3-18

in date fields  10-10

displaying formatting characters 
when  6-15

from drop-down lists  10-12

by duplicating records  10-6

by filling fields with a value  10-16

in memo fields  10-8

moving between records 
when  10-4–10-5

in numeric fields  10-9

in PicturePlus fields  10-14–10-16

from radio buttons  10-13

specifying data formats 
for  6-14–6-22

in text fields  10-8

in time fields  10-11

using ENTER key as TAB key 
when  19-14

Entering passwords  2-6

on networks  18-7

Environment pop-up menu in status 
bar  1-9

Environments  1-9–1-15

See also specific environments

Browse  1-13, 10-1

Design  1-11, 5-1

Find  1-14, 11-1

Preview  1-15, 14-3

EPS (Encapsulated PostScript) pictures

adding, to views  5-13

pasting, into fields  10-14–10-16

.EPS filename extension  B-10

Equal to (=)

as comparison operator  A-5

in numeric formats  6-20

as search operator  11-4

Exact function  A-15

Excel

filename extension  B-10

spreadsheets, creating databases 
from  2-11

Excel. See Microsoft Excel

Exclamation point (!) as search 
operator  11-4

Excluding records from 
calculations  10-22

Exp (Exponentiation) function  A-15

Exporting data  16-12

creating a SQL query file by  C-14

as delimited text  16-13

excluding records when  10-22

as fixed length text  16-14

limiting data when  16-14

from SQL query  C-16

Exporting pictures in fields  16-15

Expressions in formulas  A-3–A-6

arithmetic  A-4

comparison  A-5

logical  A-6

Extensions, filename  B-8–B-10

External indexes for dBASE and 
FoxPro  19-12

F
Factorial function  A-15

Field borders, named styles 
for  5-26–5-31

Field boxes  6-1

Field Definition command (File menu)

See also Field Definition dialog box

Field definition dialog box, flag in  3-10

Field definitions, database  3-1–3-20

See also Fields

dBASE and  B-2

editing  3-11, 6-23

FoxPro and  B-5

IBM DB2 and  C-12

Microsoft Access and  B-7

Microsoft SQL Server and  C-7

ODBC and  D-2–D-3

Oracle and  C-4

Paradox and  B-4

Field labels  6-27

See also Labels; Text

aligning  6-27

applying named styles for  6-23

editing  6-27

hiding  6-27

inside field borders  6-26

named styles for  5-26–5-31, 6-23, 
19-2

properties of  6-27

three-dimensional  6-27

wording of  6-27

Field length

changing  3-11

in dBASE files  B-2

in FoxPro files  B-6

in IBM DB/2 tables  C-12

in Microsoft Access files  B-7

in Microsoft SQL Server tables  C-8

in ODBC data sources  D-3

in Oracle SQL tables  C-5

in Paradox files  B-4
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Field mapping  16-2

when importing Approach 
files  16-11

when importing database files  16-8

when opening Approach files  2-7

Field names

in dBASE files  B-2

editing  3-11

on form letters  9-8

in formulas  A-2

in IBM DB2 tables  C-12

in Microsoft Access files  B-7

in Microsoft SQL Server tables  C-7

in ODBC data sources  D-2

in Oracle SQL tables  C-5

in Paradox files  B-4

showing, in Design  5-9

showing, in Design, preference 
for  19-2

Field references

See also Field names

in formulas  A-2

Field types  3-1–3-4

See also specific types

Boolean. See Boolean fields

calculated.See Calculated fields; 
Formulas; Functions

changing  3-11

date. See Date fields

memo. See Memo fields

numeric. See Numeric fields

PicturePlus.See PicturePlus fields

text. See Text fields

time. See Time fields

variable. See Variable fields

Fields  1-1

See also Field labels; Specific field 

types

adding, to databases  3-5

adding, to form letters  9-12

aligning  5-34

aligning data in  6-24

applying named styles to  6-23

applying properties to, from another 
object  5-25

attaching macros to  15-14

automatic data entry in, setting up 
for  3-13

automatic data verification of, 
setting up for  3-15

borders of  6-25

calculated.See Calculated fields

checkboxes for  6-10, 6-23

colors of  6-24

copying, cutting, and pasting data 
in  10-7

data entry order of, on views  6-32

data entry type  6-23

data formats for  6-14–6-22

database definitions of  3-11

in dBASE, limitations of  B-3

defining. See Defining fields

deleting data from  10-7

deleting, from databases  3-20

deleting, from form letters  9-13

deleting, from views  5-25

deleting, from worksheets  12-18

deselecting, in Design  5-17

displaying baselines on  6-25

displaying, on crosstabs  12-17

displaying, on form letters  9-8, 9-12

displaying, on forms  6-1–6-14, 7-6

displaying, on mailing 
labels  6-1–6-14, 9-17

displaying, in repeating panels  7-14

displaying, on views  6-29–6-32

displaying, on worksheets  12-17

distributing  5-34

drop shadows for  6-25

drop-down lists for  6-4, 6-23

duplicating data in  10-12

editing, in databases  3-11

entering and editing data in. See 
Entering data

equal spacing between  5-34

finding matching values in. See 
Finding

in FoxPro, limitations of  B-6

grouping  5-32

in IBM DB2, limitations of  C-12

in reports. See Reports

InfoBox for  6-15

join  4-3

labels for. See Field labels

limiting the values for  6-7

mapping. See Field mapping

in Microsoft Access, limitations 
of  B-8

in Microsoft SQL Server, limitations 
of  C-8

moving  5-22, 5-24

moving, automatically when printing 
(sliding)  6-28, 9-21

moving, on crosstabs  12-19

moving data in  10-7

moving, on form letters  9-13

moving, on mailing labels  9-21

moving, in repeating panels  7-15

named styles for  5-26–5-31, 6-23, 
19-2

non-printing  6-23

in ODBC data sources, limitations 
of  D-2

OLE (Object Linking and 
Embedding) options for  3-17

in Oracle SQL, limitations of  C-5

in Paradox, limitations of  B-5

PicturePlus.See PicturePlus fields

properties of  6-22–6-29, 6-31–6-32

radio buttons for  6-12, 6-23

read-only  6-23

reducing boundaries when 
printing  6-28

removing, from crosstabs  12-19

in repeating panels  7-6, 7-14–7-15

resizing, on mailing labels  9-21

resizing, on views  5-21

selecting, in Browse  10-7

selecting, in Design  5-17

showing field names or data in, in 
Design  5-9

sliding, when printing  6-28
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sorting records by  11-14–11-18

stacking order of  5-34

text properties of  6-24

three-dimensional  6-25

types of. See Field types; specific 

types

ungrouping  5-32

updating, by importing data.
See Importing

File formats

See also Applications; specific 
programs

File menu

Field Definition command.
See Field Definition dialog box

File sharing.See Network

File types, database  2-5

Filename extensions  B-8–B-10

Files

See also Approach files; Database 
files

Approach  1-1, 2-1

copying  2-19, 2-22

creating backup  2-19

database  1-1, 2-1

dBASE, limitations of  B-3

deleting  2-22

FoxPro, limitations of  B-6

importing. See Importing

Microsoft Access, limitations of  B-8

Paradox, limitations of  B-5

sharing, on networks. See Networks

Fill color

of fields  6-25

of page background  5-38

of repeating panels  7-12

of report panels  8-22

of text and design objects  5-19

Fill function  A-15

Fill pattern

of report panels  8-22

of text and design objects  5-19

Filling fields with values  10-16

Filtering data in drop-down lists  6-7

Financial functions summarized  A-8

Find bar, preference for displaying  19-2

Find environment  1-14, 11-1

customizing icon bar for  19-16

default icon bar for  11-2

Find and replace.See Filling fields with 
values

Find request

creating  11-2

saving, with macros  11-11, 15-17

Find requests

See also Finding data in records

Find Special dialog box  11-13

Finding  11-1–11-14

“And” searches for  11-5

blank fields  11-9

Boolean values  11-8

case-sensitivity of  11-7

case-sensitivity of, in Paradox 
databases  19-10

checkbox settings  11-9

complex expressions  11-10

with conditional searches  11-10

creating find requests for  11-2

dates  11-8

distinct values  11-12

duplicate values  11-12

homonyms  11-7

with “If” statements  11-10

macro for, example of  15-17

with multiple criteria  11-5

non-blank fields  11-9

numbers  11-8

operators for  11-4

“Or” searches for  11-5

radio button settings  11-9

range of values  11-8

records matching multiple 
criteria  11-5

records matching one of several 
criteria  11-5

repeating searches when  11-11

text  11-6–11-7

times  11-8

unique values  11-13

values in a range  11-8

wildcards for  11-6

words that sound like other 
words  11-7

First record, moving to  10-5

Fixed-length text files

creating databases from  2-16

exporting  16-14

importing  2-16, 16-6

Flag, in Field Definition dialog box  3-10

Font

of data in fields  6-24

of field labels  6-27

of text in text objects  5-23

Footers, in reports  8-24

Form letters  1-5, 9-1–9-13

See also Views

adding to contents of  9-11–9-13

addresses on  9-6

block  9-3

closing for  9-7

color settings for  9-10

creating  9-3

current date on  9-2

default icon bar for  9-9

displaying fields on  9-12

entering and editing data on.
See Entering data

field names on  9-6

formatting text on  9-9

inside address on  9-6

main databases for  9-8

modified block  9-4

moving fields on  9-13

personal  9-4

return address on  9-6

rulers on  5-8, 9-9

salutation on  9-6

SmartMaster styles and layouts 
for  9-3

typing on  9-12
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Formatting

charts  13-14

crosstabs for printing  12-23

data  6-14–6-22

reports  8-20–8-28

text on charts  13-15

text on crosstabs  12-23

text in Design  5-23

text fields  6-22

text on worksheets  12-23

worksheets for printing  12-23

Forms  1-4, 7-1–7-21

See also Views

appearance of joined data on  4-5

calculated fields for  7-15, 7-19

columnar  7-4

creating  7-4

creating, in Lotus 1-2-3  17-9

detail databases for  7-3

displaying calculated fields 
on  7-15, 7-19

entering and editing data on.See 
Entering data

examples of  7-16–7-21

finding records on.See Finding

lookups on  4-8, 7-17

main databases for  4-6, 7-3, 7-7

repeating panels on. See Repeating 
panels

SmartMaster styles and layouts 
for  7-4

standard  7-4

summarized data on  7-15, 7-19

Formulas  A-1–A-32

See also Calculated fields; Functions

adding columns and rows to 
crosstabs for  12-24

adding columns to worksheets 
for  12-21

constants in  A-2

creating, in calculated fields  3-8

dates in  A-2

editing, on crosstabs  12-25

editing, in field definitions  3-12

elements of  A-1–A-4

expressions in  A-3–A-6

field names in  A-2

functions in  A-3, A-6–A-32

operands in  A-1–A-3

operators in  A-1

summarizing records with  3-10

text in  A-2

times in  A-2

using, without calculated fields  3-15

where-placed option in  3-10

Found set  11-2

FoxPro files

See also Database files

case-sensitivity of searches in  11-7

character sets for  19-9

compatibility with  B-5–B-6

compression in  19-9

database options for  19-9

field definitions and  B-5

filename extensions  B-9

indexing and  19-12, B-6

read-only  19-9

size limitations in  B-6

viewing, on a network  B-5

.FPT filename extension  B-9

“Freezing” network data in Preview  18-8

Front, moving design objects to  5-33

Full record locking  19-14

Functions  A-3

See also Calculated fields; Formulas

described  A-10–A-32

in formulas  A-3, A-6–A-32

international settings for  A-7

parameters in  A-6

summarized  A-8

using  A-6–A-8

within other functions  A-7

FV (Future value) function  A-15

G
Geometric objects

deselecting, in Design  5-17

drawing on views  5-12

selecting, in Design  5-17

.GIF filename extension  B-10

GIF pictures

adding, to views  5-13

pasting, into fields  10-14–10-16

Graphic files

adding pictures to views  5-13

filename extensions for  B-10

pasting, into fields  10-14–10-16

types of, supported  5-13

Graphics grid.See Autogrid

Graphs. See Charts

Greater than (>)

as comparison operator  A-5

in numeric formats  6-20

as search operator  11-4

Greater than or equal to (>=)

as comparison operator  A-5

as search operator  11-4

Grid, design.See Design grid

Grouping objects  5-32

Groups on crosstabs  12-2

H
Headers

for columns on worksheets.
See Column headers on 
worksheets

in reports  8-24

Height of objects, displaying, in status 
bar  5-21

Help, online

for charts  13-1

for commands  1-10

for commands, preference for  19-2

for dialog boxes  1-10

for icons  1-10

for printing options  14-3

Help system, using  xii
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Hiding

design grid  5-7

field labels  6-27

find bar, preference for  19-2

icon bar  1-10

icon bar, preference for  19-2

page margins in Browse  5-36

page margins when printing  5-38

records from view  10-23

status bar  1-10

status bar, preference for  19-2

title page for reports  8-25

view tabs  1-10

view tabs, preference for  19-2

views in Browse  5-36

Homonyms, finding  11-7

Hour function  A-16

Hundredth function  A-16

I
IBM DB2

compatibility with  C-12

connecting to, server  C-9–C-12

field definitions and  C-12

files, caching  19-11

files, case-sensitivity of searches 
in  11-7

files, creating  2-5

files, database options for  19-11

files, read-only  19-11

size limitations in  C-12

Icon bar pop-up menu, in status bar  1-9

Icon bars  1-8

in Browse, default for  10-2

for crosstabs, default for  12-12

customizing  19-16

in Design, defaults for  5-2

displaying  1-10

in Find, default for  11-2

for form letters, default for  9-9

for forms, default for  5-2

for mailing labels, default for  9-15

in Preview, default for  14-4

for reports, default for  5-2

showing or hiding  1-10

showing or hiding, preference 
for  19-2

text  5-2

for worksheets, default for  12-11

Icons

See also specific icons

SmartIcons  xii

Icons. See Icon bar

.IDX filename extension  B-9

If

calculations in macros, example 
of  15-21

function  A-16

as search operator  11-4

searches  11-10

Importing

appending records when  16-8

Approach files  16-10

database files  16-2–16-10

delimited text files  16-5

fixed-length text files  16-6

matching records and  16-9

text files  2-14–2-18, 16-5

updating records when  16-9

Incrementing record numbers  3-15

and renumbering by importing  
16-10

and renumbering with macros  3-4

Indented. See Three-dimensional

Index files

dBASE  19-12, B-2

external, for dBASE and 
FoxPro  19-12

filename extensions for  B-9

FoxPro  19-12, B-6

Paradox  19-13, B-4

secondary, for Paradox  19-13

InfoBox

collapsing  5-6

for design objects  5-5

for fields  6-15

online help for  5-5

opening  5-5

Initial check in macros  15-21

Inserting records.See Adding records

Inserting. See Adding

Insertion point in Browse  10-7, 10-8

Installing

ODBC drivers  D-7

International date formats

in date fields  10-11

in formulas  A-2

International settings for functions  A-7

International time formats

in formulas  A-2

in time fields  10-12

Invalid joins  4-17

IsBlank function  A-17

IsLastRecord function  A-17

J
Join dialog box, dimmed OK button 

in  4-16

Join fields  4-3

linking  4-13

in repeating panels  7-3

Joined data

appearance on views  4-4

examples of forms using  7-16–7-21

looking up  4-8, 7-17

Joining database files  4-13

Joins  4-1–4-20

advantages of  4-1–4-3

alias  4-11

between database and itself  4-11

on calculated fields  4-17, 19-14

creating  4-13

invalid  4-17

main and detail databases and  4-5

options for inserting and deleting 
records automatically  4-17

repeating panels for.See Repeating 
panels

types of relationships in  4-7–4-11

unjoining  4-20

valid  4-17

Justifying text  5-23
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K
Key field, specifying for Paradox 

databases

when adding fields to databases  3-19

when copying databases  2-21

when opening databases  2-10

L
Labels

See also Field labels; Mailing labels; 
Text

for repeating panels  7-9

for report panels  8-21

Labels. See Field labels; Mailing labels

Landscape orientation for printing  14-2

Last record, moving to  10-5

Layout

See also Design environment

of charts  13-14

of mailing labels  9-23

Layouts. See SmartMaster layouts

.LCK filename extension  B-9

Leading summary reports  8-4, 8-8

Left function  A-17

Left-aligning

data in fields  6-24

field labels  6-27

text in design objects  5-23

Legend frames on charts  13-2

layout and position of  13-14

Legends on charts  13-2

format, layout, and position of  13-14

Length function  A-18

Less than (<)

as comparison operator  A-5

in numeric formats  6-20

as search operator  11-4

Less than or equal to (<=)

as comparison operator  A-5

as search operator  11-4

Like function  A-18

Line charts  13-3

Line items. See Repeating panels

Line spacing of text  5-23

Line width

of design objects  5-19

of fields  6-25

of lines drawn in PicturePlus 
fields  10-16

of page margins  5-38

of repeating panels  7-12

Lines

See also Design objects

drawing, in PicturePlus fields  10-16

drawing, on views  5-12

number of, in repeating panels  7-11

Linked OLE objects  16-21–16-25

See also Embedded OLE objects; 
OLE (Object Linking and 
Embedding) objects

activating  16-25

breaking links for  16-25

changing sources for  16-25

deleting  16-25

editing  16-23–16-25

inserting, in Approach files  16-21

modifying links for  16-24

updating  16-25

Linking join fields  4-13

Lists, drop-down, for fields

changing values for  6-23

creating  6-4

Ln (Natural logarithm) function  A-19

Location. See Position

Locking protocol for dBASE files  18-4

Locking records for editing  19-14

Log (Logarithm) function  A-19

Logical expressions  A-6

Logical functions summarized  A-9

Lookups in joined data  4-8

example of  7-17

Looping macros  15-8

example of  15-19

Lotus 1-2-3 spreadsheets

creating databases from  2-11

creating views in  17-9–17-10

displaying data from  17-7–17-10

filename extensions for  B-10

Lotus Notes

database options for  19-11

displaying data from  17-1–17-6

mailing views and data with  16-16

replicating a database  17-4

Lotus Notes F/X 1.1  17-6

Lotus Symphony filename 
extensions  B-10

Lower (Lowercase) function  A-19

Lowercase, displaying text fields in  6-22

Lowercase letters.See Case sensitivity

M
Macro buttons, adding to views  15-11

Macros  15-1–15-25

adding commands to  15-4

adding macro buttons 
for  5-15, 15-11

attaching, to fields  15-14

attaching, to macro buttons  15-12

attaching, to objects  15-13

attaching, to views  15-15

Browse  15-5

Close  15-5

commands allowed in  15-5

conditional  15-21

creating  15-1–15-9

Delete  15-5

deleting  15-10

Dial  15-5

displaying dialog box for 
canceling  19-14

Edit  15-6

editing  15-9

Enter  15-6

examples of  15-16–15-25

Exit  15-6

Export  15-6

Find  15-6

Find Special  15-6

finding records with  11-11, 15-17

If calculations in  15-21

Import  15-6

looping  15-8
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looping, example of  15-19

Mail  15-7

Menu Switch  15-7

Message  15-7

moving commands in  15-4

Open  15-7

Preview  15-7

Print  15-7

Records  15-7

removing commands from  15-3

Replicate  15-7

Run  15-7

running  15-15

Save  15-8

saving find request 
with  11-11, 15-17

Set  15-8

setting a value with  15-19

Sort  15-8

Spell Check  15-8

switching views with  15-16

Tab  15-8

View  15-8

Zoom  15-8

Magnetic grid. See Design grid

Magnifying. See Enlarging

Mail, electronic  16-16

Mail merge. See Form letters

Mailing labels  1-6, 9-13–9-23

See also Views

adding design objects to  5-12–5-16, 
9-20

Avery forms for  9-16

changing layout of  9-23

creating  9-16–9-20

creating, in Lotus 1-2-3  17-9

custom layout for  9-18

default icon bar for  9-15

displaying fields on  9-17

layout of, changing  9-23

main databases for  9-18

margins for  9-23

moving fields on  9-21

moving fields on, automatically 
when printing (sliding)  9-21

options for  9-23

resizing fields on  9-21

SmartMaster layouts for  9-16

typing text on  9-22

Main database

for forms  xi

Main database files

for charts  13-6

for crosstabs  12-8

for form letters  9-8

for forms  7-3, 7-7

for mailing labels  9-18

for repeating panels  7-3, 7-11

for reports  4-6, 8-8, 8-11

for views  4-5

for views, changing  5-36

for worksheets  12-4

Main dictionary  10-18

switching  10-21

Many-to-many relationships in joins  4-9

Many-to-one relationships in joins  4-7

Mapping. See Field mapping

Margins. See Page margins

Mathematical functions summarized  A-9

Maximize button  1-9

.MB filename extension  B-9

.MDB filename extension  B-9

.MDX filename extension  B-9

Memo fields  3-2

See also Entering data

adding, to databases  3-2

editing definitions of  3-11

entering text in  10-8

in ODBC data sources, limitations 
of  D-2

Memo files  3-2

in dBASE, limitations of  B-3

in FoxPro, limitations of  B-6

in Microsoft Access, limitations 
of  B-8

in Microsoft SQL Server, limitations 
of  C-8

in Oracle SQL, limitations of  C-5

Menu bar  1-9

in Browse  10-2

customizing  19-18–19-22

in Design  5-3

Menus

changing, for views  5-36

context-sensitive, in Browse  10-2

context-sensitive, in Design  5-3

creating with macros  15-1

customizing  19-18–19-22

pop-up. See Pop-up menus

short  5-36

Menus, pop-up. See Pop-up menus

Merging text and data on form letters  1-5

Metafile (Windows) filename 
extension  B-10

Microsoft Access

database options for  19-11

field definitions and  B-7

filename extensions  B-9

files, opening  2-11

files, read-only  19-11

Microsoft Access files

compatibility with  B-7–B-8

opening  2-11

size limitations in  B-8

Microsoft Access tables

read-only  19-11

Microsoft Excel filename extension  B-10

Microsoft SQL Server

See also Database files

compatibility with  C-6–C-8

connecting to  C-6

field definitions and  C-7

files, caching  19-11

fi les, case-sensitivity of searches 
in  11-7

files, creating  2-5

files, database options for  19-11

files, read-only  19-11

size limitations in  C-8

Middle function  A-19

Minimize button  1-9
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Minus sign (-)

in numeric formats  6-20

as subtraction operator  A-4

Minute function  A-19

Mod (Modulus) function  A-20

Modem preferences  19-8

Modes. See Environments; specific 

environments

Month function  A-20

MonthName function  A-20

Moving

See also Aligning; Distributing; 
Editing; Stacking order of objects

between cells in a worksheet  12-16

between records  10-4–10-5

columns on crosstabs  12-18

columns on reports  8-27

columns on worksheets  12-18

commands in macros  15-4

data in fields  10-7

design objects  5-22, 5-24

design objects automatically when 
printing (sliding)  5-22

design objects to back or front  5-33

fields automatically when printing 
(sliding)  6-28

fields on crosstabs  12-18

fields on form letters  9-13

fields on mailing labels  9-21

fields on mailing labels 
automatically when printing 
(sliding)  9-21

fields in repeating panels  7-15

insertion point in Browse  10-8

report panels  5-22, 5-24

rows on crosstabs  12-18

Multiple databases. See Joins

Multiple objects, working 
with  5-32–5-35

Multiplication operator (*)  A-4

N
Named styles  5-6, 5-26–5-31

applying, to design objects  5-19

applying, to fields and field 
labels  6-23

applying, to page background  5-36

applying, to PicturePlus fields  6-31

applying, to repeating panels  7-11

assigning default, for objects and 
views  19-2

defining and saving  5-27

deleting  5-31

editing  5-31

Natural logarithm (Ln) function  A-19

.NDX filename extension  B-9

Networks  18-1–18-9

changing to single-user status 
on  18-6

control files for Paradox  18-4

downloading data from, in 
Preview  18-8

entering passwords on  18-7

“freezing” data from, on screen  18-8

locking protocol for dBASE files 
on  18-4

record locking on  19-14

refreshing data from, on screen  18-8

requirements for  xi, xiii

setting up environment 
for  18-2–18-6

sharing dBASE files on  18-2

viewing FoxPro files on  B-5

Next record, moving to  10-4

Non-blank fields, finding  11-9

Non-printing

design objects  5-19

fields  6-23

page margins  5-38

PicturePlus fields  6-31

Not equal to (<>)

as comparison operator  A-5

as search operator  11-4

NOT operator in logical expressions  A-6

Notation conventions  xii

Notes F/X 1.1  17-6

Notes on charts  13-2

format and position of  13-14

Notes server

quick connecting  17-3

replicating with  17-4

NPeriods (Number of periods) 
function  A-21

.NSF filename extension  B-9

Number of pages on reports, 
reducing  8-25

Number sign (#) in numeric formats  6-19

Numbering records  3-15

and renumbering by 
importing  16-10

and renumbering with macros  3-4

Numbers, finding  11-8

Numeric fields  3-2

See also Entering data

adding, to databases  3-2

automatic data entry in, setting up 
for  3-13

automatic data verification of, 
setting up for  3-13

displaying formatting characters in, 
when entering data  6-21

editing definitions of  3-11

entering data in  10-9

formatting  6-19

sort sequence for  3-2, 11-16

NumToText (Number to text) 
function  A-21

O
Object Linking and Embedding 

(OLE). See OLE (Object Linking 
and Embedding) objects

Object linking and embedding. See OLE 
objects

Objects

See also Design objects

linking. See OLE objects

Objects. See Design objects; Fields; OLE 
(Object Linking and Embedding) 
objects; Text objects
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ODBC data sources

adding, for an installed driver  D-8

case-sensitivity of searches in  11-7

database options for  19-11

field definitions and  D-2–D-3

on a server  D-5

opening, in Approach  D-3–D-7

quick-connecting to  D-6

set up on your system  D-6

size limitations in  D-3

ODBC drivers

adding data sources for  D-8

installing  D-7

OK button, dimmed, in Join dialog 
box  4-16

OLE (Object Linking and Embedding) 
objects  16-18–16-28

creating Approach  16-19–16-21

editing  16-23, 16-28

embedding  16-26–16-28

linking  16-21–16-25

in PicturePlus fields, options 
for  3-17

updating  16-25

One-to-many relationships in joins  4-9

repeating panels and  7-3

One-to-one relationships in joins  4-9

Online Help, using  xii

See also Help

Online tutorial. See Tutorial

Opening

Approach files  2-5–2-7

databases created by another 
application  2-9

SQL query files  C-15

Operands  A-1–A-3

constants  A-2

field names  A-2

Operators  A-1

in arithmetic expressions  A-4

in comparison expressions  A-6

search  11-4

Operators in logical expressions  A-6

Optimistic record locking  19-14

OR operator in logical expressions  A-6

“Or” searches  11-5

Oracle SQL

See also Database files

compatibility with  C-1–C-5

connecting to, on local drive  C-4

connecting to, server  C-2

field definitions and  C-4

files, caching  19-11

files, case-sensitivity of searches 
in  11-7

files, creating  2-5

files, database options for  19-11

files, read-only  19-11

size limitations in  C-5

Order

data entry (tab order)  6-32

sort. See Sort order

Orientation of pages when printing  14-2

.OYZ filename extension  B-9

P
<<#>>. See Page numbers

Page background  5-38

Page breaks after summary report 
panels  8-18

Page margins

borders of  5-38

hiding, in Browse  5-36

non-printing  5-19

resizing  5-38

Page numbers on report headers and 
footers  8-24

Page orientation for printing  14-2

Page size for printing  14-2

Pages, report

keeping records together on  8-27

reducing number of  8-25

Paintbrush (Windows) filename 
extension  B-10

Pane dividers on crosstabs  12-12

Pane dividers on 
worksheets  12-11, 12-16

Paper orientation for printing  14-2

Paper size, printer  14-2

Paradox files

See also Database files

case-sensitivity of searches 
in  11-7, 19-10

character sets for  19-10

compatibility with  B-3–B-5

database options for  19-10

field definitions and  B-4

filename extensions of  B-9

indexing and  19-13, B-4

key fields for  2-10, 2-21, 3-19

network control files for  18-4

read-only  19-10

sharing on networks, options 
for  18-4

size limitations in  B-5

PARADOX.NET Paradox network 
control file  18-4

Parameters in functions  A-6

Parent/Child.See One-to-many 
relationships in joins

Parentheses () in numeric formats  6-20

Passwords

defining  19-6

entering  2-6, 18-7

Pasting

design objects  5-24

fields  5-24

pictures as design objects  5-13

pictures into fields  10-14–10-16

text  5-24

Payment (PMT) function  A-22

.PCX filename extension  B-10

PCX pictures

adding, to views  5-13

pasting, into fields  10-14–10-16

PDOXUSRS.NET Paradox network 
control file  18-4

Pen. See Border

Pen width.See Borders; Line width

Percent sign (%) in numeric formats  6-19

Period (.) in numeric formats  6-19

Pi function  A-21
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Pick list. See Drop-down list

Picture fields

in ODBC data sources, limitations 
of  D-3

in Oracle SQL, limitations of  C-5

Picture files

in Microsoft SQL Server, limitations 
of  C-8

in ODBC data source, limitations 
of  D-3

PicturePlus fields  3-3, 6-29–6-32

adding, to databases  3-3

allowing drawing in  6-32

applying named styles to  6-31

copying contents of, to files  16-15

cropping graphics in  6-32

display options for  6-32

displaying on views  6-30

drawing in  10-16

editing definitions of  3-11

named styles for  5-26–5-31, 6-31, 
19-2

non-printing  6-31

OLE objects in  16-21–16-28

options for OLE objects in  3-17

pasting pictures into  10-14–10-16

properties of  6-31

read-only  6-31

resizing pictures in  6-32

Pictures

See also PicturePlus fields

adding, to views as design 
objects  5-13

displaying, on views as fields  6-30

exporting  16-15

pasting, into fields  10-14–10-16

pasting, on views as design 
objects  5-13

Pictures, adding to views

See also PicturePlus fields

Pie charts  13-7

Plotted area on charts  13-2

position of  13-14

Plus sign (+)

as addition operator  A-4

in numeric formats  6-19

PMT (Payment) function  A-22

Pop-up list.See Drop-down list

Pop-up menu in Design  5-6

Pop-up menus  1-9

Portrait orientation for printing  14-2

Position

See also Aligning; Distributing; 
Moving; Stacking order of objects

of chart components  13-14

of objects, displaying in status 
bar  5-22

of summary report panels  8-18, 8-23

Position function  A-22

PostScript (Encapsulated) filename 
extension  B-10

Pow (Power) function  A-22

PowerClick reporting  8-28–8-33

PowerKey technology  1-2

Preferences  19-1–19-16

See also Customizing

for all Lotus Notes tables  19-11

for all ODBC data sources  19-11

for all SQL tables  19-11

for dBASE files  19-9, 19-12

for default sort order of records  19-5

for Design  19-2

for displaying window 
elements  19-2

for FoxPro files  19-9, 19-12

general work  19-14

modem  19-8

for Paradox files  19-10, 19-13

password  19-6

screen display  19-2

Prefix function  A-23

Present value (PV) function  A-23

Preview environment  1-15, 14-3

customizing icon bar for  19-16

default icon bar for  14-4

downloading data for  19-14

“freezing” network data in  18-8

non-printing design objects in, 
showing  5-19

non-printing fields in, showing  6-23

non-printing PicturePlus fields in, 
showing  6-31

status bar in  14-4

zooming in and out in  14-3

Previewing records in views  14-3

Previous record, moving to  10-4

Printer, specifying  14-2

Printing  14-5

See also Non-printing

excluding records from  10-22

formatting crosstabs and worksheets 
for  12-23

moving design objects automatically 
when (sliding)  5-22

moving fields automatically when 
(sliding)  6-28

options for  14-2

records in views  14-5

reducing field boundaries when  6-28

Proper function  A-23

Pulse dialing for modems  19-8

PV (Present value) function  A-23

Q
.QRY filename extension  B-9

Query files. See SQL query files

Query. See Find request; Finding

Question mark (?) as search 
operator  11-4, 11-7

Quotation marks (") in numeric 
formats  6-19

R
Radian function  A-24

Radio buttons for fields

changing values for  6-23

creating  6-12

finding in  11-9

turning on and off  10-13

Raised.See Three-dimensional

Random function  A-24
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Range

of text, selecting, in design 
objects  5-17

of text, selecting, in fields  10-8

of values, finding  11-8

Read-only

Approach files  2-6

dBASE files  19-9

fields  6-23

FoxPro files  19-9

Paradox files  19-10

passwords, defining  19-6

PicturePlus fields  6-31

SQL tables  19-11

Read/write passwords, defining  19-6

Rearranging.See Aligning; Distributing; 
Editing; Moving; Stacking order 
of objects

Record numbers, automatic

renumbering, by importing  16-10

renumbering, with macros  3-4

setting up  3-15

Records

adding  10-5–10-6

adding, on networks. See Networks

adding, in repeating panels  10-6

in dBASE, limitations of  B-3

default sort order of  11-14, 19-5

deleting  10-23–10-24

duplicating  10-6

entering and editing data in.See 
Entering data

excluding  10-22

exporting  16-12

finding. See Finding

in FoxPro, limitations of  B-6

hiding, from view  10-23

in IBM DB2, limitations of  C-12

importing. See Importing

join options for inserting and 
deleting, automatically  4-17

keeping, together on reports  8-27

last. See IsLastRecord function

locking, for editing  19-14

mailing, electronically  16-16

in Microsoft SQL Server, limitations 
of  C-8

moving between  10-4–10-5

numbering  3-15

in ODBC data sources, limitations 
of  D-3

in Oracle SQL, limitations of  C-5

in Paradox, limitations of  B-5

previewing, in views  14-3

printing, in views  14-5

renumbering  3-4, 16-10

in repeating panels, number of  7-11

in repeating panels, summarizing 
data for  7-15

sharing, on networks.See Networks

showing hidden  10-23

sorting  11-14–11-18

updating, by importing. See 
Importing

Rectangles

See also Design objects

drawing on views  5-12

reshaping  5-21

Reducing

graphics in PicturePlus fields  6-32

number of pages on reports  8-25

views in Design  5-11

Referential integrity.See Joins

Refreshing

found records in macros  15-17

network data on screen  18-8

Relational database

applications  1-3

files  4-1–4-4

Removing

fields from worksheets and 
crosstabs  12-19

summary columns and rows from 
crosstabs  12-25

Removing. See Deleting

Renumbering records

by importing  16-10

with macros  3-4

Repeating panel reports  8-5, 8-11

Repeating panels  7-3

adding, on existing forms  7-7

adding, when creating forms  7-6

alternating colors in  7-7, 7-12

applying named styles to  7-11

borders of  7-12

displaying fields in  7-14

displaying records in  10-6

drop shadow for  7-12

example of  7-19

labels for  7-9

main databases for  7-3, 7-11

named styles for  5-26–5-31, 7-11

non-repeating fields in  7-14

number of lines in  7-9, 7-11

properties of  7-11

rearranging fields in  7-15

resizing  7-12

selecting  7-10

sort order in  7-7, 7-11

summarizing data for records 
in  7-15

three-dimensional  7-12

unjoining databases used in  4-20

Repeating searches  11-11

Replace function  A-24

Replace. See Fill field

Report columns.See Columns on reports

Report panels  8-21–8-24

alignment of  8-18

borders of  8-22

color of  8-22

deleting  5-25

drop shadows for  8-22

location of  8-18

moving  5-22, 5-24

selecting  8-22

showing labels for  8-21

summary  8-14–8-20
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Reports  1-4, 8-1–8-33

See also Columnar reports; 
Repeating panel reports; Standard 
reports; Summary reports; Views

adding subtotals to  8-31

adding summary panels 
to  8-16, 8-29

adding title pages to  8-25

columnar  8-3, 8-5

creating  8-3–8-13

creating, in Lotus 1-2-3  17-9

default icon bar for  5-2

displaying fields on  8-7

editing text and design objects on, in 
Design  5-18–5-25, 5-32–5-35

examples of  8-28–8-33

finding records on.See Finding

footers for  8-24

formatting  8-20–8-28

headers for  8-24

keeping records together on  8-27

leading summary  8-4, 8-8

main databases for  4-6, 8-8, 8-11

moving columns on  8-27

number of columns on  8-25

PowerClick examples of  8-28–8-33

previewing. See Preview

reducing number of pages on  8-25

repeating panel  8-5, 8-11

report panels in.See Report panels

resizing columns on  8-28

SmartMaster styles and layouts 
for  8-3

standard  8-3, 8-5

subtotals on  8-31

summarizing data on  8-14–8-20

summary  8-4, 8-8

title pages for  8-25

trailing summary  8-4, 8-8

Requirements

network  xiii

system  xiii

Reserializing records

by importing  16-10

with macros  3-4

Reshaping, design objects  5-21

Resizing

columns on reports  8-28

columns on worksheets and 
crosstabs  12-19

design objects  5-21

fields on mailing labels  9-21

fields on views  5-21

page margins of views  5-38

pictures in PicturePlus fields  6-32

repeating panels  7-13

rows on worksheets and 
crosstabs  12-19

Right function  A-24

Right-aligning

data in fields  6-24

field labels  6-27

text in design objects  5-23

Round function  A-25

Rounded rectangles

See also Design objects

drawing on views  5-12

reshaping  5-21

Row gutters on worksheets  12-11

Row markers on worksheets  12-11

Rows on crosstabs  12-12

adding, for fields  12-17

adding summary  12-24

deleting summary  12-25

editing formulas for  12-25

moving  12-18

removing  12-18

resizing  12-19

Rows on worksheets  12-1

resizing  12-19

selecting  12-14

Rulers, design  5-8

in form letters  9-9

Running totals, setting up formulas 
for  3-8

S
Salutation on form letters  9-2

SAverage (Summary Average) 
function  A-25

Saving

Approach files  2-18–2-22

changes to shared records  18-9

creating SQL query file by  C-14

data from SQL query  C-15

databases, copies of  2-19

design changes  5-1

Find requests with 
macros  11-11, 15-17

named styles  5-27

queries with macros  11-11, 15-17

sort order with macros  11-11

templates for databases  2-19

SCount (Summary count) function  A-25

Screen display

increasing work space  1-8

work area  1-8

work area, preferences for  19-2

Search criteria.See Find request

Search operators  11-4

Search strings, case-sensitivity of  11-7

in Paradox files  19-10

Search. See Find

Searching.See entries beginning with 
Find

Second function  A-25

Secondary indexes for Paradox 
files  19-13

“See-through” objects  5-19

Selecting

in Browse  10-7

in Design  5-17

repeating panels  7-10

report panels  8-22

on worksheets  12-13

Semicolon (;) in numeric formats  6-20

Serial numbers for records

editing, by importing  16-10

editing, with macros  3-4

setting up  3-15
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Series on charts  13-2

adding  13-14

Server applications  16-18

Servers, connecting to

IBM DB2  C-9–C-12

Microsoft SQL Server  C-6

Oracle SQL  C-2

Shape of design objects, changing  5-21

Sharing data

on networks. See Networks

with other applications. See OLE 
(Object Linking and Embedding) 
objects

Sharing files.See Network

Short menus  5-36

Show data entry format option, in 
InfoBox  6-15

Showing. See Displaying

Shrinking graphics in PicturePlus 
fields  6-32

Sign function  A-26

Sin (Sine) function  A-26

Single user status on networks  18-6

Size

changing. See Resizing

of design objects, displaying in status 
bar  5-21

Slash (/) as arithmetic operator  A-4

Sliding, when printing

fields  6-28

objects  5-22

Sliding. See Moving

SLN (Straight-line depreciation) 
function  A-26

Smart index  11-3

SmartIcons  xii , 1-8

See also Icon bars

online help for  1-10

SmartMaster layouts

for charts  13-3

for form letters  9-3

for forms  7-4

for mailing labels  9-16

for reports  8-3

SmartMaster styles

for charts  13-4

for form letters  9-3

for forms  7-4

for reports  8-3

SmartMasters  1-3

See also SmartMaster layouts; 
SmartMaster styles

SMax (Summary maximum) 
function  A-26

.SMI filename extension  B-9

SMin (Summary minimum) 
function  A-27

Snapping objects to design grid  5-8

SNPV (Summary net present value) 
function  A-27

Software compatibility  16-1, B-1–B-10, 
C-1–C-16, D-1–D-3

summarized  1-2

Sort order

ascending  11-15

changing  11-18

default  11-14

default, preference for  19-5

descending  11-15

in repeating panels  7-7, 7-11

restoring original  11-18

saving, with macros  11-11

specifying  11-16

Sorting  11-14–11-18

excluding records from  10-22

Soundslike function  A-27

Space-delimited text files

creating databases from  2-14

importing  2-14, 16-5

Spacing

adding blank columns to worksheets 
for  12-21

of lines of text  5-23

of objects  5-34

Span function  A-27

SpanUntil function  A-28

Spelling checker  10-17–10-22

editing user dictionary for  10-20

main and user dictionaries for  10-18

options for  10-21

running  10-18

switching main dictionary for  10-21

Spreadsheets

creating databases from  2-12

filename extensions for  B-10

SQL queries

exporting data from  C-16

saving data from  C-15

SQL query files  C-13–C-16

creating  C-14

editing  C-14

opening, in Approach  C-15

SQL Server, Microsoft.See Microsoft 
SQL Server

SQL servers.See IBM DB2; Microsoft 
SQL Server; Oracle SQL

SQL system table filenames, displaying, 
in dialog boxes  19-11

SQL tables  C-1–C-16

caching  19-11

case-sensitivity of searches in  11-7

database options for  19-11

read-only  19-11

Sqrt (Square root) function  A-28

Squares

See also Design objects

drawing on views  5-12

reshaping  5-21

SSTD (Summary standard deviation) 
function  A-28

SSum (Summary sum) function  A-28

Stacking order of objects, changing  5-34

Standard deviation (STD) function  A-29

Standard forms  7-4

Standard reports  8-3, 8-5

Starting Approach, showing Welcome 
dialog box when  2-3, 19-2

Statistical functions summarized  A-9
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Status bar  1-9

in Browse  10-2

for crosstabs  12-12

in Design  5-3

in Preview  14-4

showing or hiding  1-10

showing or hiding, preference 
for  19-2

STD (Standard deviation) function  A-29

Stored queries  11-11, 15-17

Stored sort order  11-11

Straight-line depreciation (SLN) 
function  A-26

Stretching graphics in PicturePlus 
fields  6-32

Style menu

Field Style command. See Field 
Style command

Text Style command. See Text Style 
command

Styles. See Named styles; SmartMaster 
styles

Subtitles on charts  13-2

format and position of  13-14

Subtotals in summary panels  8-19–8-20

Subtraction operator  A-4

Summarized data

on crosstabs  12-24–12-26

on forms  7-15

on forms, example of  7-19

on reports  8-14–8-20

on reports, examples of  8-28–8-33

when calculated  14-4

Summary average (SAverage) 
function  A-25

Summary count (SCount) function  A-25

Summary fields.See Calculated fields; 
Formulas

Summary functions summarized  A-9

Summary maximum (SMax) 
function  A-26

Summary minimum (SMin) 
function  A-27

Summary net present value (SNPV) 
function  A-27

Summary panels  8-14–8-20

adding  8-16

aligning  8-18

displaying calculated fields on  8-19

page breaks after  8-18

position of  8-18, 8-23

Summary reports  8-4, 8-8, 8-14

Summary standard deviation (SSTD) 
function  A-28

Summary sum (SSum) function  A-28

Summary variance (SVAR) 
function  A-29

SVAR (Summary variance) 
function  A-29

Symbols, operators  A-1

Symphony filename extensions  B-10

System requirements  xiii

T
TAB key, using ENTER key as  19-14

Tab order for data entry  6-32

Tab-delimited text files

creating databases from  2-14

importing  2-14, 16-5

Table limitations

in IBM DB2  C-12

in Microsoft SQL Server  C-8

in ODBC data sources  D-3

in Oracle SQL  C-5

Table view. See Worksheets

Tables. See Database files

Tabs, divider.See View tabs

Tagged Image File format (TIFF) 
filename extension  B-10

Tan (Tangent) function  A-29

Targa filename extension  B-10

Targa pictures

adding, to views  5-13

pasting, into fields  10-14–10-16

Template databases  xii

Templates for databases  2-3, 3-5

saving  2-19

Text

See also Design objects; Field labels; 
Labels; Text fields; Text objects

adding, to form letters  9-12

adding, to mailing labels  9-22

aligning, in design objects  5-23

color of, in data fields  6-24

color of, in design objects  5-23

deleting, in Design  5-25

deselecting, in Design  5-17

editing, in Design  5-18–5-25, 
5-32–5-35

editing, in worksheet column 
headers  12-22

entering, in text and memo 
fields  10-8

finding  11-6–11-7

finding, wildcards for  11-6

formatting  6-22, 6-24

formatting, on charts  13-15

formatting, on crosstabs  12-23

formatting, in Design  5-23

formatting, on worksheets  12-23

in formulas  A-2

icon bar  5-2

selecting, in Design  5-17

Text fields  3-1

See also Entering data; Text; Text 
objects

adding, to databases  3-5

automatic data entry in, setting up 
for  3-13

automatic data verification of, 
setting up for  3-13

capitalization of  6-22

displaying correct capitalization of, 
when entering data  6-22

editing definitions of  3-11

entering data in  10-8

formatting  6-24

sort sequence for  3-1, 11-16

Text files

creating databases from  2-14–2-18

filename extensions for  B-10

importing  2-14–2-18, 16-5
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Text objects

See also Design objects; Text

adding, to views  5-14

aligning text in  5-23

applying named styles to  5-19

applying properties to, from another 
object  5-25

deleting  5-25

deselecting  5-17

editing  5-18–5-25, 5-32–5-35

entering text in  5-14

form letters as  9-12

line spacing of text in  5-23

named styles for  5-19, 5-26–5-31, 
19-2

properties of text in  5-23, 5-25

selecting  5-17

Text size

of data in fields  6-24

of field labels  6-27

of text in design objects  5-23

Text style

of data in fields  6-24

of field labels  6-27

of text in design objects  5-23

Text-related functions summarized  A-9

TextToBool (Text to Boolean) 
function  A-30

TextToDate function  A-30

TextToTime function  A-30

.TGA filename extension  B-10

TGA pictures

adding, to views  5-13

pasting, into fields  10-14–10-16

Three-dimensional

charts  13-12

design objects  5-20

field labels  6-27

fields  6-25

repeating panels  7-12

report panels  8-22

.TIF filename extension  B-10

TIFF

adding, pictures to views  5-13

filename extension  B-10

pasting, pictures into 
fields  10-14–10-16

tilde (~) as search operator  11-4

<<TIME>>. See Time, current

Time, current

in formulas  A-2

in report headers and footers  8-24

on views  5-38

Time fields  3-3

adding, to databases  3-5

automatic data entry in, setting up 
for  3-13

automatic data verification of, 
setting up for  3-13

displaying formatting characters in, 
when entering data  6-19

editing definitions of  3-11

entering data in  10-11

formatting  6-18

international formats for  10-12

sort sequence for  3-3, 11-16

Time, finding  11-8

Time function  A-30

Time-related functions summarized  A-9

Title frames on charts  13-2

position of  13-14

Title pages for reports  8-25

Titles on charts  13-2

format and position of  13-2

Today function  A-31

Tone dialing for modems  19-8

Tools palette in Design  5-9

Top, moving design objects to  5-33

Totals

for data in repeating panels  7-15

setting up formulas for  3-8

in summary report panels  8-19–8-20

Trailing summary reports  8-4, 8-8

Translate function  A-31

Transparent

objects  5-19

repeating panels  7-12

Triggers, macro  15-10

Trigonometric functions, 
summarized  A-9

Trim function  A-31

Trunc (Truncate) function  A-31

Tutorial  xi

.TXT filename extension  B-10

Typing text

See Entering data

Typing. See Entering data; Entering 
passwords

U
Ungrouping objects  5-32

Unjoining database files  4-20

Updating

linked OLE objects  16-25

records. See Editing; Importing

Upper (Uppercase) function  A-31

Uppercase, displaying text fields in  6-22

Uppercase letters.See Case sensitivity

User dictionary  10-18

editing  10-20

V
Valid joins  4-17

Value list. See Drop-down list

Values

constants  A-2

entering, in fields  10-16

finding. See Finding

in formulas  A-2–A-32

limiting, in fields  6-7

operands  A-2

Var (Variance) function  A-32

Variable fields  3-4

adding, to databases  3-5

automatic data type verification of, 
setting up for  3-15

editing definitions of  3-11

enabled for Notes F/X 1.1  17-6
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in find macros  15-19

options for data in  3-18

Verification of data, automatic  3-13, 3-15

Vertical bar (|) in numeric formats  6-20

.VEW filename extension  B-9

View files

designing. See Design

View password, changing Design and

See also Set View Password

View pop-up menu, in status bar  1-9

View tabs  1-9

for crosstabs  12-12

showing or hiding  1-10

showing or hiding, preference 
for  19-2

for worksheets  12-11

Viewing. See Displaying

Views  1-3–1-8

See also Charts; Crosstabs; Design 
environment; Form letters; Forms; 
Mailing labels; Reports; 
Worksheets

adding design objects to  5-12–5-16

adding OLE objects to  16-21–16-28

appearance of joined data on  4-4

applying named styles to background 
of  5-36

attaching macros to  15-15

background color and pattern 
of  5-38

borders of  5-38

charts  13-1–13-12

checkboxes on  6-10, 6-23

creating Approach OLE objects 
for  16-19–16-21

creating, in Lotus 1-2-3  17-9

crosstabs  12-1–12-26

current date on  5-38

current time on  5-38

customizing icon bar for  19-16

data entry order on  6-32

data formats for fields on  6-14–6-22

deleting  5-40

deleting text and objects on  5-25

designing. See Design

displaying fields on  6-1–6-14, 
6-29–6-32

displaying PicturePlus fields 
on  6-29–6-32

drop-down lists on  6-4, 6-23

duplicating  5-39

duplicating objects on  5-24

editing fields on, in 
Design  6-22–6-29, 6-31–6-32

editing text and objects on, in 
Design  5-18–5-25, 5-32–5-35

entering and editing data on. See 
Entering data

finding records on. See Finding

form letters  9-1–9-13

formatting text on  5-23

forms  7-1–7-21

hidden records on  10-23

hiding, in Browse  5-36

hiding, page margins of   5-36

importing  16-10

limiting the values for fields on  6-7

mailing, electronically  16-16

mailing labels  9-13–9-23

main databases for  4-5, 5-36

margins of  5-38

menus for  5-36

moving design objects on, 
automatically when printing 
(sliding)  5-22

moving fields on, automatically 
when printing (sliding)  6-28

moving objects on  5-22, 5-24

named styles for  5-26–5-31, 5-36, 
19-2

names of  5-36

page background of  5-38

previewing  14-3

printing  14-5

properties of fields on  6-22–6-29

radio buttons on  6-12, 6-23

reducing field boundaries on, when 
printing  6-28

reports  8-1–8-33

resizing fields on  5-21

resizing page margins of  5-38

selecting on  5-17

switching between  1-9

switching between, example of 
macro for  15-16

types of  1-3–1-8

unjoining databases used for  4-20

worksheets  12-1–12-24

W
WeekOfYear function  A-32

Welcome dialog box, displaying when 
starting Approach  2-3, 19-2

Where-placed option, for formulas  3-10

Width

See also Line width

of objects, displaying in status 
bar  5-21

Wildcards for finding  11-6

Windows bitmap

adding, pictures to views  5-13

filename extension  B-10

pasting, pictures into 
fields  10-14–10-16

Windows character set.See character sets

Windows Metafile

adding, pictures to views  5-13

filename extension  B-10

pasting, pictures into 
fields  10-14–10-16

Windows Paintbrush

adding, pictures to views  5-13

filename extension  B-10

pasting, pictures into 
fields  10-14–10-16

.WKn filename extension  B-10

.WKS filename extension  B-10

.WMF filename extension  B-10

WMF pictures

adding, to views  5-13

pasting, into fields  10-14–10-16

Words. See Text
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Work area  1-8

preferences for  19-2

Work space, Approach file window, 
increasing  1-8

Worksheets  1-7, 12-1–12-24

See also Crosstabs; Views

adding columns to  12-17, 12-21

in Browse  12-3

column gutters on  12-11

column headers in. See Column 
headers on worksheets

converting to crosstabs  12-8

copying, to Clipboard  12-15

creating  12-3

default icon bar for  12-11, 12-12

deleting fields from  12-18

in Design  12-3

displaying fields on  12-17

dividing, into panes  12-16

formatting for printing  12-23

formatting text on  12-23

formulas for  12-21

main databases for  12-4

moving between cells on  12-16

moving columns on  12-18

pane dividers on  12-11, 12-16

properties of  12-22

resizing columns and rows on  12-19

row gutters on  12-11

row markers on  12-11

selecting on  12-13

text properties on  12-23

.WR1 filename extension  B-10

.WRK filename extension  B-10

X
X-axis on charts  13-2

properties of  13-14

.XGn index filename extension  B-9

.XLS filename extension  B-10

.Xnn index filename extension  B-9

Y
Y-axis on charts  13-2

properties of  13-14

Year function  A-32

.YGn index filename extension  B-9

.Ynn index filename extension  B-9

Z
Zero (0) in numeric formats  6-19

Zooming in and out

in Design  5-11

in Preview  14-3
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